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Trial Mode Trial mode refers to the 30-day period in which is not required to log in to use Wealth-Lab Pro. After the first log in, during or after the 30-day trial period, Wealth-Lab Pro becomes a "full" version. During the "trial" period, only features related to logging in that are disabled. Specifically: No streaming charts. Static intraday charts can be updated with approximately 20 minutes delay, and daily data updates only for the previous complete session. No quotes in Quotes tool (requires streaming) No real-time quotes in trade ticket No Trading in live accounts No Accounts and Balances for live accounts Strategy monitor is available in the trial version for daily strategies associated with Paper account. The full version with login is required to run strategies in intraday scales. Fundamental data updates are not available No ability to update the GICS database
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New and Noteworthy Version 6.9.17 is a maintenance release with bug fixes for trading, accounts display, and login stability. For enhancements and bug fixes, see What's Changed 4 .
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What's New See What's Changed



4



.
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What's Changed Bug Fixes and Maintenance Minor bugs and cosmetic fixes may not be listed. Orders Tool and Trading Covering short orders were incorrectly being submitted as new long positions in Fidelity trading. Fills, partial fills, and execution prices were not consistently reflected in the Order status. Potential fix for Wealth-Lab Pro "Stuck Submitted" orders implemented in Fidelity backend Accounts Tool Closed accounts were erroneously appearing in the account list. Certain types of alternate brokerage accounts (BrokerageFlex, etc.) were not showing up in the account list. Miscellaneous Various login instability issues. Improved application security.
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Introduction What is Wealth-Lab Pro? Wealth-Lab Pro is a complete platform for developing and back-testing stock and futures trading strategies based on technical analysis and where applicable, fundamental analysis. Proven trading strategies can be applied to trading end-of-day as well as real-time data using Wealth-Lab's automated trading features. A trading strategy (or trading system) is a set of explicit rules that tell you when to buy, sell, sell short, and cover. Trading strategies are meant to exploit opportunities to profit in the markets. Wealth-Lab Pro lets you develop and validate trading strategies, and can help you implement them in real-world trading.



Who Should Use Wealth-Lab Pro? Wealth-Lab is a programming environment and is geared toward programmers. By offering a full-blown programming platform, there is no limit to the strategy ideas that can be transcribed, tested and traded. However, the product contains a number of Wizards and visual tools that allow non-programmers to create their own trading systems. The tools are specially designed so that non-programmers can leverage the expertise of the WealthLab programming community, who provide a constant source of fresh ideas. So, the bottom line is that Wealth-Lab Pro is the tool for any Windows user who is interested in technical analysis-based trading systems.



Getting a True Sense of a Strategy's Potential Before committing your money to trading a strategy, it's important to test the strategy on as many markets and time periods as possible. Wealth-Lab allows you to test strategies on a single market (symbol) or on a complete portfolio at once. Thorough backtesting can give you an idea of a strategy's profit potential, its drawdown, and therefore the confidence to employ the strategy using your actual trading account.



Finding a Strategy for You Every individual has a distinct personality, risk tolerance, and amount of time that can be dedicated to trading. Wealth-Lab Pro comes pre-packaged with a number of complete trading strategies, which are very useful as examples. Nonetheless, you can explore these systems to find one that best suits your own trading style, or find one to use as the basis for your own unique creation.



Putting a Strategy into Action After you find your ideal strategy (or strategies) it's time to trade. Wealth-Lab has the tools to help you manage your trading on a day-by-day (or even tick-by-tick) basis. The all-new Strategy Monitor 147 makes it possible to execute all of your strategies in a single window so that you can scan for signals at the end of each day or use up-to-the-minute data to get signals in real-time.
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How to Use This Guide The organization of this guide makes it a good reference for each tool, dialog, and menu item. When you need more information about a window, just strike the F1 key to launch the guide into the topic that you're currently using. Nonetheless, we've organized this guide so that it can be read by newbies in a cumulative fashion to discover the features of Wealth-Lab Pro in a logical manner: Quick Start Quick Start is an abridged version of the detailed information found in the rest of the User Guide. 1. Data After a few notes and tips on getting started, we go straight into the all-important topic of Data. You cannot even view a chart without data, so it's a good place to start. 2. Charting With the data that you've collected for your DataSets, you'll want to get right to charting. Wealth-Lab charts are some of the finest, and eventually you may discover that you can do some strategy building and testing with them that isn't offered in any other charting or backtesting software. 3. Strategy Window Developing, testing, and trading strategies is at the heart of what Wealth-Lab is all about. In this chapter you'll learn how to run strategy simulations against individual instruments as well as for complete DataSets. In addition, you can use the Optimizer to find ranges of strategy parameters that are more likely to work best. While the ability to program is a big plus for developing practically any trading strategy that you can think of, non-programmers can use WealthLab's Strategy Builder to express trading ideas using a convenient dragand-drop interface. 4. Strategy Monitor Version 6's all-new Strategy Monitor 147 executes all of your strategies in a single window so that you can scan for signals at the end of each day or using up-to-the-minute data to get trading alerts in real-time. 5. Quotes You can use Quotes windows to simply monitor streaming quotes for selected symbols, but the real power is to use it as an automation tool to trigger stop and limit orders entered from trading strategies so that they can be staged in the Orders window at the most opportune moment. 6. Orders The Orders tool is the bridge for trading automation between Wealth-Lab Pro and the Fidelity brokerage back end. You can Stage orders from the various Alert-generating tools to later manually or automatically place them in the market. 7. Account Balances and Positions Accounts automatically tracks trades placed through the Orders tool accounts to paper trade a strategy before going live.
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8. Preferences User defaults for Chart appearance, backtesting, sounds, etc. are configured through the Preferences dialog, just an F12 keystroke away. 9. Extension Manager Add features to Wealth-Lab by installing them using the Extension Manager. 10. Index-Lab®, Neuro-Lab®, and Monte Carlo-Lab Three major, integrated add-ins are available for Wealth-Lab Pro: Index-Lab® is included in the Wealth-Lab installation to create your own market breadth, aggregate indicator, and other custom indices. Monte Carlo-Lab is implemented as a Performance Visualizer 211 so that you can perform Monte Carlo analyses on Portfolio mode simulations. Neuro-Lab® gives you the ability to create and train your own artificial neural networks and implement them with the NNIndicator in Strategy code. Monte Carlo-Lab (part of the Extra Performance Visualizers component) and Neuro-Lab® are installed using the Extension Manager 244 . 11. Reference The Reference has important information and guidance for menus, toolbars, and other dialogs that are used by the primary tools in Wealth-Lab Pro. You can also find a list of Keyboard shortcuts and a useful glossary.
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How to Run Example Code It's not the intent of this guide to instruct how to program in WealthScript, however, where appropriate you'll find examples of code to demonstrate how to accomplish something in an automated fashion. In general, use the following procedure to run example code. 1. Launch a new Strategy Window 2. Click on the Editor tab.



95



.



Example code comes in two forms: complete and partial. 3. Complete: The code is complete if you see with "using" statements at the beginning (as in the image below). In this case, copy the example and completely replace all of the code, if any, showing in the Editor. After pasting the code, skip to step 5. Partial: To focus on the essence of the example, most often only the Execute() method is given. In this case, completely replace the Execute() method, which is highlighted in the image below. 4. Pay attention to green comment lines in the sample code, which may include special initialization or setup instructions. 5. Click Compile in the Editor's toolbar and ensure "Strategy compiled successfully!" in the lower message frame. 6. Click F5 on the keyboard, or click a symbol of your choice in the Data Panel execute the example.



Replacing the Execute method in the Strategy Editor.
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Quick Start About Quick Start The goal of Quick Start is to provide additional material that will help customers quickly get started using Wealth-Lab Pro. For more in depth detail on any of the topics covered refer to the specific topics in the Wealth-Lab User Guide, WealthScript Programming Guide, or QuickRef (F11), all located within the Help menu of Wealth-Lab Pro, or on Fidelity.com’s Active Trader download section.



Important Note: Examples of specific securities or concepts depicted in the in this WealthLab Pro Quick Start and User Guides are given for illustrative purposes only and should not be used or construed as a recommendation or offer for any specific security.



Fidelity’s Wealth-Lab Pro is available to those investors in households that place 120 or more stock, bond, or options trades in a rolling twelve-month period, plus $25,000 in assets across their eligible Fidelity brokerage accounts are eligible for Wealth-Lab Pro. Combined household trading activity is calculated each business day. Customers who do not maintain the required trading activity in their combined household accounts will become ineligible for Active Trader Pro and Wealth-Lab Pro entitlements without notice. See the Household Relationship Form for details on how to authorize Fidelity to consolidate accounts held by you, or your immediate family members who reside with you, into an aggregated relationship household. Fidelity Brokerage Services, Member NYSE, SIPC
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How to gain access to Wealth-Lab Pro Wealth-Lab Pro is available to customers wishing to access the software in a limited 30 day trial or a fully integrated version. Note the full version of Wealth-Lab Pro is only available to qualified Fidelity Active Trader customers. 30 Day Trial Version A Wealth-Lab Pro 30 day trial version is available with limited functionality to all current and potential customers interested in sampling the software’s capabilities. To access the trial version go to Fidelity.com/Investment Products/Active Trader/Download, or call 1800-TRADER1 for more information. Full Wealth-Lab Pro Version: The fully integrated version of Wealth-Lab Pro offers all the product’s functionality to develop and back-test trading systems, and place trades based on your technical trading strategies. This version is available to Investors in households that place 36 stock, bond, or option trades in a rolling 12-month period, with a minimum of $25,000 in assets across all their eligible Fidelity brokerage accounts. Call 1-800-TRADER1 for more information. Eligibility for the fully integrated version of Wealth-Lab Pro is subject to change by Fidelity.
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Getting Started Entitlement Wealth-Lab Pro Version 6 requires an entitlement to run the software with full functionality. The following steps detail the process. Please note that entitlements will be given to qualified Fidelity Active Trader Services customers. All others should call 1800-TRADER1 for further information. The 30 day Trial version does not require an entitlement and can be used with limited functionality once your download is complete. Follow these easy steps to start using Wealth-Lab Pro: Step 1:



Download the 30-day trial version software from fidelity.com/wlp



Step 2:



Open or save the download to your computer.



Step 3:



Run the installation.



Step 4:



Accept the user agreement to complete the installation.



Step 5:



For users who don’t have an account with Fidelity Active Trader Pro and are downloading the 30 day trial version you can now begin using Wealth-Lab Pro. The 30 day Trial version does not require an entitlement and can be used with limited functionality for 30 days.



- Or Step 6:



4.2.1



If you are eligible for Wealth-Lab Pro and have already been granted access, you may now begin to use the full version of the application. You are no longer required to obtain an entitlement key from Fidelity.



Home Page Navigate through Wealth-Lab Pro quickly and easily by using the Home page. Access the key features and tools you need to build, backtest, monitor, and trade your Strategies right at your finger tips.
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Figure 1.1 Wealth-Lab Pro Home Page



Key Sections 1) View Charts



View historical or real-time charts for your favorite stock. Enhance your analysis with drag & drop technical indicators and fundamental data or use the drawing tools to create support and resistance channels, tradable trendlines or chart annotations.



2) Explore and Backtest



Explore pre-built trading strategies for ideas, or customize them to validate your own trading ideas by backtesting the idea and analyzing the hypothetical results.



3) Build and Backtest



Build your own trading strategy easily with drag & drop functionality, or program your own strategy. By backtesting your trading strategy using historical data you can see the hypothetical performance of your strategy and understand how your strategy could behave in the future.



4) Activate Strategies



Now that you've built a strategy, add that strategy to the Strategy Monitor. Monitor your trading strategies for trade alerts in one location. Customize each strategy to your trading preferences with backtesting parameters like scale, trade size or portfolio management settings, data range, and symbols. Activate each strategy to automatically check for data updates and new trade alerts, and then manage those alerts from the same window.



5) Manage Orders



With the Orders tool get the latest status on active, canceled and executed orders thru Wealth-Lab Pro.



6) What’s New



This section will update dynamically to display links to Help, information
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about new features in Wealth-Lab Pro, links to the Wealth-Lab Community, and Expert Strategies. If you're not connected, the last page saved is shown. 7) Recently Viewed Strategies



4.2.2



Track recently viewed strategies and easily go back to review hypothetical performance, change parameter settings, and re-run the backtest using the changed values. Analyze the effect of the changes in the hypothetical results.



Charting Basics Opening up a basic Chart Now that you have installed Wealth-Lab Pro, one of the basic functions is to view a chart, but before doing that you will need to collect the stock’s data. You have two options as to which data you wish to display. The first option would be to connect to a data provider of your choice. Eligible customers with the full version of Wealth-Lab Pro have the option to access live streaming data through Fidelity or downloading static historic data without any additional costs. Logging in to Active Trader Pro® is not required to use Wealth-Lab Pro. You can log in to Fidelity directly from Wealth-Lab Pro by clicking the Log in to Fidelity button located on the Function toolbar or by selecting File > Log in to Fidelity.



Enable Streaming Feed To enable streaming data in a Chart or Strategy window, select the Scale and Data Range fields to check your settings. Then click on the Stream button in the bottom right hand corner to enable streaming as indicated in Figure 2.0.
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Figure 2.0 Selecting Scale, Data Range, and Streaming.



Steps to view a basic Wealth-Lab Pro chart 1) 2) 3) 4) 5) 6)



Log in to Fidelity via the Function toolbar. Open a Chart or Strategy window. Verify the Scale and Data Range settings are correct. Click the Streaming button in the lower right hand corner of the charts. Type in the symbol of your choice in the Symbol entry box. Click the Go button. Basic charts can also be viewed using static historical data stored in WealthLab Pro. See the Manage Data 15 section to learn how to download static data.
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Manage Data Collecting Static Data Static data is historical data that you've collected (stored) on your computer to use for analysis and backtesting. Downloading static data is a critical step in using Wealth-Lab Pro since market data powers all your tools. Failing to do download data in advance may result in a “No Data Available” Message when attempting to view a chart. If the On Demand Data feature is active the chart data will be downloaded and displayed, however, the delay while the data is downloaded for the first time can be considerable. Symbols with intraday timeframes such as 1, 3, or 5minutes may experience significant delays (5 minutes or more) due to the amount of data being downloaded. The static data can consist of different time intervals such as daily, or 1, 3, 5, 10, 15, 30 minute bars, and, Wealth-Lab can easily re-scale these source data to other intervals as well.



Create Datasets that capture your market data The Data Manager is the component of Wealth-Lab Pro that manages the data you need to build and test your trading strategies or to review a historic chart. It provides a number of functions that let you manage, edit, and update your data. It also contains special features for managing Fidelity and other Integrated Data Providers. You can access the Data Manager by selecting it the main toolbar (Fig. 3.0) or by using the keyboard shortcut Ctrl+M.



Figure 3.0 Launch the Data Manager from the Navigation toolbar.



Data Manager Once in the Data Manager you have two main actions: 1. Create a new DataSet. 2. Modify or update an existing DataSet like the Dow 30. See the User Guide's Data Manager options.



37



topic for more details and other data maintenance
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Figure 3.1 Data Manager showing Symbol Details for the selected DataSet (Dow 30) and right-click DataSet actions menu.



Creating a New DataSet Using The Wizard Several popular indices and their components are preloaded in Wealth-Lab Pro. To create your own symbol list, select the DataSet Wizard and enter the symbols that you would like to collect, separated by commas or spaces. You can also select a list of symbols from Industry Classifications or even import a Watchlist from your fidelity.com account. After defining the symbol list choose among data bar frequencies of daily, or 1, 3, 5, 10, 15, and 30 minutes in the lower dropdown menu and click the next button to complete creation of the DataSet symbols (Fig. 3.2). To collect data, follow Update instructions. If interested in an interval not listed, choose greatest integer multiple interval. For example, if you want to test with 9 minute bars, download 3-minute data. You'll be able to re-scale these data on the fly in each of the testing tools.



© 2017 FMR LLC All rights reserved.



17



User Guide, Wealth-Lab Pro



Figure 3.2 New DataSet Wizard



Manual or Automated Data Updates Wealth-Lab Pro Version 6 allows you to perform manual data updates or Schedule Data Updates in the same interface - the Data Updates tab in Data Manager. To conduct a manual data update, select from historical data providers Fidelity, MSN, and/or Yahoo! Next, select the fundamental data providers you wish to update. Now, select the Update all data for selected Providers now button, which will update all your stock end of day and intraday price data, and selected Fundamental and Economic Indicator data (Figure 3.3). Downloading intraday histories for the first time can take several minutes per symbol.
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Figure 3.4 Data Manager running a manual data update



Another way to keep your data current is to enable Automated Data Updates (Fig. 3.4). It is highly recommended that you keep your market data as up to date as possible by running daily manual or scheduled data updates to maximize your experience with WealthLab Pro. Your PC must be on and Wealth-Lab running during the hour that you've scheduled automated data updates.
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Configuring Options Use the Preferences tool to control and personalize the default settings in Wealth-Lab Pro. Some of the settings can be overridden from within a Strategy using corresponding WealthScript functions. Choose from: Chart Color/Style, Chart Annotations, Streaming Data, Performance Visualizers, Commissions, Backtest Settings, Slippage and Round Lots, Sounds, Advanced Options, Trading, and Email Settings. All these settings may be found by selecting Preferences, or using the F12 shortcut. This is the first step in personalizing Wealth-Lab Pro.



Figure 4.0 – Wealth-Lab Pro Preferences



Chart Layout Use the Chart and Scale toolbars to control the appearance of the Chart View. Configure the default settings for Chart Color, Fonts, and Grid Lines using the Colors/Style view of the Preferences tool. For example, use the Chart Drawing Toolbar (far right) to apply Fibonacci Lines or a Regression Channel (Fig. 4.1).
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Figure 4.1 – Chart Layout controls.



Chart Toolbar Use the Chart toolbar to customize the appearance of your charts by increasing or decreasing bar spacing, or change the chart style to Kagi or Renko among the many other options offered (Fig. 4.1). A DataSet represents a link to a source of static historical market data. DataSets appear in a tree view along the left side of the application in the Data Panel, which can be viewed or hidden from the View menu or using the Ctrl+D shortcut. Contained in each branch of the tree are the symbols that make up the DataSet.
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Using Strategies What is a Strategy? In general, a Strategy is your trading system that is normally used to automate methods and features within Wealth-Lab Pro. A Strategy is a script, a small computer program, written using WealthScript functions in C#. (Advanced users can use any supported Microsoft .NET language in a separate development environment.) Strategies contain the trading rules you use to trigger trade alerts, but also usually contain instructions for plotting indicators and various other annotations on charts. Consequently, a Strategy packages the trading system logic with its visual presentation. Strategies can be written by manual programming, but can also be created by using Drag and Drop Rules making it easy for non-programmers to craft trading strategies visually.



Included Strategies Wealth-Lab Pro Version 6 comes with more than 25 pre-built strategies, a list of standard technical indicators, and a list of fundamental data items that you can leverage to help create your own trading systems. Additional pre-built strategies may be downloaded from Wealth-Lab.com using the Strategy Explorer's Download feature.



4.5.1



Design your Trading Strategy Strategy Builder Wealth-Lab Pro has the most advanced and capable Wizard available to help you design and produce complete trading systems without the need for you to manually write any code! The Strategy Builder allows you to visually design a trading system by combining various types of Entries, Exits, and Conditions via an easy-to-use drag-and-drop interface. Even if you like to write your own code, the Strategy Builder can give you a head start in rapidly prototyping new trading systems. The Strategy Builder utilizes a database of Entries, Exits, and Conditions, which are collectively referred to as Rules. The Wealth-Lab Pro installation comes with a full set of Rules (Fig. 6.0).
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Figure 6.0 – Strategy Builder



How to use the Strategy Builder The following steps outline a suggested procedure for using the Strategy Builder. The order in which you add, delete, or modify rules is not important. Step 1. Activate the Strategy Builder. Select Charts and Strategies > New Strategy from Rules. The Strategy Builder dialog shown above appears along with a new Strategy window (Untitled) in the background to which the Wizard will ultimately apply the chosen rules. Step 2. Elect your Position Management options. Single Open Position at a Time:



Choosing this option will result in a script that manages only a single open position in a given security at any given time. You may select "Allow Stop and Reverse on Same Bar" with a single position.



Multiple Open Positions:



Elect this option to allow your script to manage more than one open position in a given security simultaneously.



Step 3. Form your basic strategy by selecting Entry and Exit types. Drag and drop an Entry or Exit type to the window on the right. You can also double click an Entry or Exit to select it, which is then added to the bottom of the list. An Exit is paired with the Entry directly above it. The Wizard accomplishes this by assigning a unique Position Signal Name to each Entry selected, as you can later verify in Strategies with multiple Entry and Exit strategies. Placing an Exit at the top of the list (above any Entries) applies it to all Entries of the same type in the strategy. For example, you may wish to place a Trailing Stop at the top of a list so that it will be used against all Long © 2017 FMR LLC All rights reserved.
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Entries, as shown above. Many of the Entry/Exit items have a description, which is displayed in a text box underneath the selections. Highlight an Entry/Exit by clicking on it and the description containing information about the item is displayed. Step 4. Assign Conditional Rules to your Entries and Exits. Click the Conditions tab to begin assigning conditional Rules to your selected Entries and Exits as shown in the image below. Qualify Conditions by dropping them on top of a selected Entry or Exit. Multiple Conditions added to the same Entry or Exit are “AND”ed together, but will be accessed in the order entered. To “OR” Conditions, separate them with the OR Divider by dropping it on top of the second (lower) Condition in an Ordered pair. Step 5. Run the Strategy. You may go back and forth, altering Entries, Exits, and Conditions, and refining parameters. When satisfied, select a symbol or DataSet in the Data panel and click the Run Strategy Now button to execute your Strategy. If you want to see how the Wizard turns your work into WealthScript code, click on the View Strategy Code button. Notice that the Wizard automatically adds the necessary code for plotting any indicator that you have selected for trading conditions in the Strategy. A Rules tab instead of an Editor tab in the Strategy window indicates that the Wizard has complete control of the Strategy code. If you select Convert to Code-based Strategy you can no longer use the Strategy Builder to modify the Strategy. Step 6. Save your work! If you wish to continue working with the Wizard at a later time, save your Strategy and Wealth-Lab Pro will remember that the script is under the Strategy Builder's control. The next time you open the strategy, you may re-visit the Wizard by clicking the Rules tab in the Strategy window.



4.5.2



Build a Strategy from Scratch For more sophisticated systems programmers, you can build you own Strategies from scratch by creating your own code and ideas. Simply open a New Strategy from Code from the main menu toolbar by selecting Charts and Strategies > New Strategy from Rules. This will open a Strategy window template. Select the Editor view, which gives you open access to the WealthScript code needed to program your own Strategies (Fig. 6.1).
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Figure 6.1 Developing and Editing a System



Template Code A "New Strategy from Code" window always initializes the Editor view with a "skeleton" (template) to start working from. If you frequently use the same library references and/or variables in Strategies, you can save yourself time by editing the Template and then selecting Edit > Set as Default Template Code. Editor Options Set your preferences for how the editor displays text, fonts, functions and other items from the Editor's Options dialog, selected right from the Editor's toolbar.
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Backtesting Trading Strategies Running your Strategy Once you've built a new Strategy you can use it to Backtest by: Choosing the Scale (interval), Data Range (timeframe), and Position Size (money management rules) you would like to analyze (Fig. 7.0). Choose a security to backtest against from your DataSets or enter a symbol and click the



button to run the Strategy.



Figure 7.0 – Running your Strategy



Multi-Symbol Backtesting You develop and backtest trading systems on individual securities in the Strategy Window. You can now easily test a system’s performance on a list of stocks or DataSet without going to a new tool with Multi-Symbol or Portfolio backtesting. To run a Portfolio backtest from the Strategy window: Click on the desired DataSet (Fig. 7.1). Make sure your settings for Scale, Data Range and Position Size are correct. Click the Backtest on all Symbols button. How the Multi-Symbol Backtest Works: Wealth-Lab Pro executes the selected Strategy on each of the symbols in the selected DataSet. This is done in a raw profit mode to compile all of the possible trades into a
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single collection. It then aligns the trades by date and time, applies position sizing rules, and finally reports on the overall system results, which includes a portfolio equity curve based on the starting equity that you specify before running the backtest.



Position Size Settings Applying your personal position sizing rules (share or dollar) mirroring the way you invest is a key component to properly simulating how your trading strategy may work under market conditions. Wealth-Lab Strategies are Position-based. You don't have to worry about the actual size of Position in your Rules or code. Wealth-Lab will apply the sizing method that you select from the Position Size control atop the Data Panel (Fig. 7.1).



Figure 7.1 Position Size Control
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Monitoring Strategies Strategy Monitor Now that you have built and backtested one or more Strategies, run them regularly to be alerted of potential trading opportunities. The Strategy Monitor allows you to track one or several Strategies at the same time. Each Strategy can have its own custom parameters, time frames, data range, and position sizing to monitor for current trade signals (also known as Alerts) for each activated Strategy. To access the tool (Fig. 8.0), select Strategy Monitor from the Function toolbar or strike the F3 shortcut.



Figure 8.0 Strategy Monitor



Adding a Strategy From the Strategy Monitor itself, just select Add A Strategy, which launches the Strategy Explorer. Navigate to the Strategy you want to add and click OK. Alternatively, from the bottom left of a Strategy window you can click the Add to Strategy Monitor link.



4.7.1



Configuring Strategies Choose your settings After adding a Strategy, the Strategy Activation Settings page is displayed (Figure 8.1). These settings allow you to customize each Strategy's execution parameters. The settings in the Data Panel do not control the settings in the Strategy Monitor. Choose from scale, data range, position size, Strategy parameters, and the symbol or DataSet you would like to test against. Once configured and activated 28 , the Strategy will be executed against these parameters until you change them.
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Figure 8.1 Strategy Activation Settings page



Choosing "All Data" in the Data Range setting for intraday Strategies will result in reduced performance due to the large amount of data being processed. Since you are looking for Trade Alerts based on the most recent price action we recommend choosing a smaller amount of data for this setting.



Changing Settings To change your settings, highlight a Strategy and select the Change Settings button. Alternatively you can double click the Strategy. Either action launches the Strategy Activation Settings page for a new settings configuration. If you save new settings by clicking OK, the Strategy must be reactivated.



4.7.2



Activate Strategy Activate the Strategy Strategies must be Activated to process data and generate Trading Alerts. To Activate a Strategy, highlight it and click on the Activate Strategy button. The Strategy Monitor automatically updates the data for each symbol at the appropriate interval selected whether daily, weekly or monthly or intraday as long as Wealth-Lab Pro and the Strategy Monitor are running. You will know the strategy is active by the yellow icon appearing next to the Strategy. The Strategy will now be run at the next interval displayed. After the data is updated, the Strategy is re-executed and any Trade Alerts are displayed in the bottom of the window (see figure 8.2). The Last Run and Next Run fields display the time and date of the most recent and next data updates. If you have Strategies that are run on a periodic basis you can still add them to the Strategy Monitor for quick access when you want to use them. To run the Strategy, simply Activate the Strategy or select Run this Strategy now item in the right click menu.



Managing Trade Alerts In the previous version of Wealth-Lab Pro, users ran WatchList Scans or Real-Time Scans to receive current Trade Alerts. The functionality of these tools is now combined in the Strategy Monitor. Trade Alerts are displayed in the Alerts section of the Strategy Monitor window (see figure 8.2). Alerts can be displayed by Strategy or as a group.



Figure 8.2 Strategy Monitor Alert Pane
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When an Alert is received for a strategy, the Alert can be sent to the Quotes tool for further monitoring or to the Orders tool for trading. You can configure Strategies to automatically send the Trade Alerts to the Orders tool by enabling Auto-Stage button. Live trading is not enabled in the current Wealth-Lab Pro 5.0 release.
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Trading Your Strategy Now that you have honed your strategy and determined the parameters, position sizing and money management rules you are comfortable with, you are ready to trade. To place trades in Wealth-Lab Pro you must be logged in to Fidelity. Click on the Log in to Fidelity button in the Function Toolbar or the Log in button on the Manual Trade Ticket (Ctrl+T). If this task is not completed prior to launching the Orders tool or placing a manual trade, you will be prompted to log in.



4.8.1



Orders Tool Wealth-Lab Pro provides a bridge from back-testing to fully-automated real-time trading. The Orders tool acts as a central point in a complex integration environment. It receives information in the form of Alerts from various Wealth-Lab tools and opens a 2-way communication channel with Fidelity. In addition, it logs trade status, trade messages, and updates Positions and Local History in the Accounts tool. Open the Orders tool by clicking on the Orders selection in the toolbar, selecting it from the Tools menu, or by using the keyboard shortcut Ctrl+R. If you have not already logged in to Fidelity, you will be prompted to login before the tool is launched. Once you are logged in you are ready to trade. Additionally, the Orders tool automatically opens whenever another tool sends an Alert for order processing. Order(s) will be queued until you submit the Staged order(s). If you do not want the Orders tool to open each time an Alert is sent you may turn off this feature in Preferences (F12) > Advanced Options.
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Figure 9.0 Manual Trade Ticket (top) and Orders tool



4.8.2



Trading Basics Set a default account If you have more than one Fidelity account, choose which account you would like to place trade in. Choose the default account from the list displayed in the Trading preferences menu.



Enter a manual trade Wealth-Lab Pro 6 includes an order ticket for you to place manual trades quickly. The trade ticket is visible regardless of which tool is being used, and can be configured to appear at the top or bottom of the application. Quote data has also been added to the ticket for



Figure 9.1 Default Account Preference
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your convenience. A variety of options are available to you from the Wealth-Lab Pro Trade Ticket. Actions: Buy, Sell, Short and Cover; Order Type: Market, Limit, Stop; Order Routing: AUTO – Fidelity’s proprietary order routing; TIF: Day and GTC; and Trade Type: Margin, Cash, or Short



Figure 9.2 Manual Trade Ticket



Strategy-Generated Trades Backtesting a Strategy allows you to generate trade alerts for a single security or an entire list of securities. The Strategy runs against historic or intraday data to generate trading signals, or Alerts, and also provides a detailed report of trading system performance. When you backtest a stock, any alerts generated appear in the Alerts tab of the Strategy window. If you are using daily data in your test, options to manage Alerts include the Place Orders, Stage Orders, and Monitor in Quotes window buttons. Place Orders immediately sends the orders to the marketplace. Stage Orders sends the orders to the Orders Tool. Staged orders are queued until you take further action. If your strategy generates a large number of Alerts, you may choose to send some or all of the Alerts to be monitored in the Quotes tool. This feature allows you to watch your alerts in real-time and set a threshold at which the Alert is turned into a trade. Alerts generated using streaming data also have the ability to be Auto Staged or Auto Placed (if Auto Trading is enabled). Auto Stage allows users to send the order automatically to the Orders tool for further action. Auto Place sends the orders to the marketplace.



Strategy Monitor With the Strategy Monitor, there's no need to open and run multiple strategies that you want to trade. Add and activate multiple Strategies in the Strategy Monitor and you are ready to begin. Whether you are using a daily or intraday interval, each strategy will be evaluated for new trading opportunities as the data is updated. As with other tools having alert-generating capability, you can route orders directly to the Orders tool for automated order entry via the Auto Place function. You may also Stage Orders for later submission, Place Orders for immediate submission, or send the alerts to be monitored in the Quotes tool. Strategies are executed only when a new complete bar interval is received. Alerts and indicator calculations are based on the last complete bar interval only.



© 2017 FMR LLC All rights reserved.



33



4.8.3



User Guide, Wealth-Lab Pro



Automated Trading When you turn on Automated Trading for live accounts in Wealth-Lab Pro, the Orders tool will automatically place orders that are received from any tool that generates an Alert. This is true hands-off trading; use the Auto-Trading option carefully. Prior to Auto-Trading with a live account, investigate the Paper Trading option to familiarize yourself with the aspects of automated trading. In the User Guide, see: Orders > Paper Trading. Important! When the Auto Trading is enabled, it is enabled for all Fidelity accounts in a given household. In general, the Orders tool ensures a consistent order flow from trading strategies such that each trade remains open or canceled based on the trading strategy's logic and that no order is duplicated. Orders that are already staged will not be submitted upon selecting Auto Trading Mode. Also, orders entered manually and put in the queue by clicking the Stage Order button will not be placed automatically even if Auto Trading is enabled. Auto Trading will be turned off by any of the following actions: Clicking the Enable Auto Trading button after it has been selected Clicking the Cancel All Orders button Closing the Order Manager To learn more or get started using Auto Trading, please call our Active Trader Service team at 1-800-TRADER1. Automated trading poses significant additional risks. Use of Wealth-Lab Pro’s automated trading feature is subject to additional terms, conditions, and eligibility requirements.



© 2017 FMR LLC All rights reserved.



Data



5



34



Data Wealth-Lab Pro isn't useful for backtesting without a good set of historical market data to use as the basis for strategy development. You have many data options, but it's important to understand that all data are not created equally! In this chapter, we'll learn primarily how the Data Manager tool can collect and update price and fundamental data, and we'll describe some of the details of the static data providers that come packaged with the Wealth-Lab installation. With Wealth-Lab Pro Version 6, it's never necessary to run Active Trader Pro to access data.



Data Specification For OHLC/V data, two requirements exist: 1. The data must include a Closing price series and a corresponding series of Dates. High, Low, Open, and Volume series are recommended if available, but are not absolutely required. 2. For the proper display of Performance data following a backtest, none of the OHLC/V series can contain negative values. Generally this isn't a problem for stock data, but some futures continuous contract data can contain negative values. In this case, we recommend adding a constant value to the OHLC series such that all data are nonnegative (example). Example (How to run Example code? C#



8



)



protected override void Execute() { // If the lowest value is negative, round it up, and add to the OHLC DataSeries double low = Lowest.Value(Bars.Count - 1,Low, Bars.Count); if (low < 0) { low = Math.Ceiling(Math.Abs(low)); for (int bar = 0; bar < Bars.Count; bar++) { Open[bar] = Open[bar] + low; High[bar] = High[bar] + low; Low[bar] = Low[bar] + low; Close[bar] = Close[bar] + low; } } }



Data Precision Wealth-Lab Pro Version 6 accesses and stores price and volume data with doubleprecision. This means that price data and calculations based on it are accurate to at least 15 digits of precision. In backtests, Wealth-Lab creates trades at the full precision of the data for AtMarket and AtClose orders. For example, a stock that splits 3:1 and traded pre-split at 35.21, will trade post-split at a double-precision value of 11.7366666666667. Note that this value
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would be rounded to 11.74 for display purposes only. Fidelity supplies historical data that is bankers rounded to 4 digits to the right of the decimal. For example, the data for the stock that traded at 35.21 presplit, would be downloaded and stored at double precision as 11.7367 by the Fidelity Provider. However, if you had downloaded the data for this stock before the split, the 3:1 split would be applied locally and the price would be cached as 11.7366666666667. Related: Price Rounding for Orders



230



Testing Equality Finally, it's important to understand that even at double-precision, most floating point numbers cannot be represented precisely in a computer. Avoid testing exact equality of floating point numbers. If necessary, one technique is to define an acceptably small value that you can use to compare to the absolute value of the difference between two floating point values (example). Example (How to run Example code? C#



8



)



// Buy and hold a stock that closes at 40.43 protected override void Execute() { const double Epsilon = 0.0005d; for(int bar = 1; bar < Bars.Count; bar++) { if (Math.Abs(Close[bar] - 40.43) < Epsilon) BuyAtMarket(bar + 1); } }



Data Corrections The Fidelity static provider applies data corrections during all Data Manager updates as well as on-demand requests. Exception: Strategy Monitor updates for 10-minute intervals and lower do not include corrections. Before starting the Strategy Monitor, we recommend using the Data Manager to update DataSets used.



Data Editing If supported by the static Provider, editing, adding, or removing bar data (or manually applying a split) is possible from the chart interface. See Edit Bar Data 61 in Charting > Chart Context Menu.



Where Data are Stored It is not generally required for you to directly handle Wealth-Lab system data, but it's important that you know where the data are located so that you can create backups. All
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custom user settings, configurations, Strategies, static data, and more are found at the following path and its subfolders, named appropriately for the data they contain. To see these data it may be required to configure Windows Explorer's Tools > Folder Options > View dialog to Show hidden files/folders. Windows XP, Windows Server 2003: C:\Documents and Settings\Windows User Name\Application Data\Fidelity Investments \WealthLabPro\1.0.0.0\Data\ Windows Vista, Windows 7, Windows Server 2008 C:\Users\Windows User Name\AppData\Roaming\Fidelity Investments\WealthLabPro \1.0.0.0\Data Regularly create backups to safeguard your work and static data!
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Data Manager Use the Data Manager for creating, updating, and obtaining information about your static DataSets.



How to: Rename or Delete a DataSet Right-click the DataSet and select



Rename or



Delete from the pop-up menu.



Data Manager showing Symbol Details for the selected DataSet (Dow 30) and right-click DataSet actions menu.



How to: Add Symbols or Modify a DataSet



Click on the the DataSet to select it and add, edit, or otherwise modify the symbols in the Symbols frame on the right. When finished, click Apply Symbol Changes made above to DataSet. Separate symbols by commas or spaces. Symbols that contain spaces must be enclosed in double quotes. Examples: "SP #1", "BH B"



Data Manager Toolbar actions To activate the toolbar, select a DataSet on which to perform an operation.



Note that
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the right-click menu provides key, but less-frequent DataSet actions. Create a new DataSet (Ctrl+Shift+D) Launches a dialog from which you select one of the installed data providers to create a new DataSet or connect to one that already exists, such as ASCII or MetaStock data. See: Create New DataSet 38 . Update DataSet Updates pricing (OHLC/V) of the selected DataSet as well as data from the Fundamental Data Providers selected in the Update Data view for the symbols in the selected DataSet. Update DataSet (Pricing) Updates only pricing of the selected DataSet without requesting data from the Fundamental Providers on the Update Data view. Fidelity Provider updates may not include data corrections for Daily data until approximately 6:00 AM on the day after the current session. An update prior to this time can result in post-market data included in daily price bars, which then will not be corrected until after the next market session. Symbol Details Displays the Symbol, Security name, number of bars, and the date last updated for each symbol in the DataSet. If the DataSet has many symbols, this operation could take several minutes.



5.1.1



Create New DataSet The first step in creating a new DataSet is to select the Data Provider. Wealth-Lab Pro comes with the provider adapters (or simply, providers) shown at the left. More providers can be added at anytime by dropping their assemblies in the main WealthLab Pro installation folder, and they'll be displayed here when Wealth-Lab detects them upon restart.



Providers may vary from your installation.



After selecting the desired provider, click the Next button. Each provider has a specific Wizard that will walk you through the steps required to select symbols, specify a scale, etc. Generally speaking, data are not collected during the DataSet creation process. Here, you'll only assign the properties of the DataSet (Data Provider, symbols, scale, etc.) and later you can perform the update.
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Naming DataSets You can use letters, numbers, and special characters in DataSet names, and, you can rename a DataSet at any time. Tip: While a DataSet's Scale is obvious in the Data Manager, the Scale may not be obvious when searching through many DataSets in the Data Tree. You can avoid confusion by consistently naming Intraday DataSets with a suffix containing the intraday interval. For example Dow 30_5 or Dow 30(5) would indicate that the DataSet is composed of 5-minute data. Advanced: Names of DataSets are only important when Strategy code needs to access a symbol in a DataSet that is not currently under test. In this case, Wealth-Lab searches through DataSets in alphabetical order to find secondary-symbol data.



5.1.1.1



Data Providers Wealth-Lab Version 6 already supports a number of different data formats, and more can be added at any time by dropping their assemblies in the main Wealth-Lab Pro installation folder. It's worth noting that static and streaming providers work together to provide chart backfill and streaming data for charts. Generally speaking, in Wealth-Lab Pro Version 6, once you've requested historical data for a particular scale, it never needs to be requested again since it will be stored locally by the static provider.



5.1.1.1.1 Fidelity



The Fidelity Static Data Provider comes with an accompanying Streaming and Fundamental Data Providers. Fidelity data are split-adjusted, but are not adjusted for dividends and other cash-distributions. You can, however, "collect" dividends (or pay if short a stock) during backtests by enabling "Apply dividends" in the Backtest Settings 230 .



How to: Create a Fidelity DataSet Step 1.



Fidelity DataSet Options Select one of three options to select symbols for the DataSet (see Step 2a, b, c).



Step 2.



Scale On the same page, define the Scale for the DataSet. Choices are Daily, 1, 3, 5, 10, 15, and 30 Minute. Wealth-Lab will create other intraday scales from these primary scales on the fly. See Scale Control 292 and Note on Time Stamps 294 .
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The 60 Minute scale is missing by design. The Fidelity data feed aggregates and marks hourly bars at the top of the hour, whereas Wealth-Lab Pro's reference is the scheduled market opening time. Since the U.S. Stock Markets open at 9:30 EST, the first hour of activity is from 9:30 to 10:30, not 9:30 to 10:00. Consequently, if you test and trade with 60-minute bars, it's ideal to create 30-minute DataSources and use WealthLab's Scale Control to scale to 60 Minute bars. Step 2a.



Enter the Symbols manually or paste them from the Clipboard Entering symbols is final step for this choice before naming the DataSet. Symbols should be separated by spaces, commas, or new lines.



Step 2b.



Select the Symbols from predefined Industry Classification groups Click the Update Industry Data button to retrieve or update the GICS data, which is stored locally. Once the Industry Data is available, navigate to the SubIndustries and double-click or use the arrow buttons. You can select more than one SubIndustry



Create a DataSet of symbols by selecting SubIndustries.



Step 2c.



Import the Symbols from a Fidelity.com Watchlist (requires log in) Use this option to import Watchlists of positions from owned and authorized Accounts as well as Watchlists that you create. On the subsequent Wizard page, double click the account or Watchlist to import.



Step 3.



Click Next The symbols corresponding to the selected SubIndustries (2b) or Watchlist (2c) are shown. If required, you can edit the symbols before the final step of naming the DataSet.
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5.1.1.1.2 ASCII



ASCII is a universal text document format, and many data vendors use ASCII format to store their data. ASCII data can come in a wide variety of formats, and Wealth-Lab Pro is very flexible in its ASCII support. General specifications for ASCII DataSets: Each file contains data for one security only. All files for the same DataSet must be in the same folder and use the same file extension (e.g., .txt, .csv, ...). All files in the folder with the specified extension will be treated as an ASCII data file. The name of the file (excluding the extension) is used as the symbol. Each record in the file represents one bar (or tick). At a minimum, a record must contain a Date field and one numeric field (Close). Excluding fields that are specified as Date, Time, or Security Name, all other fields must be numeric. If your data files contain other fields that non-numeric, these fields should be specified as "Filler" when creating the ASCII DataSet in Wealth-Lab. The format of each record (decimal character, field delimiter, etc.) is variable, but you must specify these properties when creating the ASCII DataSet in Wealth-Lab. See Format Options below. Data can be in chronological or reverse-chronological order.



ASCII Data Cache An important innovation in the ASCII Provider v1.2.5 (and up) is Data Caching. Caching ASCII data speeds up working with them by reducing file access time. By default it's turned off, and can be enabled on the Data Manager's ASCII Data tab. The feature is file-based and once enabled, requires no extra user action.



How it works When an ASCII file is accessed for the first time, a binary file is created that comprises its Bars object and any custom Data Series that it contains. Subsequent backtests benefit from reading the data from binary cache. The provider compares the time of last modification of actual ASCII file with its cached version. If it hasn't been modified, data is read from cache, otherwise the cache is cleared and re-created. To easily tell that you're working with cached data, the chart will display an extra string "#Cache#" attached by the provider to the Bars.SecurityName property. Background Because ASCII files contain text strings, they have to be parsed and converted to numbers. Binary files, like WL native format, MetaStock and others don't require parsing, so working with them is faster. From the technical standpoint, there are arguments as to how implement caching: file-based cache vs. RAM-based. Although caching in RAM could be slightly faster, it increases memory consumption and such cache must be recreated in every Wealth-Lab session - so the file-based scheme wins!



© 2017 FMR LLC All rights reserved.



Data



42



Benefits of caching ASCII data is noticeable on large data histories. On a final note, it effectively deprecates the workarounds like DataToWL or utility scripts that serialize data to binary formats, leveling out the speed difference between ASCII and binary data files."



How to: Create an ASCII DataSet Step 1.



Location and File Extension Navigate to the folder that contains the ASCII files. Next, specify the File Extension of your data files. When you change the file extension, the list of files is updated to show only the files that match the extension that you specified. You can type your own File Extension if it isn't included in the drop down list.



Step 2.



Bar scale and interval Specify the Bar scale and interval of the DataSet.



Step 3.



Specify the ASCII Format Specify the format of the data in your ASCII files. You must precisely specify how the data is arranged so that it can be parsed by the ASCII adapter. At this stage, it's useful to view one of the data files to get an idea of how the data is arranged. Just click the View Data File in Notepad button.



Field Order



Use the Arrow buttons to move data fields up or down. If the ASCII DataSet doesn't contain a data element, such as Volume, click on the item and delete it by clicking the Delete Field. Likewise, use the Add Field... button to add to the Field Order and then move it to the appropriate position. The "vertical" Field Order list corresponds to the horizontal fields (left to right) in the ASCII data file(s).



Add Field... Time If the data file contains a separate field for time, add Time to the field list and move it to the appropriate position. It's common for a single white space to appear between Date and Time. In this case, don't add a separate Time field unless the Field Separator is actually a "Space". Open Interest Add the Open Interest field for futures data containing Open Interest. Use the FindNamedSeries method of the Bars object to access the Open Interest DataSeries. Filler Items For non-numeric items, or other fields that should not be read, add "Filler" items to act as place holders. Filler fields are simply skipped so that the rest of file can be properly parsed. Custom Field Custom Fields contain any other numerical data like indicators or fundamentals. You must provide a unique name for each custom field that you enter. Use the FindNamedSeries method of the Bars object to
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access a Custom Field's DataSeries. Custom Fields currently work only in the data's native time frame. For example, if you have a daily DataSet, Custom Field data is not available if you switch to Weekly scale from the toolbar. Format Options Common Formats... If applicable to your ASCII DataSet, select a common format to quickly arrange the ASCII Format settings, or, apply the format of an existing ASCII DataSet to the one that you're creating via Copy format from a DataSet. Add your own frequently-used ASCII Formats to the list by selecting Save these Settings as a Common Format. Date Format Specifies the description of how dates are formatted in the file. For a specification of the Date and Time Format specifiers, see http:// msdn2.microsoft.com/en-us/library/8kb3ddd4(VS.71).aspx Time Format Specifies the description of how time values (if present) are formatted in the file. Field Separator Specifies the character that separates the fields in a single row of data. If your ASCII data uses a field separator that doesn't appear in the list, just type it in. Decimal Separator Specifies which character is used as the decimal separator for price fields - either Period (.) or Comma (,). Thousands Separator If it exists, the Thousands Separator must be different than the Decimal Separator. Ignore First/Last Lines in File If your data file contains one or more header/trailer lines, specify this value in the Ignore First Lines in File entry field. These lines are ignored when the file data is imported. Volume Multiple Some files store volume data that must be multiplied by 10, 100, or another multiplier. Implied Decimals Decimal numbers that do not actually use a decimal separator require an implied decimal specification. For example, the number 12340 with 2 implied decimals would be imported as 123.40. It's rare to find data that uses implied decimals. Specify 0 if you're unsure.
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Data Preview The next step validates that the ASCII Format was correctly specified. If it was, you'll see a sample of your file's data in the preview window. Otherwise, a Parse Error dialog will indicate where an error was detected. In this case, go back and correct the problem.



5.1.1.1.3 MetaStock



The MetaStock format is a common data format for historical financial data. It is the format used by the Reuter's DataLink data subscription service.



How to: Create a MetaStock DataSet Step 1.



Data Location Specify the Folder for the MetaStock files on your local system. Navigate to the desired folder and double click on it in the folder tree. Once you set the location, you will see a list of symbols that are contained in the selected MetaStock folder.



Step 2.



Enter Volume Multiplier Be sure to properly specify if your data's volume field should be multiplied by a constant factor. If your MetaStock provider is Reuters Datalink, then generally speaking, you'll need to specify 100 here. On the other hand, if your data was a converted to MetaStock by MLDownloader, then a multiplier is not required and you should enter 1.



5.1.1.1.4 WL4 Files



The WL4 Files (Wealth-Lab Version 3/4) Format Provider lets you connect to Wealth-Lab Pro or Developer DataSources that you created with Version 4 or prior. We've created the WL4 adapter for WL5 as a matter of convenience for backtesting with existing data. You cannot create or update Version 4 data using this adapter. Wealth-Lab Version 6 Streaming data providers use local history from a corresponding Static provider for backfill. If you want to use a year of 5-minute data in a streaming chart - no problem! For trading and streaming charts, it's to your advantage to build up and use Version 6 DataSets.



How to: Connect to Wealth-Lab Version 4 DataSources Step 1.



Choose the source application Even if the Version 4 application is no longer installed, select the appropriate version that created the Version 4 files. Wealth-Lab Pro 4 Wealth-Lab Developer 4



Step 2.



Add existing symbols
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For Version 4 installations on the same machine, choose the first option to connect to an existing WatchList. Select an existing DataSource... Select a folder containing *.wl files The first option is incompatible/disabled in 64-bit mode. For Wealth-Lab Pro 4, choose the first option only for Fidelity DataSources. For all others, such as Yahoo!, Intraday Historical, etc., use the second option. Step 3.



Verify the Scale and Interval Ensure that the values are correct for the selected DataSet.



5.1.1.1.5 Yahoo!



Wealth-Lab Pro's Yahoo! Provider could very well be the best Yahoo! downloader available for static Daily data. Its features include: Local storage of split and dividend history, which can be optionally applied to price data. This means that DataSet refreshes are never required in order to apply the mostrecent split and dividend data. Chart Annotations 209 : "Split (Yahoo! Finance)" and "Dividend (Yahoo! Finance)". Automatic data corrections for data changed on the Yahoo! server (usually affects volume). On-demand data requests supported.



How to: Create a New Yahoo! DataSet Step 1.



Choose a symbol-entry option: Enter the Symbols manually or paste them from the Clipboard This option includes a feature to automatically add world exchange suffixes to symbols so that it's only necessary to enter the base ticker. Select the Symbols from predefined Industry Classification groups In addition to Industry Classifications, you can create DataSets of constituents from popular indices around the world. When moving to the next page, click the Refresh classification button to get the most-recent data from Yahoo!.



Step 2.



Select a Starting Date Before moving to the next page, specify the date of the oldest data point that you want to collect for your DataSet. Tip: To increase history depth at a later time, simply delete the DataSet and recreate it using an older starting date. The Yahoo! Provider will automatically refresh symbols with the oldest starting date requested from any DataSet.
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Complete the Wizard based on select in Step 1.
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Provider Settings The Yahoo! Provider Settings are found in a dedicated tab in the Data Manager (see image) Always return data with partial bar When the option is enabled, static data will include the current day's partial bar, and the last bar will be corrected on each update. File > Update Data on Demand must also be enabled. Never perform On Demand data updates Overrides Wealth-Lab's On demand update option for the Yahoo! Provider so that backtests in the Strategy Window/Monitor always run quickly with cached data. Perform Dividend/Split Adjustment Data are adjusted at the moment they're passed to Wealth-Lab by the Y! Provider so that the newest dividends are applied automatically to the price data. Note that split and dividend adjustments affect both price and volume. The dividend adjustment factor equation is 1 - dividend/close . Prices (pre-ex-date) are multiplied by the adjustment factor(s), whereas the factor becomes the divisor for volume. Ignore Selected Splits Occasionally, and usually due to special corporate actions such as company spinoffs, Y! Finance will report a stock split in addition to applying a split adjustment to the "unadjusted" data. When Perform Split Adjustment is selected in the Yahoo! Data options (as is normal), a large erroneous gap in the price data will be observed due to the duplicated split action. Ignore Selected Splits allows you to enter dates for these infrequent events so that the Yahoo! Provider does not adjust the already-adjusted data. Known events (e.g., AXP, VZ) are included with this installation. Adjustment mode when Data Range Applies to: Perform Dividend and Split specified Adjustment Choose "Keep" so that price and volume data are always the same, historically, even when
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specifying a past data range. "Ignore" is an advanced option for testing with past adjusted data without the influence of future splits or dividends that are excluded from the chart's Date Range. To use the bar data editor for anything besides deleting a bar in a Y! chart, you must apply the "Keep" option during the edit. See Data Editing below.



Working with Dividends The Y! Fundamental Provider always returns split-adjusted dividends for a chart's dividend popup as well as when accessing the "Dividend (Yahoo! Finance)" fundamental item in Strategy code. While the dividend adjustment factor maintains proper percentage relationships between prices, it's possible that new dividends affect previous backtest results (trades) for some strategies. Disable "Apply dividends" in the Backtest Settings Preferences 230 when using dividendadjusted data for backtesting. If you don't, the dividend effect could be duplicated in the Performance results, especially for the Buy & Hold Strategy.



Data Editing To edit bar data, open a chart and either: a) double-click the bar to edit, or, b) right-click the bar and select Edit Bar Data. When editing Y! data, be aware of the Perform Dividend Adjustment selection since the chart values will reflect this adjustment. Deselect this option and refresh the chart to edit raw price and volume. With the "Ignore splits and dividends which fall out of the range" option selected (disabled by default), only deleting bars is possible.
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Update Data The Update Data view contains general updating options as well as the ability to update all DataSets or only those from selected static Providers. Historical Data Providers This list contains integrated price and volume Providers that support updates from the Data Manager. For example, MetaStock and ASCII would never be listed here since you must update those DataSets using other applications. Fundamental Data Providers This list contains integrated Fundamental Data Providers that support updates from the Data Manager. Excluding a Pricing-only Update in the DataSet view, Wealth-Lab requests updates for selected Fundamental Data Providers for each DataSet updated from the Data Manager. Update all data for selected Providers now This action initiates updates for all DataSets corresponding to the selected Provider(s).



Data Provider Update Options Update only Symbols that are contained in DataSets See next option for more information. Also Update Symbols that you accessed, but are not contained in DataSets When you delete DataSet from a Wealth-Lab-integrated Provider, only the list of symbols is deleted, but the price data is not. Enabling this option will continue to maintain all symbols' price data when you perform an "Update all" even if the symbols no longer exist in any DataSet. Delete data for Symbols that are not contained in DataSets Although old data can be useful for testing, enabling this option instructs the Data Provider to delete symbol data files that are no longer contained in DataSets. The cleanup operation takes place during Update processes.
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Automated Data Updates Schedule a daily, Automated Daily Update Initiates an "Update all" process for all selected Historical and Fundamental Data Providers after the specified hour. The minute (0 - 59) at which an update is triggered is specified by the RandomMinute parameter in the \Data\WealthLabConfig.txt file. See Where Data are Stored 35 .



On Demand Data Updates Automatically update data for symbols on-demand when they are charted or accessed. This is the same option as File > Update Data on Demand. While this option is useful during the trading day to access ad-hoc static charts, Multi-Symbol Backtests will run faster with "on demand" disabled. Use the Data Manager for the best update performance. Streaming charts ignore the "on demand" selection, and, in some cases will cause static data to be updated with the historically-requested bars. 5.1.2.1



Data Update Log A real-time status of an update's progress is displayed in the Data Update Log. Specific message formats and progress are dependent on each Static Provider. You can copy the Update Log by highlighting the text and then using the right-click menu Copy action. LastUpdateLog.txt For performance reasons, Wealth-Lab clears the update log automatically when approximately 50kB of text is displayed. Nonetheless, you can obtain the complete log of the most-recent update by inspecting the LastUpdateLog.txt file located your Wealth-Lab Data directory 35 .



5.1.3



Symbol Management Symbol Management tools in the Data Manager can help reduce update times and keep your Fidelity DataSets filled with only active symbols. Fidelity Data Symbol Management applies only to Fidelity DataSets and it does not affect any other type of DataSet or provider, which may include their own symbol management functions.
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Fidelity Data Symbol Management in the Data Manager



Turn on Symbol Management The Symbol Management functions involving the Quarantine and Data Updates is enabled only if this option is checked. Symbol Quarantine Quarantined symbols do not participate in Fidelity Data Updates. When Wealth-Lab Pro detects a specified number of [Symbol Not Found] errors during data updates, those symbols are placed in the quarantine list. See Error(s) Before Quarantine 52 .



Actions Delete Symbol(s) This action physically deletes the data for the selected symbol(s) in the quarantine list and removes them from all Fidelity DataSets. Prior to deleting a symbol and its data: 1. check to see if the symbol has changed. If it has, perform the Change Symbol action instead to preserve the local data history. 2. determine if you want to maintain data from delinquent companies for testing. If so, do not delete symbols from the quarantine! Restore Symbol(s) The restore action removes selected symbol(s) from quarantine so that they will participate in Fidelity Data Updates. Restored symbols are simply removed from the list and can re-enter the quarantine after failing updates again.
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Error(s) Before Quarantine Select the threshold of errors for Wealth-Lab Pro to use before placing a symbol in quarantine. Errors are counted for a particular symbol regardless of the DataSet in which it appears (Daily, 5-Minute, etc.). Change Symbol Symbols change more frequently than you may imagine. (In 2006 alone, nearly 800 companies traded on U.S. exchanges permanently changed their symbols.) Using the Change Symbol action, you can update all Fidelity DataSets and data files for a change in symbol. This action can take several seconds the first time it's used in a Wealth-Lab session, but thereafter the operation is much quicker. Relocate Data Specifies the location of Fidelity price and fundamental data. You can, for example, update and store all of your Fidelity static data on a shared network folder and access it from any computer on the LAN with Wealth-Lab Pro. If you physically move existing data from the default location 35 to a new folder, arrange it such that the top-level folder that you specify for the Relocate Data path contains the folders FidelityStaticProvider and the fundamental data folders, FidelityFMDFundamentalProvider and FidelityWSOD*.



5.1.4



Watchlist Export Exporting DataSets to Fidelity.com You can export DataSets (or a mix of DataSet symbols) from Wealth-Lab to Fidelity.com with the restrictions that the number of symbols does not exceed 50 for each list, and you have fewer than 15 Watchlists at Fidelity.com.



How to: Export Watchlists to Fidelty.com 1. Log in to Fidelity
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2. Launch the Data Manager (Ctrl+M) and select the Fidelity Export tab 3. Check one or more of your Fidelity DataSets containing the symbols that you want to export. 4. Select symbols individually or click the Select/Deselect All Symbols buttons. You cannot export more than 50 symbols per Watchlist. 5. Name your Watchlist. You cannot use the name of an existing Fidelity.com Watchlist. 6. Click Export The Export button is enabled if, a) you're logged in to Fidelity, b) the number of symbols selected is 1 to 50, and, c) 15 or fewer Watchlist exist at Fidelity.com.
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Streaming Data See Streaming Charts



© 2017 FMR LLC All rights reserved.



93 .



54



55



6



User Guide, Wealth-Lab Pro



Charting Charts are the primary tool of a technical analyst to visualize trading opportunities as well as to verify that a programmed strategy is functioning per specification. This chapter is dedicated to describing the types of charts that are available as well as the most basic operations you'll need to get going with Wealth-Lab charts. As you become more familiar with Wealth-Lab, you'll find that additional methods are often available to perform the same action.



How to: Open a new chart (Ctrl+Shift+C



315



)



Open a basic chart when you want to see only a symbol's data or otherwise want to start with a "clean slate". Later, you can add indicators 86 , plot fundamental data 92 , or apply a trading strategy 55 that uses the chart's data. Open a new chart from the main menu, navigation bar, or function toolbar: Main menu: File > New > New Chart Window Navigation bar: Charts & Strategies > New Chart Function toolbar: New > New Chart Window



Once the chart window appears, choose a symbol and configure the scale, data range, etc. from the Data Panel 321 .



If a chart window is not in focus 325 : • you can configure the Data Panel's scale, range, sizing, and symbol before opening a chart. • double-clicking a symbol in Data Panel is another way to launch a new chart window.



How to: Change the chart's symbol Click the Chart window to place it in focus. Then you can: type a symbol in directly in the Chart and strike the Enter key, or, type a symbol in the Symbol box and click the Go button (see image above), or, click a symbol in the Data Tree.



How to: Add a strategy to a chart If after opening a blank chart, you wish to apply a Strategy 328 to the same chart window, simply click the Open a Strategy... hyperlink in the chart's lower left status bar window to launch the Strategy Explorer from which you can choose an existing strategy to add to the chart. © 2017 FMR LLC All rights reserved.
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To perform this operation, it is necessary that the chart's status bar is in view. If it is not, select the Show Status Bars on Chart button in the Function "Show" toolbar. See also: Strategy Window



95



How to: Add blank space to a chart Blank space can be added only using the WealthScript function PadBars() in Strategy window code. See the Strategy Window 95 chapter for details.
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Chart Window A typical Chart window is packed with information and options. We'll review the main pieces and provide links to where you can find more detail.



1: Price Pane The main OHLC/V Data Series (1a) are automatically plotted in the Price Pane according to the selected Chart Style 79 . Up/Down coloring of the bars are controlled in the Chart Colors 206 Preferences. Prices Tooltips 207 (1b) are displayed, when enabled, upon hovering the mouse pointer over a specific bar. Horizontal and vertical gridlines (1c) as well as Pane separators can be optionally displayed based on their individual selections in the Chart Colors and Styles 206 Preferences, whose chart shortcut is (Ctrl+F12).



Tip: Resize Chart Panes Manually Click and drag pane separator lines up and down to manually resize chart panes. 2: Volume Pane Volume data are automatically displayed in the Volume Pane as a histogram (2a), whose © 2017 FMR LLC All rights reserved.
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Up/Down coloring defaults are controlled by the Chart Colors
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Preferences.



3: Custom Indicator Pane(s) Any number of panes other than the Price and Volume Panes can be added to display Fundamental data items, or, in general, technical indicators that don't belong in the Price or Volume panes. These panes and their data (3a, 3b) are automatically created when plotting using Drag and Drop 87 or when creating a rule-based strategy with the Strategy Builder. 4: Horizontal Scroll Bar A chart may contain much more data than can be readily displayed by its current window size. In this case you have several scrolling options, from largest to smallest movements: Striking Ctrl+Home / Ctrl+End quickly advances the chart to the beginning / end. Click and drag the slider Click, hold, and drag horizontally in the chart area to move up to the chart's full width Click in the slider area to move in n-bar increments Click on the slider arrows to scroll one bar at a time Adjusting the bar width smaller (larger) is another way to display more (fewer) bars in a chart. 5: Chart Status Bar 1 - Price Data The status bar immediately below the horizontal scroll bar provides the bar number, date, and price data at the position of the mouse pointer. You may need to increase the horizontal width of the window to see all of the information in each panel. In the far-right status panel, "Mouse:" shows the y-axis value of pointer with respect to the current pane. Chart Status Bars are displayed only if selected in the Function toolbar.



Show Status Bars on Chart is



6: Chart Status Bar 2 Open a Strategy...



Launches the Strategy Explorer to choose an existing Strategy to add to the chart window.



Last Date



The date (and time, if intraday chart) of the last bar loaded in the chart.



Bars



The total number of bars loaded in the chart.



(link icon)



Charts with link icons "enabled" automatically switch to display data for the next symbol entered in the Data Panel from any chart window. Each chart window continues to use its previously-established Scale, Data Range, and Position Size settings. Appears for Strategies that have Preferred Values applied when selected.



Stream
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Enables streaming for the Streaming Data Provider Preferences. See Streaming Charts 93 .
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7: Y-axis Each pane has its own y-axis that is auto-scaling for data currently displayed. By default, y-axes are scaled linearly, but can be made logarithmic programmatically by the SetLogScale() method. Wealth-Lab does not provide a special method to display more than one y-axis scale in the same pane, though a motivated programmer could certainly accomplish this. 8: Chart Scaling Hovering the mouse over the



cue will display a basic scaling menu



from which you can use one click to change the chart scale to Daily, Weekly, Monthly, or any of the n-Minute scales shown. Using this method to change a chart scale is convenient especially when the Data Panel is hidden.
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Chart Context Menu The Chart's right-click menu presents options for interacting with the Chart and its data. Since some actions are context-sensitive, all options shown in the image will not always available. Buy Sell Short See Right Click Trading 61



Cover



Open a Strategy ... / Open a Different Strategy ... Launches the Strategy Explorer to permit selection of an existing Strategy. Plot an Indicator on the Chart ... Launches the Technical Indicators dialog (also: Ctrl + F11) for drag and drop plotting of indicators 87 . Plot a Fundamental Data Item on the Chart ... Launches the Fundamental Data dialog (also: Ctrl + U) for drag and drop plotting of Fundamental Data Items 92 . Right click menu after clicking on a Trendline object.



Copy Chart image to Clipboard Copies the Chart image for pasting into another application that accepts and image bitmap. Charts can be exported automatically from code. See GetChartBitmap in the QuickRef for an example. Copy Price Data to Clipboard Copies all DataSeries, including plotted indicators, to the Windows clipboard. Add this Symbol to the selected DataSet This action is enabled after having obtained a chart for a symbol that does not exist in the current DataSet through an on-demand request or by entering a symbol from another DataSet for the current Provider. Print Prints the chart image. See Print Preferences



238



in the Advanced Options.



Change Drawing Object Properties Launches the Properties dialog 67 for the selected manual drawing object



66 .



Delete Drawing Object Permanently deletes the selected manual drawing object for the symbol/scale.
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Chart Colors and Styles ... Launches the Preferences dialog (F12) to the Chart Colors and Styles F12).



206



group (Ctrl +



Chart Style Settings ... Enabled for Chart Styles that have custom settings. This action launches a settings dialog that is specific to the current Chart Style. Reload Chart History Enabled for data Providers that support on-demand data collection. Process a Stock Split ... Launches the Stock Split dialog that allows you to perform a manual split of the current symbol's data. Edit Bar Data The bar editing option is enabled for data providers that support data editing for their Bar Data Store. Right click (or double click) the bar to edit in order to launch the Bar Data Editor. Change the value(s) in the New column to those desired. If adding a bar, the New date/time value must not already exist in the static data file. Data editing is not available while Streaming, however, the edits made to the static provider Click Ok to save the edit or Remove to delete the current bar. To completely refresh a chart and discard edits, use the Reload Chart History option (above). Create Parallel Trendline Copies the selected trendline's properties and creates a new, parallel line that can be placed in another location.



6.2.1



Right Click Trading Right-Click Trading The Chart Window's main context menu includes options to Buy, Sell, Short, or Cover shares of the current chart symbol. The order's share size displayed is determined by the setting in the Position Size Control 296 . Upon selection, a market order is Staged in the Orders tool, however, if the Auto-Trading is enabled the order is immediately placed with Fidelity.
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Immediately send a market order to Buy, Sell, Short, or Cover the underlying ticker to the Orders tool.



Remarks Right-click trading is disabled for Portfolio Simulation mode Max Percent Risk sizing. Trades are destined to the default trading account 240 unless the underlying Strategy has an alternate account association. You can associate Strategies with specific accounts with the Strategy Explorer 305 via the Set Account account. All trades are market orders, however, you can edit the trade once in the Order Manager's queue if Auto-Trading is disabled. If the Auto-Trading is enabled, trades are immediately placed at market without the ability to edit the order. Determining Position Size The following pseudo code summarizes how Position Size is determined for Right-click trading. For money-management options that are not shown, Right-click trading is disabled. Fixed Dollar



Shares = Trunc( Dollar_setting / Close[mrb*] )



Fixed Shares



Shares = Fixed_Share_Size_setting



Percent of Equity



Shares = Trunc( PctEq_setting * Equity[mrb*] / Close[mrb*] )



Equity is based on the equity curve value at the last bar after running the ChartScript. * mrb = most-recent bar
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Chart Control Chart control exists primarily in three areas: the Chart Window itself, the Data Panel, and on the Function toolbar. See the previous topic on the Chart Window 57 .



Data Panel Use the Data Panel to control chart Scale, Data Range, and Symbol. Position Size isn't a chart control setting per se, and like the Strategy Parameters frame, it applies only to Strategy Windows 95 and Alert sizing for Tradable Trendlines 71 .



See the Data Panel 292 topic in the Reference chapter for a more complete treatment of this very important set of controls.



Function Toolbar (Chart Mode) When a Chart or Strategy window is in focus 325 , the Function Toolbar provides several charting control options for that window. Different chart windows have their own set of options, which are recalled each time focus returns to the window.



Function Toolbar selection for Charting Mode.



New Selections identical to File | New in the main menu for creating a new DataSet and launching fresh Chart/Strategy, Workspace, and Quotes windows. Open Strategy Launches the Strategy Explorer to open a strategy in a new Strategy window. Save / Save As Saves Dragged & dropped indicators, Strategy code, and/or Wizard-based Strategy Rules.



Log in to Fidelity Logs in to Fidelity servers, which is required for streaming charts, Strategy Monitor, GICS updates, account views and trading. Spacing: To adjust the spacing of the bars on your chart, use the Increase, Decrease, and Restore bar spacing buttons. You can also control the bar spacing by scrolling the mouse wheel © 2017 FMR LLC All rights reserved.
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after clicking on the chart. Increase Increases the width of bars so that fewer are displayed in the chart area. Use this in combination with the horizontal scroll bar to see more detail in a specific area. Restore Restores bar width to Wealth-Lab's default setting. Decrease Decreases the width of bars so that more are displayed in the chart area. Chart Styles: Chart Styles are graphical representations of an instrument's OHLC/V data. Linear Scale Semi-Log Scale Switch between linear and semi-logarithmic scales by selecting the appropriate button. The semi-log scale option scales the Y axis of the chart by percentage change in price, rather than absolute price value. With log scaling, the distance between 10 and 100 on the Y axis would be the same as the distance between 100 and 1000. It's called "semilog" because the X axis (time) is linear, not logarithmic. Tip: To control a chart pane's y-axis scaling from your Strategy code, use the SetLogScale method. Show: Show Indicator Labels on Chart Shows/hides indicator labels (if any) in the upper left corner of all plotted panes. Show Status Bars on Chart Shows/hides the two status bars on the bottom of the chart to maximize the chart viewing area. Show Selected Fundamental Data Items on Chart Shows/hides all fundamental items selected for display in the Chart Annotation Preferences.



209



Tip: To toggle "Show" selections to all charts at once, press and hold the Alt key when clicking on of the Show buttons above.



Data Window The Data Window displays digital information for all plotted prices and indicators for the bar at the mouse pointer's position. The decimal display for prices and indicators is © 2017 FMR LLC All rights reserved.
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controlled by the Decimal Places settings in Advanced Options



239



.



Plot Technical Indicators Launches the Technical Indicators dialog from which you can drag and drop selected indicators into a chart. See Plotting with Drag and Drop 87 for important details. Plot Fundamental Data Items Launches the Fundamental Data dialog from which you can drag and drop selected fundamental items into a chart. See Plotting with Drag and Drop 87 for important details. Clear Drag & Drop Indicators Immediately clears all Indicators, Fundamental Items, and associated panes that were created using drag and drop. Push Dropped Indicators and Fundamental Items into Strategy Code See Pushing Dropped Indicators 89
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Drawing Toolbar The focus of Wealth-Lab Pro is on automated trading system development, and the WealthScript language offers an extensive set of "Cosmetic Chart" functions to draw in a chart programmatically. Nonetheless, sometimes it's handy to just draw a trendline manually or add a note to a chart. Consequently, Wealth-Lab provides an array of drawing tools to manually add lines, shapes, images, and in general, "objects" to your charts.



The Drawing toolbar is located along the right border of the application.



Where Drawing Objects are Stored Data for drawing objects are located in the DrawingObjects.Standard folder and subfolders in the primary Wealth-Lab Pro data path 35 . As with DataSets, the subfolders are organized by scale and symbol, and, the drawing object (.DRW) files are binary-formatted. Generally, the raw data from these files are not useful to you. However, it may be useful to know that you can delete the DrawingObjects and/or scale folders to clear all drawing objects for all symbols in a single operation. Before deleting Wealth-Lab data, close all Workspaces first. Drawing objects are saved for Symbol/Scale upon closing a Chart or Strategy Window.



How to: Manually Draw Objects Generally speaking, to manually place an object in a Chart Pane start by selecting the desired object from the Drawing toolbar with a single left click. Then, identify the location to place it within the Chart Pane. Some of the more advanced drawing tools have a specific positioning method as described later, but generally drawing is accomplished using the click-and-drag method. Click the first point on the chart, and while maintaining the mouse button depressed, drag until reaching the second point. Drawing objects can be drawn in either static or streaming modes. New drawing objects are initialized with the last-selected properties.



© 2017 FMR LLC All rights reserved.



67



User Guide, Wealth-Lab Pro



How to: Modify a Drawing Object's Properties To edit a drawing object, position the pointer over an edge of the object, right click on it, and then select Change Drawing Object Properties from the pop up menu. Alternatively, simply double click on an edge of the drawing item. Either action will launch a dialog box that will allow you to modify the properties of the object. Some objects have a selection point or control line rather than an arbitrary edge. The exceptions are noted in the object descriptions where applicable.



How to: Move Drawing Objects To reposition the entire object while preserving its original shape, place the pointer over the edge of a drawing object, the pointer will change to a small crosshair symbol and a red "handle" will appear underneath. To reposition the object, use the drag-and-drop method by left clicking the movement handle.



Click and drag an object by its red handle, but use the grey handles for resizing.



Drawing objects remain contained in the pane (Price or Volume Panes only) in which they are drawn. However, by using a movement handle on an edge opposite of the direction in which you want to drag, it's possible to extend objects partially outside the top, bottom, or left portion of the pane while preserving the object's original shape. However, a drawing object cannot extend past the right edge of a chart. In this case, object's will distort (become smaller) in the horizontal dimension.



How to: Resize Drawing Objects To resize a drawing object, position the pointer over an edge of the object to locate the grey handles. Click and drag the handle to a new position. Use the Snap Endpoints to Price to quickly re-position on an exact OHLC price.



Delete [All] Drawing Objects Tool Click this tool once to immediately and permanently delete all drawing objects for the currently-selected chart (symbol and scale). An individual object can be deleted by positioning the cursor over a selectable edge of the object, right-clicking, and selecting Delete Drawing Object.
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Crosshair Tool Use the crosshair to visually align vertical and horizontal components of a chart. Select the crosshair, click, hold, drag and release at the desired location. The price and date are shown at the left and upper extremes of the crosshair.



6.4.1



Notes and Images Text Note Tool To place a text note on a chart, click this tool, then click the area of the chart where you want the note to go. A dialog box will appear where you can enter the text for your note and specify the font. To move a note, grab the red handle near the upper left hand corner of the note and then drag the note around on the chart. To edit the note, place the mouse pointer above the note text, right click, and then select Edit Object or Delete Object.



Callout (Text Balloon) Tool As an option to using the Text Note tool, you can add a Callout and point to a specific area on the chart to highlight it. Add a Callout in the same manner as you would a Text Note. In addition to entering text and choosing a font, you can also specify the background color of the balloon and its color transparency (alpha) value. Transparency is a number from 0 (completely transparent) to 255 (opaque). When hovering the cursor over the balloon, two handles will appear. The red, upper-leftmost handle allows you to reposition the balloon. To move the pointer to a different location, drag and drop the grey handle at the tip of the pointer.



Image Tool Quickly add your company's logo or other image to a chart via the Image Tool. You use image files of type *.BMP, *.JPG, *.JPEG, *.GIF, *.PNG, or *.TIF. Select this tool and then click on an area in the chart where you want the upper-left corner of the image to appear. After identifying this area, select the image file from the dialog box that appears and click Open. The image can be repositioned using its selection handle.



6.4.2



Shapes Tip: You can set a Fill Transparency value from 0 (opaque) to 100 (transparent) for each shape's Properties. A value between 75 and 90 provides a very pleasing effect on a chart.



Rectangle Tool Ellipse Tool Rectangles and ellipses are drawn in a similar fashion by defining two-opposing corners of © 2017 FMR LLC All rights reserved.
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the shape. In the case of the ellipse, the "corners" are the intersecting (and invisible) horizontal and vertical tangent lines. Select the shape desired, click on the first point on the chart, and while holding the mouse button drag until reaching the second point. Resizing these objects are done in the standard manner using the grey resizing handles.



Triangle Tool Diamond Tool The triangle and diamond-shape tools actually create 3 and 4-sided polygons, respectively. Choose the tool by clicking on it once, and then create a vertex by leftclicking a point on the chart. While maintaining the button depressed, drag the cursor to another point for a second vertex. Generally, a third vertex is automatically created at a slightly-greater value but several bars to the right of the initial point clicked. A fourth vertex is required for the diamond tool, and it is initialized at the value of the point first clicked. The diamond shape should be formed at least 10 bars to the left of the final bar in the chart. After defining the points for the first two vertices, use the vertex handles to re-shape the polygon.



6.4.3



Lines and Trendlines Vertical Line and Tool Horizontal Line Tool To draw a vertical or horizontal line on your chart, click these tools and then click the point on the chart where you want the line to be placed. You can move a line by dragging the single handle that lies along the line. Note, however, a vertical line spans all panes of a chart. To drag a vertical line, you must grab it from the pane in which it was dropped.
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Trendline Tool To draw a basic trendline, click this tool. Click on the point of your chart where you want the trendline to start. Keep the mouse button pressed and drag until the trendline is completed.



Tip: For a horizontal trendline, select the Trendline tool and simply click once on the chart and release. Drag the line with the red handle to precisely the price level desired by monitoring the Trendline value displayed. Name of Line A useful Strategy feature is the ability to provide a name for your manually-drawn trendlines in the Trendline Properties dialog. You can then access the trendline's value at any specific bar in your Strategy code, using the TrendLineValue function.



Trendline Properties



Drawing Style, Options You can set the color, thickness, and line style of the trendline, as well as control whether the ends "snap" to the nearest price (open, high, low or close). With the snap feature, you may need re-drag the end points after initially drawing the trendline. Trendlines may be extended right and/or left. When extended, the "drag handles" are positioned at the trendline endpoint(s) when hovering the cursor. Finally, you can display the percentage change between the closing prices that correspond to the trendline endpoints. Example (How to run Example code? C#



8



)



/* Draw a circle on bars that penetrate a trendline named "Resistance" to the upside Note! To observe the effect, you must draw a Trendline through the bars and name it "Resistance" in the Properties. */ using System; using System.Collections.Generic; using System.Text; using System.Drawing; using WealthLab; namespace WealthLab.Strategies { public class MyStrategy : WealthScript { protected override void Execute() { const string trendlineName = "Resistance"; double res; for(int bar = 1; bar < Bars.Count; bar++)
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{



if ( Close[bar-1] < TrendlineValue( bar-1, trendlineName ) ) { res = TrendlineValue( bar, trendlineName ); if ( Close[bar] >= res ) { SetBarColor( bar, Color.Green ); DrawCircle( PricePane, 10, bar, res, Color.Red, Color.Yellow, WealthLab.Li } } } } } }



Tradable Trendline Tool The Tradable Trendline (TT) tool as an extension of the basic Trendline tool with the added ability to generate Alerts based on the most-recent closing price crossing above or below the line. A Tradable Trendline is always active in the Chart/Strategy Window (only) for the symbol and scale for which it was drawn. Even when viewing a semi-log scale, internally Wealth-Lab projects a TT on a linear scale to determine the Alert.



We recommend always leaving "Extend Line Right" checked for Tradable Trendlines.



Trades Properties (Rules) While most options are identical to the basic Trendline counterpart, you should verify and set the Trades properties after drawing a TT. For this reason the Properties dialog is displayed automatically after initially drawing the line. You can create an Alert to Buy, Sell, Short, or Cover when the closing price crosses above/below the trendline. If the trendline extends to a value above the closing price of the most-recently-completed bar (not the ghost bar 325 ) when drawn, then the selection defaults to crosses "Above" and vice-versa.
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Trade Alerts The share (or contract) size for TT Alerts is based on the Position Size setting and the closing price of the Alert bar. For example, $5,000 fixed sizing for a stock that closes at $25.00 will cause the Alert sizing to be 200 shares. The trendline name will appear in the Signal Name 328 of the Alert, i.e., Tradable Trendline( Trendline_name ). Because TT Alerts are market orders, they will out-prioritize Stop and Limit Alerts from an underlying Strategy while using the Auto-Trading. Since Tradable Trendlines signals are discretionary in nature, we do not recommend mixing TT Alerts with automated system trading. TT Alerts are directed to the Default Account 240 . To direct the order to a different account, right click to edit the alert or order. The same TT will continue to generate Alerts as often as the crossing condition occurs.



321



as bars are added to the chart



Scale matters: TTs trigger Alerts only for the symbol and scale for which they were drawn.



6.4.4



Fibonacci Fibonacci Retracement Fibonacci Fan Fibonacci Arcs Fibonacci Retracement, Fan, and Arcs tools project support and resistance areas into the future that are characterized by Fibonacci and/or user-defined ratios. After defining a major peak and trough, these zones are represented in the various manners by dividing the difference between the peak and trough into the ratios configured in the Fibonacci Retracement Properties dialog. Although the principal Fibonacci ratios are 38.2, 50.0, and 61.8%, Wealth-Lab allows you to enter your own ratios, which may be any positive number expressed as a percentage. The manner in which each Fibonacci Retracement tool is drawn is exactly the same. Select the desired tool, and draw a line from a swing high to a swing low, or from a low to a high. The Fan and horizontal retracement levels are extended to the chart edge. You can modify the levels by editing the Fibonacci control line. Tip: Generally Fibonacci tools are drawn between well-defined peaks and troughs. However, when drawn to the end of the chart before a peak/ trough develops, the retracement values will be "off the chart". To see the retracement levels add the statement PadBars(15); to the Execute() method in a Strategy window.
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Fibonacci Time Zones Whereas the default percentages (38.2, 50.0, and 61.8) for the Fibonacci retracement tools are based on ratios of Fibonacci numbers, the Fibonacci Time Zones are based on the Fibonacci sequence itself. For reference, the sequence is: 1, 1, 2, 3, 5, 8, 13, 21, 34, 55, 89, 144, ... Consequently, the Time Zone tool draws vertical lines at Fibonacci number distances, where each zone line is relative to the previous. To draw the time zones, simply click the tool and then click the bar on which to begin the Fibonacci Time Zones. The [first] line drawn at the start bar is the control line used to select, edit and move the object. A number corresponding to the Fibonacci distance is displayed for each time-zone line. The illustration below indicates where lines will be drawn if the start bar were Bar Number 0 (the first bar in the chart). TZ Line at Bar: 0 | 1 | 3 | 6 | 11 | 19 | 32 | 53 | 87 ... Fib Sequence Num: 1 2 3 5 8 13 21 34 ...



Tip: If using more than one Time Zone tool in the same chart, you can distinguish them by changing the color and/or line style in the object's property settings. Double-click (or right click) the initial line to Change Drawing Object Properties.



6.4.5



Gann Fan Gann Fan Drawing Tool A Gann Fan is a set of lines emanating outward (forward in time) from a single price. The lines suggest possible points of support and resistance based on a simple rate-of-change relationship between time and price. Wealth-Lab's Gann Fan Properties editor allows you to specify the Time/Price ratio as well as the number of price units for each time unit (bar).
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The Gann Fan properties shown at the right will attempt to draw 9 lines emanating forward and up using the Time/ Price ratios shown. To demonstrate what these ratios signify, concentrate on the 2x1 line and notice that 0.25 is selected for the Time/Price Units ratio. If you were to start a Gann Fan on Bar Number 1000 at a price of 10.0, the 2x1 line would be drawn through a price of 11.0 at Bar Number 1008. In other words, we're adding 1 price unit (10.0 + 1) for each 2 time units, and, each time unit (bar) is equal to 0.25 price units. Consequently, the Bar Number is 1000 + (2 / 0.25 ). Draw the Gann lines by clicking on the Drawing toolbar button and then click on the point that will serve as the origin for the lines. At this time you will have an opportunity to edit the Gann Fan Properties. Click OK to complete the drawing.



Tip: Change the Line Width to 2 or more to clearly identify the 1x1 (45º) line.



Gann Fan Properties dialog



Modifying a Gann Object The selection point for the Gann Fan is the lines' origin. Hover the cursor over the origin until it changes to a small crosshair icon. You can click, hold, and drag the Gann object to a new location. With Snap Endpoints to Price enabled, the object will automatically snap to the nearest OHLC price while dragging the fan for repositioning. To edit the properties, launch the Gann Fan Properties dialog by double clicking the origin, or by selecting Change Drawing Object Properties from the chart's right-click menu. Tip: Adjust the Time Unit setting to a number such that the 1x1 line appears at a 45º angle on the chart. For higher-priced instruments like indices, a number greater than 10 is required, whereas a number 0.5 or less is suitable for most stocks. As a general rule, raise (lower) the number if the 45º line is too flat (steep).



Example (How to run Example code
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C# using using using using using using



System; System.Collections.Generic; System.Text; System.Drawing; WealthLab; WealthLab.Indicators;



namespace WealthLab.Strategies { public class GannFan : WealthScript {
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/* Draw a Gann Line and return its value on the last bar of the chart */ public double DrawGannLine( int bar, double price, int timeUnits, int priceUnits, double priceUnitsPerBar, Color color, LineStyle style, bool drawU { //int b2 = bar + (int)Math.Round(timeUnits/priceUnitsPerBar); int b2 = bar + timeUnits; int bcm1 = Bars.Count - 1; double delta = priceUnits * priceUnitsPerBar; double y = price + delta; if( !drawUp ) y = price - delta; if( b2 > bcm1 ) { DrawLabel(PricePane, "Sorry, cannot draw this line", Color.Red); return -1d; } else { DrawLine(PricePane, bar, price, b2, y, color, style, 1); double res = LineExtendY(bar, price, b2, y, bcm1); DrawLine(PricePane, b2, y, bcm1, res, color, style, 1); return res; } } protected override void Execute() { /* Draw a Gann Fan from the 9 Oct 2008 low */ int tb = DateTimeToBar(new DateTime(2008, 10, 9), false);



/* Adjust the priceToTimeRatio so that the black 45 deg line (1:1) appears to be 45 de * If the line is pointing upward too steeply, then raise the value (and vice-versa). */ double priceToTimeRatio = 0.25;



if( tb > 0 ) { DrawGannLine( tb, Low[tb], 1, 1, priceToTimeRatio, Color.Black, LineStyle.Solid, tr int n = 2; do { DrawGannLine( tb, Low[tb], 1, n, priceToTimeRatio, Color.Blue, LineStyle.Solid, DrawGannLine( tb, Low[tb], n, 1, priceToTimeRatio, Color.Red, LineStyle.Solid, t n += 2; } while (n < 8); } } } }



6.4.6



Regression Channel Regression Channel Tool To draw a Regression Channel, click the Regression Channel tool. Then, click the point on the chart that you want the Regression Channel to begin. Holding the mouse button down, drag right or left until the channel is completed. The Regression Channel draws a linear regression line of the closing prices between the start and end points. It draws channels around the regression line. The distance of the channels are based on the highest distance of a single point above or © 2017 FMR LLC All rights reserved.
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below the regression line. To edit or delete a Regression Channel, follow the same procedure as described for trendlines. Exercise in Linear Regression 1. Drag and drop a LinearReg indicator with a Period of 50 into a chart (Plotting Indicators 86 ). 2. Select the Regression Channel Tool. 3. Click on the last bar of the chart, hold, and drag backwards 50 bars and release. For assistance in determining the precise number of bars, watch the bar number in the Price Data Status Bar 58 . 4. Move the regression channel back and forth by grabbing its red handle along the middle regression line. You should see that the regression channel always ends precisely at the same value as the LinearReg indicator.



The n-Period linear regression line always ends at the value of the n-Period LinearReg indicator.



6.4.7



Speed Resistance Lines Speed Resistance (S-R) Lines Speed Resistance Lines are composed of three trendlines. Use this tool to define a line between a major high and low. After selecting the S-R tool, click the left-most point of the trendline first. Continue holding the mouse button and drag to the right until reaching the second point. The S-R lines are rendered on the chart during the drag operation to assist in positioning.
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Speed Resistance line showing endpoint handles.



Only the defining trendline is used for editing and movement of the S-R object. The two resistance lines are formed automatically by drawing lines from the origin that intersect values at the final bar that are 1/3 and 2/3 the distance between the prices identified by the control trendline. The intersection points, illustrated by the grid crossings at points A and B, are located at the same bar as the end point of the control trendline. Since the trendline is drawn from 94.0 to approximately 106.0, the 1/3 divisions are 4.0 points apart. Notice how the resistance lines cross the endpoint bar at 102.0 (A) and 98.0 (B). Modifying a S-R Object The selection point for the S-R object is anywhere along the defining trendline, but only between the defined endpoints. Hover the cursor until a red handle appears, which is used to reposition the entire object without changing the endpoint relationship by clicking, holding, and dragging to a new location. Snap Endpoints to Price does not affect the action of repositioning the S-R object. On the other hand, you can reposition the endpoints themselves, and in this case Snap Endpoints will assist positioning endpoint to the nearest OHLC price. To edit the properties, launch the S-R Properties dialog by double clicking a selection point, or by choosing Change Drawing Object Properties from the chart's right-click menu. It's easy to duplicate S-R lines and other objects in a script as the next example demonstrates. Example (How to run Example code
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)



C# using using using using using using



System; System.Collections.Generic; System.Text; System.Drawing; WealthLab; WealthLab.Indicators;



namespace WealthLab.Strategies { public class SpeedResistanceDemo : WealthScript {



© 2017 FMR LLC All rights reserved.



Charting



78



public void SpeedResistance(int bar1, double price1, int bar2, double price2 ) { // You can extend the lines drawn with this procedure using LineExtendY or LineExtendY double delta = price1 - price2; DrawLine(PricePane, bar1, price1, bar2, price2, Color.Red, LineStyle.Solid, 2); DrawLine(PricePane, bar1, price1, bar2, price2 + delta / 3, Color.Blue, LineStyle.Dots DrawLine(PricePane, bar1, price1, bar2, price2 + delta * 2 / 3, Color.Blue, LineStyle. } protected override void Execute() { // Find the latest 8% peak and trough and draw the S-R lines between them int bar = Bars.Count - 1; int b1 = (int)PeakBar.Value(bar, Close, 8.0, PeakTroughMode.Percent); int b2 = (int)TroughBar.Value(bar, Close, 8.0, PeakTroughMode.Percent); if (b2 > b1) SpeedResistance( b1, Close[b1], b2, Close[b2] ); else SpeedResistance( b2, Close[b2], b1, Close[b1] ); } } }
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Chart Styles A Chart Style is a visual representation of a symbol's OHLC/V data. General Properties of Chart Styles Chart Styles are "sticky". The most-recent style that you select will be used for new chart windows. Each Style has its own set of Chart Style Properties that can be accessed from the chart's pop up menu or by striking Ctrl+Y. Generally speaking, Chart Styles do not affect a trading strategy. However, an advanced programming feature of the Trending Chart Styles allows you to access data objects calculated during the chart's construction.



How to: Change chart styles Wealth-Lab comes with a number of popular chart styles (OHLC, Candlestick, and Line) as well as with several more exotic styles (EquiCandle, Kagi, etc.). To switch between chart visualizations, put the chart window in focus and select the Chart Style from the Function Toolbar.



Candlestick, OHLC, and Line styles have dedicated icons. Select all other available chart styles from the "More" drop down.



Software developers can create their own Chart Style Adapters for Wealth-Lab Pro. See the WealthScript Programming Guide chapter "APIs".



Chart Style Settings Most Chart Styles have preferences that can be controlled through a custom dialog, which are activated from the chart's right-click menu, or simply by striking the Ctrl+Y keyboard shortcut.



6.5.1



Line Line The Line style is the most simple of all chart styles. It is formed by connecting the closing prices of contiguous bars with a line segment whose color is based on the Up/Down Bar Color specified in the Chart Colors and Style Preferences (F12).
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Since Wealth-Lab's Up/Down Bar Color is with respect to the open and close of the current bar, it's possible for a descending line segment to be drawn with the "up" color and vice versa due to gap openings 321 . Chart Style Settings... Line Width



6.5.2



Specifies line thickness in pixels.



OHLC OHLC The Open-High-Low-Close representation is one of the most popular chart styles since it conveys all of a bar's information in a concise format. Referring to the OHLC icon selected above (top left), the open and closing prices of the bar are represented by the horizontal ticks to the left and right of the vertical line, respectively, while the high and low of the bar are given by the extremes of the vertical line, which in turn represents the bar's trading range. If the right tick (close) is higher than the left tick (open), then the bar is drawn with the Up Bar Color selected in the Chart Colors and Style Preferences (F12). Chart Style Settings... (none)



6.5.3



Candlestick Candlestick Candlesticks contain the same Open-High-Low-Close information as OHLC bars, but accentuate the difference (if any) between the open and closing prices. The rectangular area of a Candlestick bar is called the "body". The lines above and below the body are the "shadows". The relationships between the bodies, shadows, and their relative sequence give rise to a whole new class of technical analysis first made popular to U.S. traders in the early 1990's in Steve Nison's books "Japanese Candlestick Charting Techniques" and "Beyond Candlesticks". Chart Style Settings...



6.5.4



Fill Candlesticks



When not selected, up-bar candle bodies are hollow. When selected, up-bar candle bodies are filled with the Up Bar Color specified in the Chart Colors and Style Preferences (F12).



Draw Outlines



Use this option to draw the candle shadows and outline the candle body in black. The up/down color is represented only by the candle body.



EquiCandle EquiCandle EquiCandle simply combines the techniques of both Candlestick and EquiVolume chart styles. Opening and closing price information is preserved in this "EquiVolume"



© 2017 FMR LLC All rights reserved.



81



User Guide, Wealth-Lab Pro



representation. Chart Style Settings... (none)



6.5.5



EquiVolume EquiVolume EquiVolume charts combine price movement and volume into a single representation. Bars are composed of only the highest and lowest price for the interval, which are designated by the top and bottom, respectively. Bar width is determined by volume and consequently is relative to other bars in the chart. For example, you would expect the width of a bar on a day that traded 100,000 shares to be twice as wide as a bar on a day whose volume was only 50,000 shares. Thin bars having large price variation can be interpreted to be "easy movement", whereas small bars having a squarish shape indicate lack of commitment from both bulls and bears. On the other hand, strong commitment from these camps are detected on bars with large volume, observed by thick bars. Large price movement on these days indicate a push from one side, whereas a short and wide bar signifies a battle between both sides. Chart Style Settings... (none)



6.5.6



Trending Chart Styles While sharing many of the same properties, Trending Chart Styles are some of the most diverse and intriguing representations of price action. Probably the most significant common property is that the x-axis of the charts are not a function of time. Instead, these charts add new "bars" from left to right based on price reversals, and in some cases, as price advances. Additionally, Trending styles unambiguously signal when to buy and sell in order to catch the beginning of the next trend, although in practice it's common to diverge from standard interpretations in an attempt to maximize a strategy's profit or efficiency.



Access to Chart Style Data Prior to Wealth-Lab Pro Version 5, it was not possible to obtain data used to create a Chart Style directly from the adapter for use in a trading strategy. Now in .NET, by simply creating a reference to the Chart Style's assembly, you can access objects and methods that the component's author has made public. The Chart Styles covered here are all part of the WealthLab.ChartStyles.Trending assembly, whose public methods will be documented in the near future.



Special note for executing scripts that use Chart Style public methods Wealth-Lab does not execute a Strategy automatically following a change to a Chart Style's settings. This is of no consequence unless your script uses data from a Chart Style adapter's public methods. In this case, you must manually execute the script after a settings change for trades to reflect the new settings.
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Kagi



Kagi Steve Nison tells us in Beyond Candlesticks that "Kagi" comes from the Japanese word for key and that the lines drawn by this style resemble an old-fashioned key with an L-shaped head. Wealth-Lab's Kagi charts are based on closing prices only. After choosing the Kagi Chart Style, configure the Kagi Reversal Amount in the Chart Style Settings. You can choose between percentage or point reversals. If you don't think you're seeing a sufficient amount of Kagi lines, try reducing the reversal amount. Tip: When using Kagi percentage reversal, switch to the semi-log Chart Scale setting so that all same-percentage moves are viewed as equal vertical displacements. Likewise, use a linear Chart Scale for Kagi point reversals. Kagi lines are constructed by drawing a continuing vertical line in the direction of gradually increasing price until a reversal occurs (on a closing basis) that meets or exceeds the Kagi Reversal Amount. When a reversal occurs, a short horizontal line, called the inflection line, is drawn. A vertical line is then drawn in the reverse direction by the full value of the reversal and continues with decreasing price until another reversal of the specified magnitude occurs, and so on. Due to the manner in which Kagi charts are drawn, the time axis is irregular. Dates and price data are displayed only for the bar of the highest or lowest point before the next reversal. Chart Style Settings... Reversal Amount



The minimum magnitude used to detect a trend reversal as specified in percentage or points.



Yin Line Width



Yin vs. Yang refers to the struggle for control between the bears and bulls, respectively. The thickness of the line changes between thin (Yin) and thick (Yang) to indicate which side is currently in control. Specify the thickness the thin line - just remember "Yin is thin."



Use one line color Kagi lines are traditionally drawn with one color, although up/ down coloring will be used if this option is not selected. Overlay HLC chart Select this option to view Kagi lines drawn over a HLC bar chart.



6.5.6.2



Line Break



Line Break Wealth-Lab offers a representation of the most popular Three-Line Break chart, also referred to as "Three-Price", "Three-Step, and "Three-Link" Break. The Line Break style uses closing prices only and allows you to visualize trends and trend reversals in any time frame. Although three (3) break prices is most often used, you can select any number of © 2017 FMR LLC All rights reserved.
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break prices, from 2 to 8. In a bull market, white (up) lines are drawn for each new higher closing price. After three white lines are drawn, the reversal or "break" price becomes the third previous higher close. Acting like a stop, the break price trails as new higher closes occur. When the break price is penetrated on a closing basis, a reversal (dark) line is drawn. At this point, a new [bear] trend can develop downward, or, the previous trend can resume if a new higher close occurs. When three dark lines are drawn, the bear trend has been established and the process is same. Trend-less markets are observed by alternating reversal lines, white and dark. Since lines are drawn only for new price highs and lows, the time axis for Line Break charts is distorted and uneven. During periods of large price movement, more bars will be shown than in a similar less volatile period. Chart Style Settings... Lines to Break



Specifies the number lines to break; 2 minimum, 8 maximum



Overlay HLC chart Select this option to view Line Break boxes rendered with 50% transparency over a HLC bar chart.



6.5.6.3



Renko



Renko As with Line Break, Renko charts use only closing prices. However, the Renko chart style draws bars, or bricks, of the fixed amount that you specify in the Chart Style Settings as Renko Price Units (RPU). Price must move greater than this fixed amount for a new brick to be drawn, and, no matter how large the price movement, bricks are always drawn equally-sized. For example, a 10-point move in a 2-RPU chart would result in five consecutive 2-point bricks. The Renko basis price, or starting price is quite arbitrary and is based on your Data Loading configuration. Consequently, Wealth-Lab uses cardinal boundaries when determining to draw a new bar. For example, if you set an RPU of 1.0, bricks will be drawn for 1-point price changes relative to integer price levels, e.g. 10, 11, 12, etc. Because Renko bricks are all the same size, price changes in excess of an integer multiple of the RPU are discarded. Continuing the previous example, if our Closing Price Series were ..., 9.0, 9.1, 10.8, ..., only a single brick would be drawn from 9 to 10. Finally, for a brick to be drawn in the reverse direction, price must exceed the base price of the previous brick by the RPU. Expanding our example series ..., 9.0, 9.1, 10.8, 10.1, 9.2, 8.7, 7.3, ...., a reversal brick would be drawn from 9 to 8 upon the 7.3 close. Remarks 1. Since "bricks" are drawn only when price exceeds the RPU, the time axis for Renko charts is distorted and uneven. During periods of large price movement, more bricks will be shown than in a similar less volatile period. 2.



Price movement that does not result in the drawing of a brick is unimportant for Renko charts, therefore, the Data Window displays only the OHLC/V data for the underlying bar of data from which a brick is formed.
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Chart Style Settings... Renko Price Units



Specifies the "brick" size in points.



Overlay HLC chart Select this option to view Renko bricks rendered with 50% transparency over a HLC bar chart.



6.5.6.4



Point and Figure Point & Figure (PnF) charts have a long history and interpreting them are somewhat of a lost art, but several good (and thick) books have been published that treat this subject with fine detail. Below we simply cover how PnF charts are formed, whereas interpretation and trading strategy based on them are left to the motivated practitioner. The basic PnF charting method divides the price axis into a user-specified box size. If the box-size is 1 point, a mark ('X' or 'O') is placed in the box into which the price falls. For example, if the control price were 18.65, a mark is placed in the 1-point box marked 18. Price fluctuations between 18.00 (inclusive) and 19.0 are completely ignored until another price prints outside that range. When prices are advancing, we use X's for the marks, such that if the next price were 19.00, 19.02, etc. we would place another X in the same column above the previous X between in the box marked 19, and so on as prices continue to rise into new box levels. In the event of gapping prices, all boxes are filled between the prior box and the box containing the price, such that no empty boxes are visible between marks in the same column. The Reversal Boxes setting determines when to start a new PnF column of marks in the opposite direction. In our example, if 3 reversal boxes were specified, once a mark had been placed in the 20 box we would ignore all pullbacks until price dropped to or below17.0, i.e., into the box representing prices between 16.0 - 17.0. When this occurs, a new column to the right is immediately formed with a corresponding number of O's, starting with the box below the most-recent X, i.e., the boxes for 19, 18, and 17 would be filled. Due to the Point and Figure convention, when prices are falling the "O" mark appears in the box above the one reached by falling prices, whereas "X" marks correspond precisely to the box attained by the control price.



2 X 2 2 X 1 2 X O X 0 1 X O X 9 1 X O X 8 1 O X 7 1 O 6



In the 1 x 3 illustration at left, we can tell that prices first advanced to 20 (but under 21), subsequently dropped to or below 16, and then rose to or above 22. Note that PnF charts are designed to track price action only without regard to time. Consequently, the chart progresses from left to right only as price reversals occur.
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While true Point and Figure charting uses tick data, the Price Field (or Control Price) allows us to use either the Close or High/Low prices from OHLC data. The closing price is essentially treated the same as tick data, although an identical chart will not be formed since the bar's high and low prices are ignored. The problem is partially remediated by using the high and low values of bar data, though this method also has limitations. In the high/low method, when prices are advancing, the high is tested to determine if another X can be drawn. If the high does not create a new box, only then is the low value checked; vice-versa for declining prices. The Log method is similar to the Point method, but mathematically more intensive since the log value of price is calculated and the box size is based on percentage movement. Finally, 1-box reversal charts have their own characteristics, the most notable of which is that an X can be drawn in the same column as an O, which is known as a "one-step back" reversal. Chart Style Settings... Price Field



Close or High/Low series can be used as the control price for Point and Figure.



Use Automated Settings



Automated settings use a box size based on the highest price of the last bar in the chart as follows: Price < 0.25  25000



Box Size 0.0625 0.125 0.25 0.5 1 2 4 5 50 500



Log Method (Ln)



The log method uses box sizes based on percent change. Since stock prices can move exponentially, the log method is recommended for backtesting longer timeframes. Automated settings never use log prices.



Box Size



The box size in points or percent (log method).



Reversal Boxes



The number of boxes price must reverse before drawing a new Point and Figure column.



Settings



Displays the Box Size x Reversal Boxes at the top center of the chart.



Grid



Draws the PnF box grid and turns off the native horizontal and vertical lines (if selected).



45º Trendlines



Draws primary and intermediate 45º Trendlines. One advantage to PnF trendlines is that they can be drawn and projected immediately following a reversal without having to wait for a second reversal point.
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Plotting Indicators Wealth-Lab Pro offers a good number of Technical Indicators that you can always access from the Tools menu or from the Navigation bar, by striking Ctrl+F11, or even from a chart's right-click menu. With a Chart window 57 in focus, you can: plot an indicator using the drag and drop method for a specified Data Series, and apply indicators to other indicators, and save your work so that you can re-open it in a Chart window and continue to interact with previously-dropped indicators.



How to: Plot indicators To quickly plot a technical indicator: 1. Open a Chart window 55 . 2. Launch the Technical Indicators dialog (Ctrl+F11). 3. Locate the indicator to be plotted and double click it. 4. If required, customize the indicator's properties, and click OK to complete the plot action.



Indicators share common properties



Tip: Save plotted indicators as a "Strategy" so that you can recall it or even open it with a Workspace 331 . You can continue to modify an indicator's properties using the point-and-click interface as long as you don't convert it to code.



How to: Plot indicators of indicators To apply an indicator to another: 1. Plot the first indicator 2. Drag and drop the second indicator directly on the plotted line of the first. The second indicator must take a "source" Data Series parameter, otherwise it will be plotted normally. For example, it doesn't make sense to drop an ATR indicator on another Data Series or indicator because ATR is only meaningful in the context of the OHLC Data Series.
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Example To smooth an RSI with a simple moving average (SMA), first plot the RSI, and then drag a SMA directly on top of the RSI's plotted line as if to select it, as shown in the image below. When the SMA Properties dialog appears, you'll notice that the "Source" Data Series contains a description of the targeted indicator.



A RSI is smoothed by a SMA indicator by dropping the SMA directly on the plot of an RSI.



How to: Plot a MACD with signal line 1. Launch the Technical Indicators dialog (Ctrl+F11). 2. Locate the MACD indicator, double click it, and customize the properties. 3. Plot the signal line by dragging and dropping an EMA indicator on the MACD plot. It's customary to choose a 9-period EMA for the signal line.



How to: Delete dropped indicators To immediately remove all dropped indicators, click the Clear Drag & Drop Indicators button in the Function Toolbar. To clear a specific indicator, hover the mouse over the line (or top edge of bars if histogram), right click, and select Delete Indicator.



6.6.1



Plotting with Drag and Drop For quick plotting, launch the Technical Indicators dialog (Ctrl+F11) from the Tools menu, the Navigation bar's Indicators button, by clicking the icon in the Function toolbar, or through the chart's right-click menu. To plot a technical indicator, simply drag an indicator from the Technical Indicators dialog and drop it into a chart. Once dropped, the Indicator's custom Properties dialog is immediately displayed to allow customization of the indicator. (For step-by-steps: How to Plot Indicators 86 .)



Interacting with Dropped Indicators Once you've dropped an indicator in a chart, you can either delete it 87 or change its properties. To modify an indicator's properties, hover the mouse over the line (or top edge of bars if histogram), right click, and select Change Indicator Properties. Also, double clicking the indicator plot will also launch its Properties dialog. It's convenient to leave Indicators Tooltips 207 enabled in order to more easily interact with dropped indicators. © 2017 FMR LLC All rights reserved.
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Dropped indicators are for viewing only and never affect the results of an actual Trading Strategy 329 . Dropped indicator parameters are never available for modification from the Strategy Parameters 328 frame. You can always continue to interact with dropped indicators, and, you can save your work to resume graphical interaction with the indicators in future sessions.



Use the Technical Indicators dialog for drag and drop plotting, or just to peruse the indicators for ideas.



Icons in the dialog have the following meanings: Typical indicator A typical indicator is one that is not characterized by special properties of those described below. The EMA indicator is one such example. You can alter the Drawing Style and Parameter values for these and all indicators.



Same as previous; except that the standard, default Drawing Style is a histogram instead of a line style. Like most preferences in Wealth-Lab, indicator properties are "sticky". The most-recent selections in an indicator's Properties dialog are stored for the next use.
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Oscillator Oscillators let you optionally define overbought and oversold regions that can be filled with color. Transparency is a percentage from 0 (opaque) to 100 (invisible).



Partner Bands Indicators that are normally plotted in pairs, such as Upper and Lower Bollinger Bands, fall into the Partner Bands group. In this case you can plot the pair simultaneously and assign a fill color to the area between the bands.



6.6.2



Pushing Dropped Indicators After dropping indicators or fundamental items, you can "push" their code into a Strategy Editor by clicking the button in the Function Toolbar. Having access to the plotted code automatically provides the syntax of indicators, which you can copy for DataSeries required by your Strategy. In addition, pushing indicators into the Editor is a great timesaving way to automatically generate code for sliders! Example Assume that you want to develop a strategy that uses a SMA and RSI indicators. You could use the Strategy Builder for this, but you want to do it manually this time. 1. Open a New Chart Window, Ctrl+Shift+C. 2. Drag and drop the SMA and RSI Standard indicators into the chart, configuring their default settings as desired. 3. Click the button in the Function Toolbar. This automatically converts the Chart to a Strategy Window, runs the "strategy", and opens the Editor view. 4. These actions produce Strategy code that plots the dropped indicator(s) and includes
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the statements and variables required for their sliders, if applicable. Depending on your Editor's template, the resulting code appears below: using using using using using using



System; System.Collections.Generic; System.Text; System.Drawing; WealthLab; WealthLab.Indicators;



namespace WealthLab.Strategies { public class MyStrategy : WealthScript { //Pushed indicator StrategyParameter statements private StrategyParameter slider1; private StrategyParameter slider2; public MyStrategy() { //Pushed indicator CreateParameter statements slider1 = CreateParameter("SMA_Period_1",50,2,200,20); slider2 = CreateParameter("RSI_Period_2",14,2,200,20); } protected override void Execute() { for(int bar = 20; bar < Bars.Count; bar++) { if (IsLastPositionActive) { //code your exit rules here } else { //code your entry rules here } } //Pushed indicator ChartPane statements ChartPane paneRSI1 = CreatePane(40,true,true);



//Pushed indicator PlotSeries statements PlotSeries(PricePane,SMA.Series(Low,slider1.ValueInt),Color.FromArgb(255,128,0,0),Line PlotSeriesOscillator(paneRSI1,RSI.Series(Close,slider2.ValueInt),70,30,Color.FromArgb( } } }



5. You'll find two PlotSeries* statements near the bottom. Within those statements, copy SMA.Series and RSI.Series and their parameter list to create easy references to DataSeries to be used in your Strategy. The complete statements would be as follows and be placed just before the for loop. DataSeries sma = SMA.Series(Low,slider1.ValueInt); DataSeries rsi = RSI.Series(Close,slider2.ValueInt);



As you can see, all of this code can be generated in just seconds!
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Plotting from Code With WealthScript Strategy code, plotting possibilities are literally endless. You can create indicators, combine them, color, draw,... and the list goes on. While this guide occasionally provides example code where appropriate for completeness, for full treatment of this topic please refer to "Painting the Chart" in the WealthScript Language Guide. It is not possible to generate WealthScript code from drag and dropped indicators. You can, however, view code used for plotting in Rule-based Strategies.



6.6.4



Show/Hide Panes To expand other panes in the chart area, you can collapse the Volume and other custom chart panes by clicking the minimize icon "-" just left of the top label. Alternatively, to show the full pane again, click the "+" icon. Although the "+/-" icons are always active, note that they are hidden with the Show/Hide Labels button in the Chart Toolbar.



Collapsing the RSI and Volume pane



As shown in the image, when multiple indicators are collapsed in the same pane, an ellipsis "..." is displayed to the right of the top indicator's label.
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Fundamental Data How to: Plot fundamental data Plot Fundamental data by dragging and dropping an item from the dialog (Ctrl+U) into a chart.



Fundamental Data



Dragging and dropping Fundamental Data into a Chart window.



You can also configure Chart Annotation Preferences 209 to enable display of Fundamental icons in the Price Pane. For the annotation method, however, it's required to "mouse over" the icon to view the data values.



More: 1) Use the Strategy Builder to plot and include Fundamental Data and Ratios in Strategy-based Rules. 2) "Working with Fundamental Data" in the WealthScript Language Guide has more details about plotting and manipulating fundamental data.



See also: Pushing Dropped Indicators
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Streaming Charts Streaming charts are formed by combining historic bars (backfill) from a Static Data Provider with streaming, tick-by-tick data from the selected Streaming Provider 210 . Consequently, from the point at which you request streaming for a Chart window, the Streaming Data Provider builds new bars from the streaming data. With a Streaming chart, you can see the most-recent trade data for the charted symbol, regardless of the interval. Fidelity Streaming is available to Wealth-Lab Pro only during regular market hours. To reduce memory requirements, especially when using streaming for Strategy Windows 95 , set the Data Range to load only the data that you need. "All Data" is not recommended for symbols that contain tens of thousands of bars since it requires a large amount of processing that could result in lagging performance.



How to: Open a streaming chart 1. Log in to Fidelity from the Function toolbar. 2. Open a Chart or Strategy window. By default, Wealth-Lab charts initially open in Static 328 mode. 3. Ensure the preferred Scale and Data Range (for backfill) is selected atop the Data Panel 292 . 4. Click the Stream button in the lower right corner of the chart. To enable streaming you'll need to Status Bars on Chart.



Show



The Streaming selection is "sticky", i.e., charts opened after having enabled streaming will initialize with Streaming enabled. Turn off streaming by disabling the Stream button, which can also be toggled using the Ctrl+Alt+Z shortcut. Tip: To enable or disable "streaming" for all charts simultaneously, press and hold the Alt key when clicking the Stream button on any chart.



Streaming Backfill and Update On-Demand Streaming charts are filled first from “historic backfill” and then from streaming tick data. Backfill is retrieved from the Fidelity Static Data Provider, which first checks to see if the data is available locally (on disk). Then, Wealth-Lab generates a request for any missing data up to the current date/time. In some cases, the request may contain additional days of overlap for data corrections. If File | Update Data on Demand is enabled, these data are saved to the Static DataSet so that they're not requested again in the future.
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Warning! Before requesting symbols for streaming, it is highly recommended to create intraday DataSets that contain the symbols with the desired interval or subinterval. Otherwise, the first request for data could result in a lengthy delay while retrieving backfill. After adding backfill bars to the chart, new bars are built by the Fidelity Streaming Provider from the streaming ticks. For a symbol that’s actively traded, you'll immediately notice a tick or bar forming on the far right side of the chart as in the image above. This is called the ghost bar 325 or partial bar. Finally, at the end of each interval, the Streaming Provider adds the final OHLC/V values of this ghost bar to the chart and immediately starts forming a new ghost bar with the next tick. Most importantly, the addition of this bar to the chart generates an interrupt to execute a Strategy window's 95 Strategy.



Streaming Spike Detection Streaming ticks can include erratic data, which are most often caused by out-ofsequence trades, trades on competing exchanges, or trades with special sale conditions. The result is known as data spikes, which can cause chart scaling problems, or more importantly, affect the outcome of automated Strategy trading (for better or worse). Data spikes are observed more often in the high/low values of bars simply because more trades have the ability to influence those values than the open or closing values. In order to reduce the effect of bad prints in Streaming Charts and Strategy Windows, consider using the Bad Tick Filter 210 .



Streaming Disconnected Should the Streaming Provider report that it has disconnected, (Disconnected) is displayed in the main Status Bar. The Fidelity Streaming Provider will continually attempt to reconnect provided that the internet connection is functioning. To attempt to restart streaming manually, click the (Disconnected) link. Upon reconnecting, be patient as the charts are automatically refreshed.
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Strategy Window What is a Trading Strategy? Simply put, a trading strategy, or Strategy, is composed of a set of conditions that when "true" trigger trading actions (buy, sell, short, or cover). Conditions and their combinations can be based on literally anything that you can express in a computer program (even moon phases), but most often they involve analysis related to price action, technical indicators, and fundamental data.



What is a Strategy Window? Strategy Windows share all of the properties and functionality of Chart windows 55 , but a Strategy window contains either a Rules or Editor view in which a trading strategy exists or can be created. Due to the presence of a Strategy, additional views such as the Strategy Summary and Performance Visualizers 211 become available. Note for Wealth-Lab Pro Version 4 legacy customers: The Strategy Window's appearance is similar to the ChartScript Window, however, internally it executes code like the $imulator (raw profit run followed by sizing). In fact, the functions of both the ChartScript Window and $imulator are combined into the single Strategy Window. Strategies are created by launching a New Strategy from Rules (Ctrl+Shift+R) or a New Strategy from Code (Ctrl+Shift+S). However, when you save a plain Chart window 55 , with or without dropped indicators, it automatically becomes a Strategy window by virtue of the addition of an Editor view that contains template code 329 for a Strategy.



Chart Window with dropped SMA indicator.



Chart window (left image) becomes Strategy window after save.



Technical Indicators and Fundamental Items that are dragged and dropped never contribute to a trading Strategy. Their useful only to you; perhaps as a visual confirmation of trading signals.
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How to: Export or Email Strategy Code Strategies are stored as XML files in the Strategies subfolders, which are located in the local Wealth-Lab ..\Data folder. Use Windows Explorer to locate the Strategy's XML file and attach it to e-mail.



How to: Use a Strategy in Live Trading Generally, Strategies correctly programmed to generate Alerts do not require code changes for live trading. For more instruction and discussion, refer to the WealthScript Programming Guide: Programming Trading Strategies, especially the Alerts subtopic. Also, Orders > Portfolio Synchronization 186 discusses how Wealth-Lab trades in a theoretical manner and how Limit order Strategies may create an out-of-synch condition between Strategy Positions and a live account portfolio.
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Strategy Builder Wealth-Lab Pro's Strategy Builder allows you to produce a complete Rules-based trading Strategy without the need to write any code. You can save, re-open, and modify a Rules-based Strategy at any time. With the Strategy Builder you visually design a trading system by combining various types of Entries, Exits, and Conditions via an easy-to-use drag and drop interface. When satisfied with a design, you're just one click away from backtesting it. Even if you enjoy writing code, the Strategy Builder can give help you rapidly prototype new Strategies. The Strategy Builder utilizes a pre-defined set of Entries, Exits, and Conditions, which are collectively referred to as Rules. In most cases you can customize selected Rules as explained below.



How to: Create a Rule-based Strategy (Ctrl + Shift + R



315



)



1. Open a New Strategy from Rules (Ctrl+Shift+R) Use the keyboard shortcut or any of the following methods to launch a new Strategy window with a Strategy Builder displayed on the Rules tab. Main menu: File > New > New Strategy from Rules Navigation bar: Charts & Strategies > New Strategy from Rules Function toolbar: New > New Strategy from Rules 2. Form your basic strategy by selecting Entries and Exits Drag and drop an Entry and Exit type in the frame on the right. The Strategy Builder is not a screener. A Rules-based strategy must can contain at least one entry and one exit. You can also double click an item, or, click and use the arrow buttons to select. An Exit is paired with the Entry directly above it. However, by placing an Exit at the top of the list (above any Entries) applies it to all Entries of the same type in the strategy. For example, place a Basic Long Trailing Stop at the top of a list so that it will be used to exit all Long Positions. Wealth-Lab Version 6 ensures that the proper order of execution is preserved for backtesting in a Rules-based Strategy such that AtClose orders for the current bar are executed before AtMarket orders for the next bar, and finally AtStop and AtLimit orders last. 3. Assign conditional Rules to your Entries and Exits Tip: Click on a Rule for a description to be displayed in the tooltip-colored box in the lower-left corner. From the Conditions tab assign conditional Rules to your selected Entries and Exits. Qualify Conditions by dropping them on top of an Entry or Exit. Multiple Conditions added to the same Entry or Exit are logically AND-ed together. To logically OR Conditions, separate them with the OR Divider (found at the top of the Conditions list) by dropping it on top of the second (lower) Condition in an OR-ed pair. Also, see how to group multiple conditions 101 using the Multi-Condition Group qualifier.
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In this sample image, the selected Rules would generate code for the script to accomplish the "pseudo code" here: Enter Long next Bar at Market if ( Price Crosses the Lower BBand ) OR if ( CMO Crosses below Oversold AND RSI is Oversold ) OR if Fast Period Crosses above Slow Period SMA Exit Long next Bar at Market if ( Bearish Doji Star ) OR if ( Bearish Belt Hold)



Make adjustments to selected Entry, Exit, and Conditions by highlighting the item and editing its parameters.



4. Elect Position Management options Position Management options refer to trading on a per-symbol basis. Single open Position Choosing this option results in a Strategy that manages only a single open position per symbol. Multiple open Positions Allowed Allows a Strategy to manage more than one open position per symbol, simultaneously. Consequently, if the entry condition(s) trigger more than once prior to the exit condition(s), then the Strategy can hold more than one position for the same symbol. 5. Run the Strategy or choose another option in the Strategy window toolbar You may go back and forth, altering Conditions and refining parameters. Notice that the Wizard automatically plots any indicator that you have selected for trading conditions in the Strategy. Run the Strategy Runs the Strategy on the currently-selected symbol in the Data Panel. You can also run the Strategy by clicking any symbol or by striking the F5 key. View Strategy Code Launches a text dialog with the WealthScript code-equivalent Rules.
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Open Code in new Strategy Window This feature is useful if you use the Wizard to get a head start in programming a Strategy manually or if you reach a point at which it's necessary to add some code manually to complete your objectives. Since this launches the code in a new Strategy window, you can still save the Wizard Rules session for editing later. Convert to Code-Based Strategy Same as the previous except you will no longer be able to modify the Rules using the Strategy Builder. You will have to make changes in the Code Editor. 6. Save your work! If you wish to continue working with the Rule-based Strategy at a later time, simply save the Strategy window. Remarks During or after Rules selection, you can re-arrange their order in the "Selected" window using drag and drop. To place Rule1 above Rule2, drop Rule1 on top of Rule2. To place a Rule at the very bottom of the Selected Rule's list, drop it in the blank area below the list. To delete a rule, use the Delete key, or drag and drop it back in the selection window at the left. Many Wizard Rules contain variable parameters. After selecting a Rule, you can configure them in the Edit Parameters frame. Limits do not exist for the number of times the same Rule can be used. Each Rule may be paired and configured independently as you please, so it's up to you to do it in an intelligent manner.



Parameter Sliders for the Strategy Builder Instead of going back and forth between the Chart and Rules views to change parameter values, you can enable the sliders for indicator parameters by clicking the icon that appears next to the indicator as shown. Indicates that you can create a slider for the parameter, but it's currently disabled. The slider is enabled and will appear in the Strategy Parameters view after executing the Strategy. The values shown for the slider (not in the Parameters' change window) are used in the Strategy.
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Indicators have a predetermined "reasonable" range and incremental slider value. For precise values that a slider does not provide, use the Rules view to enter that value.



Renaming Parameters Slider parameters are often generically named, especially in the General Indicator Rules 100 . If more than one indicator has a Period parameter, for example, it can be difficult to tell which rule's Period is the one being adjusted. By clicking the blue parameter link, you can specify your own unique name for each parameter so that you can easily distinguish them when using the sliders. Slider Notes Sliders have pre-defined default values to which they are initialized when created. Slider increments are calculated based on a predefined min/max range expected for a particular indicator. For example, Period sliders will generally increment in units of 10 since a large range of periods can be defined. For fine tuning, turn off the slider and enter a precise value in the Rules view.



Drag and drop Indicators and the Strategy Builder While working with the Strategy Builder, you can interact with dropped indicators or fundamental items. The dropped items are saved with the Strategy, but affect the chart view only, not the Strategy rules.



Limitations Possibilities are literally endless when programming in WealthScript, but the Strategy Builder is limited to the Rule entries available in a database. The Strategy Builder helps you build simple strategies visually, but it doesn't cover the full range of possibilities of coding a script manually.



7.1.1



General Rules General Rules such as those contained in the General Fundamentals or Generals Indicators Condition categories, permit the immediate use of all indicators and fundamental items without the need to transcribe a specific rule set for each one. The method of selecting and setting up an indicator is illustrated below.
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1. 2. 3. 4. 5.



From a "General" category, drag the desired general condition to the entry or exit signal. Where prompted, click to select an indicator (or fundamental item). C hoose the indicator from the list, and then, select its parameter values. Set up any remaining parameters required for the condition.



All indicators are not appropriate for every condition. In the example above, the condition "Indicator crosses above a Value", makes sense for an oscillator bound to a specific range (like RSI), but not for a moving average of a stock's price, which is not range-bound.



7.1.2



MC, Multi-Condition Group A Multi-Condition (MC) Group goes beyond simple logical AND/OR combinations of rules. By defining a MC Group, you can specify if all or just a subset (one or more) of the conditions in the group are required to have been true during a lookback period. A MC Group provides a way for the Strategy Builder to combine setups and triggers for multiple conditions that aren't required to occur simultaneously. [MC] Multi-Condition Group Placement The Multi-Condition has scope over all conditions (the group) that follow it up to: 1) a subsequent OR Divider, 2) the next Entry/Exit, or, 3) the end of the conditions. The MC Group has an AND relationship with the condition that precedes it. However, if preceded immediately by an OR Divider, an OR relationship will exist with the immediately prior condition A Multi-condition group having no conditions is ignored.
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MC Group Parameters: Sliders are created for the number of Required Conditions and Lookback Period. To expose sliders at the bottom of the Data Tree, see Parameter Sliders for Strategy Builder 99 . Required Conditions defaults to 1 (the minimum). You should set Required Conditions from 1 up to the total number of conditions in the group. Lookback Period is the "window" during which the conditions can add to the count of Required Conditions. From the current bar and looking back Lookback Period bars, if a condition is true during at least one of those bars, it adds 1 to the group tally for the current bar. If the tally adds up to the specified number of Required Conditions then the collective MC Group is logically true for the current bar. Example Consider the following image. The MC Group is AND'd with "Moving Average is trending up" but OR'd with "Bullish Hammer" below. Within the MC Group of conditions, all 3 are Required Conditions to have occurred at least once during the specified 4-bar Lookback Period. Consequently, the BuyAtMarket condition will trigger if ("Moving Average is trending up" AND "MC Group") OR "Bullish Hammer".



Applying a Multi-Condition Group in a Rules-based Strategy. The blue box was added to the image for the purpose of this example.
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Strategy from Code While combinations of Rules-based Strategies are virtually innumerable, Wealth-Lab's truly limitless potential can be harnessed by programming Strategies manually. While details of Strategy code are left to the WealthScript Programming Guide, several pre-built Strategies come with the installation, and we'll show you how to backtest and even trade with them. Dropped indicators are for viewing only and never incorporated into actual Trading Strategy 329 . Dropped indicator parameters are never available for modification from the Strategy Parameters 328 frame.



How to: Open a New Strategy window (Ctrl+Shift+S



315



)



A new Strategy window initializes an Editor with template code that programmers can use as a basis to form a new strategy. Main menu: File > New > New Strategy from Code Navigation bar: Charts & Strategies > New Strategy from Code Function toolbar: New > New Strategy from Code You can edit the template code and save it by clicking Edit > Set as Default Template Code.



How to: Create a Strategy from Code Consult the WealthScript Programming Guide for details on programming Strategies.



How to: Add blank space to a strategy chart Blank space can be added only by calling the WealthScript function PadBars() in Strategy code (not a Rules-based Strategy). Open a new or existing Strategy and add the PadBars() method just inside the Execute block. Tip: If you always wish to see blank space to the right of the bars in a Strategy window, insert PadBars( 10 ); where 10 is the number of bars to "pad", immediately after Execute() method in the Strategy window's Editor. Then from the main menu, click Edit > Set as Default Template Code.
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Combination Strategy Wealth-Lab Pro has an integrated solution for multi-system testing: Combination Strategies. As the name implies, you can combine two or more strategies in a single Portfolio Simulation backtest. The child strategies operate on a specified allocation or overall starting capital and each can run on different DataSets and/or in different scales. According to modern portfolio theory, by properly combining non-correlated strategies/ instruments you can theoretically hedge for different market conditions, potentially improving profit, reducing risk, and/or smoothing the equity curve over the test period.



How to: Create a Combination Strategy (Ctrl + Shift + M



315



)



Open a New Combination Strategy (Ctrl+Shift+M) Use the keyboard shortcut or any of the following methods to launch a new Strategy window with a Strategy Builder displayed on the Rules tab. Main menu: Navigation bar:



File > New > New Combination Strategy Charts & Strategies > New Combination Strategy Function toolbar: New > New Combination Strategy



Tip: Combination Strategy Visualizer post-processing can be intensive, therefore time-consuming. Before launching a Combination Strategy window, disable Performance Visualizers (F12) not required for analysis. 1. Assign a value for the overall Starting Equity and Margin Combination Strategies Starting Equity (and Margin for stock trades) is assigned at the top of this view. Later you allocate all or portions of this starting "cash" value to individual Strategies (step 4). Margin applies in the context of the overall Combination Strategy. See Margin Effect in Mechanics of a Combination Strategy 106 . © 2017 FMR LLC All rights reserved.
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2. Select Strategies from the list of Available Strategies, and, 3. combine them in the Selected Strategies column on the right. To add a Strategy, double click or select it and use the arrow button. Repeat for each Strategy to be included in the Combination Strategy. We refer to selected strategies as child strategies. A child strategy can be another Combination Strategy, however, circular references are not allowed. Example: assume three Combination Strategies: C1, C2, and C3. A circular reference would be if C1 contained C2, C2 contained C3, and C3 contained C1. 4. Configure each child strategy. Click on a Selected Strategy and configure the backtest settings in the lower half of the view: Allocations and Strategy Priority Allocate a Fixed Dollar amount or a Percentage of the overall Starting Equity (multiplied by margin) to the selected child strategy. The Position Sizing settings will reflect the starting capital amount used in each of the child strategy simulations. The sum of all child strategy allocations can be more (or less) than the overall Starting Equity. Giving over-sized allocations to one or more of the child strategies can help to increase exposure. If an equity constraint arises in the backtest, Wealth-Lab gives higher priority to Positions created by strategies with a lower value for Strategy Priority, i.e., a child strategy with priority 1 has the highest priority. Settings Account



Alerts for the child strategy are assigned to the Account specified. This value overrides the default account and the account assigned to a Strategy in the Strategy Explorer.



Scale



The data scale used for the child strategy



Position Size



Portfolio Simulation sizing for the child strategy. The Starting Equity displayed is a function of the overall Starting Equity and the amount allocated.



Use Preferred Values



Self-explanatory. See Preferred Values



136



.



Parameters The parameters associated with the child strategy may be modified using the slider(s) provided that Use Preferred Strategy Parameter Values is not selected in the Settings box. DataSet Use default DataSet is automatically checked when adding a new child strategy. The "default DataSet" is the DataSet or symbol selected in Wealth-Lab's main Data Panel (Ctrl+D). To assign the Strategy to a DataSet other than the default (and recalling that you specify Scale in the Settings box), uncheck the default DataSet option and click on the DataSet or symbol.
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5. Data Range Assign the test period using the main Data Range control atop Wealth-Lab's main Data Panel (Ctrl+D) for Combination Strategies. Only one test period is used for the overall Combination Strategy. Note that the Data Panel's Scale and Position Sizing controls do not apply to Combination Strategies. Avoid using All Data or the Fixed Number of Bars option for Combination Strategies, especially when combining child strategies that use different scales.



Mechanics of a Combination Strategy The following is an outline of the methodology used to process Combination Strategies. 1. Child strategies are each configured with their individual Starting Capital allocation. 2. Separate Portfolio Simulation backtests are run on each of the child strategies. Each strategy item develops its own equity and cash curves. Position sizing is based on the child strategy's equity and cash levels. 3. At the child level backtests, rejected signals are evidence of achieving maximum allocation. Rejected trades are not candidates for the overall Combination Strategy backtest. 4. Finally, the overall Combination Strategy backtest's equity curve is built on a bar-by-bar basis using trade candidates (already-sized Positions) provided from each of the child strategies. Positions are selected from higher-priority strategies first, starting with the highest-priority Position in each one. This process implies that trade candidates that were sized and accepted in the child strategy simulation may be rejected in the overall Combination Strategy backtest. The number of trades not included in the Combination Strategy backtest is the sum of the trades rejected at the child and combination backtest levels. Margin Effect Increasing Margin to a level greater than 1:1 increases the ability of the overall Combination Strategy to accept more trades from the contributing child strategies on bars with limited cash. For example, if a Combination Strategy simulation rejects a trade from a strategy with lower priority due to insufficient capital, increasing margin could allow this trade to be taken. Margin loan interest specified in Preferences > Backtest Settings 230 applies. Combination Strategy margin affects allocation. For example, with 2:1 margin you can allocate up to 200% of Starting Capital to a child strategy. Assuming $100,000 Starting Capital with 200% allocation, it follows that 100% of equity sizing will size a $200,000 position.



Viewing Results Performance Visualizers that apply to Portfolio Simulations also apply to Combination Strategies. An exception is Analysis Series 225 , and although Monte Carlo-Lab 225 can be applied, it has limited utility Combination Strategy mode due to its inability to work at the © 2017 FMR LLC All rights reserved.
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allocation level of child strategies.



Look for the Strategy Selector atop the Performance, Equity Curve, and Drawdown visualizers, where you can see results from the aggregate Combination Strategy as well as the backtest results for each of the child strategies separately. Trades Double-clicking a trade in a Combination Strategy window launches a Strategy Window associated with the trade. If the child strategy ran a Multi-Symbol Backtest, then the window is displayed in MSB mode 119 . It's important to note that the trades shown in the new window are from the child-level Portfolio Simulation, which may include trades that were rejected in the aggregate backtest.



Employing Combination Strategies Combination Strategies are primarily a backtesting exercise to see Portfolio-level effects of combining strategies. For live (or paper) trading, especially for intraday scales, each child strategy must be traded individually in the Strategy Window or Strategy Monitor. Automatic control of allocations does not exist, and this aspect of employing Combination Strategies can be challenging unless strategies are assigned to different accounts whose capital represent the allocations. The Combination Strategy Window can be used effectively for end-of-day (EOD) trading without the need to break out the child strategies in the Strategy Monitor. As with any backtest, however, all Alerts are displayed, so even in this case allocations must be controlled manually or by using different accounts.
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Existing Strategies The Wealth-Lab Pro installation includes several pre-built Strategies that you're welcomed to explore, test, or use as a basis for your own Strategy creation. Strategies are organized in folders that best describes their trading style; nonetheless you can copy, move, or re-organize as you see fit. Strategies are stored as XML files in the ..\Data \Strategies subfolders with the same organization found in the Strategy Explorer.



How to: Open an existing strategy (Ctrl+O



315



)



Open an existing strategy when you want to modify, test, or even trade the strategy. Main menu: File | Open Strategy Navigation bar: Charts & Strategies | Open Strategy Function toolbar: Open Strategy These actions launch the Strategy Explorer from which you can select an existing strategy to open in a Strategy window. See Backtesting Strategies 116 .



How to: Run a strategy (F5



315



)



Existing Strategies are compiled when opened. You can execute compiled Strategies in the Strategy window by any of the following methods: strike the F5 key click a symbol in a Data Panel 292 DataSet type a symbol in the Symbol box atop the Data Panel 292 and click Go Also: Multi-Symbol Backtest 119 Strategies are executed using the Scale, Data Range, and Position Size settings that you select at the top of the Data Panel 292 .



Important Disclaimer: Pre-built Strategies are strictly for informational purposes and are not to be construed as advice or solicitation to buy or sell any security or instrument.
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Strategy Window Views Strategy Window Views consist of: Chart or DataSet View Strategy Summary Editor or Rules (Strategy Builder) Alerts View Performance Visualizers For a complete discussion of each of the Performance Visualizers see their topics in the Preferences 205 chapter.



Performance Visualizer tabs are displayed after completing a backtest.



7.5.1



Chart and Trades Chart View Strategy windows share all of the properties and functionality of Chart Windows 55 . Trade triangles, circles, and tooltip information, however, are unique to Strategy windows.



Trade Circles Wealth-Lab draws blue circles centered on trades' entry prices. Likewise, red circles are centered on trades' exit prices. Since circles are drawn inside a bar's range, it's possible for the bar coloring to be occlude them. Try switching to the OHLC Chart Style 80 if you have trouble locating trade circles.
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Trade entry and exit rollovers (tooltips).



Trade Triangles Triangle icons mark entries and exits. An inverted triangles ( ) above a bar denotes sale, whereas a right-side-up triangle ( ) below a bar represents a purchase. Refer to the legend below: Long entry Long Position sold for a profit Long Position sold for a loss Short entry Short Position covered for a loss Short Position covered for a profit Hover the mouse over a triangle for trade entry and exit tooltip information. Wealth-Lab automatically draws a line to connect a trade's entry circle to its associated exit circle (if applicable).



DataSet View When you click on a DataSet name in the DataSet Tree, the DataSet view replaces the Chart to prepare for a backtest on all symbols contained in the DataSet. The interface contains only one button to initiate a Multi-Symbol Backtest 119 .



DataSet View replaces the Chart view.
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Strategy Summary The Strategy Summary is mostly self-explanatory, except as outlined below.



Strategy Summary View



Parameters A comma-delimited list of the currently-selected Strategy Parameter



303



values (if any).



Strategy Activation If the Chart data is streaming, then the Strategy is "Active", meaning that you can elect to Auto-Stage 321 trading Alerts that the Strategy generates. See the Alerts View 113 for details. Otherwise, the Strategy is not Active as shown in the image. Current Trade Alerts See Alerts 321 Add to Strategy Monitor (link) As a convenience, you can add the Strategy initialized with the current Data Panel settings to the Strategy Monitor 147 , where you can Activate the Strategy whenever required.



7.5.3



Rules (Strategy Builder) The Rules View is the home of the Strategy Builder, used to create Rules-based trading strategies from sets of pre-defined entries, exits, and conditions. See the Strategy Builder 97 topic for details and procedures.



7.5.4



Editor The Editor view is where you compose and enter WealthScript Strategy code for codebased Strategies. When you open a New Strategy from Code, the Editor initializes with some template code that you can use as a basis to form a new strategy. You can edit © 2017 FMR LLC All rights reserved.
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and save your own template code for future sessions by clicking Edit > Set as Default Template Code.



Editor Toolbar Actions Run the Strategy Compiles and executes the Strategy in one action. If the script compiles with no errors, the Strategy is executed and the view switches to the Chart View of the [last] selected symbol. Otherwise, compilation and runtime errors are displayed in the lower error messages frame. Wealth-Lab uses a C# compiler for Strategy code. See the WealthScript Programming Guide for details about using Strategies compiled in managed code from any .NET language. Compile Compiles the Strategy only. It's a good idea to stay on top of syntax errors by occasionally clicking the Compile button while coding. Once the code has been compiled, you can execute it (How to Run a Strategy 108 ). Tip: Clicking on a syntax error in the lower message frame will automatically place the cursor at the point where the error was detected. Often, but not necessarily, this is the precise location of the error. 46 m s (Last Execution Time) Execution time measures the time that it takes the Execute() method to complete. It does not include the time required to retrieve data on-demand 326 , load the amount of data requested in the Data Range control 295 , or any post-processing required for the Performance Visualizers 211 .
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References... Power users can select references to external .NET assemblies for use in strategy code. The Reference's dialog provides a static list of .NET Framework assemblies. For assemblies not in the list, use the "Other Assemblies to Reference" method. Selected references are saved with each script. If you use the same References often, open a new Strategy Window (Ctrl+Shift +S), select your reference(s), and choose Edit > Set as Default Template code. Print Provides preview and printing options for Strategy code. Options... The Editor is feature-rich. Explore the options to customize the Editor's environment and to find dozens of keyboard shortcuts 319 . Debug Window (Ctrl+Alt+D) You can use PrintDebug() statements in your scripts to display information in the Debug window for troubleshooting or any other purpose. For example, run this simple script on a DataSet to display symbol detail information in the Debug window that you can use to copy and paste in Excel, for example. Example (How to run Example code? C#



8



)



protected override void Execute() { int bc = Bars.Count; string someInfo= Bars.Symbol + "\t" + bc + "\t" + Date[bc-1].ToShortDateString(); PrintDebug(someInfo); }



QuickRef (F11) Convenient launch points for Debug window and QuickRef dialog. Tip: Place the cursor on a WealthScript object or method name and strike the F1 key to launch the QuickRef to precisely the right place.



7.5.5



Alerts View After running a Strategy on one symbol or a set of symbols, all trading Alerts appear in the Alerts view. Alerts are notifications for an order to be placed in the market for the next bar. Alerts do not refer to any historical or past theoretical trades created by a Strategy. In the image, the DipBuyer Strategy triggered an Alert on 11/5/2007 to Buy 110 shares of BA at a limit price of 90.13. Since the Scale is Daily, the order should be placed on the market open for 11/6/2007, the next bar. © 2017 FMR LLC All rights reserved.
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Select Alerts for further action by highlighting them. Use the Ctrl and Shift combinations with the mouse for multiple selections.



Alerts View Toolbar and Context Menu Actions Select Alerts for further action by highlighting them. Use the Ctrl and Shift combinations with the mouse for multiple selections. The Alerts View is automatically refreshed each time the Strategy is executed. Edit Alert



Applies to: Right-click menu Launches a dialog to allow you to change the Alert's properties. Select All Highlights all Alerts for another action. Place Orders Immediately places the order with Fidelity. You must be logged in to activate this action. Stage Orders Transfers the selected order(s) to the Orders tool, where additional action may be required to Place the trade. Trade Type (Cash / Margin)



Applies to: Live (not Paper) Trading Trade Type defaults to Margin for margin accounts and applies to long trades/positions only. If required, choose Cash to buy or sell a cash Position in your margin account. Note that in this case the Alert's Trade Type remains Margin, but it changed to Cash when the order is Staged/Placed.See also: Trade Type 194 . Auto-Stage / Auto-Place



Applies to: Streaming Strategy Window This action appears for Streaming Strategy windows only. When Auto-Stage is enabled, new Alerts are immediately Staged (see above). When Auto-Trading is enabled in the Orders tool 179 , this button changes to Auto-Place to indicate that new Alerts (orders) are immediately placed with Fidelity. Auto-Email



Applies to: Streaming Strategy Window Auto-Email sends Strategy Alerts to the Email account(s) that you set up in Preferences > Email Settings 243 . This option is enabled if a) the window is Streaming, and, b) Email © 2017 FMR LLC All rights reserved.
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Settings



243



have been configured in Preferences.



Monitor in Quotes Window Sends the details of the Alert to the most-recently opened Quotes window for monitoring and trade triggering. Generally this action is used for Stop and Limit order types.



Field Descriptions Self-explanatory: Symbol, Account, Qty, Order Type, and Scale Alert Time The date and time of the last bar that triggered the Alert. Price The Stop or Limit price of the Alert. This field will be blank for AtMarket and AtClose order types. Signal Name The string name assigned (if any) to the trading signal in the Strategy code.
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Backtesting Strategies A Backtest uses actual historical data to determine what would have occurred, theoretically, had you traded a Strategy during a specified test period. In this guide, "backtest" and "simulation" are used interchangeably. Wealth-Lab offers two modes of backtesting - Raw Profit Mode and Portfolio Simulation Mode. Both modes and their respective sizing options are covered in detail in their Reference chapter 296 topics, so here we briefly suggest when to use each mode: Use Raw Profit Mode ... when you want to see every historical trade signaled by a Strategy. to compare Strategy results between different Stock (fixed dollar sizing) or futures (fixed contract size). to trade live on a per-symbol basis so that the effects of simulated Portfolio equity do not influence Position size. Use Portfolio Simulation Mode ... for backtesting Strategies on an entire Portfolio, or DataSet, of stocks and/or futures. to trade Strategies that use complex sizing algorithms, especially for intraday futures trading. More: Position Sizing Tips for Trading



296



Important Backtesting Notes Below are some key ideas concerning trading system development and evaluation. Wealth-Lab Pro is a flexible tool, and you can adapt it to your own style. Nonetheless, the following are good practices to keep in mind. Position Sizing Notes When testing your system on a single market, it's important to establish a metric to measure the system's efficiency. For stocks, make sure that each Position has an equal dollar value. By doing this, you'll prevent distortions in the system results that occur when you instead give each position a fixed share size. In futures markets, each point movement translates to the same dollar gain or loss. For this reason, futures Positions are always established using a fixed contract size, rather than a dollar size. Measuring the System's Performance We use the Profit per Bar metric to gauge the efficiency of the trading system compared to Buy & Hold 322 . Profit per Bar is simply the system's total net profit divided by the total number of bars that the system held open Positions. This method lets us fairly compare the system results to Buy & Hold's, even if our system manages multiple open Positions. The following examples show how Profit per Bar relates to net profit and holding time. Strategy



Net Profit



Bars Held



Buy & Hold Breakout Trend Follower Oscillator



$2000 $200 $670 $300



1000 120 450 60
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Profit per Bar $2.00 $1.67 $1.48 $5.00



Conclusion Baseline Poor Poor Very Good
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BBand Break Average Down



$95 $4500



13 3600



$7.30 $1.25



Best Poor (even though Profit is higher)



For illustrative purposes only.



Position Sizing At first glance, the results above don't look very promising. The Buy & Hold strategy resulted in the most net profit. So why use a trading system at all? Note that the Oscillator and BBand Break systems both had a Profit per Bar substantially higher than that of Buy & Hold. This indicates that the systems were more efficient at extracting money from the market. You can translate this efficiency into profit by applying Position-sizing rules to the system. The idea is to maximize the exposure 324 of the system without taking on too much risk. By increasing the Position size, you can realize more profit. In the example above, we can take the BBand Break strategy and apply Position sizing of 25% of capital per Position. The results would be amazing. When evaluating the results of a system, we look at total net profit, but also Exposure, Max Drawdown and other metrics. Our own statistic, Wealth-Lab Score 215 , combines profit, exposure and drawdown into a single figure. Strategy



Net Profit



Exposure



Drawdown



WL Score



Buy & Hold



75%



100%



34%



49.5



Breakout



15%



23%



13%



56.7



Trend Follower



32%



47%



39%



41.5



Oscillator



12%



15%



29%



56.8



BBand Break



10%



6%



24%



126.6



For illustrative purposes only.



We can now re-run the BBand Break strategy, but increase the Position-sizing to 25% of capital per Position: BBand Break



120%



65%



37%



116.3



Net profit increased (beating Buy & Hold). Note that Wealth-Lab Score changed only slightly, illustrating that this metric isn't as influenced by Position-sizing as net profit is.



7.6.1



Symbol Mode Backtest How to: Run a Backtest with a Strategy Running a backtest is as simple as clicking a symbol, so the most important part is the setup: 1. Open an existing Strategy 108 . 2. Configure the Scale, Data Range, and Position Size atop the Data Panel 292 . Scale is initialized to the native Scale of the selected DataSet, but can be changed after the first selection. 3. Be mindful of your Preferences 205 for Backtest Settings, Commissions, Slippage and Round Lots. 4. Click a symbol in the Data Tree, or, type a symbol in the Symbol box and click "Go". © 2017 FMR LLC All rights reserved.
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This action loads the data, executes the backtest, and causes results to be displayed. Re-running a Strategy By changing the scale, Strategy Parameter(s) 303 , or any other setting in the Data Panel, Wealth-Lab automatically re-runs the Strategy. An exception is Wealth-Lab applies Position Size modifications without the need to execute the Strategy code/rules. To rerun a Strategy after changing Preferences



205



, click



or use the F5 shortcut.



If you make changes to a code-based Strategy, you must compile the Strategy first before using any of the methods above for the changes to be recognized.



Backtest Results When a Strategy script completes, Wealth-Lab's post-processing tasks begin. Wealth-Lab immediately renders all plots of indicators, chart annotations 209 , drawing by cosmetic chart methods, and plots the trades 109 for the primary chart symbol. In addition, if the Chart Status bar is displayed, you'll see a Net Profit summary of the Strategy as well as one for Buy & Hold. Besides the Chart view, a variety of detailed metrics and visualizations of backtest results appear in Performance Visualizers 211 that you've selected for displayed in Preferences.



The Status Bar shows a Net Profit summary for the Strategy under test and the Buy & Hold Strategy.



Strategy Window Status Bar 2 Monitor



147



Optimize



130



Immediately adds the Strategy to the Strategy Monitor initialized with the Data Panel current settings. You must activate the Strategy in the Strategy Monitor. Opens the Optimization view for the Strategy.



Net Profit



The Net Profit of the Strategy.



BH Net Profit



Net Profit of the Buy & Hold Strategy 322 . It's fair to compare B&H Net Profit with that of the Strategy in Raw Profit mode. However, in Portfolio Simulation mode for a single symbol backtest, since B&H uses all Starting Capital for a single trade, the comparison for single-symbol strategies is of little value.



(link icon)
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Charts with link icons "enabled" automatically switch to display
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data for the next symbol entered in the Data Panel from any chart window. Each chart window continues to use its previously-established Scale, Data Range, and Position Size settings. Stream



7.6.2



Enables streaming for the Streaming Data Provider 210 selected in Preferences. More: Streaming Charts 93 , Streaming Strategies 128



Multi-Symbol Backtest How to: Run a Multi-Symbol Backtest (MSB) with a Strategy For a Multi-Symbol Backtest as with Symbol-mode backtests (The first 3 steps are identical to Symbol Mode.)



Select a DataSet folder for a Multi-Symbol Backtest



117



, the key is in the setup.



1. Open an existing Strategy 108 . 2. Configure the Scale, Data Range, and Position Size atop the Data Panel 292 . Scale is initialized to the native Scale of the selected DataSet, but can be changed after the first selection. 3. Be mindful of your Preferences 205 for Backtest Settings, Commissions, Slippage and Round Lots. 4. Select a DataSet folder in the Data Tree. This action changes the Chart view to the DataSet view. 5. Click Backtest on all Symbols in the DataSet View, or click



.



Warning! "All Data" is not recommended for multi-symbol testing for intervals less than 5-Minutes. Re-running a Strategy Same as Re-running a Strategy 118 in Symbol Mode, with the exception that the Strategy is not automatically executed again upon changing Strategy Parameters.



Backtest Results See Symbol Mode Backtest Results
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.
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Changing Strategy Parameters



Adjusting Strategy Parameters after a Multi-Symbol Backtest causes the "Re-run Backtest" link to appear. Since MSB can take several seconds to complete, you can adjust parameters precisely and then re-execute the backtest when you're ready. Click Re-run Backtest, or



,



Backtest on all Symbols.



Viewing Backtest Trades in a Chart Multi-Symbol Backtest results are "locked". By clicking symbols from the test DataSet in the DataSet Tree, you can review their trades in a chart. The strategy is not re-run in this case so that the Trades list and Performance views retain the multi-symbol results.



Resetting Multi-Symbol Backtest Mode To reset the "locked-in results", select or type a symbol and click , or, click a symbol from another DataSet. Either action forces Wealth-Lab to return to execute the Strategy in Symbol Mode Backtest 117 mode.



7.6.3



Pairs and Rotation Strategies Strategies such as Pairs or Symbol Rotation involve explicitly creating trades on secondary symbols, the details of which are left to the WealthScript Programming Guide. For now, it's important just to know that the proper mode for running such strategies is Symbol Mode Backtest. If you use Multi-Symbol mode to backtest, Wealth-Lab runs the Strategy once for each symbol in the DataSet, and in doing so effectively duplicates secondarysymbol trading. Generally speaking, MSB will not produce the desired behavior for Pair, Rotation, and other strategies that create trades on secondary symbols. Note for Wealth-Lab Pro Version 4 legacy customers: Multi-Symbol Backtest mode does not kick out of the implied symbol loop even if trades are created after a call to SetContext().



7.6.4



Inside a Portfolio Simulation In this topic, we briefly describe some of the processes that Wealth-Lab uses for backtesting Strategies in Portfolio Simulation Mode to provide insight into what's going on inside "the black box". Main backtest processing functions Collecting Data... This process can take a significant amount of time to update and load data into
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memory, especially for DataSets with many symbols. For the best backtest performance, use the Data Manager to update data required for the backtest and consider disabling File > Update Data On Demand. Executing System... With the test data loaded in memory Wealth-Lab executes the Strategy on each symbol individually in serial fashion and in a Raw Profit mode. Trades generated by the Strategy are stored in a list with an initial size of 1 share. Since Wealth-Lab is Position-based the size of a Position is unimportant during the Strategy's execution as Position Sizing is applied later using real-world rules. Armed with a list of trades, Wealth-Lab sizes each Position and synchronizes the trades bar-by-bar as the combined equity curve is calculated in a chronological fashion. It is important to know that it's not possible to determine within a Strategy (script) the actual/eventual size of Positions or to create trading rules that are based on a Portfolio's Equity, Cash, or Drawdown.



Compiling Performance Results... Once all Positions have been given their final size, commissions are calculated and the equity curve is formed. Performance Visualizers 211 complete the post-processing to arrange trading results in various formats for display. Freeing cash after trade exits Cash is made available for new trade entries on the same bar following SellAtMarket and CoverAtMarket exits only. For all other order types (including AtStop and AtLimit orders that would have executed on the open) cash is available for new entries on the bar following the exit. Single-Position Strategies with multiple triggers In one very special case for both Raw Profit and Portfolio Simulation backtest modes, it's possible for Wealth-Lab not to trigger an entry signal when expected. The following conditions are required: 1. the script uses single-position logic, i.e., can hold only one position for a particular symbol, and, 2. a trade is rejected due to Position Sizing rules, and, 3. a new entry signal is programmed to occur prior to the condition that would have exited the trade in item 2 (had that trade not been rejected). Since Wealth-Lab always executes a Strategy's trades in Raw Profit mode, the first trade in a series of entry triggers will always result in creating a Position. If that Position is later rejected due to sizing rules or insufficient cash, when using single-Position logic it's not possible for any of the other potential trade triggers to have occurred until the programmed exit of the first trade because the entry logic would not be executed until that time. As a generic example, imagine a strategy whose single-Position entry logic buys a Position on any Tuesday or Wednesday and whose exit logic sells on Friday. Raw profit processing will always result in picking up the Position on Tuesday, which causes only the exit logic to be processed until the Position is sold on Friday. The test to enter a Position on Wednesday will never be executed - even if the simulated Position from Tuesday is rejected. © 2017 FMR LLC All rights reserved.
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We've alluded to the fact that Positions can be rejected in a Portfolio Simulation Mode backtest. In the next topic we explore how Wealth-Lab chooses trades... 7.6.4.1



Note on Lead Bars Generally, strategies begin the trading loop at the bar on which all indicators used by the strategy are valid; the start bar. The period between bar 0 (the first bar in the chart) and the start bar is known as the seed data period, whereas the first to last bar is known as the data range, or test period. Although strategies do not trade during the seed data period, its bars are included when calculating some of the performance metrics for the entire backtest period. This fact tends to have the effect of understating some performance measures of backtests that generate positive results, and likewise can make some negative results less pessimistic than they are in reality. (Most are concerned with the case of positive results only.) In an attempt to nullify the effect of the seed data period, legacy versions of Wealth-Lab introduced an optional feature for backtests called Lead Bars. An analyst specified the number of lead bars required so that additional bars were front-loaded to be used as the seed data for the strategy. However, Wealth-Lab ignored those extra bars (and any trades that may have occurred on them) when computing the performance metrics, resulting in a measured system performance for the entire test and trading period. Metrics affected by Lead Bars Lead Bars affect performance metrics in different ways depending on their calculation. For example, ratios and averages like Profit per Bar, Average Profit, Average Profit %, and Profit Factor are minimally affected by Lead Bars provided that simulated trading performance during the beginning of the test period would have approximated that of the rest of the test period. On the other hand, cumulative metrics like Net Profit, Net Profit %, and Gross Profit/Loss, as well as measures that encompass the performance of the entire test period like Annualized Gain %, Exposure, Recovery Factor, Sharpe Ratio, etc., are impacted by Lead Bars. Due to the compounding effect of equity, the amount of influence has a non-linear relationship with the number of seed bars divided by the total number of bars in the test period. (Look up the formula for CAGR 332 to get an idea how additional bars of trading can affect a smoothed rate of return.) For example, assume that you backtest an EOD strategy over the past 2 years (about 500 bars) using a 100-bar SMA, and thus a 100-bar seed period. If Profit per Bar were 10.0 without the use of Lead Bars, you're likely to find that Profit per Bar varies minimally from 10.0 when using Lead Bars, assuming that no trading outliers existed during the first 100 bars. However, without Lead Bars there is no way for the strategy to contribute to profit during those 100 bars, and that effectively reduces Profit, Gain, and Sharpe Ratio for a profitable strategy. It's not possible to identify a single formula that accounts for the effect of Lead Bars for all performance measures. It depends on the particular metric's calculation as well as the sizing strategy in use. The other side of Lead Bars While Lead Bars was a good idea, it introduced additional complexity in the legacy Wealth-
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Lab code base that ultimately resulted in bugs that made the feature difficult to maintain and often unreliable. In addition, a large percentage of users were confused by Lead Bars and how to use them - no doubt largely due to the former. For these and other reasons, the Lead Bars feature was retired with the Version 4 code line. Summary The Lead Bars feature will not be available in Version 6 primarily to simplify backtesting and the code base that supports it, which we believe will lead to greater reliability. The result of the inability to apply Lead Bars for positive return-producing strategies is that full test period metrics will tend to be more pessimistic than in reality. The amount of pessimism is non-linearly related to the proportion of seed data to the backtesting data range. If this ratio is large (above 5 to 10%), then pessimism can be larger, and you may consider applying corrections, such as a smoothed rate-of-return for APR. Nonetheless, you will agree that it's better to get a pessimistic backtesting result and later be pleasantly surprised by better-than-expected trading performance than the other way around. Finally, we recommend using a Monte Carlo simulation tool to gain better insight into the trading dynamics associated with strategy backtests. A backtest is just one possibility that is unlikely to ever repeat; in other words, do not put too much faith in the results of a single backtest. In a matter of seconds, Monte Carlo simulations can randomize and scramble a backtest's trades and/or returns thousands of times to provide the most pessimistic, median, and optimistic results one could have expected for actually having traded a strategy.



7.6.4.2



A Lead Bar Solution Provided that you have sufficiently more data history than is required for the test period (i.e., the chart's data range), with a small bit of added programming you can write scripts that can create trades starting on bar #1 of the loaded chart data regardless of the number of bars required to seed your indicators. The idea is based on an extension method available in the Community.Components library at Wealth-Lab.com. Instead of using the Bars object loaded with the chart to initialize your indicators, you can employ a method called GetAllDataForSymbol() to return an "all data" Bars object for a symbol, which can then be used to create an [unsynchronized] indicator DataSeries for the entire history in the cache. Finally, a Synchronize() operation returns the indicator(s) synch'd to the chart for use in the trading rules and plotting. This solution is not valid if you select to test/load "All Data". Consider the following strategy that simply buys when the closing price crosses over the 200-bar SMA and sells when it crosses below. Normally, the first trade wouldn't be possible until the 200th bar since that's when a 200-bar SMA can be calculated. However, provided that you have at least 200 more bars in the symbol data cache and they occur before the first bar of the chart, the method is able to give the value of the 200-bar SMA on the very first bar of the chart (bar #0) allowing you to start the trading loop on bar #1 and potentially create a trade on that bar. Strategies that use an indicator's .Value method must be converted to employ the .Series method in order to apply this "lead bars" technique. Run the script on a recent data range (like 1/1/2012 to present) and scroll to the start of the chart. Notice that the SMA is plotted with the correct value on the very first bar of © 2017 FMR LLC All rights reserved.
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the chart. (You can verify it by extending the start date back in time by another year and again checking the SMA value on the first trading day of 2012.) Example (How to run Example code? C# using using using using using using using



8



)



System; System.Collections.Generic; System.Text; System.Drawing; WealthLab; WealthLab.Indicators; Community.Components; /* 1. Add this statement (extension installation also requi



namespace WealthLab.Strategies { public class NoLeadBarsRequiredExample : WealthScript { protected override void Execute() { /* 2. Copy and paste this line; bars will have the out-of-synch Bars object with al Bars b = Bars.Symbol.GetAllDataForSymbol( this.GetDataSetName(), Bars.Scale, Bars.B /* 3. Create out-of-synch indicator(s) with bars. DataSeries sma200 = SMA.Series(b.Close, 200);



Note! bars.Close (not just Close



/* 4. Synchronize the indicator with the chart's Bars*/ sma200 = Synchronize(sma200); /* 5. Plot the now-synch'd indicator(s) (optional )*/ PlotSeries(PricePane, sma200, Color.Blue, LineStyle.Solid, 2); /* 6. Use the indicator(s) in the Strategy as you normally would. *Provided that* you have sufficient cached data, you can start trading from bar #1, just as Buy & Hold does. */ for(int bar = 1; bar < Bars.Count; bar++) { // Note! For trading (and plotting) use references to synchronized series, // e.g., Close (Bars.Close), High, Low, sma200, etc. if (IsLastPositionActive) { if (CrossUnder(bar, Close, sma200)) SellAtMarket(bar + 1, LastPosition); } else { if (CrossOver(bar, Close, sma200)) BuyAtMarket(bar + 1); } } } } }
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How Trades Are Chosen By now you should know that a Raw Profit mode backtest will show all trades generated by a Strategy. On the other hand, in a Portfolio Simulation Mode backtest, it's often the case that many trades are rejected. Very simply, rejected trades are the result of not having sufficient buying power to take on more Positions, just like in real trading. When a backtest has discarded trades due to insufficient simulated capital, the cues shown in the next image are provided.



In Portfolio Simulation Mode, trades can be rejected due to insufficient buying power.



If some trades are rejected, which trades are picked? When sizing Positions, the Wealth-Lab processes trades in priority order, always. Position priority is important only when a Portfolio backtest has too many trade candidates on a particular bar for the current level of buying power. For example, assume that you're using $5,000 sizes and have $10,000 available for new Positions on a given bar. If the strategy generates 5 entry signals for that bar, only 2 new trades can be taken - the two signals with the highest priority. How is priority assigned? Programmers can assign priority to Positions in Strategy code via the Position's Priority property. However, if you do not assign priorities, Wealth-Lab automatically assigns a random value for priority. Consequently, when trades are rejected and priorities are random, the results of successive but identical backtests will most often not match even when using the same settings. The randomization algorithm for priority has changed from previous versions of Wealth-Lab Pro. The important concept here is that a single backtest is just one of many possibilities. To control the outcomes, it may be required assign priorities to Positions (and hence to Trade Alerts 321 ) in your Strategy.



How to: Obtain Worst-Case Backtest Results Method 1 In Backtest Settings Preferences, check the box for "Use Worst Trades in Portfolio © 2017 FMR LLC All rights reserved.
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Simulation". This method produces worst-case simulations by default for all strategies. Method 2 By adding the last 2 lines in the Example to your Strategy code, you can generate worstcase simulations for selected strategies. Just as Method 1 does automatically, the code forces Wealth-Lab to choose the Positions with the least NetProfitPercent in a cashlimited situation. Generally, this results in a worst-case simulated scenario. Example (How to run Example code? C#



8



)



protected override void Execute() { for(int bar = 20; bar < Bars.Count; bar++) { if (IsLastPositionActive) { //code your exit rules here } else { //code your entry rules here } }



/* Give the largest losers the highest priority for backtests in Portfolio Simulation Mode * foreach (Position Pos in Positions) Pos.Priority = -Pos.NetProfitPercent; }



How to: Backtest and Trade with Priority To create repeatable backtests, even when simulated buying power is insufficient for all trades, assign Priority to each Position. For example, if there is too little cash chasing many buying opportunities, it's customary to choose the most oversold stocks. In the example, since a low RSI value indicates an oversold condition, a higher priority is assigned by negating its value. The trick to actually trading with priorities is to pass the priority value as the signalName parameter in the entry signal. When trading, sort the trade Alerts by the Signal Name column to choose the orders with the highest Priority. Example (How to run Example code? C#



8



)



protected override void Execute() { SMA smaFast = SMA.Series(Close, 8); SMA smaSlow = SMA.Series(Close, 20); RSI rsi = RSI.Series(Close, 14); PlotSeries(PricePane, smaFast, Color.Green, LineStyle.Solid, 2); PlotSeries(PricePane, smaSlow, Color.Red, LineStyle.Solid, 2); for (int bar = 20; bar < Bars.Count; bar++) { if (IsLastPositionActive) { if (CrossUnder(bar, smaFast, smaSlow)) SellAtMarket(bar + 1, LastPosition); } else if (CrossOver(bar, smaFast, smaSlow)) if (BuyAtMarket(bar + 1, rsi[bar].ToString("0.00") ) != null) LastPosition.Priority = -rsi[bar]; }
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}



7.6.6



100% of Equity Sizing Sizing with 100% of Equity is akin to the proverbial "putting all your eggs into one basket". While clearly not recommended for live trading with corporate stocks or leveraged ETFs, traders often like to see the theoretical backtest results that 100% sizing generates. Without exception, even when trading a single symbol, you're bound to see that a good number of trades were dropped from the backtest. The reason is Basis Price. Basis Price Whenever your script generates a buy or short signal, Wealth-Lab must determine the number of shares for the order. Imagine that you use a Fixed Position Size for each order, such as $5,000, so that each trade contains the number of shares that will come as close to $5,000 as possible. You might think that the best way to accomplish this is to simply take the Entry Price and divide this into the fixed dollar size. For example, if the entry price of the trade is $25, then the Position Size should be 200 shares. However, we don't know the actual entry price of the trade until after the fact. For market orders, the entry price is the market open price, not considering slippage. One way to determine the Position Size would be to observe the market open price and then quickly calculate the number of shares and submit the order. If you're dealing with more than a handful of orders, this is clearly unfeasible and would result in order-placement delay. Wealth-Lab uses the Basis Price to determine the number of shares to buy or short. The Basis Price is dependent on the order type. In the table below, Signal Bar refers to the bar on which the order was signaled, and Entry Bar is the bar following the Signal Bar. Order Type



Basis Price



Actual Entry Price



Buy(Short)AtMarket



C losing price of Signal Bar



Open Price of Entry Bar



Buy(Short)AtLimit



Limit Price



Limit Price or Open Price, whichever is Lower (Higher)



Buy(Short)AtStop



Stop Price



Stop Price or Open Price, whichever is Higher (Lower)



Buy(Short)AtC lose



C losing price of Signal Bar



C losing Price of Entry Bar



Relationship of Basis Price to Order Type



How can this Cause Dropped Trades? In Portfolio Simulation Mode, the Strategy window allows you to simulate trading using different Position Sizing rules and a starting account value. A side effect of the real-world Position Sizing logic employed by Wealth-Lab is that some trades can be dropped when you select 100% (or near 100%) of Equity per Position. Consider this case. The Basis Price of a market order is $25 and the backtest currently has $100,000 of capital to invest. The number of shares to purchase at 100% of Equity is 4,000. Imagine there is a price gap between the closing (Basis) price, and the next bar's open (Entry) price. Say prices open at $26, a $1 difference. The total size of the resulting
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position would be $104,000. The simulation does not have enough money to take this trade, so it is dropped. Solution: Use Margin One solution to the problem is to employ a margin ratio greater than 1:1. For example, A 2:1 ratio will allow you to select 200% equity sizing for full margin. (If you select 200% sizing, however, the same dropped-trade problem will occur.) However, by trading 100% cash positions, backtest simulations can "borrow" a small amount of cash when necessary to complete all of the trades. The cash borrowed is subject to the Margin Loan Rate, if enabled in the Backtest Settings 230 . Note on Round Lots The Round Lots 233 preference can also cause missed trades or even no trades. Imagine that you've set $10,000 Starting Equity and 100% of Equity for Portfolio Simulation mode to trade GOOG at $400/share. Without round lots, you could happily buy 25 shares of GOOG. However, with round lots the minimum size is 100 shares. Consequently, the only way to purchase GOOG in this example is to use 400% sizing (4:1 margin) in the Strategy window.



7.6.7



Streaming Strategies Strategies can be run with Streaming 328 (real-time) data in Symbol Mode 117 only - it's not possible to run a Multi-Symbol Backtest when using Streaming data. When Stream is enabled for a Strategy window, Wealth-Lab automatically executes the Strategy when the Streaming data provider adds a new complete bar to the chart (at the end of the selected interval). Fidelity Streaming data is available in Wealth-Lab Pro during market hours only. Pairs and other intraday Strategies involving external symbols may be required to execute from the Strategy Monitor to properly synchronize the secondary data with the primary symbol.



Trading Alerts Streaming or static, trading alerts generated in Strategy windows appear in the Alerts view 113 . The only difference is that you can enable the Auto-Stage 321 option for Streaming Strategy windows so that orders are immediately routed to the Orders 179 tool. For more Streaming details and tips, see the Streaming Charts 93 topic in the Charting chapter.



7.6.8



Troubleshooting the Unexpected If you're not seeing the backtest results that you expect, try working through these checklists. Perform corrective actions as required. Otherwise contact Wealth-Lab support. Any problem or suspected incorrect results 1. Check for errors in Strategy Editor's error message pane and/or the Debug and Error Message window (Ctrl+Alt+D). 2. Ensure that no stock symbols (or funds) are identified as a type "Future" in the Symbol
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Info Manager (Ctrl+Alt+F). No Trades 1. See 100% of Equity Sizing 127 if applicable. 2. Ensure that Position Size 296 is set adequately large enough to purchase at least 1 share. 3. Turn off Round Lots 234 4. Check (or disable) Slippage 234 5. Check that you're loading a sufficient amount of data for the strategy to operate on. For example, if your strategy uses a 200-period moving average, then you'll need more than 200 bars for trading to occur. Determine the number of bars loading in a chart by moving the mouse pointer near the last bar of the chart and check the chart's price data status bar 58 . Difference in backtests between two computers 1. Ensure that the data is precisely the same. Generally speaking, this is possible only by connecting to precisely the same DataSet via LAN, or by physically copying the same data to both computers. It's possible for data to be different if downloaded at different times or from different servers even if from the same provider. 2. Ensure all Data Panel settings are the same including Scale, Date Range, and Position Size. 3. Ensure all Preferences 205 that have an effect on trading are the same: Commissions, Backtest Settings, Slippage and Round Lots, etc. 4. If Strategy supports Strategy Parameters, check that they are identical on both computers.
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Optimization What is Optimization? The process of optimizing a trading strategy involves executing it repeatedly over a range of different parameter values and collecting the results from each run. For example, if you have a strategy that enters and exits based on price closing above or below a moving average, you could optimize it to discover which moving average period produced the most profitable results, i.e., the "optimal" return. You can optimize a strategy using any number of parameters (within practical limits of time and computer memory) on a single instrument or on a DataSet for a Multi-Symbol Backtest. Wealth-Lab is installed with two different optimization methods, Exhaustive and Monte Carlo, described later in this chapter, but additional methods may be added later by third-party programmers. For example, a Genetic Optimizer by MS123, Inc. is available as a free extension from Wealth-Lab.com. In Wealth-Lab Version 6 optimization comes in two flavors: Full Optimization (FO) and Walk-Forward Optimization (WFO).



7.7.1



Full Optimization In a Full Optimization, backtests are run repeatedly over the entire test period (data range) using a single set of parameters, which are varied for each run. The results of each backtest are added to a list and the optimum set of parameters can then be determined and used. For example, you may wish to select the set of parameters the returned the most profit, lowest draw down, highest recovery factor, etc. The trick is to avoid selecting over-optimized values; for more on this see the topic: Graphs 138 .



Getting Started with a Full Optimization To launch the Optimizer tool view in the Strategy Window, click the Optimize link in the lower-left status panel. Optimize is not available while Streaming. A Strategy that already uses Strategy Parameters (Straps for short) is ready for optimizing "out of the box". If a Strategy that you'd like to optimize does not use Straps, the Optimization Control provides the ability to add them. For instructions, see Programming Trading Strategies > Strategy Parameters in the WealthScript Programming Guide.)



Select Optimize from the Status bar of static (not Streaming) Strategy Windows.



How to: Run a Full Optimization The typical steps to set up an optimization on a Strategy already containing Strategy Parameters is as follows:
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1. 2. 3. 4. 5. 6.



Open a trading strategy in a Strategy Window Select either a symbol or a DataSet on which to perform the optimization Choose the Scale and Data Range Select the sizing method in the Position Sizing Control 296 Click the Optimize link in the lower left status bar In the Optimization Control, specify the Optimization Method (Exhaustive, for example) 7. On the Results tab, choose the Scorecard that will contain the desired the tabular metrics from the optimization. 8. If you chose the Monte Carlo method in step 6, specify the Metric to Optimize in the Optimization Method Settings control. 9. Click Estimate (optional) 10. Begin Optimization If your strategy does not yet use Straps, follow the instructions for Add New Parameter in the Optimization Control 131 topic. 7.7.1.1



Optimization Control In the Optimization Control (O.C.) generally you'll just select the Optimization method and start the optimization process. However, control of Parameter Default, Start, Stop, and Step values is provided.



Optimization View with the Optimization Control tab selected.



Strategy Parameters Strategies that incorporate Strategy Parameters (Straps) are ready to optimize "out of
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the box". The parameter list reflects the properties for the Straps that are defined and compiled in the script. Parameter editing options are not available for Rule-based Strategies or precompiled Strategies, like the ActiveTrader Strategy Pack, which is available at www.wealth-lab.com > Extensions. Edit Selected Parameter To edit a parameter's properties, select it in the list on the left and modify the values for Name, Default, Start, Stop, and/or Step. Note that the Name property is used for slider label, not the parameter variable name in the code. Changing the Name property of a Parameter after having assigned Preferred Values will effectively disable them for the renamed Parameter. Apply Changes to Code Changes that you make in the O.C. will be used for the optimization, but are not saved to the script until you click Apply Changes to Code. Rollback Changes Restores the parameter changes in the O.C. to their state in the previously-saved script. Add New Parameter Whether or not you plan to optimize, it's easiest to add Straps to your script using the O.C. Note that once you've added them and clicked Apply Changes to Code, you must modify the Strategy to actually use the parameter(s)! For example, assume that want to optimize the period of a moving average. Your code will have a statement like this one: DataSeries fastMA = SMA.Series(Close, 20);



After adding a Strap and applying it to the code, you need to modify the line above with the Strap variable, parameterN, where N is the parameter number in the list. DataSeries fastMA = SMA.Series(Close, parameterN.ValueInt);



Remove Selected Parameter Removing a parameter does not imply a change to the script. You can remove a coded parameter from the O.C. (without applying changes to the code) in order to ignore it during an optimization. In that case, the default value for the "removed" parameter defined in the code will be used, and this parameter will not appear in the Results. If you wish to completely remove a parameter that is actually used in the Strategy, Apply Changes to Code and then manually edit your code to remove any instance of the parameter variable. Parameter Checkboxes Uncheck a parameter to exclude it from full optimization processes such as Exhaustive or Monte Carlo optimizations. When a parameter is not checked, optimizations will apply the parameter's default value shown in the Optimization Control. Other add-in optimizers may require modification for this feature to work.
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Modify a parameter's default value using the sliders and clicking "Save Parameters". The Optimizer will recognize the new default value after closing/ re-opening the Strategy and selecting the Optimize link in the status bar.



Optimization Method Two optimization methods are installed with Wealth-Lab Pro; others may be added by extension. Optimization methods are extendible by third-party programming. API documentation will be made available on the WL5 Wiki. Exhaustive An exhaustive optimization is a brute-force approach that executes the Strategy once for every possible combination of parameters. Carefully choose the number of parameters and their ranges or you could soon enter the range of optimizations that would take weeks or months to complete. Runs Required indicates the number of individual Strategy runs on a per symbol basis. Monte Carlo A Monte Carlo optimization attempts to zero in on a range of parameter values that maximize the selected Optimization Metric (see below) by trying different random combinations. Because of its random nature, a Monte Carlo optimizer will not always discover the values that truly optimize the selected metric, but it can find optimal ranges much more quickly than an Exhaustive search for a large number of parameter combinations. Metric to Optimize To choose the MC Optimization metric, 1) select the desired Position Sizing



296



method and click to run the script. This action initializes the metric sets, which are slightly different between Raw Profit and Portfolio Simulation sizing methods, and, 2) choose a Scorecard on the Results 135 tab from the drop down control above the results grid. At this point, the choices for the Metric to Optimize are correctly set up. Highest/Lowest Value Instructs the Monte Carlo process whether it should zero in on the highest or lowest value for the selected metric. Settings... Applies to: Monte Carlo Set a number of Runs and a number of Tests per Run. During each optimization pass, the optimizer tries a different set of random parameters for each run, remembering the values that maximize the chosen metric as it continues. Runs



Controls the number of times that the MC optimizer shrinks the parameter windows to re-center them around the resultant closestto-optimal value.



Test per Run



Controls the number of random tests within each Pass without shrinking or moving the windows.
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Assume that you have chosen "Profit" to be maximized. At the start of each pass, the range of random values is decreased and centered on the most profitable value determined in the previous pass. The Monte Carlo Optimizer keeps shrinking the parameter windows as it proceeds, until it winds up centered on a set of values that maximize the targeted metric. The Monte Carlo process chooses random combinations of values that fall between the Start and Stop values defined for the parameters; the Step value is meaningless. Genetic Optimizer A Genetic Optimizer is usually able to find an optimal solution in a fraction of the time required by an exhaustive search, and one is available as a free extension from Wealth-Lab.com.



Optimize Select a Scorecard The Scorecard contains a set of selected metrics available to the selected Optimization Method, and these metrics are usually (but are not required to be) displayed in the optimization Results 135 . Estimate Click the Estimate button to get an idea of how long the optimization procedure will take based on the current settings. This action executes the Strategy on the selected symbol or DataSet. If the number of calculate runs exceeds 100,000, the Estimate will be "Too many runs". You can continue the optimization anyway know that time and memory use could be excessive. Begin Optimization Starts optimization processing. Prior to starting an optimization, it's important to set up the optimization target in the Data Panel 292 . You can optimize on a single symbol or an entire DataSet. Next, set up the Scale, Data Range and Position Sizing method 296 to use for the optimization. Raw Profit sizing yields symbol-by-symbol optimizations, whereas Portfolio Simulation mode results in true portfolio simulations for the DataSet as a whole. In this case, the (DataSet Name) will be indicated as the symbol in the Results tabulations view. Portfolio Simulation sizing yields a true portfolio simulation, including dropped trades due to insufficient capital. To achieve repeatable optimization results, assign Position.Priority in your script, or enable "Use Worst Trades in Portfolio Simulation" in Preferences (F12) > Backtest Settings 230 . Cancel Optimization Interrupts an Optimization in progress. Incomplete results up to the point at which the operation was canceled will be shown in the Results 135 view. 7.7.1.1.1 Optimizing Rule-based Strategies



To optimize Rule-based Strategies, expose the sliders for the parameters that you wish to optimize. See Parameter Sliders for the Strategy Builder 99 . A Step value is calculated © 2017 FMR LLC All rights reserved.
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automatically to provide a reasonable of variations between the Start and Stop values for each indicator. If the Optimize view is already open, click after adding or removing parameters for the changes to be reflected in the Optimization Control. 7.7.1.2



Results The optimization process automatically executes a Strategy over and over using a different combination of variables each time. The Results view displays the outcome of each Strategy run in a tabulation view, which can be sorted by any metric. Scorecard ScoreCards are used in both Strategy Ranking 157 and Optimization tools. Choose either the Basic or Extended Scorecard. Scorecard metrics (appear when optimization completes) depend on the selection of Raw Profit or Portfolio Simulation sizing modes. Wealth-Lab is installed wth two Strategy ScoreCards: Basic and Extended. Like other extensions, ScoreCards are loaded when Wealth-Lab starts. Developers can create their own ScoreCards that produce any metric desired by creating a class that derives from StrategyScorecard. Grouping of results from an optimization on a DataSet also depends on the Position Sizing method. In Raw Profit mode, each symbol's run is shown separately, but an  result for all symbols can be selected (see View the Average Result for all Symbols 135 ). However, for Portfolio Simulation sizing creates true portfolio simulation optimizations Portfolio Simulation sizing yields a true portfolio simulation, including dropped trades due to insufficient capital. To achieve repeatable optimization results, assign Position.Priority in your script. Metric for Preferred Value Assignment Several options exist for assigning Preferred Values 136 using the Optimization Results. Choose the metric for assignment based on the highest or lowest metric from this drop down control after completing an optimization. View the Average Result for all Symbols Applies to: Raw Profit Optimizations This option, which appears after completing an optimization on a DataSet that uses Raw Profit sizing, calculates the arithmetic mean of each Scorecard metric for each parameter set. The result is an  row.



Results Context Menu Right click in the table area for a pop up menu (see image).
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Copy to Clipboard Copies the Results table to the Windows clipboard for pasting into another application. Save to (Load from) File... Saves the results to a file (xml format) so that you can Load them again to analyze in WealthLab at a later time. The Load option restores the window with Strategy that corresponds to the optimization. When loaded from a file, optimization results must match the parameter signature from the script that created them. Wealth-Lab can't load the results if you change the number or type of parameters in the script or if you optimized after removing a parameter but didn't apply the change to the code. Set these Parameter Values as Default for the Strategy Following an optimization, you can assign a particular set of parameters to be used at the default values for the Strategy. Sort the optimization by clicking a metric in the table header, right click the desired row, select the Set these Parameter Values option, and save the Strategy Window. This action modifies the default values for the Straps in the code. 7.7.1.2.1 Preferred Values



The primary purpose of an optimization is to discover combinations of variables that work better for specific symbols (and DataSets). You can establish Preferred Parameter Values for a Strategy. Once preferred values have been assigned, a PV button appears in the lower right status bar of the Strategy Window. In the Strategy Monitor 147 , apply Preferred Values by selecting the option in the Strategy Activation Settings dialog. Likewise, in Strategy Rankings 157 , enable PVs for selected Strategies from the toolbar. If a symbol (or DataSet) doesn't have Preferred Values assigned for a particular script, then its PVs are the Parameter's default value(s).



Assigning Preferred Variables Following an optimization, to assign a set of Preferred Values to a symbol (or DataSet in the case of a MSB in Portfolio Simulation mode), right click the Results table for the context menu selections, as follows.
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Assignment options depend on Raw Profit or Portfolio Simulation sizing mode and if the optimization target is a symbol or DataSet.



Assign Preferred Values based on the highest (lowest) metric value per symbol Applies to: Optimizations using Raw Profit or Portfolio Simulation mode The metric whose highest (or lowest) value determines the set of parameters assigned is selected in the dropdown control above the table on the right. Note that multiple rows may contain the same highest or lowest metric value (especially for integer metrics or infinite results), and in this case you should specify PVs by using one of the row selection options. Assign Preferred Values based on the highest (lowest) average value per symbol Applies to: Optimizations using Raw Profit mode Same as the previous action, but the metric is averaged among all contributing symbols before finding the highest (or lowest) value. To see  metric calculations, select the View the Average Result for all Symbols 135 option. Assign Preferred Values to the selected Symbol from this Row Applies to: Optimizations using Raw Profit or single-symbol optimizations in Portfolio Simulation mode This option allows you to selectively assign PV on a per symbol basis by right clicking the specific row. Assign Preferred Values to all Symbols from this Row Applies to: Optimizations on DataSets using Portfolio Simulation mode Following a Portfolio Simulation on a DataSet, click the desired row to assign its PVs to each symbol in the DataSet. Important!



After assigning Preferred Values, save the Strategy Window, Ctrl+S. PVs are stored in the Strategy code's xml file.



Managing Preferred Parameters Existing Preferred Values assigned to a symbol or DataSet are changed when updating the assignment for the Strategy. You can manually manage the PVs by opening the strategy in Strategy Window, enabling the PV button in the lower right status bar, and then selecting a symbol. The sliders will indicate the PVs for the symbol. For a DataSet in Portfolio Simulation mode, click the DataSet and run the backtest in order to view the PV configuration. To manually change or assign PV, modify the sliders and right-click in the Strategy Parameter area and select Store these Parameter Values as the Preferred © 2017 FMR LLC All rights reserved.
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Values for the Symbol(s). PVs are not scale dependent. You cannot have more than 1 set of PVs assigned the same symbol for a particular Strategy. 7.7.1.3



Graphs Exhaustive optimizations generate 2 and 3-dimensional graphs to visualize relationships between Parameter values and performance metrics. Graphs are not available for Monte Carlo optimizations. 1-Parameter Graph The 1-Parameter Graph displays a graph of a single Parameter. Select the symbol, Strategy Parameter (x-axis), and Scorecard metric (y-axis) that you want to graph from the drop down lists. 2-Parameter Graph The two Parameter Graph lets you visualize the results of two Parameters simultaneously and their interrelationships. Select the symbol and metric (y-axis) as before. Then, select two different Parameters to be plotted on the x and z axes. The result is a threedimensional surface showing the results of the first Parameter mapped to the second Parameter. You can rotate this 3D view by clicking and dragging with the mouse. The graph can help you visualize profitable ranges in your Parameters. When optimizing with more than two parameters, use the sliders to configure all other parameters to see their effect on the 2-parameter optimization space. When selecting parameters based on the graphs, you should focus on areas that are stable, not on sharp peaks. It's desirable to see curves like the one on the left below, which shows stable and profitable areas for multiple adjacent parameter values. On the other hand, it's difficult to see a stable area in the jagged curve on the right, whose Strategy is likely to produce much more volatile and inconsistent trading results.



Focus on smooth areas of the curve without sharp peaks or drop-offs.



Selecting parameters based on sharp peaks is an example of over-optimization, which is undesirable.



If your optimization consisted of more than 2 variables you can check the values of the additional parameters by using the controls as described previously.
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Walk-Forward Optimization Walk-Forward Analysis is an evaluation of a trading strategy exclusively on the basis of its performance on Out-of-sample price data, i.e., data that have not been seen by the optimization process. A Walk-Forward Optimization, then, finds a set of optimum Strategy parameters by testing an "In-sample" (IS) data interval and applies them to an "Out-ofsample" (OOS) section of data. The previously OOS data is subsequently included in a new IS interval, whose resulting parameters are applied to another chunk of OOS data, and so on. The process is repeated over 2 or [usually] more intervals. The combined results of the OOS tests theoretically provides a far more realistic simulation of what could have been achieved trading an optimized Strategy than when compared to the backtest results of a Full Optimization 130 .



Walk Forward Optimization conceptual diagram: Sliding Window with 6 intervals, 25% Out of Sample.



You can use WFO to establish if a walk-forward trading methodology hypothetically improves your trading system's performance. It's even possible that the opposite occurs, which may indicate that the Strategy is not robust and/or that the parameters are overfitted. Also, since the WFO process chooses parameters that result in maximizing (or minimizing) a specified performance metric, it can and will pick peaks on an optimization surface that you may not have actually selected as the best choice for a stable system. Consequently, while a Walk-Forward Optimization will give more realistic results than a Full Optimization, it still may not provide results that would have followed trader's best choice of optimized parameter values.
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Getting Started with a Walk-Forward Optimization To launch the Walk-Forward tool view in a Strategy Window, click the WFO link in the lower-left status panel. WFO is not available while Streaming. A Strategy that already uses Strategy Parameters is ready for optimizing "out of the box". If a Strategy that you'd like to optimize does not use Straps, see Programming Trading Strategies > Strategy Parameters in the WealthScript Programming Guide.



Select WFO from the Status bar of static (not Streaming) Strategy Windows.



How to: Run a Walk-Forward Optimization The typical steps to set up an optimization on a Strategy already containing Strategy Parameters is as follows: 1. 2. 3. 4. 5. 6.



Open a trading strategy in a Strategy Window Select either a symbol or a DataSet on which to perform the optimization. Choose the Scale and Data Range Select the sizing method in the Position Sizing Control 296 Click the WFO link in the lower left status bar In the Walk-Forward Optimization Control, configure: a. Number of Walk-Forward Intervals b. Out-of-sample % c. Walk-Forward Window Type d. Scorecard e. Optimization metric - must be included in the selected Scorecard. 7. Select the Optimization Method (Exhaustive, Monte Carlo, etc.) and its Settings (if applicable) 8. Click Estimate (optional) 9. Begin Optimization 7.7.2.1



WFO Control



Walk-Forward Settings Number of Walk-Forward Intervals The number of intervals control the number of walk-forward optimizations that are performed. This setting (perhaps more than any other) should depend on the type and frequency of trading performed by your Strategy. In general, use more intervals when more data are available, and fewer intervals for lower trading frequencies. As a rule of thumb for end-of-day strategies, choose one interval per year of data in the test range.
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Walk-Forward Optimization Control view



Out-of-sample Data % The percentage of data in each interval that is reserved for the Out-of-sample backtest using the optimized parameters that were found in the same interval's Insample optimization. For practical reasons, the value is constrained to be between 10 and 50%. In an expanding window (see Window Type below), the percentage corresponds to the amount of OOS data for the first interval only. Walk-Forward Window Type For a sliding window (see sliding window 139 conceptual diagram above), the In-sample range is [approximately] a fixed number of bars that slides forward to include the Outof-sample data in the subsequent interval. Although the first interval for an expanding window is the same as that of a sliding window, the In-sample range for an expanding window is anchored at the beginning of the full test range.
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Expanding Window with 6 intervals, 25% Out-of-sample data.



Wealth-Lab Walk-Forward Optimizations also include a Current interval. See Results > Current Interval 144 . Scorecard and Metric to Optimize The Walk-Forward process selects the parameter(s) for the OOS backtest based on a highest or lowest metric found for the In-sample runs. The metrics from the selected Scorecard populates the dropdown control, where you choose the metric on which to optimize. Since Raw Profit or Portfolio Simulation modes affect which metrics are available in a given Scorecard, it's a good idea to configure the Position Sizing control first. Tip: When selecting a performance metric to base the Walk-Forward Optimization on, consider what that metric represents. Some metrics express a Strategy's pure profit, while others factor in its ability to recover from a drawdown, and the overall volatility of its results.



Optimization Method The Optimization method is employed for each In-sample interval. For details, see Optimization Methods 133 in the Full Optimization documentation.
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Optimize Estimate Click the Estimate button to get an idea of how long the optimization procedure will take based on the current settings. Begin Optimization Starts optimization processing. Prior to starting an optimization, it's important to set up the optimization target in the Data Panel 292 . You can optimize on a single symbol or an entire DataSet. Next, set up the Scale, Data Range and Position Sizing method 296 to use for the optimization. Raw Profit sizing yields symbol-by-symbol optimizations, whereas Portfolio Simulation mode results in true portfolio simulations for the DataSet as a whole. In this case, the (DataSet Name) will be indicated as the symbol in the Results tabulations view. Portfolio Simulation sizing yields a true portfolio simulation, including dropped trades due to insufficient capital. To achieve repeatable optimization results, assign Position.Priority in your script, or enable "Use Worst Trades in Portfolio Simulation" in Preferences (F12) > Backtest Settings 230 . Cancel Optimization Interrupts an Optimization in progress. Incomplete results up to the point at which the operation was canceled will be shown in the Results 135 view. 7.7.2.2



Results The WFO In-sample Results view provides the Strategy Parameter combination and Scorecard metrics for the optimum backtest (based on the selected metric) for each Insample (IS) interval as well as for the current IS range. As if it were a regular backtest, Out-of-sample (OOS) results and trades for the Walk-Forward Optimization are given in the other Performance Visualizers you have selected. Although the Out-of-sample date ranges for each interval is provided for reference, performance shown on the Results page refer to In-sample outcomes only. Out-of-sample results for the walk-forward backtest are shown in the regular Performance Visualizers 211 like any other backtest. In-sample Range / Out-of-sample Range Dates for each interval's IS and OOS ranges are automatically calculated based on the Strategy Window's Date Range and the WFO Settings (Intervals, OOS %, and Window Type). Note: Positions that are open at the end of an Out-of-sample may be exited in a subsequent OOS interval using a different [optimum] set of parameters. WFO Efficiency (WFE) % Robert Pardo in The Evaluation and Optimization of Trading Strategies, states that "WFE is a unique measurement of the quality of the actual optimization process" and goes on to define WFE to be the annualized profit of the OOS test divided by that of the IS (optimized) test, or APoos / APopt. A WFE above 50% is generally viewed as a robust strategy - one that is expected to generate profit in different market conditions consistent with backtest results. WFE values well below 50% may indicate a non-robust, over-fitted Strategy that is more likely to lose money when traded. © 2017 FMR LLC All rights reserved.
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Instead of using annualized profit as the normalized metric in calculating WFE, Wealth-Lab divides net profit by the total number of bars in each of the IS and OOS tests, respectively. Because profit per bar (PPB) is valid for both Portfolio Simulation and Raw Profit backtesting modes, it allows the same relationship to be reflected when calculating WFE. Consequently, WFE is calculated by dividing the profit per bar of the Out-of-sample run by that of optimized run, i.e., PPBoos / PPBopt. In the case that In-sample net profit is negative, Wealth-Lab calculates WFE as (PPBoos - PPBopt) / Abs(PPBopt). The Overall Walk-Forward Efficiency displayed above the table is the mean of the WFE values for all walk-forward intervals. Be mindful that it is desirable that a high percentage of intervals produce favorable efficiencies. Important! In-sample and Out-of-sample metrics used to calculate WFO Efficiency are taken from backtests executed over their respecitve date ranges. Strategies that require a long seed period before indicators are valid may need to make adjustments so that a representative sample of trading can be produced. This can be done by: a. b. c.



reducing the number walk-forward intervals, and/or, increasing the OOS %, or, using the Lead Bar Solution 123 . Although simple to implement, this advanced programming technique provides the greatest ability for almost any indicatorbased Strategy to create a valid trade even from the first bar of the date range.



Scorecard Metrics The Results view provides the parameters and the corresponding metrics for each interval's optimal In-sample run, which is based on the selected Metric to Optimize. To inspect a particular In-sample run more closely, double-click a row to open the Strategy for a Standard Full Optimization in a new window using the Insample Date Range. As always, metrics that are available for a particular Scorecard are a function of the Position Sizing mode, i.e., Portfolio Simulation vs. Raw Profit modes. When performing a WFO on a DataSet in Raw Profit mode, metrics return the average values for the group, i.e., all symbols under test. Current Interval Wealth-Lab Walk-Forward Optimizations include a Current interval optimization. To trade a Strategy per the WFO methodology, one would assign the optimized parameter value(s) from the Current run for use as the Strategy's default or Preferred Values for live (or paper) trading.
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Saving / Loading Results The right-click context menu provides the ability to save the WFO In-sample results to the Windows Clipboard (which can be pasted into a spreadsheet) or to disk file, which in turn can be used to re-load a WFO's results in a Strategy Window at a later time. Assigning Parameters By right-clicking on a specific row, you can: a) set the row's parameter values as the Strategy's default values, and/or, b) assign them as the Strategy's Preferred values for the entire DataSet used for the WFO or the selected symbol. Generally, if you decide to begin trading the walk-forward method, you would choose to assign the optimum parameters from the Current optimization row. Save the Strategy to persist the change.



Comparing Out-of-sample Results to Benchmark All Walk-Forward Optimizations necessarily include an initial In-sample range, and by definition the In-sample results cannot be included in the Out-of-sample backtest results. This In-sample period can leave a large gap in the backtest trading, giving the Benchmark/Buy & Hold strategy a significant time advantage. A fair side-by-side comparison is not possible at this time. 7.7.2.3



Parameter Graph The WFO parameter graph shows the evolution of optimum parameter values over each of the walk-forward intervals. To see more detail for a particular parameter, it may be necessary to deselect other parameters by unchecking them in the graph's legend.



Parameter Graph for a 12-interval WFO. Check the parameters in the legend to display them.
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WFO FAQs Some trades in my Out-of-sample backtest have exit dates that are different from non-WFO backtest? A trade is opened using the best parameter(s) determined for a walk-forward interval. Assuming the trade doesn’t close in the same interval, exit criteria for the trade will be based on the best parameters in a subsequent interval. In other words, in the walk-forward OOS backtest it's possible (and probable) for some trades to be opened using one set of parameters and closed using a different set.



Why do I get different results each time I run the same WFO in Portfolio Simulation mode? Position Priority. See How Trades are Chosen 125 . Consider using the "Worst Trades in Portfolio Simulation" option in Preferences > Backtest Settings 230 for WFO testing.



How do memory requirements for a WFO compare to a standard optimization? Walk-Forward Optimization generally require more resources than a standard Full Optimization. For larger optimizations, we continue to recommend using Wealth-Lab's 64-bit version on a machine with a minimum of 8GB of RAM.



© 2017 FMR LLC All rights reserved.



147



8



User Guide, Wealth-Lab Pro



Strategy Monitor The Strategy Monitor allows you to store one or more Strategies and set up each one with custom Strategy Parameters, data, scale, and sizing so that you can manage all Trading Alerts from one location. In short, the Strategy Monitor alerts with the current trading signals for each activated Strategy. Launch the Strategy Monitor from the Tools menu, Navigation bar, or by striking the F3 shortcut.



Strategy lines are red during update requests.



Characteristics of the Strategy Monitor Only a single Strategy Monitor window can be opened and is shared by all Wealth-Lab Workspaces. Attempting to open a second Strategy Monitor in a separate Workspace will result in placing focus on the Workspace containing the Strategy Monitor. No limit exists for the number of Strategies that you can add, but practical limits do apply. See Employment Notes 155 . Min/Max selectable scales are 1 Minute/1 Year. See Scale control



292



.



Active Strategies update data automatically, execute the Strategy, and display the current Trade Alerts, which can be Placed or Staged as orders in the Orders tool. The Strategy Monitor accesses historical bar data from Fidelity's data servers, not streaming data. It's possible for the Strategy Monitor to produce different results than a Streaming Strategy window since the data may not be precisely identical. The Strategy Monitor obtains its copy of the compiled strategy when it is opened. Edits in a Strategy Window do not affect strategies until the Strategy Monitor is closed and re-opened. The lower Alerts pane displays the most-recent trading alerts, if any, for the selected strategy in the upper pane. The Alert pane is refreshed with each new interval. You can't clear a Strategy's Alerts, nor is there a need to do so. (It's also possible to show the Alerts for all Strategies by enabling that option in the Alerts pane toolbar.)
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Operational difference between the Strategy Monitor and Backtester Wealth-Lab's Backtester runs a Strategy on all of the symbols and then applies position sizing on a Portfolio-level after the fact. The Strategy Monitor cannot take this approach because it's required to run the Strategy and produce alerts in the most timely manner possible, especially for intraday data. The Strategy Monitor runs the Strategy individually for each symbol as soon as the data is available. This will lead to differences in position sizing between the Strategy Monitor and Backtester when using Portfolio Simulation modes. For this reason it is generally recommended to use Raw Profit sizing modes in the Strategy Monitor and not a Portfolio Simulation mode (like PosSizers 300 ). For example, a PosSizer 300 that sizes based on "percent winners" would base the number of winners on all symbols in the DataSet in a Multi-Symbol Backtest, whereas in the Strategy Monitor the winners would come only from the symbol currently executing.



Behavior as a function of Scale There are two different behaviors based on the bar interval. Behavior 1: Intervals 5 minutes and lower As soon as the strategy item is activated, a thread is launched to update data history for each symbol. If the symbol is not in the local data store, this will result in a long delay. These data are updated on demand and saved locally. Thereafter, data from new interval updates are not saved (eliminates disk access delay for saving multi-megabyte files). Strategies are executed as soon as the data updates are retrieved on a per-symbol basis. For thinly-traded instruments that don't necessarily have data every bar, Wealth-Lab may continue to retrieve updates until 10 seconds before the end of the interval, at which point the results are displayed for the period. Behavior 2: Intervals greater than 5 minutes Updated data are saved to disk cache as they are collected. When fed by a Static Provider, strategies execute only after all data are collected for the DataSet or after 90 seconds have elapsed. However, when supported by Streaming Providers, strategies are executed as soon as data updates are retrieved on a persymbol basis.
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Strategy Monitor QuickStart



Step 1. Update Data (optional) Update DataSets to be used by your Strategies with the Data Manager 37 . Although this ste isn't absolutely necessary, you should update historical data at least once for all symbols in y DataSets. Step 2. Launch the Strategy Monitor Click the Strategy Monitor button in the Navigation toolbar or strike F3. Step 3.



Add Strategy Select an existing Strategy from the Strategy Explorer. Following the selection, configure the "Strategy Activation Settings" in a dialog (right) that mimics each of the Data Panel's controls - Date Range, Position Size, Scale, DataSet or symbol, and Strategy Parameters. You can specify the time at which Strategies are scheduled to be executed in non-intraday scales (Daily, Weekly, etc.); default is 30 minutes after the market close. Options exist to use Preferred Values 136 , Auto-Stage orders, and Auto-Email, the latter two of which can also be configured from the main Strategy Pane.



Strategy Activation Settings dialog



Set the Data Range to load only the data that you need. "All Data" is not recommende intraday data that contain tens of thousands of bars since it requires a large amount of processing that will result in lagging performance. Step 4.



Activate the Strategy If not selected, click on the Strategy and then the Activate button.



Step 5. Repeat Steps 3 and 4 for additional Strategies (optional) Step 6. Manage Alerts To see Alerts for a particular Strategy, click on it in the upper frame, otherwise enable Show Alerts for all Strategies in the lower toolbar. See Alerts Pane 153 . When opened, the Strategy Monitor recalls the last configuration. Therefore, for future Wealth-Lab sessions, it's only required to manage the current Alerts generated by your Strategies.



© 2017 FMR LLC All rights reserved.



Strategy Monitor



8.2



150



Strategy Pane In the Strategy Pane you configure and control the characteristics of each Strategy. The possibilities of the each of the Strategy Pane's toolbar buttons are summarized below.



Strategies marked with an Alert icon currently have Trading Alerts. Select the Strategy to view its Alerts in the lower Pane.



Add Strategy This action launches the Strategy Explorer to select an existing Strategy. Once selected, edit the Strategy Activations Settings in a dialog (below) that mimics each of the Data Panel's controls - Date Range, Position Size, Scale, Trade Type 194 , DataSet or symbol, and Strategy Parameters (see Employment Notes) 155 . Options exist to use Preferred Values 136 , Auto-Stage/Place orders, and Email trading Alerts, the latter two of which can also be configured from the main Strategy Pane. When the setup is complete, the Strategy is added as inactive (see Activate below). Tip: You can add a pre-configured Strategy directly from the Add to Strategy Monitor 118 link in the Strategy Window's lower Status Bar.
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Account Association For customer with multiple accounts you can specify the account (or paper account) to associate for Strategy Monitor alerts. If not specified, the default account specified in the Trading Preferences is used.



Strategy Activation Settings and scheduling the time for non-Intraday (Daily) scales.



Daily Strategy Scheduling You can specify the execution schedule for end-of-day (EOD) strategies on a per-Strategy basis. By default, Wealth-Lab schedules EOD strategies to run 30 minutes after the market close. In the Daily Strategy Scheduling frame (image left), various times are displayed as follows: Market Close time is shown for reference in the market's time zone. For example, U.S. markets close at 16:00 GMT - 05:00 (4:00 PM Eastern Time). Use the dropdown controls to change the strategy's Execute time with respect to the market's time zone. The time corresponding to your [computer's] time zone is given as the Execute Local time.



Remove Strategy Removes the selected Strategy from the Strategy Monitor. Change Settings Double-click a Strategy or use this action to edit the Strategy Activation Settings. Making changes to the settings of an Active Strategy will automatically Deactivate it. Show Local Times By default, Last/Next Run times are displayed in the market's time zone. If you trade multiple world markets or don't live in the market's time zone, Show Local Times will display Last/Next Run times in your computer's local time zone for better situational awareness.
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Activate / De-activate Strategy Inactive



Strategy is dormant, waiting to be activated. Data is not collected or updated.



Active



The Strategy Monitor updates data when required and executes the Strategy, which can generate Trading Alerts.



When active Strategies require a data update, Wealth-Lab requests data from the Static Data Provider associated with the symbol or DataSet. See Employment Notes 155 . Run Dailies Executes all daily and higher time frame strategies immediately, on demand. Auto-Stage / Auto-Place When Auto-Stage is enabled, new Alerts for the selected active Strategy are immediately Staged 328 . When Auto-Trading is enabled in the Orders tool 179 , this button changes to Auto-Place to indicate that new Alerts (orders) are immediately placed with Fidelity. Wealth-Lab retains and restores the configuration of each Strategy in the Strategy Monitor - including Active and Auto-Stage settings. Auto-Email Auto-Email sends Strategy Alerts to the Email account(s) that you set up in Preferences > Email Settings 243 . This option is enabled only after Email Settings 243 have been configured in Preferences.



8.2.1



Strategies Right-Click Menu Right-click actions that aren't duplicated in the Strategy Pane here. Open this Strategy in a Strategy window Launches a Strategy Window and restores the Data Panel with the Strategy Activation Settings. Run this Strategy now Executes the Strategy. Choose the "Run now" option if you don't want to wait for the scheduled Next Run time. "Run now" deactivates the Strategy. To schedule future runs, you must re-activate it. Enable/Disable/View Logging A convenient way to create and view logs of Strategy Monitor processes is provided for purpose of troubleshooting, if required.
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Alerts Pane The Alerts Pane displays the current Alerts generated from the Strategy selected in the upper Strategy Pane. To see all Alerts for all Strategies, enable the Show Alerts for all Strategies button.



Similar to the Strategy Window 95 , Alerts are automatically refreshed each time the Strategy is executed. The current set of Alerts for any particular Strategy is always shown. Important! Alerts are never suppressed by logic in PosSizers 300 . If, for example, you use the Max Entries per Day PosSizer with 3 set as the maximum number of entries, it's possible to have many more than 3 Alerts simultaneously generated. In this case, you must choose which of the Alerts are ultimately placed as orders.



Place Orders / Stage Orders Place or Stage both transmit orders to the Orders tool. The key difference is that Staging an order requires an action in the Orders tool to place the order with Fidelity, whereas Place immediately places the order with Fidelity. Note that if Auto-Trading is enabled in the Orders 179 tool, then all Staged orders are automatically Placed. Monitor [Selected Alerts] in Quote Window Generally used with end-of-day stop or limit Strategies, you can send selected Alerts to a Quotes Window to trigger order placement at an opportune moment. See Quotes 160 . Show Alerts for all Strategies When this button is disabled, only Alerts for the Strategy selected in the upper pane are shown; otherwise all current Alerts for every Strategy are displayed. Note that Alert icons appear in the upper Strategy Pane next to Strategies that currently have Alerts. Tip: To help select the Alerts from a single Strategy, click "Strategy" in the column header to sort Alerts.
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Alerts Right-Click Menu Right-click actions duplicate the Alerts Pane ability to edit an Alert.



153



toolbar actions with the exception of the



Edit Alert... Keep in mind that if the Auto-Stage option is enabled for a Strategy's Alerts, the Staged order should be managed in the Orders tool.
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Employment Notes Data Updates Since the Strategy Monitor relies on local historical data from static data Providers, you should perform a static data update each day (especially for new symbols) to avoid long delays when activating the tool. Thereafter, updates occur in two ways: Update Method 1 (Used by Fidelity for Daily scales and higher only) When a Strategy requires an update for the most-recent bar, Wealth-Lab initiates the request via the Static Data Provider associated with the symbol or DataSet. This method is always using for Daily scales and higher, but also for intraday scales unless the provider implements the alternate method. Update Method 2 Data providers may implement intraday updates with a streaming solution. In this case polling for data updates is not required, minimizing update delay at the expense of additional processing overhead (building bars from ticks). Fidelity implements a client/ server integrated solution such that data interval conflation occurs at the server, freeing client processors of that task. Complete bars are fed to the Strategy Monitor after the end of interval at which time Wealth-Lab client can apply their full cpu load on processing strategies.



Be sure to set the Data Range to load only the amount of data that you need. "All Data" is not recommended for symbols that contain tens of thousands of bars since it requires a large amount of processing that could result in lagging performance



Synchronizing Local Time For Update Method 1 (above), the Strategy Monitor uses the computer's local clock to determine the time to start requesting interval updates. Ideally, the local clock would be precisely synchronized with the Static Provider's bar server. While not vitally important for end-of-day Strategies, at a minimum you should ensure that the local clock is not running behind to avoid delaying an intraday Strategy's request for data and execution. The following two methods are suggested. 1 Synchronize to an Internet Time Server ) Use the built-in Windows Internet Time server update on the Internet Time tab (Date and Time Properties dialog). 2 Synchronize to your Provider's Time of Sales (TOS) ) If a TOS is available, set your computer clock to synchronize with a pre-market trade report on an actively-traded symbol, like QQQQ.



Saving Data to Disk For efficiency, Wealth-Lab does not store static data requested throughout the day by the Strategy Monitor for intraday scales under 10 minutes (or higher scales that are aggregated from intervals less than 10 minutes). For this reason, it's imperative to update intraday DataSets prior to each trading day to avoid excessive data loading delays when starting the Strategy Monitor.
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End-of-day Strategies By default Wealth-Lab schedules the run time for Strategies using Daily and greater scales one half hour after the market close. You can change the scheduled run time for EOD Strategies in the Strategy's Activation Settings. See Daily Strategy Scheduling 151 . Additionally, you can refresh the Alerts manually at any time using the Run this Strategy now action from the Strategy frame's right-click menu 152 .



Position Sizing for DataSets See: Position Sizing Tips for Trading
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Strategy Rankings The Strategy Rankings tool provides the ability to backtest a selected group of strategies on one symbol or a complete DataSet as a batch process. By sorting the tabular results by clicking on the column headers, you can find the strategies with the best performance for a specified set of test conditions (Scale, Data, Data Range, Sizing, etc.).



Strategy Rankings: By adding a Strategy more than once, you can rank it using different Parameters by adjusting the sliders for each instance.



Tip: To retain all settings and strategies for future rankings, save the Workspace after configuring Strategy Rankings.
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Setup Scorecard Choose either the Basic or Extended Scorecard. As with the Performance Report 212 , Scorecard metrics depend on the selection of Raw Profit or Portfolio Simulation sizing modes. Wealth-Lab is installed wth two Strategy ScoreCards: Basic and Extended. Like other extensions, ScoreCards are loaded when Wealth-Lab starts. Developers can create their own ScoreCards that produce any metric desired by creating a class that derives from StrategyScorecard. API documentation for Scorecards will be made available on the WL5 Wiki.



Add Strategies To add strategies, select one or more Strategies from the Strategy Explorer. Hold the Shift or Ctrl keys to select multiple Strategies. Repeat the "Add" procedure as often as required to select Strategies from different folders. You can add the same Strategy more than once to test and compare various configurations of Strategy Parameters for the same Strategy. Once added, select each Strategy one by one to modify its parameters (if any) using the sliders at the bottom of the Data Tree. Strategies are compiled when loaded into the Rankings tool (and upon modification of a Strategy Parameter). Changes to code in a Strategy Window won't take effect in Rankings until a) removing and re-adding the Strategy in Rankings, or, b) closing and reopening Rankings. Remove Strategies Hold the Shift or Ctrl keys to select multiple Strategies and click this button to remove them from the Rankings list. Use Preferred Values Highlight one or more Strategies and enable or disable use Preferred Values executing Rankings.



136



when



Begin Before initiating the Rankings process configure the Data Tree for Scale, Date Range, Sizing, and symbol or DataSet. Click



Begin or



to start.



Modify Strategy Parameters Parameter changes for scripts in the Rankings tool are saved for use in the Rankings tool. In this way, you can rank the same strategy using multiple parameter configurations. "Save Parameters" sets the default parameters for the script. Recalling the Previous Rankings Setup Wealth-Lab automatically saves the settings - but not the Strategies - for the most recently-configured Rankings tool. To save the complete configuration, Strategies included, save the Workspace 288 (main menu).
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Results and Errors Scorecard Results For a description of the metrics used in Rankings, refer to the Performance topic Visualizer Preferences. Click on the column headings to sort.
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in the



Errors Referring to the next image, strategy syntax or execution errors are denoted by the icon. Check the Errors view for more information. Double click or right click to open the strategy in a Strategy Window to troubleshoot the code. After correcting the error, save the Rankings Workspace and then re-open it to re-compiled all Strategies in Rankings.



Strategy Rankings: Errors and Context menu.



How to: Copy and Print Rankings Results To copy or print, right click inside the Rankings tool and select the desired option. With Rankings in focus, you may also print from the main menu File > Print.
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Quotes The Quotes tool monitors streaming quotations for ad-hoc symbols and creates visual and/ or audio alerts when prices reach target levels for limit and stop orders, i.e., Price Triggers 326 . You can add Price Triggers manually one-by-one in a Quotes window, but normally you'll populate Quotes from the Strategy Monitor's Alerts, Strategy Window's Alerts, or WealthSignals Trader by highlighting one or more Alerts and then clicking the Monitor in Quotes Window button (as shown).



Populating Quotes with Price Triggers from a Strategy Window's Alerts



When Adding or Removing a large number of symbols or Alerts at once, the Quotes user interface will become sluggish for several seconds.



What is Triggering? Example: Assume Symbol ABC trades at 20.01 and that your Strategy has determined that you should enter a BuyAtLimit order for 200 shares at 17.99. It's uncommon for most stocks to move the 10% required for this limit order to be filled, and, ABC could very well trade higher. Consequently, placing the order can tie up buying power that could be used for other trades. Price Triggers give you a automated way to place stop and limit orders at the moment they are marketable. By monitoring real-time quotes, Wealth-Lab can automatically trigger the order when ABC is trading at or near the target price. Once triggered, you can manually Stage/Place the order in the Orders tool or set up Quotes to do it automatically (Auto-Stage/Place).
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Market orders are always immediately triggered from Quotes since by definition a market order should be placed at the beginning of the session (or just before). Consequently, triggering is a way to place stop and limit orders in the market at (or near) the moment that they're likely to execute.



Quotes Providers Quotes is a streaming tool that is fed by the Streaming Provider selected in Preferences . Note that it's a good idea to enable the Bad Tick Filter 210 to reduce chances of premature triggering due to a single data spike.
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By design, Quotes is "always on" when the tool is opened.



Quotes in Workspaces As with all tools, Quotes windows are saved with Workspaces. Lists of symbols that are added for basic quotes will be saved with the Quotes window, however Price Triggers (and Alerts) are not saved with Workspaces.



Quotes for Paper Trading Strategy Window and Strategy Monitor Alerts sent to Quotes are routed to separate windows for Live and Paper accounts. A Quotes Window designated for Paper Trading alerts will indicate "(Paper Trading)" in the title bar. Only Alerts/Price Triggers for Paper accounts can be added to a Paper Trading Quotes window. A Quotes window for Paper Trading can be created only by choosing to monitor Alerts created from a Strategy assigned to a Paper account.
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Quotes Pane The Quotes window is divided in upper and lower panes. The upper, or Quotes Pane, provides last-quote information and a proximity-to-target price representation for Price Triggers.



Quotes Pane with Price Triggers



Quotes Pane Toolbar Add Quotes To monitor quotations for any general purpose, click Add Quote(s). Enter one or more symbols separated by spaces or commas. Symbols added as "quotes" are not Price Triggers and don't have buy/sell arrows. Tip: Add one symbol or an entire DataSet of symbols by dragging and dropping their respective icons into the Quotes Pane from the Data Panel.



Add Price Trigger For discretionary trading, you can add manual Price Triggers by specifying the stop or limit order characteristics. Recall that Quotes are separate for live and paper accounts. See Quotes for Paper Trading 161 for more information. Clear All Immediately clears the Quotes Pane of all Price Triggers and quotations. Trigger Threshold % Threshold % is a measure of the proximity of the current price to the target stop or limit price with respect to a reference price, where 100% means that price has attained the target. Set the threshold in percent at which you want Alerts to be triggered. When the
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Threshold value matches or exceeds the Trigger Threshold %, the Alert is triggered. The default setting is 100%, but positive values above 0 and up to 100 can be used. A setting slightly below 100%, say 95%, will trigger stop and limit orders just before the market actually reaches the alert price, which can help place an order in time to catch a fast-moving market or to place a short limit order early while a stock is still in an up tick. For rising targets (e.g., SellAtLimit, BuyAtStop, etc.) threshold is calculated as follows. Negate the equation for descending targets (e.g., SellAtStop, BuyAtLimit, etc.).



Threshold % where, Last is the most-recent quote, price.



100



Last Ref Abs Target Ref



Ref is a reference price, and Target is the stop or limit



By default, Price Triggers use the previous day's close as the reference price. However, if a rising (descending) target price is entered below (above) yesterday's close, the value of the first incoming tick is used as the reference. This is required to prevent premature or unexpected triggering, especially for Price Triggers added during market hours. Gap Filter The gap filter is a EOD Quotes tool feature that prevents an entry limit order from triggering if the opening price of the market session "gaps" too close to (or beyond) the limit trigger price. Just as you can program a filter using the opening price for backtesting, this allows you perform the same operation in real time trading. The gap filter affects only BuyAtLimit and ShortAtLimit order types. Activation The Gap Filter is disabled by specifying 0% (default). To enable it, enter any positive number (2 decimals max); generally a number on the order of 2 to 5%. The value specified represents a percentage of the limit price. The last-entered value is the default for new Quotes windows, however each Quote window is independent and changes to the filter value are applied when quotes update. To avoid triggering Alerts for gaps at or beyond the limit price itself, enter a small value, like 0.01. If the session's Opening price falls within that percentage, Alert triggering is blocked. For example, assume a BuyAtLimit price of 50 and the gap filter set to 5%. If the open of the day were equal to or below 52.50, the gap filter would prevent the limit order from triggering even if price eventually fell to 50 or lower. Conversely, for a ShortAtLimit price of 50 and a 5% gap filter, if the open were equal to or above 47.50, the gap filter would prevent the short order from triggering even if price eventually rose to 50 or higher. Operation When the gap filter has blocked an Alert trigger from triggering, the icon is displayed (see images above) next to the last quote time. While the icon is showing the Alert will not automatically transition to the triggered Alerts pane, but you can right click and manually trigger the Alert at any time. Sample Usage: Assume you backtest a Dip Buyer Strategy with an entry rule like this one that rejects (filters) trades if the opening price is within 5% of the limit order price:
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double limitPrice = Close[bar] * 0.93;
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// 7% dip from previous close



// open of the trade day must be greater than 5% above the limit price if (Open[bar+1] > limitPrice * 1.05) BuyAtLimit(bar + 1, limitPrice);



Since you can't get the Open price for tomorrow (bar + 1) you must code the rule as follows in order not to generate an error when processing the last bar of the chart: double limitPrice = Close[bar] * 0.93;



// 7% dip from previous close



// the open of the trade day must be greater than 5% above the limit price if (bar < Bars.Count - 1 && Open[bar+1] > limitPrice * 1.05) // this signal is for backtest; BuyAtLimit(bar + 1, limitPrice); else // always Alert for real trading for the last bar BuyAtLimit(bar + 1, limitPrice);



Note that the Strategy must generate all Alerts because it's not possible to know the Opening price until the market opens, and that's where the gap filter comes in. It does the job of checking if (Open[bar+1] > limitPrice * 1.05) for live trading. In other words, if this condition returns false, the limit order is prevented from triggering. For ShortAtLimit orders, a 5% setting would be equivalent to if (Open[bar+1] < limitPrice * 0.95). Auto-Sort Automatically sorts the Quotes list by Threshold value. Price Triggers with the greatest values rise to the top of the list. Auto-Remove When enabled, this option removes Price Triggers from the Quotes Pane when they trigger.



10.1.1 Quotes Right Click Menu Right-click actions that aren't duplicated in the Quotes Pane here.
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Edit Price Trigger



Applies to: Price Triggers Provides a dialog to edit the properties (Symbol, Action, Quantity, Trade Type 194 , etc.) of the selected Price Trigger. This option is not available for basic quotations. Editing the properties of a Price Trigger that has triggered resets the Price Trigger in the Quotes frame. Remove selected items now Simply removes the selected items from the Quotes list.



Trigger Selected items now



Applies to: Price Triggers



Causes a Price Trigger to be immediately triggered to the Alerts pane. You can also prematurely trigger Alerts by adjusting the Trigger Threshold. If the Gap Filter has prevented an Alert from triggering, you can still manually trigger using this method.



Clear Triggered items now When Auto-Remove is disabled, triggered Alerts will continue to be displayed in the Quotes Pane. You can remove those Alerts with this clearing action. Rename this Quotes Window... If you use multiple Quotes windows in the same Workspace, assigning names to them will facilitate finding the one you want from the Quotes dropdown in the Navigation toolbar or from the Window menu.
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Alerts Pane The Quotes window is divided in upper and lower panes. The lower Alerts Pane accumulates Price Triggers that have met their target prices and are ready to be Place or Staged in the Orders window.



Alerts Pane with 2 triggered Alerts.



Alerts Pane Toolbar The Alerts Pane toolbar is context sensitive; meaning that to enable some actions you must select an Alert or Alert(s) to act upon. Select All By "selecting all", you can apply the Place, Stage, or Remove actions to all triggered Alerts simultaneously. Place Orders / Stage Orders Place or Stage both transmit orders to the Orders tool. The key difference is that Staging an order requires an action in the Orders tool to place the order with Fidelity, whereas Place immediately places the order with Fidelity. Note that if Auto-Trading is enabled in the Orders 179 tool, then all Staged orders are automatically Placed. Remove Wealth-Lab does not automatically remove Triggered Alerts from the Alerts Pane. To remove all Alerts simultaneously, right-click and select Clear all Alerts. Auto-Stage/Place With Auto-Stage enabled, triggered Alerts are immediately Staged in the Orders tool without any manual intervention required. When Auto-Trading is enabled in the Orders tool 179 , this button changes to Auto-Place to indicate that new Alerts (orders) are immediately placed with Fidelity. Auto-Email Auto-Email sends Strategy Alerts to the Email account(s) that you set up in Preferences > Email Settings 243 . This option is enabled if Email Settings 243 have been configured in Preferences. Convert to Market While "Convert" is enabled, Wealth-Lab converts stop or limit orders to market orders upon triggering. Since it's possible for an instrument to quickly move away from a target price, you can be certain to execute the trade if you place the order "at market" instead of © 2017 FMR LLC All rights reserved.
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using a stop or limit order. Data latency or order-entry and transmission delays can also influence if a stop or limit order is marketable when it is placed. Related: Trigger Threshold 162 . When using this option, it's recommended to employ the Bad Tick Filter 210 with a tight percentage (less than 1%) to reduce chances of premature triggering due to a single data spike. The act of enabling or disabling this option does not have an affect on existing triggered Alerts.



10.2.1 Alerts Right Click Menu Right-click actions that aren't duplicated in the Alerts Pane
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toolbar are described here.



Edit Alert... If not using the Auto-Stage option, it's possible to change an Alert's order properties before staging or placing it. Clear all Alerts Clears all triggered Alerts from the Alerts Pane. Save Alerts to File when Triggered... When enabled, triggered Alerts are written to a file that you specify using a semicolon field delimiter. As an example of the specification and field order, the first Alert in the previous image would be saved as follows. BA;12:59 PM;55;BUY;90.79;LIMIT;LDL2;Dow 30;4 Years When enabling the "Save" action, all existing Alerts are immediately written to disk file. A separate file specification can be assigned to each Quotes window. Rename this Quotes Window... If you use multiple Quotes windows in the same Workspace, assigning names to them will facilitate finding the one you want from the Quotes dropdown in the Navigation toolbar or from the Window menu.
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Employing Quotes Generally, when trading end-of-day Strategies (Daily, Weekly, etc.), you can enter your stop and limit orders at the same time as you do for market orders - at the beginning of the session. In this case, the Quotes tool may be useful to you to indicate which trades are being triggered and to monitor the progress of other open trades. However, the Quotes tool is practically a requirement for "band trading" or "dip-buyer" Strategies that generate a large number of Price Triggers (at least one for each symbol in the DataSet) but in reality only have the opportunity to enter a few trades per day. For example, assume that you're sizing positions with 10% of equity. Imagine attempting to enter 100 or more limit orders with a broker while trading a dip-buyer Strategy. It's likely that your broker will reject orders after having exceeded your buying power. Instead, you'll use Quotes to monitor a list of Alerts, and, when a security approaches its corresponding Alert price, Quotes will notify you that the time is opportune to place the stop or limit order. In other words, Alerts that are not marketable are never placed in the market, so they do not consume your buying power. Still, it's possible that your system needs a "human element" to reject specific trades following news events, or, you may simply not want to show your order for all the world to see until the market comes to your price. The Quotes and Orders tools make a potent combination to post your order at nearly the precise moment in which a trade is marketable.
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WealthSignals Trader The first topic in this chapter describes the web-based end-of-day trading signals service developed by Wealth-Lab.com called WealthSignals™. You can participate in WealthSignals™ as a subscriber to and/or an author of WealthSignals™ Trading Systems. The next topic introduces the WealthSignals Trader Tool, which subscribers can use to download signals from WealthSignals trading systems directly to their Wealth-Lab Pro desktop application for further trade processing. A Wealth-Lab.com login is required to participate in WealthSignals as an author or subscriber.
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WealthSignals



WealthSignals™ is a web-based end-of-day trading signals service developed by WealthLab.com. The WealthSignals service allows WealthSignals customers to subscribe to trading strategies that are created by strategy authors, who use Wealth-Lab to design, backtest, and trade mechanical trading systems. Instead of sharing code or proprietary knowledge, these authors publish trading signals (a.k.a. alerts) from their Wealth-Lab Strategies. Customers who subscribe to a Strategy will receive these Signals on a daily basis and can choose whether or not to take action based on the signals, such as buying or selling a security. Authors pay a fee to advertise their trading systems on WealthLab.com's Trading Systems Subscriber's Network (TSSN) and receive subscription fees in exchange for posting their signals. The WealthSignals subsystem maintains hypothetical results of a system's WealthSignals forward test results, which are available on each system's Detail page. The forward test (a.k.a. "out of sample") can be used to compare against performance of the back test submitted by the author to see if the system is performing within expected bounds. A free login to Wealth-Lab.com is required to watch or subscribe to trading systems. For details, disclosures, and WealthSignals sign-up, please visit the Trading System Subscriber's Network at Wealth-Lab.com. WealthSignals™ might be appropriate for: Experienced trading system authors who wish to publish their experience and work in designing and backtesting trading systems with Wealth-Lab. After publishing a trading system, authors must agree to communicate their strategy's signals for every market session. Any trader who wants to trade a mechanical trading system by leveraging the work of another trading system author. Wealth-Lab customers can use WealthSignals to create private or public Sandbox systems in order to paper trade and start building a forward test history. Sandbox systems can be converted to the subscriber network at a later time. A Wealth-Lab.com login is required to participate in WealthSignals as an author or subscriber.



11.1.1 Subscribe to WealthSignals These steps outline the way to find and subscribe (or watch) WealthSignals Trading Systems. 1.



Login to Wealth-Lab.com and use the menu to navigate to WealthSignals > Find-aTrading-System.



2.



Configure the Trading System search filters then Get Results.



3.



Investigate WealthSignals systems in depth by visiting their Details page, where you'll find information about the author, a description, expanded metrics, and the system's
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own forum. 4.



If you determine that a particular trading system interests you, Subscribe to (or Watch) the trading system. Nearly all systems will include a free, no-obligation trial subscription period in which you can receive signals.



5.



Monitor and navigate to all your subscriptions and watches from a single view using My Dashboard at Wealth-Lab.com.



6.



To retrieve signals directly in Wealth-Lab Pro, launch the WealthSignals Trader from the Tools menu and enter your Wealth-Lab.com credentials. See Accessing Signals 175 in the WealthSignals Trader Tool topic. "Watching" a system lets you monitor a trading system's hypothetical performance without the ability to see or receive daily signals.



Position Size Factor When subscribing to a system, you should enter the amount of capital that you want to use to trade the system so that the signals you receive are sized appropriately for your account. For example, if the model account equity is currently $100,000 and you wish to use an account with $50,000, the position size you receive by email or via the WealthSignals Trader will be half (0.5) the size shown for the model account. You can change the scaling factor by entering a different account value using the Admin section of the system's Detail page on Wealth-Lab.com.



11.1.2 Author WealthSignals Systems Follow these steps to post a system on the subscription-based Trading System Subscriber Network, or TSSN. You can also post a system in a public or private "Sandbox" to develop a forward test history before converting to the TSSN for subscriber use.
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One-time Setup 1. Install the WealthSignals Publisher extension and put a check mark next to it in Preferences (F12) > Performance Visualizers > WealthSignals. The WealthSignals Publisher is a type of "Alerts Visualizer" that allows you to upload backtest results and trading signals (alerts) to Wealth-Lab.com. Get it from the Extensions section at WealthLab.com. 2. Design, develop, and backtest a trading system on Wealth-Lab. 3. Fill out the form to Post a Trading System at WealthLab.com. Registration with a credit card is required to complete the sign up 4. Run a backtest in Portfolio Simulation Mode in a Strategy Window. 5. Open the WealthSignals Publisher. Click Setup, enter your Wealth-Lab.com credentials, and click Refresh to populate the dropdown control with the names of the WealthSignals systems that you've posted at WealthLab.com. 6. Associate the backtested Strategy to a WealthSignals system by selecting it in the dropdown control. 7. Click the Upload button to upload the backtest results. 8. Click Save so that the WealthSignals Publisher remembers the configuration.
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After completing this one-time setup, you only need to run the strategy each day, select the signals, and click the Stage button to publish. Staging Signals Two methods exist to Stage signals for publishing. Method 1: WealthSignals Publisher Assumes that you've performed the one-time setup above. Run your system in a Strategy Window. Click on the WealthSignals tab and select one or more signals to publish. When exiting positions, it's a good idea to verify that the size of theoretical WealthSignals open positions is the same as Wealth-Lab's signal size. Click Stage. Many signals may take several seconds to upload; be patient and wait for the status to return. Check each signal's Result status. Staging signals from the WealthSignals Publisher immediately starts the 15minute grace period 173 . Method 2: System Detail page Run your system in a Strategy Window. Enter each Alert manually in the system's Details page at Wealth-Lab.com. Click the Publish All Signals button, starting the 15-minute grace period 173 .



15-Minute Grace Period After staging signals and prior to 9:00 ET, authors have a 15-minute grace period to abort publishing 173 in order to make corrections. After complete edits, use either staging method to restart the grace period. Signals staged after 9:00 AM ET are published for subscribers without delay (no grace period). Important! It is not possible to modify signals after they have been published following the grace period or immediately after 9:00 AM ET. Abort Publishing During the 15-minute grace period, you can abort publishing signals by ether method by clicking the Abort Publishing Signals button on the system's Wealth-Lab.com Details page. Signals that were entered remain queued after aborting and may be deleted or modified on the Details page. Following an abort, be careful not to duplicate signals that are already queued when re-staging with the WealthSignals Publisher (Method 1 above).
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WealthSignals Trader Tool Introducing the WealthSignals Trader WealthSignals™ distributes signals to subscribers multiple ways. A subscriber can view today's signals on a trading system's Detail page and also receive them via email. However, especially for strategies that generate dozens or even hundreds or signals each day, the WealthSignals Trader will download signals to your Wealth-Lab Pro client software, which you can use to: associate a paper or live trading account to a strategy's signals send signals to the Quotes tool for monitoring stop and limit alerts and optionally stage or place them stage or place orders directly to the Orders tool



WealthSignals Trader showing signals and statuses for WealthSignals systems.



11.2.1 Actions Launch WealthSignals Trader To launch the WealthSignals Trader, select Tools > WealthSignals Trader. Log in to WealthSignals Use your Wealth-Lab.com credentials to Log in to WealthSignals. To log out from WealthSignals, close the WealthSignals Trader window. Download Signals Shortly after login to WealthSignals, signals to systems to which you are subscribed are downloaded automatically. After 12:00 AM ET and prior to 9:00 AM ET the WealthSignals © 2017 FMR LLC All rights reserved.
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Trader "Auto-updates" these signals every 15 minutes. After 9:00 AM ET, automatic refreshes occur every 5 minutes until approximately 9:25 AM. At any time, if you wish to download signals manually, just click the Download Signals button. To disable Autoupdates, close the WealthSignals Trader. Set Account... Just as with Wealth-Lab Strategies, you can assign WealthSignals Systems to a specified live or paper account. Just highlight a WealthSignals system (or one of its signals), click Set Account, and select one of the accounts from the list. Assigning an account is required just once per WealthSignals System. If you do not assign WealthSignals systems to an account, signals are Staged or Placed to the Default Account shown in Preferences (F12) > Trading. Select All This action selects all signals for all WealthSignals systems for the Place, Stage or Monitor actions. Select all orders for a single system by clicking on its name. Individual or multiple signals may be selected using the standard windows methods (left click plus Shift or Ctrl). [Trade Type] Choose Margin or Cash trading if required for live accounts. Place Orders, Stage Orders Places or Stages selected signals using the Orders tool. Orders are placed/staged to the assigned (or default) account. See Set Account above. Monitor in Quotes Window Sends selected signals to the Quotes Window for price monitoring and triggering. For more, refer to the Quotes tool 160 chapter.



11.2.2 Signal Pane Accessing Signals To download signals to the WealthSignals Trader, log in to WealthSignals using your Wealth-Lab.com credentials. The WealthSignals Trader will automatically poll for signals for systems to which you are subscribed. After 12:00 AM ET and prior to 9:00 AM ET the WealthSignals Trader "Auto-updates" these signals every 15 minutes in order to retrieve new signal publication from all your subscribed systems. After 9:00 AM ET, automatic refreshes occur every 5 minutes until approximately 9:25 AM. At any time, if you wish to download signals manually, just click the Download Signals button. To disable Autoupdates, close the WealthSignals Trader. A system's signals will not change once they have been published/downloaded.
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Signal Fields Signals are grouped by Strategy. Action



Awaiting Publication Buy Sell



Short Cover



System author has not yet staged signals for the session Trading signal type



No Signals Today



System author published a "NST" notification



Under Review



Author failed to stage signals (or NST) for two consecutive market sessions. Current subscribers can still receive signals, but the system cannot accept new subscribers for 30 days.



Symbol



(Self-explanatory)



Qty



The number of shares based on your personalized account factor.



Order Type



Market, Stop, or Limit. Market at Close orders are not supported.



Order Price



Stop/Limit trigger price. Blank for Market orders.



Account



Account to which the WealthSignals system is assigned; or default account in Preferences (F12) > Trading



Date/time Downloaded



(Self-explanatory)
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Best Practices Subscribers to WealthSignals Systems Check your subscribed systems for WealthSignals orders each day before the market opens at 9:30 AM ET in order to ensure that you have enough time to decide whether you would like to take action based on the signals received. Before the market opens, place orders to be executed during regular market hours and/or set up the Quotes tool to monitor stop/limit signals for triggering. WealthSignals does not recognize trading outside of regular market hours. For systems that trade limit orders, consider using the Convert to Market 166 feature of the Quotes tool to avoid the possibility of an orphaned position. Because of the hypothetical nature of simulations, Wealth-Lab and WealthSignals will always consider an order "executed" if the limit price has been reached. However, in actual trading scenarios it is possible that a limit order not be executed at the limit price due to several factors. Each day, cross check synchronization of positions between your [paper or live] trading account and the WealthSignals model account. Position sizes between the model account and your account are expected to be different if they have been scaled for your account size. Synchronization Note for Systems that use Stop Orders The Fidelity brokerage uses the bid/ask to trigger stop orders on the back end subsystem while Wealth-Lab and WealthSignals require a trade at the stop price for theoretical execution. Therefore if an actual trade does not occur at the bid (sell/short stop orders) or ask (buy/cover stop orders) that falls on a stop price, an out-of-synch condition may occur since the backend execute the stop order, but Wealth-Lab will not recognize that the stop order triggered. This is a rare condition for a highly-liquid markets, but can occur more frequently when using stop orders in lightly-traded markets. Case 1: Stopped out You could be prematurely stopped out of a position. If you decide not to reenter the Position in order to stay in synch with the WealthSignals system account, future exit signals will "error out" if placed. Case 2: Stopped in If the system uses stop orders to enter a position (long or short), you could end up owning a position that is not supported by the WealthSignals system. This is an "orphaned position" that the account owner must manage.



Trading System Authors System authors must help to ensure the highest level of synchronization between their Wealth-Lab back test and WealthSignals, the latter of which should closely follow trading for live accounts. Perform daily a cross check for synchronization of positions between your Wealth-Lab back test and the WealthSignals model account's Open Positions view. (We recommend using the Trades+ Open Trades view of the Performance Visualizers library extension by MS123, available at Wealth-Lab.com.)
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Be wary of trade synchronization around dividend ex-dates when using dividend backadjusted data. The back adjustment can cause hypothetical trades resulting in current positions to be "missed"; likewise new trades may appear to be active that were not previously. When exiting a full position, ensure that the exit signal position size matches the WealthSignals's Position and adjust if required. WealthSignals will automatically adjust "too many" shares to match the current Position, but no action is taken if the shares are fewer since a partial position exit may be intended. Limit order slippage should be disabled for the WealthSignals forward test trading in Preferences (F12) > Slippage and Round Lots. High-exposure stop or limit order systems should employ a time-of-day Position priority logic such that trades that occur earlier in the day have the highest priority. Contact Support at Wealth-Lab.com if you need assistance with this. If you feel that WealthSignals should have (or did not) execute a trade due to bad data or otherwise, create a support ticket at Wealth-Lab.com as soon as possible.
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Orders Warning! Do not use the same Windows User login to trade accounts for more than one Social Security Number (SSN). If necessary, create a separate Windows login for each SSN, and run Wealth-Lab Pro in a separate Windows session for each user. The Orders tool dynamically handles orders from all Wealth-Lab alert-generating tools and the manual Trade Ticket 195 , and integrates user options to customize order placement decisions. Orders are integrated with both Live and Paper accounts. To familiarize yourself with the automated trading environment, we encourage you to try Wealth-Lab's Paper Trading 180 first. Once you are familiar with the manner in which the Orders tool functions and have made the necessary preparations, the Orders tool can significantly reduce your trading activity workload while providing you with the latest trading and Fidelity account statuses. Trades that are placed and executed through the Orders tool will be reflected in the Default Account 240 or in the Fidelity account associated with the Strategy that generated the Alert (automated entry).



How to: Open the Orders tool (Ctrl+R) 1. Log in to Fidelity 2. From the main menu select Tools > Orders (Ctrl+R), or, click Orders in the Navigation toolbar 289 . See the Advanced Options 238 that control the behavior of the Order Manager when a trading is Staged or Placed. Although you can open many main Workspaces, only a single Orders window can be active. Attempting to launch a second Orders window will automatically shift focus to the first active Orders tool in another Workspace. Margin accounts cannot trade cash positions with Wealth-Lab Pro.
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Paper Trading Throughout the Orders topic you'll find references to Paper Trading. Paper Trading allows you to use most of the same functionality that you use in Wealth-Lab Pro for real/live trading except that orders are filled in a simulated environment. Although Paper Trading uses live data, order executions occur in a simulated environment where fills are generally not as responsive as Live trading (see How Orders Are Filled 180 ). Unless stated otherwise, documentation applies to trading for both Live and Paper account types.



Why Paper Trade? It can be a nail-biting experience to see multiple orders (even dozens) placed simultaneously when trading intraday strategies with the Strategy Monitor for the first time. Paper trading can be viewed as a training feature to familiarize yourself with these and other aspects of automated trading. By paper trading first, you'll understand the automated process better and have a chance to optimize your Workspace(s) and work flow to be better prepared for Live trading. Warning!



Simply because your Strategy performs well while paper trading is in no way a guarantee that it will perform well in Live trading.



Features Not Supported for Paper Trading Cancel/Replace Selected method (Orders Toolbar 2 Bracket OCO Exit Order functionality GTC orders Directed Trading (route to QWIK)
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How to: Paper Trade Paper accounts are integrated alongside Live accounts. By default, three Paper accounts are installed, although you may add more (see Accounts 201 ). Associate Strategies to Paper accounts (see Set Account 305 ) in the same way you do for Live accounts, and, you can even make a Paper account the default account 240 . In this way, you can direct automated orders to be filled by the Paper broker, and, when you're ready to make the transition to live trading, simply reassign the Strategy to a Live account. Real and paper trades can be staged or placed through strategy-generated trades/alerts using Chart or Strategy Windows, Strategy Monitor, price trigger trades/alerts in the Quotes tool, as well as through the Manual Trade Ticket 195 . Log in to Fidelity is not required to place trades with Paper Accounts via the Trade Ticket or from a static (EOD) chart. However, to trade an automated intraday strategy using a Quotes tool, a Streaming Strategy Window, or the Strategy Monitor, login is required to access data. How Orders Are Filled Market orders are filled using the most-recent trade price. The Paper Trading provider polls for quotes approximately twice per minute for active stop/limit orders. Quotes are then crossed with the stop/limit activation prices, which may result in simulated fills. Snapshot quotes are delayed by 15 minutes unless logged in to Fidelity.
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In dynamic markets the Paper broker may not execute stop/limit orders when expected. A strategy will always theoretically fill a stop/limit order whose activation price is met or exceeded, assuming zero slippage 234 . However, if the market moves back within the activation price at the time the snapshot is taken, the Paper broker won't fill the order, which will cause an out-of-synch condition between the Strategy and Paper account.
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Features and Limitations Orders tool logic and Features In general, these features apply to automated, Strategy-generated (non-Manual) orders. Automated cancels Wealth-Lab Pro cancels Active orders if an Alert does not exist for the same order(s) on the next bar. Wealth-Lab Pro cancels Active stop and limit orders only if 1) price changes, or if 2) the Alert(s) are not submitted again on the subsequent bar. When the limit or stop activation price changes, the order is canceled and replaced with the new price. It should not be necessary to change your strategy code for this interaction to occur. It occurs naturally as a fallout of the way strategies are programmed. Duplicate Order Detection Identical Alerts from the same Strategy will not be duplicated in the Orders tool. The filtering logic checks the Strategy, symbol, scale, order and trade types to ensure that the same order is cannot be placed automatically more than once even if the Alert is generated in different tools. Additionally, only one stop and/or limit order is possible (one of each type) for exit orders on a single position. For example, 2 stop loss orders with different prices for the same position is not valid, and only the stop order closest to the current price will be accepted. Trailing Stops, Cancel and Replace Trailing stops are supported in real-time. When a stop adjustment is required, existing stop orders are canceled and the new stop level is submitted when the cancel is confirmed. The same logic applies to limit orders that change price on subsequent bars. Bracketed Exit Orders Bracket trading is supported when Auto-Trading as well as for manual-order entry. Stop and limit orders for the same instrument can co-exist simultaneously. When one order is executed, the Order Manager cancels the other order automatically, i.e., one cancels other (OCO). Stop and Reverse Stop and reverse systems may be traded. Stop loss and/or Profit target on the entry bar Entry-bar stop loss and profit limit orders are supported optionally. See Allow Same Bar Exits in Trading Preferences 240 .



Limitations It's not possible to place cash trades for margin accounts in Wealth-Lab Pro. Warning!



© 2017 FMR LLC All rights reserved.



183



User Guide, Wealth-Lab Pro



Do not use the same Windows User login to trade accounts for more than one Social Security Number (SSN). If necessary, create a separate Windows login for each SSN, and run Wealth-Lab Pro in a separate Windows session for each user. AtClose Orders AtClose Orders are not supported by the Orders tool. See How to: Alert for AtClose Signals in the WealthScript Programming Guide. AtStop/AtLimit Orders Placing AtStop/AtLimit orders such that they would immediately execute "at market" is not accepted by Fidelity backend subsystems and will result in an order entry error accompanied by a message to the effect, "please review your order". Generally, this situation may occur when placing a Strategy's stop/limit orders into a price gap for an end-of-day Strategy. Intraday Strategies can conditionally place market orders upon detecting that a stop/limit trigger price would trigger at market with respect to the current closing price. Please be informed that Fidelity has informed us that it is not possible to change the behavior of backend subsystems to accommodate stop/limit orders that would execute at market when placed. Portfolio Synchronization Portfolio Synch is greatly simplified in Wealth-Lab Pro Version 6, which no longer requires additional code to function. Strategies always execute in a theoretical backtest mode while synchronization occurs only in the context of exit Alerts. The main limitation is the inability of a Strategy to directly access a real Position's actual entry price, which may or may not apply to your Strategy. See Portfolio Synchronization 186 for more details. Account Feedback It is not possible to ascertain the status of live Positions (or their exits) from within a Strategy. While this isn't a problem for Market or Stop order strategies, it's quite possible that a Limit-order strategy fills an order theoretically while the live order remains open, which can happen when the market trades precisely to the Limit price and then reverses. Monitor Limit-order strategies closely.
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Stage, Place, Auto Warning! Do not use the same Windows User login to trade accounts for more than one Social Security Number (SSN). If necessary, create a separate Windows login for each SSN, and run Wealth-Lab Pro in a separate Windows session for each user.



Stage, Place, Auto-Stage/Place Orders Stage, Place, and Auto-Stage/Place are Strategy Window/Monitor, Quotes, and Trade Ticket actions that route Alerts to the Orders tool in either a manual or automated fashion as described below. The terms "Orders" and "Alerts" are used interchangeably. Stage



Sends an Alert, which may have been manually modified, to the Orders tool, where the Order can be edited (if required) and placed. Staging an order is manual action that will never place an order, even if AutoTrading is enabled.



Place



Places the selected order(s) with Fidelity. The order status can be monitored in the Orders tool.



Auto-Stage



Stages Alerts in the Orders list without manual intervention.



Auto-Place



Immediately Places Alerts as orders with Fidelity without manual intervention. When Auto-Trading is enabled in the Orders tool, all Auto-Stage actions become Auto-Place.



The status of the Auto-Stage/Place actions are dependent on whether or not Auto-Trading is enabled in the Orders tool. By enabling Auto-Place, you acknowledge that you wish to place orders immediately without the possibility of reviewing or editing them.



Auto-Trading Live accounts require a special entitlement to enable the Auto-Trading feature. See the Auto-Trading User Agreement in the main Help menu. Call Fidelity for the most current information. The Orders tool is responsible for placing orders with Fidelity and managing their status thereafter. When the Orders tool receives an order, two things can happen: 1. the order is staged (queued) and must be placed manually, or, 2. the order is placed immediately, i.e., Auto-Trading Auto-Trading has three (3) states: Off



All Alerts that are Staged or Auto-Staged to the Orders tool must be placed manually.



Paper Accounts



Enables Auto-Trading for Alerts destined to Paper Accounts (only). WealthLab tools with Strategies that have been assigned to a Paper Account for
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trading will have an Auto-Place button, whereas those for Paper Accounts will have an Auto-Stage button. Live Accounts



Enables Auto-Trading for Alerts destined to Live Accounts (only). WealthLab tools with Strategies that have been assigned to a Live Account for trading will have an Auto-Place button, whereas those for Paper Accounts will have an Auto-Stage button.



Auto-Trading can be enabled either for Paper Accounts or for Live accounts, but never both simultaneously. Clicking Stage to stage an order will never result in placing an order even when Auto-Trading is enabled.



Order-Entry Summary Anywhere an Alert can be triggered in Wealth-Lab Pro, the order can be passed directly to the Orders tool. The following table lists the options available: Strategy Window



Stage, Place; Auto-Stage/Place (if Streaming)



Strategy Monitor



Stage, Place, Auto-Stage/Place



Quotes



Stage, Place, Auto-Stage/Place



Trade Ticket



Manually Place or Stage single orders
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Portfolio Synch Portfolio Synchronization (Portfolio Synch) Wealth-Lab Version 4 traders may recall the PortfolioSynch() WealthScript function used to synchronize historic trades in a streaming chart or scans. Version 5's design is simplified such that strategies always display the theoretical trades, but synchronize exit orders (Alerts) to match your account's actual positions in the way described above.



By default, Wealth-Lab Pro synchronizes automated trading with your account's positions in two ways: Alerts and Trade Ticket orders to exit positions with more shares than you own are automatically reduced in size to match your account shares, and, Alerts to exit positions that are not owned in your account are not automatically transmitted to the Orders tool when Auto-Stage or Auto-Place is enabled. These Alerts will still be visible in the Alerts views, however. To disable Portfolio Synchronization, refer to the Trading Options group in Trading Preferences 240 . In addition, you can choose to make exit Alerts always match the total number of shares held in your account by selecting the "Exit Orders" option in the Trading Preferences 240 . It is not possible for a Strategy to directly access a live Position's true entry price or number of shares. In the following examples assume that you've enabled Auto-Stage so that Alerts are automatically staged in the Orders tool. Example 1 Your account (or Paper account) holds 300 shares of XYZ. Position sizing is set up such that a strategy generates an Alert to sell 500 XYZ. Portfolio Synch will automatically reduce the Alert shares to match those in the associated account and stage the order to sell 300 XYZ in the Orders tool. Example 2 Your account (or Paper account) holds 500 shares of XYZ. Position sizing is set up such that a strategy generates an Alert to sell 200 XYZ. There are two possibilities depending on the selection of the "Exit Orders" preference. 1. If the preference is enabled, an Alert to sell 500 XYZ (all shares in the account) is staged in the Orders tool. 2. If the preference is disabled, an Alert to sell 200 XYZ is staged. Example 3 Your account (or Paper account) holds 0 shares of XYZ, and, a strategy generates an Alert to sell 300 XYZ. Since the account associated with the strategy does not hold a Position that matches the Alert, Wealth-Lab will not stage the order in the Orders tool.



Theoretical vs. Actual Strategies always operate in a theoretical trading environment (subject to slippage © 2017 FMR LLC All rights reserved.
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settings) 233 and can therefore become out-of-synch with your Live account. Generally, this isn't a problem for strategies that use market orders, but can be a factor when stop/ limit orders are used. AtStop Orders Fidelity uses the bid/ask to trigger stop orders on the back end subsystem while WealthLab requires a trade at the stop price for theoretical trade to take place. Therefore if an actual trade does not occur at the bid (sell/short stop orders) or ask (buy/cover stop orders) that falls on a stop price, an out-of-synch condition will occur since the backend will execute the stop order, but Wealth-Lab will not recognize that the stop order triggered. This is a rare condition for a highly-liquid markets, but can occur more frequently when using stop orders in lightly-traded markets. AtLimit Entries For example, assume slippage is deactivated, the market is trading at 25.50, and you place an order to buy 100 shares at 25.32 limit. If the market trades down to precisely 25.32 and then rises again, Wealth-Lab will theoretically fill the order and as a consequence the strategy will begin processing exit logic for this Position. However, in real life, it's quite possible that your order, one of many at 25.32, not be filled. While you're still looking to enter the market in real life, your Strategy will be processing exit logic, which could result in a missed opportunity to enter the market later. With an end-of-day strategy employing the Quotes tool, consider using the "Convert to Market Order" option to prevent an out-of-synch situation from occurring. Currently no viable solution exists to resolve this for intraday strategies. While you my be tempted to activate limit-order slippage 233 such that the theoretical fill does not occur until a tick occurs at even a lower price, the precise opposite synch problem could occur in which your Live account fills but the strategy does not. In this case, the strategy will continue processing entry logic, which may result in additional (unwanted) positions. Disable limit-order slippage for live trading of strategies that use limit orders to enter positions. AtLimit Exits Conversely, for strategies that use market orders to enter a trade but limit orders to exit, it may make sense to apply limit-order slippage. In this way, you're almost guaranteed that the strategy will continue processing exit logic until an actual fill occurs. It's "almost" because there's always a possibility of a trade occurring beyond your limit (e.g., a data spike, or a trade hitting an order on a different ECN), which again may fill the strategy's theoretical condition but not your actual trade.



Risk exists that your strategy become out-of-synch with your Live account. Monitor for this condition and compensate for it manually, if required. In real-time you can adjust a limit order price, create an offsetting order with the trade ticket, or manage the out-of-synch position at your discretion.
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Orders Toolbar 1 The Order Manager supports both manual and automatic (Auto-Trading) modes of operation. This topic describes the process for login and for enabling/disabling the AutoTrading. For details about manual order entry, continue to the next topic. Log in to Fidelity In order to place a trade for Live accounts it's required to manually complete the login action. You can log in to Fidelity in two ways: 1. Click on the Log in to Fidelity button in the Function toolbar as shown below, or 2. Click on the Log in to Fidelity button in the manual trade ticket. Depressing the Log in to Fidelity icon will launch a dialog box to allow the user to connect to Fidelity. Upon successful login, toolbar.



appears in Wealth-Lab's Function



Account The Order tool can show a composite list of Wealth-Lab orders for all your Fidelity accounts by selecting "All Accounts". Choose a specific account to filter Orders information for an individual account. "All Accounts" represent all Live accounts; Paper accounts are not included. Cancel All Clicking the Cancel All button 1) cancels all Live and Paper account orders having an Active or Partial status, and, 2) disables Auto-Trading. You must acknowledge a Cancel All action by clicking the Yes/No dialog. Warning! The Cancel All button cannot cancel Live orders if a stable internet connection does not exist between Wealth-Lab Pro and Fidelity. For emergencies, keep your broker's trading desk phone number handy. Auto-Trading: (Off / Paper Accounts / Live Accounts) Experienced traders who want to make their trading experience truly mechanical can use Wealth-Lab Pro's Auto-Trading feature. The Orders tool automatically places orders that are received from any tool that generates an Alert. This is true hands-off trading, so use this option carefully. Important! When the Auto-Trading is enabled: 1. it is enabled for all Live Accounts or Paper Accounts, as specified by your selection. 2. Auto-Stage buttons becomes Auto-Place for the Strategies associated with the account type enabled for Auto-Trading. See Stage, Place, Auto 184 . The Orders tool ensures a consistent order flow from trading strategies such that each © 2017 FMR LLC All rights reserved.
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trade is active or canceled based on the trading system's logic and that no order is duplicated. For example, if your trading system uses bracket exit orders (simultaneous stop and limit orders for the same symbol), the Auto-Trading feature will automatically enter the order pair as a bracketed (OCO) order. When one of the orders is filled, the Order Manager automatically cancels the opposing order. Orders that are already staged are not placed upon selecting Auto-Trading Mode. Also, orders manually put in the order list by clicking the Stage button from any tool will not be placed automatically even if Auto-Trading is enabled. Auto-Trading is turned off by any of the following actions: selecting Auto-Trading: Off, or, clicking the Cancel All button, or, closing the Orders tool, or, logging out of Fidelity Update Wealth-Lab Pro communicates with Fidelity to display the latest status of all orders. However, in the case that Wealth-Lab Pro does not receive a timely message from the back-end, you can click the Update button to request order statuses for all Accounts for orders in any of the following states: Active, CancelPending, or Unknown. Wealth-Lab Pro must Logged in to Fidelity to activate the button. "Guaranteed Alerts" are part of Fidelity's backend subsystem to provide updated order status to Wealth-Lab Pro. In the event that Guaranteed Alerts fails, Wealth-Lab polls for order updates approximately once every 30 seconds. Use the Update button to request order status updates immediately. To reconnect to Guaranteed Alerts after a failure, restart Wealth-Lab Pro.
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Orders Toolbar 2 Use Toolbar 2 to interact with the Orders list.



Selecting Orders For the actions that can be applied to multiple orders, you can select multiple items using the Shift or Ctrl keys in combination with the left mouse button in the standard Explorer manner. Alternatively, make multiple selections by holding the Shift key while tapping the up/down arrow keys or by left-clicking and dragging over an area. The DEL key will remove selected orders that are not Active from the list. Options for Cancel and Place are enabled only when a connection exists with Fidelity. Note that you cannot Delete or resubmit (Place) orders having a Submitted or Active status; the Orders tool will ignore such requests. Edit Selected This action provides the ability to change a staged order's details - see dialog to the right. If the Route selection is not displayed, then your account is not entitled for directed trading and Auto is used as the default route. Place Selected Places all highlighted (selected) queued order(s) to Fidelity for execution. Cancel Selected Requests that Fidelity cancel all highlighted (selected) Active, including partially-filled orders. For Live accounts, Cancel and Place are enabled only when a connection exists with Fidelity. You cannot Remove or Place orders that have a Submitted or Active status; the Orders tool ignores such requests
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Applies to: Live Accounts Cancel/Replace Selected Opens a dialog that allows you to change Quantity, Order Type, Price, and/or TIF for the selected Active or partially-filled order. Click OK to cancel the active order and replace it with the specified order parameters. Remove Selected Removes orders using the same criteria as Remove Completed (below), but only for the orders selected in the list. Remove Completed Removes all completed Live and Paper orders from the list. Completed orders are those that have a status of Filled, Overfilled, Canceled, Error, or Unknown. This action will not clear Partial, Staged, Submitted, or Active orders.



Auto Remove Automatically removes stop/limit orders that are canceled and replaced by trading automation. For example, if you Strategy uses a trailing stop, the order is likely to be canceled and replaced several times as the Position becomes more profitable. Auto Remove keeps the Order list tidy by removing canceled orders and showing only the most-recent trailing stop and limit orders.
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Managing the Orders List The Order List provides dynamic status and logging for each order staged and/or processed. Executed orders with a Filled status are tracked locally, and Account positions can be reviewed at any time in the Accounts tool. Using the Order List, you can modify an order, place groups of staged orders, or cancel live orders with minimal effort. Sorting and Selecting Orders Sort the list by clicking on the heading of any column. You can select multiple order items using the Shift or Ctrl keys in combination with the left mouse button in the standard Explorer manner. Alternatively, make multiple selections by holding the Shift key while tapping the up/down arrow keys or by left-clicking and dragging over an area. Finally, the DEL key will remove selected orders that are not Active from the list.



Orders tool Order List detail



Order List (Column Descriptions) Account The Fidelity account associated with the order. The Orders tool list can be viewed by individual account or as a composite summary of all orders for all Fidelity accounts, which are identified by the Account field. See Orders Toolbar 1, Account. Date/Time Date and time of the order. For automated trades (alerts generated by the Strategy Window or Strategy Monitor, the date is the time stamp of the signal bar, which due to order-entry and execution delays, will always be prior to the time of the actual trade execution. The Orders tool discards duplicate orders, consequently the date/time will reflect that of the order which was initially Staged or Placed. An order is a duplicate if all the following components are the same: Strategy, Scale, Symbol, Order Action and Type, Quantity (shares), and Price.
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Status Submitted



Order submitted to Fidelity, but not yet confirmed active.



Active



Order accepted and confirmed active by Fidelity. Active orders must be first canceled if you wish to clear them from the list.



PartialFilled



Order partially filled and will remain active unless canceled.



Filled



Order completely filled. Note that this information is passed to the Accounts tool.



CancelPending



A request to cancel the Order has been submitted to Fidelity.



Canceled



Order confirmed canceled by Fidelity. See Order Messages for more information.



Error



An error occurred during Order processing. See the Message field for more information.



Overfilled



On a very rare occasion your order may be Overfilled. In this case you'll see the order's status change from Filled to Overfilled. Immediately contact Fidelity to remove the overfilled portion of the order.



Unknown



The order status cannot be verified through Fidelity. This will occur, for example, if you shut down Wealth-Lab Pro with active orders. If you then launch the Orders tool without having connected to Fidelity, the status of previous live orders cannot be verified.



Bracket Exit



OCO (one cancels other) bracket order placed. A bracketed exit simultaneously places profit target limit order with a stop loss order.



Self-explanatory: Symbol, Action, Type, Quantity Order Price The Stop/Limit order price. For the Market Order Type, this field will be blank. Filled (Shares) The number of shares that were secured or sold for the order. A cumulative number of partially-filled shares will appear in this field and be dynamically updated as additional shares are secured. This data is received from the 
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Message This field contains detailed information for orders with an Error or Canceled status. Error messages are received from Fidelity and may occur for any number of reasons. By clicking on the error in the Order messages window, additional message details may be displayed in the Message Full Text frame. If the message text is cut off in the Order Messages window, highlighting it will show the complete message in the message full text box. Wealth-Lab can also prevent an order reaching Fidelity by canceling it due to one of the following conditions which are controlled in the Trading Preferences 240 : Buying Power below user-defined threshold Cash below user-defined threshold TIF Day, DayPlus, or GTC. See Time in Force
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Trade Type Trade Type is identified by Cash, Margin, or Short for live accounts, but is blank (not used) for Paper Accounts. While cash accounts are confined to cash-only long trades, you can specify Cash or Margin when entering or exiting long positions (Buy or Sell) in a margin account. Short trades (Short or Cover) are identified automatically with a Short Trade Type for margin accounts. Specifying Trade Type primarily allows customers with margin accounts to trade cash positions. You can pre-configure and/or edit Trade Type in the Strategy Monitor Activation Settings 150 Dialog, Strategy Window Alerts view, and Quotes tools. Right-Click Context menu By right clicking in the order list, the actions in Orders Toolbar 2 190 are presented in a pop up menu, which you can apply to the orders currently selected. Additionally, Copy to Clipboard copies all the data in the order list, which can then be pasted in another application.
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Manual Trade Ticket While Wealth-Lab Pro automates your scripted trading activities, don't miss those other opportunities that arise in the markets by quickly entering a trade manually. The Manual Trade Ticket may be displayed at the top or bottom of a Workspace, allowing you to easily place a manual trade regardless of other tasks you may be performing. With the exception of the ability to use AtClose orders, which are not compatible with the Orders tool, the Manual Trade Ticket interface gives you the same order-entry options available to you in Wealth-Lab Pro Strategies. The trade ticket is largely self-explanatory and is independent of the Orders tool. In the image below, for example, an order has been configured to Buy 100 Shares of AA at a Limit price of $8.50.



Manual Trade Ticket, .



If you are not actively entering orders, you can hide the trade ticket by clicking the Hide Trade Ticket button located in the Function Toolbar 290 or by striking Ctrl+T to toggle the view on and off. Account Choose the Fidelity (or Paper) account to which manually-entered orders will be directed. Initially, the Default Account 240 is selected. Symbol, Action, and Quantity Self-explanatory. Order Type Account



Order Types



Live



Market, Limit, Stop, Trailing Stop $ and %. Trailing Stops are based on the last trade when the Place or Stage button is clicked and are valid for both entry and exit orders.



Paper



Market, Limit, Stop. (Trailing Stops not supported)



Amount The price for Limit or Stop Order Types or the point/percentage Trailing Stop amount. This field is disabled for when Order Type is Market. Example: For a Sell stop to trail the last price by 2%, select Trailing Stop % and enter 2 for the Amount. Only whole numbers can be entered for the Trailing Stop % Amount. e.g., 1, 2, 3 (%), etc. Route Currently, Auto is the only available order-routing option for Live accounts.
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TIF (Time in Force) Account



TIF



Live



Auto-routed Stop and Limit orders



Paper



All order types: Day (only)



Route



TIF



Auto



Day



Auto



GTC



Special Conditions



Day and GTC ('Good Til Canceled')



Details Orders are marketable for the current (or next) day session, regular market hours



Stop/Limit only



GTC orders are marketable during regular market hours during the next 120 calendar days.



Summary of order routing and TIF combinations in Wealth-Lab Pro for Live accounts.



Trade Type The selection generally defaults to the appropriate type based on the Account and Order types, providing the ability to identify your trades as Cash, Margin, or Short. Trade Type does not apply to Paper Accounts. Place Enabled when a connection exists with Fidelity. When clicked, the specified order is immediately submitted to Fidelity. Manual orders are never checked against Account positions, therefore Wealth-Lab Pro will never inhibit submitting a manual order. In all cases, however, Fidelity's back-end prevents invalid orders (like selling a Position that you don't have) and the corresponding error code/message will be displayed in the Order List. Stage Enabled when a connection exists with Fidelity. This action places the order in the Orders tool queue for submission at a later time. Staged orders from the Manual Trade Ticket are never automatically placed even if Auto-Trading is enabled. Last, Bid, Ask (Quotes) Tab off the Symbol field to update the snapshot quotes. Quotes are live when logged in to Fidelity. Without logging in, delayed quotes are provided if a Paper account is selected in the Account field.



Bracket Order, Manual Placement Applies to: Live Accounts For Live (not paper) accounts, you can place an OCO (one cancels other) bracket order manually by Staging both a stop and limit order pair for the same symbol in the Orders tool queue. To identify and place the pair as a bracket order, simultaneously highlight the stop and limit pair, right click, and select Place Selected Order(s).
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You can highlight and place any staged order at the same time that you place bracket orders. OCO orders are identified by placing a stop and limit order simultaneously for the same symbol. The OCO behavior is automatic and not optional.
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Modify, Cancel, Partial Fills Modifying / Canceling an Order You may modify or cancel staged or placed orders from the Orders tool interface as described in the Managing the Order List 192 topic. Once an order that has been placed using Wealth-Lab Pro's Orders tool is active, you can cancel it from Orders or via Fidelity.com.



Partial Fills Applies to: Non-GTC Automated Orders Wealth-Lab is a Position-based platform, which in essence means that a partially-filled Position is treated the same as a fully-filled Position. The Orders tool, however, handles partial fills differently in real time depending on if the order is an entry (BuyAt/ShortAt) or an exit (SellAt/CoverAt). It is not possible to ascertain (from within a Strategy) whether or not a position has been fully filled or only partially filled. Further, it is not possible to force a partially-filled entry order to remain open at the completion of the current bar interval when using trade automation. Partial Fills for Entry Orders For intraday Strategies, the Orders tool cancels the remaining shares at the end of the intraday interval. Likewise, the trading exchange will cancel any order at the close of the session. Partial Fills for Exit Orders Exit orders remain open on the Fidelity backend subsystem until the end of the trading session. Even if your Strategy changes the stop or limit price of an exit order, WealthLab will not impede or interrupt the original, partially-filled order by canceling it and then replacing it with new prices. If your automated stop/limit order is partially filled and you wish to immediately exit the trade at an improved price, you must cancel the order and then exit the remaining shares manually. Synchronization and Partially-Filled Exits Wealth-Lab Pro synchronizes with positions with a fully-filled, uninterrupted or interrupted order of partial fills.
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12.10 Auto-Trading Checklist Before making the leap from backtesting to the more complex and dynamic environment of automated trading, follow this checklist: Step 1.



Check Strategy Compatibility Do not use AtClose orders in combination with the Orders tool. In general, intraday strategies should not use AtClose orders, even for backtesting. Be sure to read the section on Features and Limitations
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.



The Orders tool does not have a concept of "bars" - it converts alerts into orders immediately. Therefore, trading systems should never use bar + N, where N > 1, to trigger an Alert. Always program trading systems to use bar + 1 in the main trading loop for trading signals, e.g., BuyAtMarket(bar + 1, "BuyAlert");



Step 2.



Assign Strategy to Account(s) If you have more than one Fidelity account or wish to use Paper Accounts, assign Strategies to a specific Fidelity account so that orders are routed to this specified destination. See Set Account... in the Strategy Explorer 305 topic.



Step 3.



Set Trading Preferences Configure your Trading Preferences
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now.



Step 4.



Print and sign the Auto-Trading User Agreement Access the Auto-Trading User Agreement from the main Help menu.



Step 5.



Consider Contingencies Do you have a plan ... ... your strategy becomes out of synch 186 with your Live account? ... if your computer memory fails? ... if your ISP loses a principal connection to the internet? ... if a power outage occurs at your trading station? ... etc. These few examples highlight that software is only one of the essential components for trading. Everyone has their own worst-case scenario; please plan carefully for yours.
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12.11 Orders FAQs How are orders canceled and replaced in real-time? Unexecuted orders are canceled on subsequent bars if the strategy does not continue to repeat the order. This is exactly the way it's done in backtesting, so you don't have to make any adjustments in your strategy for this to occur in real time. Changes in a stop or limit price will also cause the previous stop or limit order to be canceled before the new order is placed. In the case of live trading, Wealth-Lab Pro employs the Cancel and Replace method, which is handled by Fidelity's backend trading subsystem. How does Wealth-Lab execute orders "between" bars? Regardless of scale (Daily, Intraday, etc), Wealth-Lab processes strategies using complete end-of-bar data. A strategy that generates AtMarket orders can be placed (with minimal delay) to execute immediately at the open of the next bar, i.e., bar + 1. Likewise, strategies also place AtStop/AtLimit orders at the open of the next bar, but generally speaking, the stop/limit activation price is not immediately marketable. This means that when the market reaches your stop/limit price the order will be executed, and this can occur at any time during the bar on which the order is active. Why did my Strategy become out-of-synch with my trading account? If you're trading a limit-order strategy, make sure that you disable limit-order slippage 234 . Even when disabled, the possibility exists for the market to trade precisely to a limit price without filling the live order. Strategies will always fill the limit order theoretically, and hence the possibility of an out-of-synch condition with reality. See the Portfolio Synch 186 discussion on Theoretical vs. Actual.
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Account Balances & Positions Designed to keep detailed trade histories of multiple portfolios, Wealth-Lab Pro's Account Balances and Positions tool, or simply Accounts, automatically tracks trades placed through the Orders tool 179 . Accounts and Orders work together to keep your account's equity holdings synchronized with those in your Fidelity account.



How to: Open the Account Balances & Positions tool (Ctrl+Alt+T) 1. Log in to Fidelity 2. From the main menu select Tools > Accounts (Ctrl+Alt+T), or, click Accounts in the Navigation toolbar 289 . Although you can open many main Workspaces, only a single Accounts window can be active. Attempting to launch a second Accounts window will automatically shift focus to the first active Accounts tool in another Workspace. It is not possible to place cash trades with a margin account using Wealth-Lab Pro. Cash positions that exist in a margin account (traded via Active Trader Pro® or fidelity.com) will not appear in Wealth-Lab's Accounts tool.
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Balances View The Balances View displays the account balances for Available Cash, Buying Power, Positions Value and Positions Profit in your Fidelity account. Buying power is updated as trades are placed, canceled or executed. Streaming Updates When the Streaming Updates button is selected during market hours, the Positions Value and Positions Profit/Loss fields are updated in real-time. Update Provides snapshot updates of Account Balances. Configure Accounts Add, delete, and otherwise configure Paper accounts. Log in to Fidelity is required to configure accounts.
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Positions View An account's current equity holdings can be found in the Positions view. The Positions view will reflect up-to-date open Positions (and their actual gain/loss) held in your Fidelity account for both margin and cash positions. Enabling the Streaming Updates button provides a real-time view of position profit or loss based on the trade's entry price. As with other lists in Wealth-Lab, click on the column headings to sort the list. For Fidelity accounts, the fields for Market Value, Profit, etc. are updated automatically when connected to Fidelity. Listed items will have a green or red Profit and % Profit field, based on being "in the black" or "in the red", respectively. Position Long or Short for securities. Account The Fidelity account in which the Position is held. Symbol The security's (or FCASH) symbol. Quantity The number of shares, or that have been secured for the Position. Cost Basis Cost basis of the Position, calculated from the trade entry or wash sale-adjusted price plus commissions. Last Price When not connected, Wealth-Lab Pro will update the Last Close automatically during a manual or scheduled update. Market Value The dollar value of the Position based on the last price. Trade Type Identifies the Position as Cash, Margin, or Short in a live account. Trade Type is always "blank" for Paper Accounts. Profit The absolute dollar profit/loss for the Position. The list item's Market Value is green for winning Positions and red for losing Positions. % Profit The percentage profit with respect to the entry price. Dollar and % Profit may not be available on the day of the trade entry (N/A).



© 2017 FMR LLC All rights reserved.



Account Balances & Positions



13.3



204



Local Trade History View The Local Trading History is a historical record of each individual Account's trading activity. As with other lists in Wealth-Lab Pro, you may click on any column heading to sort the list. This is useful, for example, to view trades by Symbol. Action Buy, Sell, Short, or Cover for securities. Account The account in which the transaction occurred. Date/Time The local date and time at which the order was filled and entered into the Trade History. Quantity The number of shares, or contracts in case of a futures symbol, that were secured or sold for the Position. Symbol The security's symbol. Price Trade execution price. Trade Type Identifies the Position's Trade Type as Cash, Margin, or Short. Trade Type is always "blank" for Paper Accounts. Trade Type will be empty for Positions entered into in the Local Trade History prior to use of Version 6.0. Strategy The name of the Strategy from which the signal was generated Scale The selected Scale (timeframe) from which the signal was generated. Intraday scales can be any number of minutes.
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Preferences The Preferences Dialog allows you to control and personalize default settings in WealthLab Pro. Open the Options Dialog by pressing the F12 function key, by selecting Preferences from the Tools menu, or by clicking the Preferences button on the far right side of the Navigation toolbar. The Preferences dialog is divided into a number of functional tabs.



Preferences dialog showing Chart Colors and Styles group.



Each Windows user has only one set of Wealth-Lab Preferences. Changes to Preferences affect all open Workspaces.
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Chart Colors and Styles Customize your Wealth-Lab charts' colors, fonts, and display of gridlines and tooltips using the preference selections on this page. Apply Chart Colors and Style changes to all open Charts By default, changes to Chart Colors and Styles preferences will be applied to all open charts. To prevent this from occurring, uncheck this option in the lower left corner of the dialog.



Chart Colors Background The color of the chart background. Tip: See SetBackgroundColor() to dynamically control the chart background color in your script. Up Bars The default color for price bars whose Close is greater than the Open. Down Bars The default color for price bars whose Close is less than or equal to the Open. Tip: You can override the Up/Down color defaults using SetBarColor() or SetBarColors() in your script. Right / Bottom Margin The color of the right margin (y-axis, price display) and bottom margin (x-axis, date display) of the chart.. Gridlines The color of x- and y-axis gridlines on the chart. Volume Up / Volume Down The color of the volume histogram corresponding to Up/Down bars as defined above. Tip: Volume and the Volume Pane can be removed from the chart with the HideVolume() method in your script. Pane Separator The color of the line that separates the Price, Volume, and/or custom chart panes. Tip: Pane lines can be hidden completely with the HidePaneLines() method in your script.



Chart Options Horizontal and vertical grid line spacing is controlled automatically. Horizontal lines are © 2017 FMR LLC All rights reserved.
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drawn at the major grid points along the Y-axis, and vertical lines are generally drawn every 5 to 20 bars depending on the time frame and bar spacing selected. Horizontal Gridlines Enables horizontal grid lines for display. Vertical Gridlines Enables vertical grid lines for display. For intraday charting, a double-thick vertical grid line is drawn on the first bar of the day. Pane Separator Lines



Enables vertical grid lines for display. For intraday charting, a double-thick vertical grid line is drawn on the first bar of the day.



ToolTips Prices Enables the pop-up display of the OHLC/V and change-from-previous-bar summary box when hovering the mouse pointer over the bars for the primary chart symbol in the price pane. Indicators Enables the pop-up display of the indicator's description and value when hovering the mouse pointer over an indicator (including fundamental data items) plotted in any pane. For histograms, point to the extremes of the bars for the tooltip. Indicator Tooltips are required in order to interact with drag and drop indicators. Fundamental Items Enables the pop-up display of 1) fundamental information when hovering the mouse pointer over fundamental data icons, including split and dividend icons, and, 2) trade rollover data.



© 2017 FMR LLC All rights reserved.



Preferences



208



1) Fundamental Item tooltip



Fundamental items are selectively available by clicking the Show selected Fundamental Data Items on Chart button in the Function Toolbar 290 . You can select which items are displayed from the Chart Annotations 209 Preferences.



2) Trade rollover tooltip



Chart Fonts Axis & Margins The Axis and Margin font control also applies to the Data Series labels (if any) in all panes. Symbol & Co. Name If indicator labels are selected for display in the Function Toolbar 290 , the symbol and company name are displayed in the upper left corner of the Price pane.
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Chart Annotations By default, dividend and split items are selected for display for Fidelity DataSets. You can choose additional fundamental items from list of Available Items (or deselect them) by clicking on an item and then the appropriate arrow button. Multiple icons are "stacked" above the bar to which they apply. If many fundamental items that correspond to the same data are selected, the chart scaling will be adversely affected in order to display all of the items.



To obtain the underlying information, hover the mouse pointer over an annotation.



Your installation includes the following Chart annotations, but more may be added depending upon installed static and fundamental data provider(s): Fidelity Static and Fundamental Providers Split Dividend Fundamental data Economic data Earnings per share Earnings estimate Equity Summary Score and Category Insider Buy, Sell, Net Transactions Short Interest Yahoo! Provider Split Dividend Apply Chart Colors and Style changes to all open Charts By default, changes to Chart Colors and Styles preferences will be applied to all open charts. To prevent this from occurring, uncheck this option in the lower left corner of the dialog.
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Streaming Data Streaming Data Provider Streaming data is used for Streaming chart windows and for Quote windows. If you require multiple streaming providers for the same Wealth-Lab session, choose the provider to use before opening the windows, however, this is not currently recommended and the configuration cannot be saved with Workspaces.



Streaming Ticker Symbols Add the tickers, separated by commas, to display in Wealth-Lab's status bar when streaming is activated. Streaming tickers are displayed when streaming is activated for a Chart window or if a Quotes tool is receiving quotes.



Toggle streaming on/off for ticker by clicking the 'abc' icon.



Bad Tick Filter Enable Bad Tick Filter Enables real-time filtering of "bad ticks" from the Fidelity Wealth-Lab Pro streaming feed. A tick that varies more than the Bad Tick Threshold percentage from the previouslyreceived tick will be ignored and not incorporated into the Streaming chart data. This option works in real time only and does not apply to the historic back-fill portion of a real-time chart.
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Performance Visualizers Performance Visualizers show up as tabs on Strategy windows after executing a strategy backtest. Visualizers portray the performance of the Strategy in different ways such as with tabular data and graphs.



Performance Visualizer tabs are displayed after completing a backtest.



Visualizer Name A unique, descriptive name for each visualizer. Applies to Whether or not a selected visualizer is displayed may depend on the strategy testing mode as follows: Portfolio Simulation These Visualizer are available only when running a simulation in Portfolio Simulation mode 326 , and consequently is not displayed for Raw Profit mode 327 simulations. Multi Symbol These Visualizers are displayed for Multi-Symbol Backtests or for strategies that explicitly execute trades on other than the "clicked symbol" following a call to SetContext. Combination Strategies Applies (currently) only to the By Strategy



217



Visualizer.



All Backtests These Visualizers are displayed in the Strategy window for all backtests in any mode. Move Up/Move Down The top-to-bottom order in which the Visualizers are displayed here determine the left-toright order in which they appear within a Strategy window. Use these buttons to customize the display order. For Performance Visualizers, the Apply button simply stores new settings without closing the Preferences dialog. Any changes are applied only to newlyopened Strategy windows.
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14.4.1 Performance The Performance Visualizer provides a detailed report of the trading system's performance statistics that describe the results of the Strategy. A list of performance metrics is presented in the first column on the left. Each metric is reported for All Trades (Long and Short), Long Only, Short Only, as well as for the Buy & Hold strategy. Long/Short Trades Columns Long and Short Trades hypothetically reflect the results as if you traded the strategy only long or short. For example, assume that your system trades only long positions and you apply a 5% rate of interest for cash to a 1-year simulation with $100,000 starting equity. The All Trades column show the metrics for all trading, which in this case will match the 'Long Only' column. Since the system does not trade any short positions, you should expect to see that you were paid 5% interest for 1 year in the 'Short Only' column. Consequently, the 'Short Only' part of this strategy (stay in cash) earned a Net Profit of $5,000.



Strategy Selector Applies to: Combination Strategies Several Visualizers, like the Performance report, include a Strategy Selector for Combination Strategies. The selector allows you to view the metrics for the overall strategy as well as the those for the contributions of each of the child strategies. Be patient when switching views. For a quick overview of key metrics for each of the child strategies, use the By Strategy 217 Visualizer.



Strategy Selector for Combination Strategies



Performance Metrics The set of metrics presented depend on the mode selected for backtest: Portfolio Simulation Mode or Raw Profit Mode. Unless otherwise specified, performance measures apply to both modes.



Starting Capital Applies to: Portfolio Simulation Mode The amount of starting capital (cash) selected for the backtest. Ending Capital
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The amount of capital including the closing value of open Positions at the end of the backtest. Net Profit The total dollar profit generated. This is the sum of the net profits, reduced by commissions 228 and slippage 233 , for each trade generated by the system. Note that in Raw Profit mode, by using a fixed position size for each trade you can more fairly compare the strategy's performance with that of Buy & Hold. Net Profit % Applies to: Portfolio Simulation Mode Total Net Profit expressed as a percentage of Starting Capital. Profit per Bar Applies to: Raw Profit Mode The total net profit divided by the total number of bars of exposure. Note that for systems that average down and open multiple positions the total bars held may actually be higher than the total number of bars in the chart. Profit per Bar provides a fair comparison to the Buy & Hold strategy, and gives us an idea of the efficiency of the trading system. Even though a system doesn't beat Buy & Hold in terms of net profit, if it has a higher Profit per Bar we can say that it's more efficient than Buy & Hold. We can exploit this efficiency by applying more aggressive Position sizing techniques in Portfolio Simulation Mode to increase actual profit. Annualized Gain % (Annual Percentage Applies to: Portfolio Simulation Mode Return, APR) Annualized Gain % is the Compounded Annual Growth Rate, or CAGR. CAGR provides a smoothed average rate of return as if the starting equity were compounded annually. In Wealth-Lab Pro, this is also referred to as APR, or Annual Percentage Return.



CAGR



FV PV



1 n



1,



where n is the number of annual periods, and, FV and PV represent the future and present values of an investment, respectively. Exposure (%) Applies to: Portfolio Simulation Mode The total market exposure of the trading strategy calculated on a bar by bar basis. The Exposure metric measures the area of portfolio equity that was exposed to the market. For example, say you have $100,000 and buy $25,000 worth of stock at the beginning of a simulation. If the prices of your purchases never change, you would have a flat equity line at $100K (assuming 0% interest on free cash) and an "exposed" line $25K. Notice that this forms a rectangle within a rectangle, and therefore exposure is 25%, which is the percentage of the equity curve exposed to the market. Total Commission Related: Commissions (Preferences) The total dollar amount of commissions paid for simulated trade executions. Return on Cash



228



Applies to: Portfolio Simulation Mode
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The total amount of interest earned on free cash during the backtest period. See: Backtest Settings Preferences 230 When backtesting a single security in Portfolio Simulation mode without sizing for high exposure, be careful to note how much of the Portfolio return is attributed to cash interest and not from the trading Strategy. Margin Interest Paid Applies to: Portfolio Simulation Mode The total amount of interest paid for margin loans during the backtest period. See: Backtest Settings Preferences 230 Dividends Received (Paid) Applies to: Portfolio Simulation Mode The total dollar amount of cash dividends received during the backtest period. See: Backtest Settings Preferences 230



Number of Trades The total number of round-trip trades plus open positions. For Buy & Hold, this will equal the number of symbols in the DataSet that was selected for the backtest. Results in this section include interest on unused cash. Avg Profit (Loss) The average profit (loss) per trade less commissions
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and slippage



Avg Profit % (Loss %) The average percentage profit (loss) per trade less commissions
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Avg Bars Held The average number of bars held per trade. Winning Trades and Losing Trades Breakdown The performance summary next breaks the trades down into winners and losers (a trade is marked a winner if its return after costs is above zero), and presents the same metrics as the previous section, plus the following: Win (Loss) Rate The percentage of all trades that were marked winners (losers) as defined in the previous paragraph. Gross Profit (Loss) The total profit generated by the winning trades, and the total loss generated by the losing trades, minus commissions and slippage. Open trades are not included in gross profit. Max Consecutive The maximum number of consecutive winners and losers generated.
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The Bottom Line The bottom of the performance view lists a number of general system performance stats: Max Drawdown Max Drawdown is the largest peak to valley dollar decline in the system's Equity Curve. Wealth-Lab reports Drawdown on a closing price basis. Max Drawdown Date Date on which the Max[[Dollar] Drawdown was realized. Max Drawdown % Applies to: Portfolio Simulation Mode Max Drawdown % is the largest peak to valley percentage decline in the system's Equity Curve on a closing price basis. Max Drawdown % Date Applies to: Portfolio Simulation Mode Date on which the Max Drawdown % was realized. The date on which the Max Drawdown % occurred is not necessarily the same as the Max [Dollar] Drawdown Date. This is especially the case for highly-profitable simulations. Wealth-Lab Score Applies to: Portfolio Simulation Mode The Wealth-Lab Score metric is one of the measures used to rank systems on the WealthLab.com web site. The goal of the Wealth-Lab Score is to arrive at a single metric that encompasses profitability, exposure (efficiency) and risk. Wealth-Lab Score is annualized, consequently simulation results that span time periods of different lengths may be compared. In Wealth-Lab Pro, the Wealth-Lab Score is calculated by first finding the Annualized Risk Adjusted Return, which is simply the Annual Percentage Return, or APR, divided by percent Exposure. For profitable systems, the RAR is adjusted by multiplying the sum of 1 plus the Max Drawdown Percent (a negative number). Consequently, profitable but risky systems, which typically have periods with large drawdowns, will have a lower score than an equally profitable system that assumes less risk. In summary, the formula for Wealth-Lab Score is:



xRAR



APR Exposure



where xRAR is the annualized RAR. If xRAR is greater than 0 (profitable) then



WLScore = xRAR × ( 1 + MaxDrawDownPct ) For example, with an APR of 8.0, an Exposure of 25%, and a Max Drawdown of -15.0%, the Wealth-Lab Score is: ( 8.0 / 0.25 ) * ( 1 - 0.15 ) = 32 * 0.85 = 27.20
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Non-profitable systems result in a negative Wealth-Lab Score. The formula, which changes for negative RAR, more heavily penalizes non-profitable systems for their inability to overcome drawdown. Consequently, if xRAR is less than 0 (not profitable) then



WLScore = xRAR × ( 1 + Abs( MaxDrawDownPct ) ) Taking the same example with an APR of -8.0, we obtain a Wealth-Lab Score as follows: ( -8.0 / 0.25 ) * ( 1 + 0.15 ) = -32 * 1.15 = -36.80



Sharpe Ratio Applies to: Portfolio Simulation Mode The Sharpe Ratio is a way to measure the risk-adjusted return of an investment. Its ratio measures how much of an investment's return can be attributed to chance. A Sharpe Ratio value of above 1.0 is considered good, while a value above 2.0 is typically considered outstanding. The Sharpe Ratio calculation assumes a zero risk-free rate of return when the Apply interest rates 230 preference is disabled. Otherwise, the value for Return rate for uninvested cash is used as the risk-free return. The Sharpe Ratio is calculated by obtaining the average of monthly percentage equity returns generated by the system, as well as the standard deviation of those returns. The risk-free rate of return (0 if not applied) is subtracted from the average monthly return and then annualized by multiplying by 12. This result is divided by the standard deviation of the returns multiplied by Sqrt(12). Profit Factor Profit Factor is the system's Gross Profit divided by Gross Loss. Look for systems that have a Profit Factor of 2 or higher. If your strategy has only winning trades and no losing trades, then Profit Factor is Infinity. Recovery Factor Recovery Factor is equal to the absolute value of Net Profit divided by Max Drawdown. Recovery Factor should typically be larger than 1. A healthy Recovery Factor, especially one that is greater than that of Buy & Hold, indicates a strategy's ability to overcome a drawdown. Payoff Ratio Payoff Ratio is the system's average percentage profit per trade divided by the average percentage loss per trade. Unless the system has a particularly high Win/Loss ratio, we look for high Payoff Ratios.



Buy & Hold



See also: Benchmark Buy & Hold



232



Raw Profit Mode If Fixed Dollar is selected, the standard Buy & Hold strategy determines the number of shares by dividing the closing price of the first bar into the designated amount. (For futures, the futures margin setting is used instead of the first bar's close.) Otherwise, Buy & Hold simply uses the Shares/Contracts setting. In either case, Positions are taken at the opening price of the second bar.
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Portfolio Simulation Mode In this mode, Wealth-Lab takes equal dollar-sized Positions in each symbol of the DataSet at the start of the backtest period and holds them until the end of the period. Wealth-Lab uses real-world trading rules even for the Buy & Hold Strategy, which bases the size of the Positions on the closing value of the first bar of data (margin value for futures) and opens the Positions at the opening price of the next bar. Due to price gaps between the close and open of those bars, B&H Exposure is usually not exactly 100%, but is typically within 1% of 100%, assuming 1:1 margin. For large DataSets, the effect of the opening-trade commission can have a large effect on Buy & Hold Equity. Assuming $20-per-trade commissions, a 500-symbol DataSet will immediately drop the B&H Equity curve by $10,000. In cases such as this one, consider using the Benchmark Buy & Hold 232 feature. B&H Calculation Notes The Strategy window does not close B&H positions. Final profit is based on closing price of the last bar. Exit commission is not applied. Buy & Hold sizing never uses Round Lots
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.



Buy & Hold applies the margin setting. For example, with $100,000 Starting Equity and 2:1 margin, Positions are sized by dividing $200,000 by the number of symbols under test. For the S&P 100 DataSet, each symbol would be allocated $2,000. If only one symbol were selected for backtest, or if using the Benchmark Buy & Hold 232 feature, the full $200,000 is used to purchase that benchmark. Applying dividends 230 has a large effect on B&H Exposure. Dividends increase the value of the B&H equity curve, but since they're not reinvested into Positions, exposure decreases.



14.4.2 By Strategy The By Strategy Visualizer provides a quick overview of key metrics for each of the child strategies in a Combination Strategy. The subset of metrics includes: Strategy Name Profit Buy & Hold Profit Per Bar Buy & Hold Profit Per Bar Trades % Winners Avg Bars Held For definitions, see Performance
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14.4.3 By Symbol The By Symbol visualizer breaks down a subset of performance statistics for each Symbol traded during the backtest with side-to-side profit comparisons to the Buy and Hold strategy. The visualizer is displayed only for Multi-Symbol Backtests or for strategies that explicitly trade multiple symbols following the use of SetContext. The following metrics are available and are described in the Performance
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topic.
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Profit 213 Buy & Hold Profit Profit per Bar 213 B&H per Bar Trades 214 Pct Winners 214 Avg Bars Held 214 Other Data Series The final value of each DataSeries created by the strategy is automatically displayed in the rightmost columns with the following exceptions: DataSeries created by the new operator must be explicitly added to the Bars.Cache for its final value to be displayed. // This will automatically appear... DataSeries sma = SMA.Series(Close, 21); // ... but this will not... SMA sma2 = new SMA(Close, 50, "SMA(Close,50)"); // ... without adding it to the Bars.Cache: Bars.Cache.Add(sma2.Description, sma2);



For scaled and compressed DataSeries values to appear, you must manually add a reference to a synchronized version of their DataSeries to the primary Bars cache as the following snippet demonstrates. SetScaleCompressed(30); DataSeries rsi = RSI.Series(Close, 14); RestoreScale(); rsi = Synchronize(rsi); Bars.Cache.Add(rsi.Description, rsi);



// extra step



14.4.4 Trades The Trades View displays a list of all of the trades (Positions) generated by the Strategy and a set of details and performance metrics for each trade. Tip: Sort the list by clicking on a column heading, or double click to zero in on a particular trade on the chart. Double-click action Double click a trade to show it in the Chart view. You can use this action to review trades in the chart after performing a Multi-Symbol Backtest (MSB) without re-executing the Strategy on the selected symbol. In this way, trades for the selected symbol are in the context of the MSB, which may have rejected some trades due to money management rules in Portfolio Simulation mode. See Multi-Symbol Backtest 119 . The following metrics are described in the Performance Raw Profit and Portfolio Simulation modes. © 2017 FMR LLC All rights reserved.
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Position Long or Short. The Position column is also flagged with the same Position icons in the Chart view. The symbols for closed Positions are filled in, while the symbols for open Positions are hollow. Strategy Applies to: Combination Strategy Contains the symbol that the Position was taken in. Symbol Contains the symbol that the Position was taken in. Qty The number of shares or contracts in the Position. Entry/Exit Date The dates that the Position was opened and closed. A time will also be displayed for backtests on DataSets that contain intraday data. Entry/Exit Price The price at which the Position was opened and closed. Profit % The percentage profit of the trade, less commissions
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and slippage



Profit $ The total net profit generated by the trade, less commissions
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Bars Held The number of bars that the trade was held. Both the entry and exit bars count in "Bars Held". For example, a Position that's exited on the next bar after entry is considered to have been held for 2 bars - instead of 1, like in Wealth-Lab Version 4. The new method gives the performance report the most pessimistic "profit per bar" rating possible. Profit per Bar The trade's total profit divided by bars held. Profit per Bar measures the efficiency of the trade. Entry Signal/Exit Signal The names of the entry and exit signals that were supplied by the entry/exit functions in your WealthScript code. You can give trading signals different names to track the performance of different types of entry and exit strategies in the same script, for example. MAE % The Maximum Adverse Excursion percentage of the trade. MAE is the largest intraday loss that the trade has suffered during its lifetime. MFE % The Maximum Favorable Excursion percentage of the trade. MFE measures the highest © 2017 FMR LLC All rights reserved.
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intraday profit that the trade gained within its lifetime.



14.4.5 Equity Curve The equity curve portrays the Strategy's performance over the historical backtesting period, optionally compared to Buy and Hold. In Portfolio Simulations, the amount of exposure taken by the Strategy is also represented.



Equity curve showing a backtest with $100,000 Starting Capital. The light green area indicates the Equity value of Positions and therefore shows the exposure on a historical basis.



Strategy Selector Applies to: Combination Strategy Using the Strategy Selector, you can view Equity curves for the aggregate strategy as well as the contributions from each of the child strategies individually. Be patient when switching views. The Equity Curve graph contains the following components: Account Equity Account Equity is portrayed as the solid green area of the graph. Equity changes over time as trading-system Positions gain or lose value. The Account Equity area itself is divided into a Cash Position (dark green) and a Market Position (light green). Dividing the Equity into Cash and Market levels lets you see at a glance the history of your strategy's market exposure.
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Buy & Hold Equity See also: Benchmark Buy & Hold 232 The Buy & Hold Equity is represented as a blue line. The line is calculated by taking equal dollar-sized Positions in each symbol of the DataSet at the beginning of the simulation period and holding them until the end of the backtest period. The Strategy Window uses real-world rules for the Buy & Hold Positions by basing their size on the closing value of the first bar of data (bar #0) and activating the Position at the opening price of the next bar. For futures the n Because of this you'll notice that Buy & Hold Exposure is usually never exactly 100%, but is typically within 1% of 100%, assuming 1:1 margin. For more information, see Performance > Buy & Hold
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Long and Short Equity Lines The Long and Short Equity lines (black and red lines) show the Account Equity for the long and short sides of the strategy, respectively. For example, in the image above, the strategy creates both long and short Positions. The black line shows the strategy's equity curve as if it had traded only long Positions, and likewise for the red line and short Positions. Exploring the Equity Curve You can zoom into any area of the Equity Curve by dragging a box (upper left to lower right) around the area with your mouse. While zoomed in, use the right mouse button (click and drag) to navigate within the enlarged Equity Curve graph. To return the Equity Curve to its normal size and position, draw a reverse box with the left mouse button by starting at the lower right corner and dragging to the upper left corner. By right clicking and dragging, you can manually center the graph. In addition, hovering the mouse pointer over a curve will display its date and precise dollar value.



14.4.6 Profit Distribution The Profit Distribution histogram provides a good overall illustration of your system's dynamics. The graph illustrates the percentage profit distribution of all of the trades that were generated by the strategy. Profits include all trading costs (commissions and slippage). Net profits of the trades are divided into a number of evenly-distributed bins. Each bar on the graph contains a number of trades whose profit falls within the upper bounds of the bin. For example, imagine that the bins are spaced apart by 5% each. The bin labeled 10% contains 20 trades. This means that 20 trades had a net profit between 5 and 10%.
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Use the right click menu to toggle between Dollar and Percent views.



14.4.7 Drawdown The Drawdown visualizer presents two different ways of analyzing equity Drawdown. Strategy Drawdown Curve (Underwater Equity Curve) The Underwater Equity Curve displays equity Drawdown on a walk-forward basis. This means that the percentage of drawdown is with respect to maximum equity achieved up to that point in time. As in the Profit Distribution view 221 , you have the choice of displaying your data in percentage (default) or dollar representations using the right click menu. The depth of the current Drawdown is displayed on a bar by bar basis, covering the complete period of the historical simulation. You can quickly identify the periods of deepest and longest Drawdown. For backtest periods involving a large number of bars, it may not be possible to display the exact drawdown for each bar due to screen rendering errors. For exact value of Max Drawdown, refer to the tabular data in the Performance 212 report. Number of Bars since Last Equity High This graph displays the number of bars since a new equity high was achieved. This can give you an idea of how long you may have to wait to recover from drawdowns in your account when trading the strategy. Strategy Selector Applies to: Combination Strategy Using the Strategy Selector, you can view Equity curves for the aggregate strategy as well as the contributions from each of the child strategies individually. Be patient when switching views.



14.4.8 MAE / MFE MAE stands for Maximum Adverse Excursion, and represents the largest intraday loss that a trade suffered within its lifetime. MFE is Maximum Favorable Excursion, and is the largest intraday profit that a trade achieved during its life. The graphs show you the MAE/MFE breakdowns for all trades generated by the Strategy. As in the Profit Distribution view 221 , you have the choice of displaying your data in percentage (default) © 2017 FMR LLC All rights reserved.
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or dollar representations using the right click menu. MAE Graph The MAE graph displays a breakdown for all trades, and another for winning trades only. Use this in combination with the Profit Distribution 221 to help set appropriate stop loss levels. The Profit graph will show you the potential losses that could be capped by setting a stop loss, and the MAE graph will show you how many potential winning trades would be converted to losers if the stop loss was placed. MFE Graph The MFE graph displays two breakdowns also. It shows MFE for all trades, and also for losing trades only. Use this in combination with the Profit Distribution 221 graph to help determine effective profit target levels. The Profit graph will tell you how much profit you're likely to lose by capping it with a profit target. The MFE graph can show you how many losing trades could have been converted to winners by establishing a profit target at a certain level.



14.4.9 By Period The By Period visualizer allows you to see the strategy performance broken down by day, week, month, quarter, or year. By Period returns are simply the account's equity value on the last day of the period minus the value on the last day of the previous period. Consequently, the return value is calculated by the change in the equity curve, not by the sum of exits in the specified period. As in the Profit Distribution view 221 , you have the choice of displaying your data in percentage (default) or dollar representations using the right click menu. After selecting a period, it could take several seconds for Wealth-Lab to compile and display By Period returns. For large simulations, be patient. By Period returns are not available after running a backtest in Raw Profit Mode. Average Return The average percentage return for the specified period. For example, if you select Monthly, the percentage return by month is calculated and its average value is reported here. Std Deviation of Returns The standard deviation of the individual percentage returns. Sharpe Ratio Sharpe Ratio measures how much of an investment's gains can be attributed to the trading system and how much to chance. A value above 1 is considered good, and a value above 2 is typically considered outstanding. Please refer to its description in the Performance 216 topic. Best/Worst Return These values indicate the best and worst returns recorded during the simulation period on a by-period basis. Total Periods The total number of periods (months, years, etc.) used in the analysis.
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Profitable Periods The total number of profitable periods, and the percentage of periods that were profitable, are reported here. Max Consecutive The maximum number of consecutive profitable and unprofitable periods are reported here. Graphs (click on the tabs) Raw Returns This graph displays the individual percentage returns on a by-period basis. Distribution of Returns This graph displays a distribution of percentage returns on a by-period basis. Detailed List of Returns The list of returns contains the starting date of each period, the dollar return and the percentage return. It also displays the maximum percentage drawdown on a walk-forward basis, the total market exposure, and the number of trades (entry and exit counted separately) that occurred during each period. Tip: Sort the list by clicking on a column heading.



14.4.10 Heat Map The Heat Map is a mosaic view of system performance by symbol or by trade, depending on the type of backtest - Multi Symbol or Single Symbol mode, respectively.



Heat Map for a Multi-Symbol Backtest.



Colors The Heat Map color codes Average Profit % (by symbol in a MSB) or Profit % (by trade for a single symbol). You can change the Profit and Loss colors by clicking the color picker. The Color Key is variable and dependent on the range of Profit and Loss values in the
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backtest. Change View While the color always represents Profit/Loss, the size of the polygon is determined by the view and type of backtest. The table below indicates what the size of a polygon is proportional to. Backtest type: Multi symbol Selected View



One symbol



Profit/Loss



Average Profit % by symbol



Profit % by Trade



Trades (or Trade Size)



Number of trades by symbol



Dollar size of trade



Search Symbol To find the polygon for a specific symbol in a Multi-Symbol Backtest, enter the symbol and click Search. Hover the mouse over a polygon for a tooltip popup with the textual information represented by the size and color.



14.4.11 Monte Carlo See chapter: Monte Carlo-Lab
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14.4.12 Analysis Series How do I obtain the Analysis Series Visualizer? Analysis Series is available by downloading/installing the Extra Performance Visualizers pack via the Extension Manager. 1. Make sure you're connected to the internet. 2. Click Tools > Extension Manager 3. If you've already installed Extra Performance Visualizers, which also includes the Analysis Series Visualizer, just update it and skip to Step 5. 4. Showing Fidelity Supported Extensions, select either Addins or Installs in the toolbar, locate Extra Performance Visualizers. Click the Install Now button. 5. Click the Restart button to complete the installation. 6. Following the restart, select Analysis Series as one of the Visualizer Preferences (F12). Use the Analysis Series Visualizer to experiment with indicator filters to find how they would have affected the performance of your trading strategy. Analysis Series compares the indicator or series that you select with the net profit of the trades generated by your strategy. For example, you could see if applying a filter based on RSI or CMO would have improved the average profit per trade. You can analyze most all indicator series in a single strategy. It will work in Raw Profit and Portfolio Simulation mode alike. Analysis Series takes all data series created by your strategy from the special Bars.Cache property (see note below). This allows you to use Analysis Series on-the-fly, even with Rule-based strategies.
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Analysis Series is not available for (or applicable to) Combination Strategies. Interpreting the Results After executing the Strategy, the Analysis Series view will contain two graphs. The first graph is a plot of the analyzed indicator value by net profit. Each dot of the graph represents a single trade. The graph contains a linear regression line that allows you to quickly identify the slope of the correlation. The strength of the correlation is also provided at the top of the chart, where +1.0 (-1.0) represents a perfectly positive (negative) correlation. The second graph depicts the average percent profit of the trading system if different levels of filtering were applied. For example, you might expect that if the system was filtered by increasingly lower values of RSI then you would see a steady increase in average profit per trade. Mouse over the histogram bin to see the net profit % value and the bin threshold. The histogram bin color varies depending on profitability: blue for a profitable histogram bin value and red for a loss.



Analysis Series Controls Above the two graphs are tools that let you control the output of the Analysis Series view. Analysis Series This drop down list contains all of the indicators or custom series created by your Strategy. Just select one of the items to regenerate the graphs. There will be one entry for each data series present in Bars.Cache. Because DataSeries can be generated in runtime, the DataSeries dropdown list is cleared after re-running the backtest. Due to Wealth-Lab's use of internal descriptions to identify indicators in cache, there could be duplicating series. A good example is WilderMA(TrueRange) and ATR, which are precisely the same thing. To analyze scaled and compressed DataSeries, you must manually add a reference to a synchronized version of their DataSeries to the primary Bars cache as the following snippet demonstrates. SetScaleCompressed(30); DataSeries rsi = RSI.Series(Close, 14); RestoreScale(); rsi = Synchronize(rsi); Bars.Cache.Add(rsi.Description, rsi);



// extra step



Analysis Bar This specifies at which bar the analysis will take place. You can specify the bar before entry and the bar of entry. The most useful Analysis Bar is the bar before entry, because this is typically the bar in which the entry signal was generated. The only time the actual entry bar might be useful is when your system enters on "AtClose", and thus has a more or less complete picture of the bar's composition when making the entry decision.
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Filter Type The Filter Type control determines the type of filter applied in the lower graph. You can select a greater than or a less than filter. Unless you select some Analysis Bar and/or Filter Type, the visualizer defaults to "EntryBar-1" and "Greater Than". The lower graph shows profit on the y-axis, and the x-axis is contains the Analysis DataSeries values divided into bins. Greater than averages the Profit from trades whose DataSeries value on the Analysis Bar was greater than the bin value. Consequently, greater than's leftmost bin contains the average profit from [virtually] all trade samples, whereas the rightmost bin's average value will contain only a few (or fewer) samples. Conversely, Less than averages the Profit from trades whose DataSeries value on the Analysis Bar are less than the bin value, and in this case the rightmost bin's average is derived from all trade samples. Percentage/dollar Ability to toggle to dollar amounts from percentages is helpful when backtesting futures instruments, where the percentage changes are not as useful as the dollar changes, especially if the prices go negative. This option can help evaluating results of a futures system. Because of the different leverage, a 1% move in Sugar can be quite different from a 1% move in Crude Oil in dollar terms.



Can't find a DataSeries in the list? To help find an indicator, the associated .Description property of the data series will be displayed on the graph's title if it was assigned in your code. Assign meaningful description to the data series you'd like to analyze if you have trouble finding it in the list. By design, a call to Bars.Cache.Clear in your Strategy code will clear all DataSeries from the cache. In order to make use of Analysis Series, do not use it. Analysis Series has limited applicability (if any) to some types of Strategies and indicators: 1. Strategies that generate DataSeries on-the-fly, such as "Dynamic Breakout System". (In order for a DataSeries to be selectable, they must be added to the Bars.Cache, which you can accomplish in the Strategy code.) 2. Symbol Rotation or other strategies that artificially use Single Symbol Mode for portfolio backtesting - not applicable.
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Commissions Commission preferences allow you to choose and test commission structures that can be applied to simulated trades. Wealth-Lab applies commissions to trades after script execution. Trading commissions are accessible during Performance Visualizer post-processing via the EntryCommission and ExitCommission properties of the Position object. Apply Commissions to simulated trades Check this option to enable the application of the selected commission structure to simulated trades during backtests and paper trading.



Select a Commission Structure Highlight the commission structure desired and check "Apply Commissions" to use it in subsequent backtests. Commission structures are programmable using the WealthLab.Commission class. When you launch Wealth-Lab, all available commission assemblies are detected and displayed here. See the WealthScript Programming Guide for more information.



Commission Settings Commission Structures that use custom user-defined settings will display a Commission Settings hyperlink (image), as for the "Per Share Commission" structure.



Customizing Commission Settings.
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Commission Description Provides a general description of the commission structure.



Test Commission Commission structures can be based only on the type of trade, number Shares (or contracts), order type, and the trade's execution price. Calculate a typical commission by configuring the controls and clicking the Calculate button.
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Backtest Settings Interest and Dividends Apply interest rates below when running a backtest using Portfolio Simulation mode Enables Portfolio Simulation mode backtests to earn interest on uninvested cash and to pay interest on margin loans. Enable margin from the Position Size control. Return rate for uninvested cash Enter an annual rate to earn interest on free cash during Portfolio Simulation mode backtests. For example, enter 3.5 for a 3.5% annual percentage rate. When this section is enabled, this return rate setting is used as the risk-free return for the Sharpe Ratio 216 calculation. Interest rate on margin loan amount Enter an annual rate to pay interest on cash borrowed to purchase equity during Portfolio Simulation mode backtests. For example, enter 4.25 for a 4.25% broker call rate.



Apply dividends to backtest results when using Portfolio Simulation mode Enables payment of dividends for backtests in Portfolio Simulation mode. The dropdown control for Dividend Fundamental Item lists all fundamental item names from installed providers; use it to choose a dividend source that represents split-adjusted, cash-pershare dividends. The Fidelity item is simply "dividend". To collect a dividend during a Portfolio Simulation mode backtest, the strategy must own shares at the close of the day prior to the dividend ex-date 324 . Likewise, if your simulation is short a stock that pays a dividend, then you pay the dividend, i.e., the simulated account's cash reserve is reduced by the dividend amount per share. Dividends are not reflected in the Trades View. In other words, although dividend payments have an effect on the overall portfolio, they are not captured on a per-trade basis. Dividend payments are applied to Buy & Hold results when this option is selected. Dividends are applied to hypothetical portfolio equity on the ex-date. Dividend payments may not appear in your live account for several weeks after the exdate. Important! When using dividend-adjusted data, do not apply dividends using this preference as the result would overstate the effect of dividends. For example, if the the Yahoo! Provider's "Perform Dividend Adjustment" option is selected, the effect of dividends is already accounted for in the data.
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Limit Days Simulation Prohibit trades in direction of market Applies to: Futures moves on Limit Days If this option is checked, trades are not taken in the same direction of limit moves for futures symbols. This option does not apply to intraday scales. Wealth-Lab uses rudimentary detection of a "locked limit" condition by testing equality between open, high, low, and closing prices. Use this option carefully for illiquid contracts.



Reduce Quantity based on Volume Limit a Position's Quantity to a Applies to: Raw Profit and Portfolio Percentage of the Bar's Volume Simulation modes When using this option, the trade quantity (shares or contracts) in backtests will be the lesser of a) the "expected" position size, and, b) the specified percentage of the trade's bar volume. The final quantity is subject to the Round Lots 234 preference. Example If your backtest trades 500 shares on a bar whose volume is 1000 shares, but you specified to limit trade volume to 15% of a bar's volume, then the Position will be 150 shares. However, if Round Lots were also selected, the Position would be 200 shares. Warning!



When using this option Wealth-Lab may reduce the filled size of the theoretical Position even though more shares or the entire size may be filled when trading live. When exiting the Position, Wealth-Lab will generate an alert with the reduced theoretical position size unless you enable the Trading Preference 240 , Exit Orders (Sell and Cover) should always exit the full Position currently held.



Worst-case Portfolio Simulation Use Worst Trades in Portfolio Simulation



Applies to: Portfolio Simulation mode



Background: When more trade entry signals than cash are available for a particular bar, Wealth-Lab chooses the Positions with the highest priority for backtests. Position.Priority is a random number unless you set the priority in the script. The "worst case" option overrides all Position priorities such that Positions that will have resulted in the least percentage gain are assigned the highest priorities. The result is often the most-pessimistic (conservative) Portfolio Simulation possible for the current backtest settings. The worst-case option functions on Profit %. A worst-case backtest will result on a cash Profit basis when using equal dollar sizing for each Position entered on the same bar.
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Benchmark Symbol Benchmark Buy & Hold



Applies to: All modes



As an alternative to the standard Buy & Hold methodology 216 , you can specify a single benchmark symbol, typically an index or mutual fund, for Buy & Hold comparison. Check the box to enable the benchmark method and specify the symbol, which may exist in any DataSet. Portfolio Simulation Benchmark Sizing Wealth-Lab uses fractional shares for the benchmark analysis. As usual, the number of shares is based on the Starting Capital divided by the basis price 127 , which is the closing value of the first bar of the chart. The benchmark Position is then established on the open of bar number 1. Raw Profit Benchmark Sizing As before, fractional benchmark shares are calculated for the Fixed Dollar size Raw Profit setting by dividing the specified size by the basis price. However, when Raw Profit Shares/Contracts are stipulated, the specified shares is also used as the benchmark size. A symbol with only daily data, such as a mutual fund, is acceptable for use as a benchmark for an intraday backtests.



Price rounding for orders Turn off limit/stop order rounding entirely



Applies to: Portfolio Simulation mode



By default, Wealth-Lab adjusts stop and limit trigger prices to a "tick" value not only for futures, but for stocks too. In some cases, the adjustment will cause a theoretical (backtest) order to fail that would otherwise have executed at full precision. This option stops Wealth-Lab from adjusting stop and limit prices to an instrument's tick value, and therefore will execute the orders at full decimal precision. Turning off stop/limit order rounding is not recommending for live trading. Order prices may not conform to order-precision requirements and may result in rejected orders. See also: Advanced Options > Decimals
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Slippage & Round Lots Slippage Settings Slippage control allows you to simulate less-than-perfect fills for your trades that can happen in the real world. When Slippage is enabled, the entry and exit prices of trades are adjusted slightly based on the amount of Slippage specified. Slippage will never cause entry or exit prices to be adjusted beyond the low/ high range of the bar. Stop orders are treated like market orders and therefore always executed if the stop trigger price is attained. Activate Slippage... Check this box to include the effects of slippage in your system performance results. Slippage adversely adjusts entry and exit prices for Market, Stop, and AtClose orders by the slippage amount based on the Percentage Slippage. Activate Slippage for Limit Orders... Warning!



Disable limit-order slippage for Live trading of strategies that use limit orders to enter positions.



By activating limit order slippage, slippage will be applied to Limit orders as well. In these cases, slippage doesn't adjust the entry or exit price of the orders (see Exception), but it does add the additional condition that price must have traded at least to the slippageadjusted price. If prices fail to trade to the adjusted price, the Limit order is not executed. This option makes the probability of limit order execution in backtesting more realistic because many competing limit orders in actual trading may prevent yours from being filled. Consequently, you can be more certain that your order would have been filled if price actually exceeded your limit price. Exception



If the limit price is exceeded on an opening gap, slippage will be applied to the opening price to obtain a new execution price to the extent allowed by the bar's range.



Exception Example Imagine that you're using 0.1% of slippage with a long position, and the market closes at 24.05. If you enter a limit order to lock in profits 24.50 and the market gaps open to 25.00, the trade will be executed at the greater of 24.75 (25.00 - (25.00 * 10 * 0.1%)) or the low of the bar. Usage Notes Limit Order Slippage is not compatible with zero-range bars, i.e., time-of-sales, or tick data. Since trade executions are enabled only for bars that achieve the slippage-adjusted price, and, execution price cannot be outside the bar's range, aberrations in execution price will result. When backtesting, the slippage-adjusted price will effectively serve as the limit order price.
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Whereas slippage applied to market orders will always penalize a trading system, Limit Order Slippage may actually keep your simulations from entering trades that ultimately would have resulted in losses (positive impact). Likewise, you may reject trades that would have been "winners" if Limit Order Slippage were not applied. For Equities This specifies how much Slippage to apply to the entry and the exit prices of Equities in percent terms. For Futures For futures, slippage is represented by the tick value of the corresponding contract, specified in the Symbol Info Manager 310 . Example The following example clarifies how Slippage settings modify entry and exit prices with respect to a long trade. Stocks: Slippage Setting = 0.50(%)



Futures: Slippage Setting = 5 Contract Tick Value = 0.25



Entry Price = $50; Exit Price = $60



Entry Price = $500; Exit Price = $510



Entry Slippage = $50 * 0.5% = 0.25 Adjusted Entry Price = $50.25 Exit Slippage = $60 * 0.5% = 0.30 Adjusted Exit Price = $59.70



Entry Slippage = 5 * 0.25 = $1.25 Adjusted Entry Price = $501.25 Exit Slippage = 5 * 0.25 = $1.25 Adjusted Exit Price = $508.75



Round Lots Round Lot options automatically adjust the sizes of stock Positions created by trading strategies and alerts to the nearest 100 shares. For example, if a Position were sized as 250 shares, rounding lots would automatically adjust the share size up to 300. Likewise, a Position sized as 249 shares would be set to 200 shares. Tip: The Round Lots options also affect Positions sized by a PosSizer. For the greatest control over position sizing with PosSizers, disable the Round Lots option and perform all sizing and rounding in your PosSizer. Round stock positions to nearest 100 shares Enable Round Lots by placing a check mark next to this option. Round Lots apply only to equity (stock) symbols. Round stock positions of < 50 shares up to 100 shares When Round Lots is enabled above, checking this option will cause a Position that is sized with fewer than 50 shares to be rounded up to 100 shares. Otherwise, Round Lots will
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round the shares to zero, resulting in a rejected or "skipped" trade. The < 50 option will not round shares up to 100 shares if you use a PosSizer to intentionally reject a trade by setting its size to 0.
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Sounds Sound preferences control when to play sounds and what sounds are played.



Alert and Trade Sounds You can change the program's sounds to use any local WAV file. To change a sound, click the ellipsis button next to the sound's path and pick a new WAV file to use. Sounds can be played when any of the following events occur: Alert Triggered from Quotes Plays the specified sound whenever a price hits its target threshold level in a Quotes window.



160



Alert Triggered from Strategy Window Plays the specified sound whenever an alert is triggered in a Strategy Window. This can be especially handy when using streaming data and following several markets at once.



Tip: When trading a stop or limit-order intraday strategy, you may want to hear an audible alert, but not for each new bar. For total control over producing sounds from the Strategy window, use the SoundPlayer in the System.Media namespace. Example (How to run Example code?



8



)



C# /* IMPORTANT! Disable 'Alert Triggered from Strategy Window' in Preferences|Sounds */ using System; using System.Collections.Generic; using System.Text; using System.Drawing; using WealthLab; using WealthLab.Indicators; using System.Media; namespace WealthLab.Strategies { public class MyStrategy : WealthScript { protected override void Execute() { SMA sma20 = SMA.Series( Close, 20 ); PlotSeries(PricePane, sma20, Color.Blue, WealthLab.LineStyle.Solid, 2 ); PlotStops(); for(int bar = 20; bar < Bars.Count; bar++) { if (IsLastPositionActive) { Position p = LastPosition; double ep = p.EntryPrice; if (!SellAtStop(bar + 1, p, ep * 0.95, "5% StopLoss"))
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SellAtLimit(bar + 1, p, ep * 1.08, "8% ProfitTarget"); // Sound exit alert only if the entry is the last bar in the chart if (p.EntryBar == Bars.Count - 1) { SoundPlayer sp = new SoundPlayer(); sp.SoundLocation = @"C:\Program Files\Fidelity Investments\Wealth-Lab Pro sp.Play(); }



} else { if (TurnUp(bar, sma20)) { BuyAtMarket(bar + 1); // Play the sound only for an Alert if (bar == Bars.Count - 1) { SoundPlayer sp = new SoundPlayer(); sp.SoundLocation = @"C:\Program Files\Fidelity Investments\Wealth-Lab P sp.Play(); } } } } } } }



Alert Triggered from Strategy Monitor An Alert triggered from any activated Strategy will cause this sound to be played. Wealth-Lab plays the sound only once for Multiple simultaneously Alerts. New Bar Arrival in Real-Time Strategy Plays a sound at the end of an interval when a new bar is added to a Strategy Window in Streaming mode. Strategies are automatically executed at this time, so it's possible to hear the sound for a triggered Alert immediately afterwards.



Other Sounds Chart interaction (Indicators and Drawing Objects) Changing Parameter Slider values
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Advanced Options Show the Home Page on Startup This option has no effect if you've Set a Default Workspace (Workspaces menu). Expand first DataSet in Tree on Startup Expands the first DataSet list in the Data Panel upon launching Wealth-Lab.



Strategy-Dependent Preferences When saving a strategy, the current configuration of the items listed below are saved in the strategy's xml file. Items that you check below are recalled and initialized upon opening the strategy. DataSet/Symbol Data Scale Data Range Position Size Parameter Slider Values These preferences apply to all strategies when selected. These settings are overridden when opening Strategy Windows a Workspace or launching a Strategy window from tools such as the Strategy Monitor or Rankings.



Orders-Related Open the Orders window when a Trade is Staged or Placed Launches the Orders tool (if closed) and places it in focus. The Orders tool may already be open in another Wealth-Lab Workspace, and this will cause the application focus to be shifted to that Workspace. Also, switch to view the Orders window for that Trade's Account The Orders tool provides a selector for which you can view trades for "All Accounts" or by a specified account. This option will automatically choose to display trades only for the account having the most-recent Place or Staged trade.



Printing Do not show print preview when printing reports By default a preview is displayed when you choose to Print a report, chart, or graph. To skip the preview, check this option. Do not show the print dialog when printing reports The printer's dialog is displayed so that you can customize your printer's settings for the © 2017 FMR LLC All rights reserved.
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final output. If you always print using the default printer's settings, it may be convenient for you to check this option.



Decimal Places Configure the number of default decimals places desired for viewing price and indicator digital information throughout Wealth-Lab. The number of decimals for symbols specified in the Symbol Info Manager 310 will override the Pricing Decimal default shown here when Futures Mode is enabled. For backtesting, Wealth-Lab adjusts prices to a "tick value". For U.S. stock markets, the tick value is generally thought to be 0.01 (2 decimal places) even though live trades may be executed at higher precision. To provide more precision for testing stocks that trade on various world exchanges, Wealth-Lab will use the number of decimal places specified here for the stock tick value. Advanced Options > Decimals Places do not apply to symbols that match expressions in the Symbol Info Manager (SIM), even when Futures Mode is disabled. In this case Wealth-Lab respects the SIM's Tick and Decimal settings. Example 1 An Alert has a BuyAtStop price of 17.0612307245525 at full precision, but when adjusted to the standard 2-decimal tick value, the order price becomes 17.07. It is adjusted higher (to ceiling) because BuyAtStop orders should trigger at or above the trigger price. If the same Alert were adjusted to a 3-decimal tick value, the order price becomes 17.062. Example 2 An Alert has a ShortAtStop price of 15.1587692754475 at full precision, and the price becomes 15.15 at two decimals. It is adjusted lower (to floor) because ShortAtStop orders should trigger at or below the trigger price. If the same Alert were adjusted to a 3-decimal tick value, the order price becomes 15.158. See also: Advanced Options > Price Rounding for Orders
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14.10 Trading Trading Preferences determine trade routing and other automated trading behavior for your Fidelity account. Important! Trading Alerts by Strategies using weekly, monthly, or larger scales are placed as Good Til Canceled (GTC).



Default Account The Default Account determines the account to which trades are directed by default. You can specify any one of your Live or Paper accounts as the default account. Log in to Fidelity to update the list. Direct Alerts to a predetermined account by associating Strategies to a specific brokerage or paper accounts. See the Set Account 305 function of the Strategy Explorer. Warning! Do not use the same Windows User login to trade accounts from more than one Social Security Number (SSN). If necessary, create a separate Windows login for each SSN, and run Wealth-Lab Pro in a separate Windows session for each user.



Trading Options Disable Portfolio Synch This preference removes the Portfolio Synchronization and therefore has the following effects:



186



logic for live and paper trading,



Exit alerts will be Auto-Staged/Placed even if a security is not owned in the account. Size for exit alerts that are Staged/Placed (auto or manual) will not be reduced automatically when the share quantity is greater than the number of shares owned in the account. Likewise, the "Exit Orders" preference (below) will be disabled and will not function. Fidelity's backend trading subsystem will respond with appropriate errors when exit orders and/or their size don't match Positions in your account. It might be advantageous to disable Portfolio Synch if, a) you're experiencing trouble with Auto-Staging/Placing Alerts, or, b) same-bar exit orders error out. Exit Orders (Sell and Cover) should always exit the full Position currently held on a per Trade Type basis This option overrides the Position size from Strategy exit alerts in favor of the number of shares actually held by the account. This option will cause Alerts that exit positions to be sized up to the number of shares of the symbol held in the account associated with the Strategy in use. If an account association does not exist, then the exit Alert is sized by number of shares of the symbol in your default account.
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Notes: 1. This option does not apply to trades entered by the manual Trade Ticket. 2. If you hold both cash and margin Positions for the same stock, Position shares are chosen by the exit order's Trade Type, Cash or Margin. 3. As part of the Portfolio Synch 186 functionality, orders are automatically sized down to the number of shares owned in the account, e.g., if your account owns 50 shares of ABC, any order to exit ABC with more than 50 shares will be sized down without regard to this option. Allow Same Bar Exits for Auto-Trading When this option is selected, upon receiving confirmation that the entry order Filled the Orders tool will activate entry-bar stop loss and/or profit target limit orders based on the values of RiskStopLevel and AutoProfitLevel assigned to the next Position in the Strategy code. This option is available for all scales. Following the entry bar, your code must include exit logic for stops and/or profit targets. Bracket-order strategies are acceptable. See the QuickRef for details and examples using RiskStopLevel and AutoProfitLevel. Though it's not strictly necessary, Auto-Trading should be enabled to promptly place the entry-bar stop and/or limit orders. Checklist for enabling stop and limit exits on the entry bar: 1. Strategy code requirements: For a stop loss on the entry bar assign a non-zero value to RiskStopLevel before generating the BuyAt or ShortAt signal. For a profit target on the entry bar, assign a non-zero value to AutoProfitLevel before generating the BuyAt or ShortAt signal. 2. In Trading Preferences, enable "Allow Same Bar Exits for Auto-Trading" 3. Enable Auto-Trading mode for the Orders tool. If you don't have Auto-Trading entitlements, you must click "Place" to submit all orders from the Orders queue, including the same-bar exit orders.



Trading Thresholds Check one or both options as required to inhibit automated orders from being placed if your real-time cash or buying power has depleted below levels that you specify. This option applies to manual and automated orders submitted through the Orders 179 tool. Enable Cash Threshold Enable Buying Power Threshold Warning!



Thresholds will not inhibit simultaneously-placed orders.



Example Assume current Buying Power (BP) is $30K and $10K BP Threshold is enabled. If the Orders tool receives two $25K orders simultaneously (on the same bar), both orders can be placed since buying power is sufficient to cover each trade
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14.11 Email Settings When you configure a Strategy tool to Auto-Email (send Alerts via Email), Wealth-Lab uses the settings that you enter here.



Email Properties Provide the SMTP Host and Port (25 is standard) properties for the SMTP server to use. Enter one or more Email addresses to receive Alert notifications. Multiple addresses must be separated by a semicolon (;) or a carriage return (new line).



Authentication Details Enter your Email account name and password if required for authentication. Check SSL to use the Secure Socket Layer protocol.



Test Mail Send Test Mail to ensure that you've configured the settings correctly. If the test message does not arrive: Double check the Email Properties and Authentication Details. Check your Email client's Junk Mail folder and Anti-Spam settings. Your SMTP server and/or anti-spam filters may filter some messages when sending dozens (or hundreds) of Email Alerts in a short period of time. If you plan to use Auto-Email in this manner, please configure accordingly.
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Extension Manager Extensions are plug-ins that that extend Wealth-Lab's features and capabilities. Examples of components that can be added as extensions include price and fundamental data providers, chart styles, performance visualizers, and strategy and indicator libraries. In conjunction with Wealth-Lab.com, Wealth-Lab Pro Version 6.9 makes it easy to find, install, and update extensions. There's no need to visit different sites and keep track of new releases. If you're searching for a data provider or a new application revision, you'll be able to install it with just a few clicks. Likewise, you can uninstall extensions that you don't find useful. For more details about the Extension Manager and available Extensions, please visit Extensions at Wealth-Lab.com.



Wealth-Lab Pro's built-in Extension Manager (EM) allows you to install, uninstall, update and get more information on installed extensions. To access the EM, click Tools > Extension Manager.



Extension Manager showing installed Fidelity Supported data provider extensions.
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Fidelity Supported The Extension Manager has two modes of operation: showing Fidelity Supported Extensions or Other Extensions. "Fidelity Supported" refers to extensions that, generally, are installed with Wealth-Lab Pro and can be supported by Fidelity phone support. When showing Fidelity Supported Extensions third-party extensions are not displayed. Addins, Providers, Strategies, Indicators In "Fidelity" mode, all available [Fidelity] extensions, installed or uninstalled are shown. By selecting the buttons in the toolbar (Addins, Providers, etc.) you'll find extensions grouped by category. Click in the area of an extension for more information on updates, change logs, or to install or uninstall an extension. Installs The Installs category groups Fidelity Supported extensions that are available for installation. Generally speaking, since Fidelity extensions are installed by default, this category will contain an item only on rare occasions. Updates Reviews all updates currently available for installed extensions. (Restart Wealth-Lab) After installing or updating an extension, you must restart Wealth-Lab for the installation to complete. You can restart using any method, but this handy restart button will close and re-launch Wealth-Lab in one click. After restarting, be ready to acknowledge a dialog describing the success of installing or uninstalling extension(s). (Options) By enabling Check for Updates on Program Start, the Extension Manager will automatically determine if updates exist for the extensions that you have installed when you launch Wealth-Lab (internet connection required).
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Other Extensions "Other" refers to any third-party extension or update to an extension that is not Fidelitysupported.



How to: Find Extensions Visit Extensions > Get Extensions at Wealth-Lab.com, where you can browse the categories for available extensions.



How to: Install [Other] Extensions Browse the available extensions at Wealth-Lab.com, and then: 1. Click the title of the extension that you want to download to see more information and the Download button. 2. Perform one of the following actions: Download the .wle (Wealth-Lab Extension) file and continue with Step 3. Instead of saving the .wle file, simply choose to open it. It will download and install without explicitly saving the file. If using this method, skip step 3. 3. Launch the EM and either: a) use the "Open Extension's *.wle file" link, b) drag and drop the .wle file on the EM, or c) double click the .wle file. Any method will cause the EM to download the associated files. 4. Restart Wealth-Lab to complete the installation.



How to: Update Extensions When connected to the Internet, the EM will compare the locally-installed extensions with those at Wealth-Lab.com. When updates to installed extension are available, the Update Now button and the New Version x.y.z.0 is displayed in bold red. Click Update Now to download and install the most-recent version.



How to: Get Update Notifications To be notified immediately upon launching Wealth-Lab that updates are available, configure the "Check for updates" from the Extension Manager's options button.
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Index-Lab® What is Index-Lab®? With Index-Lab® you can use to easily create and update your own unique Market Indices and Aggregate Indicators. Here are some examples of what you can do with IndexLab®: Create a Market Index that tracks the average gain/loss of any group of symbols that you select. Create custom Advance/Decline Lines to measure broad market performance, and create other Market Breadth indicators. Create Aggregate Indicators, such as the average RSI for all symbols in the Index. Take action when the Aggregate Indicator reaches oversold or overbought levels. Capture the breadth of the market with Aggregate Indicators like Tsokakis MACDBull and Tsokakis MACDBear. The terms Index-Lab® and Index-Lab® may be used interchangeably in this guide, although Index-Lab® always refers to the Index-Lab® tool window. How Does Index-Lab® Work? Index-Lab® uses Index Definitions which define how to create the Index or Aggregate Indicator. Index Definitions are compiled components that Wealth-Lab detects at startup. For more information on how to develop your own library of Index Definitions, see WealthLab Pro Under the Hood at fidelity.com. Once your Index Definitions are created, you can assign them to one or more DataSets using Index-Lab®'s Index Builder view. The assignment determines which Index Definition is applied to which DataSet. The calculation process begins automatically the first time that you reference an index or in the Data Manager during a price-only or Custom Index Provider update. Index-Lab® Creates New DataSets Index-Lab® automatically creates an Index DataSet for each timeframe. For example, you'll find a index created using a Daily DataSet in a DataSet named Index-Lab Daily. All of the indices and aggregate indicators that Index-Lab creates become new symbols in these DataSets by scale. Index symbols can be accessed in any Strategy via the standard SetContext, GetExternalSymbol, GetExternalSeries, or PlotSymbol calls. Index symbols appear in the Data Tree under Index-Lab DataSets, but they cannot be traded or streamed.
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Custom Indexes Launch Index-Lab® from Tools > Index-Lab® or with the keyboard shortcut Ctrl+Alt+I. Two primary views are presented. Custom Indexes This view simply contains a complete list of all indices created along with the Index Definition used, DataSet, and applicable parameters, if any. To delete an index, right-click it in the Data Tree and select the Delete option. Alternatively, you can edit the Data Set in the Data Manager to effectively delete index(es). Index Builder Use the Builder view to begin creating one or more indices by assigning an Index Definition to DataSet(s). A new index symbol is created for each DataSet that you select.



Creating Aggregate Indicators for 3 DataSets. Use Ctrl+Click to select more than one DataSet.



The Builder view shown above is the first in a series of wizard pages. Simply follow the Index Definition cues to choose methods, indicators, and/or parameter to customize your indices. For example, when creating an Aggregate Indicator, you select the indicator and adjust its parameters on second Builder page. Index Naming, % Prefix In the final wizard page, you can use the default symbol names or modify the name for each index separately by selecting it in the list. Wealth-Lab's Index-Lab® convention includes a "%" prefix for all index symbol names.
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The final wizard page gives you a chance to choose a name for each custom index.
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Index Calculation Index Calculation Assigning an index definition to a DataSet does not compute the index immediately. The initial calculation occurs when the index symbol is first: 1. opened in a Chart or Strategy Window, or, 2. referenced as a secondary symbol in a script, or, 3. updated in the Data Manager via the DataSet or Custom Indexes Provider methods (see image). Calculating an index can last from a few seconds to several minutes depending on number of DataSet symbols, update status, bars in history, etc. The final result is added to the index's Bars object, which therefore contains Open, High, Low, Close, and Volume series. For most index definitions derived from indicators, these DataSeries will be identical. For others, like the Basic Index, these series will differ, resembling a synthetic symbol.



Custom Indexes Provider Update



Warning! Index Definitions that operate directly on price, like the Basic Index or Moving Averages, inherently peek if the constituent symbols have split. A split is a "future action" that influences prices and volume in the past. Therefore the historic prices that make up then index today would not be the same as when traded prior to split actions. Synchronization When creating or updating an index, contributions from each of the DataSet symbols are collected on a bar-by-bar basis and averaged by the number of symbols contributing to a particular bar. Generally this method will provide a good average measure of the aggregate, but spikes or irregularities may be observed when a DataSet has only a few symbols (with widely-varying prices) or perhaps as symbols are introduced to the index series due to different start (and end) dates. For best results prior to creating an index, update the target DataSet and run the "Bad History Data Check" script (or equivalent). Identify and correct/ refresh symbols who have missing or out-of-sequence bars. Index Updates In general, Index-Lab® applies updates to indices by checking an index's last date and then adding bars as required based on updates to its DataSet symbols. Once calculated, an index's bar value will not change unless the index is refreshed; by a Reload Chart Data action, for example. Index-Lab® also respects the Data on Demand setting, for example: © 2017 FMR LLC All rights reserved.
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If an index is charted and Data on Demand is enabled, then the DataSet symbols are updated prior to updating and charting the index. Likewise, referencing an index as a secondary symbol with Data on Demand enabled can cause the DataSet symbols to be updated before the index. When Data on Demand is disabled, indices are generally not updated. Stock splits, Bar Data Edits Index-Lab® has no special handling for these events. Once an index value for a bar is calculated, it will not be updated even if the source bars are updated. Stock splits generally don't affect breadth, momentum, or oscillator-based aggregates. However, in the case of a Basic Index that simply averages absolute prices, stock splits not only affect an index already in use, recalculating the index introduces a "peeking effect" due to forward-looking information. Refreshing an Index To refresh an index's calculation for any reason, open it in a Chart Window and use the right-click Reload Chart History option. This action has the following effect for index symbols: 1. 2. 3. 4.



deletes the data file for the custom index temporarily turns on on-demand update updates the DataSet on which the custom index depends if required, and, regenerates the Bars for the custom index
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Using Indexes You can use index symbols in your Strategies in the same way as other secondary symbols. Like standard indices (.DJI, .SPX, etc) they cannot be traded other than theoretically. Generally, you would use an index to in a Strategy to provide a setup or trigger condition that enables entering or exiting a Position. Example (How to run Example code? 8 ) The following Strategy accesses a market breadth index, smooths it with a Kalman Filter, and creates a signal line that when crossed enters the market long. C# protected override void Execute() { // Access a custom index DataSeries index = GetExternalSeries("%EMAPCT_DOW_30", Close); // smooth it index = Kalman.Series(index); // make a signal line for a crossing trigger DataSeries signal = EMA.Series(index, 9, EMACalculation.Modern); // plots ChartPane iPane = CreatePane(40, true, true); PlotSeries(iPane, index, Color.Blue, LineStyle.Solid, 2); PlotSeries(iPane, signal, Color.Red, LineStyle.Solid, 2); for(int bar = 100; bar < Bars.Count; bar++) { if (IsLastPositionActive) { Position p = LastPosition; if (bar + 1 - p.EntryBar >= 5) ExitAtMarket(bar + 1, p, "Time-Based"); } else if (CrossOver(bar, index, signal)) { BuyAtMarket(bar + 1); } } }
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Monte Carlo-Lab What does the Monte Carlo Visualizer do? Monte Carlo Visualizer (MCV) performs Monte Carlo Analyses on Wealth-Lab historical simulations. This analyses consist of computing a large number of randomized Runs based on the original simulation results, providing insight into the trading system's potential in the future by giving you an idea of the probability of achieving various profit objectives. How do I obtain the Monte Carlo Visualizer? The MCV is available by downloading/installing the Extra Performance Visualizers pack via the Extension Manager. 1. Make sure you're connected to the internet. 2. Click Tools > Extension Manager 3. If you've already installed Extra Performance Visualizers, which also includes the Analysis Series Visualizer, just update it and skip to Step 5. 4. Showing Fidelity Supported Extensions, select either Addins or Installs in the toolbar, locate Extra Performance Visualizers. Click the Install Now button. 5. Click the Restart button to complete the installation. 6. Following the restart, select Monte Carlo as one of the Visualizer Preferences (F12). Monte Carlo Visualizations apply only to backtests with Portfolio Simulation sizing. What is a Monte Carlo Simulation? The first step in Monte Carlo analysis is to provide the simulation with a set of historical trading results. This can consist of an equity curve or a list of trades. Then, a number of simulation "Runs" are generated. Each Run randomizes either the equity curve data or the underlying trades (and/or trade returns), to create a new equity curve and system result set. This new result represents a potential outcome of the system based on the historical trading dynamics. The Simulation continues to generate a statistically-significant number of Runs, at least 500 to 1,000. Each randomized Run is based on the original system results but has its own ultimate Net Profit and Drawdown. The Monte Carlo Simulation tabulates the Profit and Drawdown of the Runs and produces probability reports based on the compiled data from all of the trials. What can a Monte Carlo Simulation tell us? A Monte Carlo analysis can answer such questions such as ... What is the largest loss I can expect from the system within a 1 year period? What is the expected average monthly profit and drawdown of the system? What is the chance that the system will generate a loss over a specific time frame? What is my chance of realizing a 20% profit using a 5% of equity position size as opposed to a fixed $5,000 per trade position size?



Limited utility for Combination Strategies Monte Carlo-Lab works with raw trades lists of backtests and does not have
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access to child strategy allocations. Therefore its use is limited and not recommended for analyzing Combination Strategies.
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Position Sizing & Preferences The Position Sizing Control settings used for the original Portfolio Simulation determines the sizing method and Starting Capital to be used when generating new randomized simulation results during the Monte Carlo process. The WealthScript Override (SetShareSize) setting is valid for use in conjunction with the Equity Curve Scramble mode. For Trade Randomization mode, MCV maintains the original size set by the script for each Position. More information: Clear Existing Runs Clear Existing Runs
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Stock/Futures Mode The Symbol Info Manager 310 preference for Enabling/Disabling Futures Mode is honored for simulations generated by the Monte Carlo process. Slippage Slippage is a function of the baseline Portfolio Simulation, which alters the entry and exit prices of the trades. The resulting, always more-conservative effect is carried forward to Monte Carlo runs, which which uses the raw trades from the baseline simulation. Interest and Margin Rates, Round Lots, and Commissions User Preferences for rates, round lots, and commissions are applied for MC Trade Randomization simulations. Dividends Dividends are not applied for MC simulations. Worst-Case Trades Since the Worst-Case Trades result in less-than-random outcomes, MCV ignores this user preference and always execute simulations with Worst-Case Trades set to false.
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Raw Trades Info Raw Trades The Raw Trades list displays information on each of the trades recorded in the raw profit backtest runs used in the simulation. In other words, whereas the Trades Visualizer shows only the trades that were accepted by the Portfolio Simulation, Monte Carlo Raw Trades includes the complete list - even those that were rejected by the single simulation results. The total number of Raw Trades is shown in the tab caption, (497) in the image below. The following information is shown for each trade: Symbol, Entry Date, Entry Price, Exit Date, Exit Price, Percentage Profit, Point Profit, and Bars Held.



Trade Price History Click on any of the trades in the Trade List to see a graph of the trade's price history. The graph represents the bar by bar price changes that occurred during the life of the selected trade. Each bar by bar price change represents a single "bar by bar return". MCV stores all bar by bar returns in a single list and uses this information when Synthesizing trades 257 during Monte Carlo runs.



Monte Carlo Visualizer Raw Trades and Trade Price History



Bar by Bar Returns Graph The Bar by Bar Returns Graph displays a distribution of the bar-by-bar returns for all loaded trades. For example, if 10 trades are loaded, and each trade has a life span of 10 bars, there would be a total of 100 bar-by-bar returns displayed in the distribution graph.
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Settings The Monte Carlo Settings (upper left toolbar) control the technique that the MCV uses to randomize the raw trade data and generate new, simulated historical results. There are two basic modes of randomization that are available: Equity Curve Scramble and Trade Randomization. Equity Curve Scramble This method performs an initial, baseline simulation using the raw trades and the specified Position Sizing 255 settings. Randomized runs are then created by randomizing the baseline equity curve. This is the simplest method, and does not involve using the raw trades during the generation of randomized Monte Carlo runs. The Equity Curve scramble works by populating a new equity curve one bar at a time. For each bar, a random bar of the baseline equity curve is selected, and the bar to bar percentage return is applied to the randomized equity curve. Equity Curve Scramble allows returns from the initial equity curve to be re-sampled. If re-sampling were not allowed all resulting equity curves would have the same Net Profit. This method effectively captures the dynamics of the historical testing period, including price shock events, because the effects of multiple positions reacting to events is captured in the baseline equity curve and translated to the randomized Monte Carlo equity curves. Trade Randomization (TR) This method randomizes various elements of the raw trades, and actually creates a new historical simulation, and resulting equity curve based on the randomized trades. The following options are available to control trade randomization: Same Date Scramble Trading systems such as "dip buyers" tend to hold large amounts of cash until market volatility rises significantly. At these times, such trading systems will quickly switch to full exposure and therefore may not have sufficient cash to enter all the signals on a particular day. Scrambling the trades on the same date provides a convenient way to see the distribution of outcomes from market-defining events. The Trade Synthesize > Maintain Date Clustering option is similar to the same date scramble (see below), but since it mixes trades from different dates the distribution of those trade returns tend to be more smooth/positive than reality. Trade Scramble The first method of Trade Randomization is Trade Scramble. The starting dates of all of the raw trades are randomized, and a simulation is performed based on the randomized start dates. Trade Scramble and Randomize Same as Trade Scramble above, but additionally, the bar by bar returns of each raw trade are randomized. This randomization does not impact the resulting Net Profit of the raw trade, but it does impact the equity curve and therefore may influence how new positions are sized.
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Trade Synthesize Same as Trade Scramble, above, but the bar by bar returns of each raw trade are synthesized. Each bar by bar return is synthesized by selecting a random bar by bar return from the complete list of bar by bar returns for all raw trades. Allow Trade Recycling



Applies to: All TR Methods



This option specifies whether or not to allow raw trades to be re-sampled during the Trade Randomization process. Enabling this option allows an additional level of randomization, because a raw trade could be selected more than once when creating the randomized simulation, and some raw trades might not be selected at all. Allow Trade Return Recycling



Applies to: All TR Methods except Trade Scramble



If enabled, it allows the raw trade's bar by bar returns to be re-sampled during the process of randomizing the trade's bar by bar returns. This results in an additional level of randomization. Maintain Date Clustering



Applies to: All TR Methods



This option forces the randomized entry dates to be drawn from the actual entry dates of the raw trades, instead of being completely randomized within the testing period. Enabling this setting can help more accurately simulate strategies that have low exposure. See also: Same Date Scramble Maintain Win/Loss Sequence



Applies to: All TR Methods



This option forces the randomized trades to maintain the same win/loss sequence of the trades in the raw trade list. This can help the Monte Carlo simulations to more accurately model the events and trends that occurred during the testing period. Maintain Serial Correlation This setting applies to both the Equity Curve Scramble and the Trade Randomization methods. It enforces the simulated Monte Carlo runs to maintain a serial correlation (as measured by the Pearson Correlation Coefficient of the equity curve returns) that is close to that of the initial baseline run; generally within +/- 0.1. AutoStop Settings See Simulation Control
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Memory Usage Mode If memory is a constraint, select Memory Usage Mode Low to perform Full Span 263 (only) analysis but with limited memory usage. Simulation Equity Curve 260 graphs are not available in low memory mode usage.



© 2017 FMR LLC All rights reserved.



259



17.4



User Guide, Wealth-Lab Pro



Simulation Control Go: Begin Simulations To start the process of generating randomized simulation runs, first configure the Monte Carlo Settings and choose the number of AutoStop Runs, which causes the MCV to stop generating runs after the specified number of runs are completed. We recommend at least 1,000 runs to obtain a statistically significant number of trials. Click the Go button in the MCV toolbar to start the process. Stop: Halt Simulations To stop the generation of runs at any point, click the Stop button in the MCV toolbar. You can explore the results, and click Go again to continue generating runs. The total number of Runs is displayed in the "Simulation Runs" tab caption. Clicking Go always restarts the AutoStop counter. For example, assuming 5000 AutoStop Runs and stopping the process after 2000 runs, clicking Go again will generate an additional 5000 Runs for a total of 7000 Runs. Clear: Clear Existing Simulation Runs This option clears the existing runs from memory, allowing MCV to start with a fresh slate. Re-running the baseline Portfolio Simulation (for example, by changing Position Sizing, Data Range, or DataSet) or changing MCV Settings will automatically clear existing randomized Monte Carlo runs.
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MC Simulation Runs Simulation Run List The Simulation Run List contains information on each of the randomized runs generated by the Monte Carlo processing. Baseline Run The Baseline Run is the initial non-randomized simulation whose results are given in all other Visualizer views like Performance, Equity Curve, Drawdown, etc. Since MCV uses all of the raw trades, not just the ones accepted by the Baseline Run, it's possible to see a diversity of outcomes not previously captured. Another reason why the Baseline Run might can have wildly different Net Profit than the other runs is caused by price shock events. During price shocks, all positions typically suffer large losses at exactly the same time. These events can be captured more effectively in MCV by maintaining Date Clustering and Win/Loss Sequence in the Monte Carlo Settings 257 . If you have a set of trades that cannot be modeled accurately in MCV using Trade Randomization mode, switch to Equity Scramble mode. This mode should result in random runs that contain the same effects of extreme events such as price shocks. On the other hand, if you want to minimize the influence of extreme effects in your randomized runs you can use Trade Randomization to effectively accomplish this goal. Equity Curve Click on any of the Runs in the list to view its equity curve in the graph below. For Equity Scramble mode, only the equity level is available, you will not be able to see a cash level. In Trade Randomization mode you will be able to see both the equity and cash levels, giving you an idea of the strategy's exposure, just like in the Equity Curve Visualizer.
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Profit & Drawdown Analysis Profit The profit analysis graph displays a distribution of net profit from all of the Monte Carlo simulations runs. The distribution is compiled over the specified Time Span 263 . The distribution displays the number of runs that have a net profit within a specified range. Below the graph is a small report that displays the average value, median value, and 5% and 1% extremes. These extremes are the robust measures of the trading system that you can consider when comparing one system with another.



Use the Monte Carlo Visualizer Analysis View to toggle between Profit and Drawdown distributions.



Drawdown Toggle the View to show the drawdown analysis graph, which is a distribution of maximum drawdown % from all of the Monte Carlo simulations runs. Maximum drawdown % is the largest peak to trough decline in the equity curve of a historical simulation. The distribution is compiled over the specified Time Span 263 . The distribution displays the number of runs that have a maximum drawdown % within a specified range. Below the graph is a small report that displays the average value, median value, and 5% and 1% extremes, exactly like the corresponding Net Profit Analysis report.
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Probability Curve Probability Curve The Probability Curve displays a graph of each Simulation run's Net Profit mapped to the percentile where that profit value occurred. The Y-axis represents the percentile, 0 to 100%. The X-axis represents the Net Profit value that occurred at the percentile. Like the Profit and Drawdown Analysis 261 , the Probability Curve uses the currently-selected Time Span 263 . The graph lets you quickly visualize the overall probability dynamic of the system that was exposed by the Monte Carlo simulation. For example, select a profit target value along the X-Axis and follow it up to where the curve intersects to Y-Axis to determine the probability of achieving the profit level. The "break-even" level displayed in the sub-title is the intersection of the zero profit level and the probability curve. It represents the chance that the trading system will at least produce a break-even result within the selected time span.
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Applying Different Time Spans Time Spans You can apply different time frames to the Profit and Drawdown Analysis 261 and the Probability Curve 262 . Select one of the Time Span toolbar buttons to change analysis time span (Full Span, W, M, Q, Y). You can select Weekly, Monthly, Quarterly, or Yearly time frames, or reset the analysis to use the complete time span of the original historical simulation. Changing time span causes the analysis views to take multiple samples within the resulting equity curves. For example, if you run an original 5 year simulation and then select to view Yearly results, the equity curve of each generated Monte Carlo run will be sampled 5 times to report on profit and drawdown.
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Neuro-Lab® What is Neuro-Lab®? Neuro-Lab® is a Wealth-Lab Pro Extension for creating and training your own artificial neural networks (ANN or simply NN) that form the basis of custom indicators. You can add the NN Indicator to Wealth-Lab Strategies for testing and trading. Use neural networks alone or in conjunction with traditional indicators and chart patterns to develop powerful trading systems. How does Neuro-Lab® Work? Starting with the Neuro-Lab® user interface you define a neural network topology. The NN inputs are controlled by an Input Script. Each call to the NL.NeuroLab.Input function installs a new neuron in the input layer of the network. The network output, always a single neuron, is determined by an Output Script so your network can be trained to predict any value* including (but not limited to) future profit. *Neuro-Lab® indicators are normalized in the range from 0 to 100. When the value of the NL indicator is high, the network is indicating that the probability is greater that the condition for which the NN was trained will occur. Train the Network You can select a single symbol or a complete DataSet as training data and also control how much of the data to use for training. For example, you can train with the first 50% of the data, and then evaluate the performance on the remaining [out-of-sample] data after training. The training process itself is visual, and the error term is graphically updated as training proceeds. You can stop (and resume) the training at any point. Evaluate the Result You can evaluate the performance of a trained network on the in-sample training data, the out-of-sample data for the training data selection, or any other symbol or DataSet defined within Wealth-Lab Pro. The performance evaluator shows you a breakdown of the network's predicted output, alongside the actual output values for each segment of the breakdown. You can quickly see if the network had predictive success on out-of-sample data. The performance evaluator is configurable so that you can view the results in coarser or finer increments. The NN Indicator Upon installing Neuro-Lab®, a new Neuro-Lab® Indicator folder containing a single NNIndicator will appear in list of Technical Indicators. The NNIndicator takes two parameters - a Bars object and the string name of a neural network. For this to be useful, you must first train one of the sample networks installed with Neuro-Lab® or create and train a network of your own design. See the Sample Networks 281 topic for typical use of the NNIndicator in a trading Strategy.
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About Neural Networks Neural Network Structure Artificial Neural Networks ("neural nets" for short) simulate the brain's learning process by examining a series of input and output values and determining how the input variables affect the output. A neural net is composed of three or more layers: an input layer, an output layer, and one or more hidden layers that lie between the input and output layers. Each layer is composed of one or more neurons. Each neuron in a layer is connected to all of the neurons in adjacent layers. These links or synapses each contain a numerical weighting value that is used to modify the signal from the incoming neuron. A neuron compiles the signals from all of the incoming weights and then applies an activation function before sending the result over its links to the neurons in the next layer. Preparing the Neural Network After the structure of a neural network is established, it is populated with a series of training data for its input and output layers. These values are typically transformed into a range based on the network's activation function, typically 0 to 1 or -1 to 1. Each set of training data contains the values for the neurons in the input and the output layers. The neuron link weights are then randomized. Training the Neural Network After the neural network is populated with training data, actual training can begin. The neural network propagates the values from the input layer to the hidden layer(s), and ultimately to the output layer. The propagation consists of summing the values of the incoming neurons, applying an activation function, and sending the result to the neurons in the next layer. The value(s) that arrive at in the output layer are compared to the desired output (which was part of the training data), and an error term is calculated. The neural network adjusts the internal weights based on how close the predicted output is to the actual output. The training process repeats for each set of training data. The completion of one cycle of such testing is called an epoch. The training process typically continues for hundreds or thousands of epochs, and the neural network eventually learns how the values in the input layer ultimately affect the output. Using the Trained Neural Network Once a neural network is trained, you can use it to predict* output value(s) based on the input that you provide to the input layer. The neural network simply propagates the input values along the hidden layer(s) and into the output layer. *Neuro-Lab® indicators are normalized in the range from 0 to 100. When the value of the NL indicator is high, the network is indicating that the probability is greater that the condition for which the NN was trained will occur. Overtraining It is very important to avoid overtraining a neural network. Overtraining can occur if the neural network contains too many hidden layers and neurons compared to the amount of training data. The neural network can memorize the relationships between input and output data, instead of generalizing the relationships. In this case, the neural network will predict the output of the training data flawlessly, but will fail when used on out-of-sample data.
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Quick Start Using the Sample Networks You can start using Neuro-Lab® with the three sample networks that are provided. Before employing these networks in Wealth-Lab Strategies, you need to train them. 1. Click on a network in the list in the Define Network view. Optional: inspect the Network Topology, Input Script, and Output scripts. 2. Switch to the Select Training Data view. 3. For simplicity, select a favorite symbol from a Daily DataSet, and then click the Apply Training Set button. (If you wish, you can retrain the network later.) 4. Choose the Train Network view and click the Begin Training button. After several hundred epochs and when the error rate is more or less stable, click Stop Training. 5. You can Evaluate Performance of the network, but it is not required for this tutorial. 6. Close Neuro-Lab® and open a new Chart Window. The symbol does not have to be the one that you chose for training. 7. Launch the Technical Indicators dialog, and drag and drop the NNIndicator from the Neuro-Lab® Indicator folder onto the chart. 8. Type the Network Name (e.g., RSI Periods) in the NNIndicator Properties dialog and click OK. We've only plotted the indicator for a quick demonstration, but it too can be used like any other indicator in a Strategy. See Sample Networks 281 .
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Neuro FAQs What method is there for choosing the number of hidden layers and neurons in the hidden layer? No pure academic consensus exists to determine these quantities. As a starting point a NN expert suggests to start with 1 hidden layer and use the square root of the number of neurons in the input layer (rounding up) for the number of neurons in the hidden layer. So, if you had 10 inputs, you might choose 4 neurons in 1 hidden layer and experiment from there. When should I halt the training process? Generally you'll need at least several hundred epochs and when the learning rate slows, consider halting the process and evaluating the network. Keeping training to a minimum should make your neural net more likely to find causal patterns and less likely that its output fits noise in the training data. Note that you can stop training, evaluate, and resume training once again. This process can be repeated often until you switch networks or close Neuro-Lab®. Does the input data have to be price data, or can it be another type of data like price-to-earnings ratio, day of week, weather forecast, etc.? You can use any numerical input data that you like or that you can generate in a script. In the end, the data are simply a series of floating point numbers that is passed to the NL.NeuroLab.Input function. How can I use neural networks created and trained on computer A on computer B? In the ..\Data\NeuroLab folder, locate the files (.xml and .ann) bearing the network's name and copy them to the new destination.
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Defining a Neural Network



18.4.1 Network Topology Settings The settings interface lets you define the network's Momentum, Training Rate, and Jitter. Momentum controls how much of the previous weight adjustment is applied to the current weight adjustment during training. It can help the network overcome obstacles and can improve the smoothness of the learning process. You can modify these rates during network training. Training Rate (also known as Learning Rate) should typically be left in the low range at least 0.1 but usually not more than 0.3. The value is the multiplier for the current change in the synapse weight demanded by the training algorithm. For example, if the current weight is 0.2 (a product of all the training to that point) and training suddenly demands it to be 0.7, only a portion of the 0.5 delta would be added to 0.2. Too low a Training Rate will make the network learn very slowly. Too high a Training Rate will lead to wild fluctuations in the network's weights, and no learning at all. Topology The Topology interface displays the number of Input and Output neurons, which are defined in the Input and Output Scripts. Here you also control how many hidden layers are in the network, and how many neurons are in each hidden layer. The number of input neurons will update automatically when the training set is applied and the scripts are evaluated. At least one hidden layer is required for non-linear classification, and since multiple hidden layers tend to optimize on the in-sample data (overtrain effect), a single hidden layer is often the best choice for most applications. As a starting point one NN expert suggests to start with 1 hidden layer and use the square root of the number of neurons in the input layer (rounding up) for the number of neurons in the hidden layer. So, if you had 10 inputs, you would start with 4 neurons in 1 hidden layer and experiment from there.



18.4.2 Input Script Input Script The Input Script Editor contains the network's Input Script, which determines how many neurons are in the network's input layer. Add a neuron to the input layer by calling the NL.NeuroLab.Input() method. The following simple example installs 2 neurons in the input layer. The neurons contain the DataSeries values of the RSI and ROC indicators. Example public NL.NeuroLab neuroLab = new NL.NeuroLab(); protected override void Execute() {
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neuroLab.Input(RSI.Series(Close, 14)); neuroLab.Input(ROC.Series(Close, 21)); }



It is not necessary to scale your input data for the network; Neuro-Lab® does this automatically. When the Input Script is ready, click the Check for Errors button to ensure that you have made no syntax errors or another mistake that would result in an error during runtime. If the Input Script executes without error, Neuro-Lab® will update the Network Topology's input layer with the correct number of neurons. Note that the function of the Input Script is to generate the DataSeries that will be utilized to train the network and later feed the input. Remember, each series passed as a parameter to NL.NeuroLab.Input() corresponds to a single neuron (node) on the input layer of the network. See the Train Network 275 topic for a description and illustration of how the DataSeries values are fed to the network in random order during network training. Valid Functions In general, you should limit Input/Output Script code to use only those functions that are required to generate data for the indicator and/or network output (see next topic). Other WealthScript functions that deal with Cosmetic Chart, Position Management, Trading, etc. are of no use in creating the NN Indicator, and when encountering one of these functions the I/O Script Editor will highlight them with italics and underline. Example: CreatePane



18.4.3 Output Script Output Script The Output Script Editor contains the network's Output Script, which determines the output value that the network is intended to predict. These values are used during the network's training process. The network output is defined by a single call (corresponding to one neuron) to the NL.NeuroLab.Output() method in the Output Script. The example below populates the network training output with the future profit after 5 days. Notice that the Output Script purposely "peeks" into the future to access future data. Consequently, the loop must end on BarCount - 1 minus the number of bars in the prediction, otherwise an error will result. When the Output Script is complete, click the Check for Errors button to ensure that you have made no syntax errors or another mistake that would result in an error during runtime. Example /* This generic Output Script can be use to predict the gain after 5-bars */ using System; using System.Collections.Generic; using System.Text; using WealthLab; using NL; namespace WealthLab.Strategies { public class MyStrategy : WealthScript { public NeuroLab neuroLab = new NeuroLab();
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protected override void Execute() { DataSeries ds = new DataSeries(Bars, "My Output"); int predictBars = 5; for (int i = 0; i < Bars.Count - predictBars; i ++) { double x = Bars.Close[i + predictBars] - Bars.Close[i]; x = (x * 100) / Bars.Close[i]; ds[i] = x; } neuroLab.Output(ds); } } }



The Output Script is used only to train the network. It provides the truth data with which the estimates that are created by the final output of the network are compared. The training process uses the difference between the Output Series and the network prediction as a basis to adjust the weights of the neural synapses (the lines connecting the neurons). See the Train Network 275 topic for a description and illustration. Valid Functions See Valid functions
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Select Training Data Data Selection Click a DataSet or a symbol in the Data Tree. If you click a DataSet folder, all of the symbols within the folder will be used for training. If you expand the folder and click an individual symbol, only data from that symbol will be used. Training Period The Training Period controls allow you to specify the first or the last portion of the data to use for training, as well as the amount of data. This will allow you to train the network on one portion of the data, and later evaluate the performance on the out-of-sample data. You can, for example, train the network with the first 50% of the data, and then evaluate the performance later on the second half. The valid range is between 1% and 99%, inclusive. Important! The Training Period is [currently] bar-based, not date-based. This is an important distinction if you select a DataSet that contains symbols with varying date ranges. For simplicity, assume that your DataSet has two symbols, YHOO and IBM. Selecting 50% of data for training means that you are selecting 50% of the available data in both sets. Depending on the data provider, YHOO data could start in 1996, but in 1962 (or earlier) for IBM. Assuming the year is 2010, the in-sample data for IBM would include data from 1962 to 1986, but from 1996 to 2003 for YHOO. In other words, you would be "accidentally" training the network with out-of-sample data with respect to IBM. To avoid this, we recommend creating DataSets of symbols that are synchronized by Starting Date for the purpose of training, if necessary. Load every N Bars Load every N Bars lets you load only a portion of the data in the in-sample range for training. This option is especially helpful if you want to train the network on a large DataSet. Loading 50% of the in-sample data will result in a very large number of input training patterns to be loaded when you proceed to Train the Network. This can easily consume all of your computer's memory. Use this option to load every 10th bar, every 20th bar, etc, to minimize the amount of training data to a manageable level. Note that another similar option, Filtering Training Data 273 , is an alternative to using every N Bars, though both methods can be applied simultaneously. What does this mean exactly? When the Training Set is applied every DataSeries from the Input and Output Scripts are calculated so that a matched set of training data is available at both the input and output layers of the network. As we'll learn later, these data are actually applied to the network in a random fashion for each epoch of training. Consequently, it makes no difference to the network that the data are sequential or chronological; rather what's important is to condition the network with known inputs and their corresponding truth data, which are compared to the network's output. Load every N Bars, then, simply reduces the number of random training patterns that are selected from the Training Data Set. Lead Bars The Lead Bars control should be set to a value based on the indicators or back data used in the Input or Output Scripts. For example, if you use 5, 10, and 15-period RSIs in your script, you should set Lead Bars to 45 since it takes an RSI indicator about 3 times its period to stabilize. Consequently, the first 45 bars of the data set will not be used for © 2017 FMR LLC All rights reserved.
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training. End Bars End Bars determines how many bars to ignore at the end of the data series for training purposes. If your network will be trained using data at the end of the data series, End Bars can be set to the number of bars used in the Output Script prediction so that zerovalue estimates are not fed back into the network during training. For the purpose of the illustration below, we omitted 2 bars at the end of the training sample, implying that the output script will predict 2 bars into the future.



Effect of Training Data selection options illustrated in a cumulative fashion.



Apply Training Set Click this button to load the training data for the network. You must load the data values into the network before Training can commence. Upon loading the data, the Input and Output Scripts are evaluated and some sample statistics are displayed. At this point, you can re-inspect the Network Topology, which will be updated to contain the proper number of input layer neurons if you had not already clicked the Check for Errors button while designing the Input Script. Statistics The statistics view displays statistics on your input data and training output data: minimum and maximum values, mean and standard deviation. Training Set The Training Set table shows the raw training data for both the input and output series.
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Filtering Training Data You can filter the bars of data allowed for training in your Neural Net. Only bars of data that meet the condition(s) specified will be loaded into the training data set when you proceed to train the Network. If you do not use the filtering feature, all bars of data selected for training will be loaded, and this is the default behavior. By filtering the data you could, for example, choose that only Friday's data were included in the training. In this way, if your target system makes buy and sell decisions only on Fridays, the NNIndicator would be properly conditioned for those events. To filter training data, create a new DataSeries and assign a value of 1 for each bar that you want to allow training data. Pass the result to the NL.NeuroLab.Filter() method. This operation must be accomplished in both the Input and Output scripts. Be sure that your Input Script and Output Script contain the same code that assigns values to the DataSeries filter. Otherwise Neuro-Lab® cannot properly align the input and output data. Example The example below modifies a Neural Network to illustrate how filtering works. The filter simply allows only bars that fall on either Thursday or Friday to be included for training. Notice that the filtering code is identical in both scripts. Input Script using using using using using using using



System; System.Collections.Generic; System.Text; System.Drawing; WealthLab; WealthLab.Indicators; NL;



namespace WealthLab.Strategies { public class RFFilterIn : WealthScript { public NeuroLab neuroLab = new NeuroLab(); protected override void Execute() { DataSeries dji = GetExternalSymbol(".DJI", true).Close; int i = 5; while (i 


RSI.Series(Close, i) ); CMO.Series(Close, i) ); RSI.Series(dji, i) ); CMO.Series(dji, i) );



/* Load only the Bars from Thursday or Friday */ DataSeries filter = new DataSeries(Bars, "RF Filter"); for (int bar = 0; bar < Bars.Count; bar++) { if (Date[bar].DayOfWeek == DayOfWeek.Thursday || Date[bar].DayOfWeek == DayOfWeek.
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filter[bar] = 1; } neuroLab.Filter(filter); } } }



Output Script using using using using



System; System.Collections.Generic; WealthLab; NL;



namespace WealthLab.Strategies { public class RFFilterOut : WealthScript { public NeuroLab neuroLab = new NeuroLab(); protected override void Execute() { DataSeries ds = new DataSeries(Bars, "My Output"); // Predict Gain after 5 bars int predictBars = 5; for (int i = 1; i < Bars.Count - predictBars; i ++) { double x = Bars.Close[i + predictBars] - Bars.Close[i]; x = (x * 100) / Bars.Close[i]; ds[i] = x; } neuroLab.Output(ds);



/* Load only the Bars from Thursday or Friday */ DataSeries filter = new DataSeries(Bars, "RF Filter"); for (int bar = 0; bar < Bars.Count; bar++) { if (Date[bar].DayOfWeek == DayOfWeek.Thursday || Date[bar].DayOfWeek == DayOfWeek.F filter[bar] = 1; } neuroLab.Filter(filter); } } }
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Train Network Begin Training Click the Begin Training button to start training the network. Note that your training data set must be loaded into the network before training can begin. Epochs since new Error Rate Low tells you how many training Epochs have passed without a new low in the training Error Rate. This value will continue to climb to ever higher levels as the Network stabilizes and more learning is not possible. You can select to AutoStop Training after a certain number of training Epochs have passed without a new Error Rate Low. This feature is handy if you are training a very complex Network and want to let the training proceed unattended until an optimal solution is found. Error Term Graph The network will begin training immediately, and you'll see the error term graphically update in realtime. Allow the training to continue as long as you can see progress being made. The error rate will slowly decline as long as the network is learning. Click the Clear Graph button the clear the existing graph history. Sometimes a neural network gets stuck at a learning threshold, and no progress will be made for a considerable amount of time. Then, a breakthrough will occur and the network will begin learning again. It's best to allow at least several hundred epochs to elapse before considering to end the training process.



The error term represents the sum of one half of the square of the difference between the network's output and the target output for all training patterns on each epoch and then multiplied by 1000. Since the network links are initialized with a set of random weights, the error rate will decrease rapidly at first and then more slowly as the network continues to © 2017 FMR LLC All rights reserved.
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learn. Stop Training Click the Stop Training button to end the training. As soon as you click Stop Training, the neural network weights are saved and the network is locked. You can resume the training by clicking the Resume Training button. After you switch networks, or close and restart Neuro-Lab®, you will lose the opportunity to resume training. Be sure that you're satisfied with the network training results before switching networks or exiting Neuro-Lab®.



Neural Net Training Algorithm Illustrated An example of the training process algorithm is illustrated below; see the RSI Periods sample network as a point of reference. The task of the training process is to adjust the weights of the neural links such that the difference between the output of the neural net (the estimate) and the truth data is minimized.



Excerpt from Wealth-Lab forums by Dr. Bruce Vanstone in response to training neural networks: A Neural network with at most 1 hidden layer has been proven to be a universal approximator. This means it will learn a correlation between the data series it sees, and the expected result. There is no guarantee that the relationship it learns is causal. i.e. The relationship will be valid for the data series it saw, but that does not mean that the relationship will predict future occurrences of the series. If you find that you have low out of sample correlation, then the relationship was not causal, it was a feature only of the data series presented, (some people refer to this as an artifact). There are many reasons for this, generally they involve overtraining, or © 2017 FMR LLC All rights reserved.
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excessive noise masking your signal (the signal is what you are trying to find, it is causal). The easiest thing to do is to systematically reduce training. Reducing training will more likely find causal patterns, and less likely fit noise. If this fails to yield any benefit, then you must experiment with your parameter settings in an attempt to avoid an inherent feature of neural networks (the dreaded local minima)... Finally, if all else fails, you have the option of reducing the complexity of the search space by using fewer inputs (this is recommended). The basic reason for this as a recommendation is related to an issue known as 'degrees of freedom', which affect neural networks just as much if not more than stats would like to admit...
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Locked Networks Locked Networks After you stop a network's training the network is locked, and no changes can be made to the settings, topology, or Input and Output scripts. Neuro-Lab® locks the network when it saves the neuron weights of the trained network. This is to prevent you from accidentally changing the settings or scripts of a network that's already been trained. Unlocking a Network If you do want to modify any network settings, or make changes to its scripts, you have to explicitly unlock the network. Click the Unlock Network toolbar button, or select Unlock Network from the Network menu to unlock the network. If you save changes to a network after unlocking it, the weighting information from the network training will be lost, and the network will be saved in an "untrained" state.
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Evaluate Performance Evaluating Network Performance After network training is judged to be complete, it is time to evaluate the network's performance. You can evaluate a locked network at any time, even after pausing training before continuing again. In the Evaluate Performance tab, click on a DataSet or a symbol in the tree to select the data to use to evaluate the network performance. You can select the same data that you used to train the network, or a different data set. You can also choose to evaluate the in-sample data, the out-of-sample data, or all data. The in-sample period is the period that was selected in the Training Data interface. It's always useful to see how well the network performs on the in-sample period of the same training DataSet, and then see how it performs on the out-of-sample period of the same data. You want to look for networks that perform reasonably well on out-of-sample data while considering that results on outof-sample data will almost never be as good as the results for the training data. Selecting the Data Set After you select the desired DataSet or symbol from the tree, click the Evaluate button. The selected data will be processed by the trained network, and Neuro-Lab® will compile the results. Performance Results The performance results table compiles the NN outputs for each bar of the symbols in the selected data set. The following columns are displayed in the performance results: NN Indicator This column contains the values that the neural network produced. The range of values corresponds with the observations in the same row. Neuro-Lab® indicators always produce output in the range of 0 to 100. When a network outputs a low value it is predicting that the output will be close to low end of the output range. Likewise, when the network outputs a high value, it is predicting that (based on the given inputs) the output will be in the high end of the range. For example, if the Output Script is set to predict the net return after 5 days, then the NN Indicator value will be higher when the NN thinks that there will be a higher profit after 5 days. Predicted Output This column contains the predicted Output Value in this indicator range. Compare this value to the Actual Output to see how well the Network is able to predict the Output. Observations This column displays the number of individual observations (bars) of data that were contained in the NN Indicator range. When interpreting the performance results, make sure that there are a healthy number of observations in a data row before giving it a high importance. Actual Output This column contains the average actual output of the observations that composed this range of NN Outputs. When evaluating the network's performance you want to see a correlation between the higher NN Output Ranges, and higher actual output values.
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% of Average This column displays how much higher or lower the average output of this row is compared to the Average Output of all Observations, displayed above the grid. A color-coded bar is displayed next to this column, which provides a visual representation of how the average output of the row compares to the overall average output. As shown here, you want to see red bars at the top and green bars at the bottom, meaning that the actual NN output is higher than the average output when the NN predicted output is also higher. Output Range Increment This control allows you to view the results in coarser or finer increments. After changing the increment value, click the Evaluate button again to regenerate the results. For some hints on how to interpret the performance results, see the Sample Networks 281 .
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18.10 Sample Networks Use the following sample networks as a guideline to create your own neural network indicators. Each example presents the use of the NNIndicator in a typical Wealth-Lab Strategy.



18.10.1 RSI Periods Basis of this Network We've seen time and again that the Relative Strength Index (RSI) indicator can be a very useful market timing tool for short or medium term trading systems. The RSI Periods neural network uses RSIs of several different periods as input, and attempts to predict the short term profit after 5 bars. Input Script The network's Input Script creates RSI indicators of various periods, and calls the NL.NeuroLab.Input() method for each one. Each call to NL.NeuroLab.Input() creates a new neuron in the network's input layer. using using using using using using using



System; System.Collections.Generic; System.Text; System.Drawing; WealthLab; WealthLab.Indicators; NL;



namespace WealthLab.Strategies { public class MyStrategy : WealthScript { public NeuroLab neuroLab = new NeuroLab(); protected override void Execute() { for (int i = 5; i 


Output Script The Output Script populates a custom DataSeries with the percentage profit 5 bars ahead. Predicting a future profit should be a very common thing in Neuro-Lab®, and new networks automatically are preloaded with a version of this Output Script so you can use this Output Script, perhaps modifying the number of bars that it looks ahead. using using using using using



System; System.Collections.Generic; System.Text; System.Drawing; WealthLab;
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using NL; namespace WealthLab.Strategies { public class BroadMarketOut : WealthScript { public NeuroLab neuroLab = new NeuroLab(); protected override void Execute() { DataSeries ds = new DataSeries(Bars, "My Output"); // Predict Gain after 5 bars int predictBars = 5; for (int i = 0; i < Bars.Count - predictBars; i ++) { double x = Bars.Close[i + predictBars] - Bars.Close[i]; x = (x * 100) / Bars.Close[i]; ds[i] = x; } neuroLab.Output(ds); } } }



18.10.2 Patterns Basis of this Network The Patterns neural network is meant as an experiment to see if there is any predictive power in the pattern of successive open and closed candlesticks in the chart (an open candle occurs when prices close above their open price, and a closed candle when prices close below their open price). The network examines the most recent string of candles and uses the pattern to try to predict whether the following candle will be open or closed. We will train the network on the first half of data for a single stock (MSFT) and write a trading system to trade the network signals on the out-of-sample data. Input Script The network has 13 inputs, that correspond to the 13 most recent candles. Open candles are represented as ones, while closed candles as zeroes. So, each training data set will contain a pattern of 13 zeroes and ones. using using using using using using using



System; System.Collections.Generic; System.Text; System.Drawing; WealthLab; WealthLab.Indicators; NL;



namespace WealthLab.Strategies { public class PatternsIn : WealthScript { public NeuroLab neuroLab = new NeuroLab(); protected override void Execute() © 2017 FMR LLC All rights reserved.
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{ // initialize an array of DataSeries const int hist = 13; DataSeries[] arPatterns = new DataSeries[hist]; for(int n = 0; n < hist; n++) { DataSeries ds = new DataSeries(Bars, n.ToString()); arPatterns[n] = ds; } // assign 1's to "up bars" for(int bar = hist; bar < Bars.Count; bar++) { for (int i = 0; i < hist; i++) if(Close[bar - i] > Open[bar - i]) arPatterns[i][bar] = 1; } for(int n = 0; n < hist; n++) neuroLab.Input(arPatterns[n]); } } }



Output Script The network is trying to predict whether the following candle will be a open or closed. The training output data assigns a one if the following candle is open, otherwise the default value of zero remains in the custom Price Series that we create. using using using using using using



System; System.Collections.Generic; System.Text; System.Drawing; WealthLab; NL;



namespace WealthLab.Strategies { public class PatternsOut : WealthScript { public NeuroLab neuroLab = new NeuroLab(); protected override void Execute() { DataSeries ds = new DataSeries(Bars, "Patterns Output"); for (int bar = 1; bar < Bars.Count - 1; bar ++) if (Close[bar + 1] > Open[bar + 1]) ds[bar] = 1; neuroLab.Output(ds); } } }



18.10.3 Broad Market Basis of this Network The Broad Markets sample is intended to show you how to train a network using external © 2017 FMR LLC All rights reserved.
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data series. This example uses the Dow Jones Industrial Average (.DJI) and Nasdaq (.IXIC) broad index symbols to train the network, as well as the underlying symbol. Input Script The Input Script feeds the network the 20 and 40 period RSI (Relative Strength Index) and ROC (Rate of Change) indicators, as well as the 20 and 40 bar RSI and ROC of the Dow 30 and Nasdaq indices. using using using using using using using using



System; System.Collections.Generic; System.Text; System.Drawing; WealthLab; WealthLab.Indicators; System.Windows.Forms; NL;



namespace WealthLab.Strategies { public class BroadMarketIn : WealthScript { public NeuroLab neuroLab = new NeuroLab(); protected override void Execute() { neuroLab.Input(RSI.Series(Close, neuroLab.Input(RSI.Series(Close, neuroLab.Input(ROC.Series(Close, neuroLab.Input(ROC.Series(Close,



20)); 40)); 20)); 40));



string sDJ = "^DJI"; string sNQ = "^IXIC"; if (Application.ProductName.Contains("Pro")) { sDJ = ".DJI"; sNQ = ".IXIC"; } // Obtain the DJ Industrial Index DataSeries dji = GetExternalSymbol(sDJ, true).Close; neuroLab.Input(RSI.Series(dji, 20)); neuroLab.Input(RSI.Series(dji, 40)); neuroLab.Input(ROC.Series(dji, 20)); neuroLab.Input(ROC.Series(dji, 40)); // Obtain the Nasdaq Composite DataSeries nas = GetExternalSymbol(sNQ, true).Close; neuroLab.Input(RSI.Series(nas, 20)); neuroLab.Input(RSI.Series(nas, 40)); neuroLab.Input(ROC.Series(nas, 20)); neuroLab.Input(ROC.Series(nas, 40)); } } }



Output Script The network's Output Script contains the percentage profit after 10 bars. using System; © 2017 FMR LLC All rights reserved.
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using using using using using using



System.Collections.Generic; System.Text; System.Drawing; WealthLab; WealthLab.Indicators; NL;



namespace WealthLab.Strategies { public class BroadMarketOut : WealthScript { public NeuroLab neuroLab = new NeuroLab(); protected override void Execute() { DataSeries ds = new DataSeries(Bars, "My Output"); // Predict Gain after 10 bars int predictBars = 10; for (int i = 0; i < Bars.Count - predictBars; i ++) { double x = Bars.Close[i + predictBars] - Bars.Close[i]; x = (x * 100) / Bars.Close[i]; ds[i] = x; } neuroLab.Output(ds); } } }
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Reference The image of the Wealth-Lab Workspace in the Orientation topic identifies the main, commonly-used components of the application, each of which is described in detail in the following topics.
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Main Menu Selections in the main menu are generally self-explanatory, consequently we provide descriptions only of items specific to Wealth-Lab that may be unclear to a new user.



File Menu Update Data on Demand When this option is selected, Wealth-Lab automatically attempts to update price and volume data as symbols are charted or accessed. This option can also be configured in the Data Manager's Update Data view. On-Demand Updates never collect or request fundamental data. Streaming chart requests ignore the Update Data on Demand selection in order to automatically update a symbol's static data, the source of a chart's backfill.



Edit Menu Set as Default Template Code Saves the code currently existing in the Editor as a template for "New Strategy from Code" windows. The Edit menu is active only when a Strategy Editor is selected and in focus.



View Menu Hides or Shows the specified dialogs and toolbars.



Tools Menu With the exception of Orders, each tool in this list can be activated once in every main Workspace. Most items can be launched from the Navigation bar as well. Although you can open many main Workspaces, only a single Orders window can be active. Attempting to launch a second Orders window will automatically shift focus to the first active Orders tool in an alternate Workspace. Charts & Strategy and Quotes windows do not exist in the Tools menu by design since these have special menu controls in the Navigation bar for multiple windows.
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Workspaces Menu New Main Workspace Window (Ctrl + Shift + W) New Main Workspace Windows are not subject to the Default Workspace (below) and are always initialized without any tools. Glossary: Workspaces 331 . The ability to create multiple main Workspace Windows replaces the necessity to launch separate Wealth-Lab instances from the Start menu. Save Workspace / Open Workspace (Ctrl + W) Your Wealth-Lab installation includes some pre-configured Workspaces, although you can create as many of your own as you like. Set as Default Workspace The default Workspace is the one that is launched automatically when you start WealthLab. By default, Workspaces are stored in the ..\Data\Workspaces folder. To delete a Workspace, such as the Default Workspace, delete its .ws file, e.g., Default.ws



Window Menu This is the Windows-standard menu for applications with a multiple document interface (MDI). Tip: It's easiest to locate a specific Chart or Quotes window among many using the Navigation bar's 289 Charts & Strategies and Quotes drop down menus.



Help Menu About Wealth-Lab Pro Use this selection if you're required to check the software version of Wealth-Lab. Software Upgrade Periodically check for upgrades to the main Wealth-Lab application. (Login to Fidelity is required.). Upgrades and installations for other components, such as data adapters, may be available separately from Wealth-Lab.com.
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Navigation Bar The Navigation bar makes launching and recalling the tools that you're most likely to use most during a Wealth-Lab session. Generally speaking, each button launches a dialog of the named tool, each of which is described in detail in the linked topics. Chart & Strategies and Quotes, however, are multi-function buttons as described below.



Links to related topics: Home 11 Charts 55 & Strategies 95 Strategy Monitor 147 Quotes 160 Orders 179 Accounts 201 (Balances & Positions) Data Manager 37 Indicators 86 Fundamentals 92



Special functionality for Charts & Strategies and Quotes buttons Since you can open many Charts, Strategies, and Quote windows in a single Workspace, the Charts & Strategies and Quotes buttons have special properties. When one or more of these tools are open, a number in parentheses indicate how many are open (see image). Clicking the button presents a submenu with options to launch new windows or to quickly navigate to one that is already available.



Selecting 1 of 4 open Charts & Strategies.
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Function Toolbar Selections in the main Function Toolbar adapt to provide options applicable to the type of window currently in focus. Therefore, you'll notice that the Function Toolbar has two principal modes, or sets of selections, as outlined below.



Charting mode With a Chart or Strategy window in focus 325 , the Function Toolbar provides several charting control options for that window. Different windows have their own set of toolbar (and Data Panel) options that are recalled for the selected window.



See: Charting > Chart Control > Function Toolbar (Chart Mode)



63



Non-charting mode When any other window besides a Chart or Strategy window is in focus, only a small subset of the buttons shown in the previous image is available. This is due to the fact that most non-charting tools such as Quotes 160 , Orders 179 , and Data Manager 37 contain integrated toolbars. New Selections identical to File | New in the main menu for creating a new DataSet and launching fresh Chart/Strategy, Workspace, and Quotes windows. Open Strategy Launches the Strategy Explorer to open a strategy in a new Strategy window. Log in to Fidelity / Log out from Fidelity Launches the Fidelity Login authentication server, which is required for streaming charts, trading, importing/exporting Watchlists, and other functions that access account data. Preferences Launches the Preferences dialog (keyboard shortcut F12).
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Drawing Toolbar Wealth-Lab provides an array of drawing tools to manually add lines, shapes, images, and in general, "objects" to your charts. See: Charting > Drawing Toolbar



66
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Data Panel Despite being attached to the left side of each Wealth-Lab Workspace, the Data Panel is data control center for Charts & Strategy Windows. Its view can be toggled on/off (visible/hidden) from the View menu or by using the Ctrl+D keyboard shortcut. The panel itself is divided in three sections whose controls are described in the topics that follow.



The Data Panel contains controls to modify Scale, Data Range, Position Sizing, DataSet/Symbol, and Strategy Parameters.



General Properties of the Data Panel Sections of the Data Panel are grayed-out (dimmed) when they don't apply to the active window. Even so, you can configure dimmed controls as desired to apply their settings immediately to the next New Chart or Strategy window that you open. Changing items in the panel will refresh Chart windows and re-execute Strategies except as specified otherwise in the Strategy Window 95 guidance. Data Panel selections are "sticky", meaning that New Chart & Strategy windows default to the most-recent selections in the Data Panel and Function Toolbar. Tip: Use Advanced Options in Preferences (F12) to automatically configure the Data Panel to the settings last-specified when a Strategy is opened.



19.5.1 Scale Control Scale controls the scale (or time frame) of the data loaded by the Data Range control 295 . Each Chart (or Strategy) window is independent, therefore the Scale always reflects the © 2017 FMR LLC All rights reserved.
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configuration of the window in focus. Typically, when opening a new Chart window, the Scale is initialized to the most recent selection (exception: Preferences > Advanced Options 238 ), which you can change without affecting the other windows.



Data scale selection and control.



How to: Change Scales in a Chart Window Method 1 1. As shown in the image above, click the drop down button to the right of the Scale selection. 2. Choose one of the standard scales or a Custom Intraday Scale at the bottom. It's not necessary to click "OK" unless you are selecting a Custom Intraday Scale. 3. Scale selections are "sticky". Once you've changed the scale, clicking other symbols in the same DataSet will be charted using the last-selected scale. Method 2 Hover the mouse over the



cue in the lower-left corner of the Price Pane to display a



basic scaling menu from which you can use one click to change the chart scale to Daily, Weekly, Monthly, or any of the n-Minute scales shown.



Non-Intraday Scales Tip: Create Daily DataSets for use with all non-Intraday scales (Weekly, Monthly, etc.). When a higher time frame (scale) is selected, Wealth-Lab will quickly scale Daily data appropriately.
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Daily Daily bars consists of all price action on the same date from 12:00:00 AM to 11:59:59 PM. Weekly Compresses Daily (preferred) or Intraday price action from Sunday through Saturday, inclusive, into a single Weekly bar. Weekly bars are date-stamped with the last day available for the weekly period; normally Friday for U.S. stocks. Monthly Same as Weekly, but summarizes all price action for a calendar month in a single bar. Quarterly Same as Weekly, but summarizes all price action for a 3-month quarter in a single bar. Quarters are date-stamped with the date of the last trading day in March (3), June (6), September (9), and December (12). Yearly Same as Weekly, but summarizes all price action for a calendar year in a single bar.



Intraday Scales Common Intervals The most common intraday interval selections (1, 5, 10, 15, 30, and 60 minute) are immediately selected from the control using a single click. In Wealth-Lab Pro, 60-minute intervals are always compressed from lower time frames. If you test/trade on an hourly basis, create 30-minute DataSets to optimize the compression. Custom Intraday Scales Custom scales are any interval not included as a standard interval above. Here you can specify any less-common intraday bar intervals, for example: 3-, 8-, or 13-minute bars. It's certainly possible to have a DataSet whose native interval is not a "standard". In this case, simply selecting the DataSet or a symbol in the Data Tree will cause the backtest's/ chart's scale to use the native scale of the DataSet. However, most custom scales are derived from compressing data from existing DataSets. For example, selecting a 7-minute scale would involve the compression of 1-minute bars, whereas a 20-minute scale could be derived from 10-, 5-, or 1-minute DataSets. Note on Time Stamps Wealth-Lab assumes that data are time-stamped at the end-of-bar. Consequently, a 1min bar time-stamped 09:31 is assumed to contain data from 09:30:00.001 to 09:31:00.000. Likewise, a 30-minute bar with a timestamp of 11:00 contains data from 10:30:00.001 to 11:00:00.000.
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Data scaled from lower to higher intervals (e.g., 1-min to 7-min) is always relative to the market opening time. For the U.S. stock market, the first 7minute bar, for example, will use 1-minute interval data from 09:30 to 09:37, the next bar from 09:37 to 9:44, and so on.



Multiple Scales Wealth-Lab Pro allows you to create Strategies that use data from multiple time frames. It's important to know that "Scale" controls the base scale of the chart, and consequently, backtests. If a Strategy changes the scale (SetScaleCompressed, SetScaleDaily, etc.) to create indicators in another time frame, it must return to the base scale by calling RestoreContext before executing any trading signals. The aforementioned WealthScript Time Frame functions allow you only to generate indicators and other Price Series in a more compressed time frame that you must referenced in the base time frame to accomplish trading. See: WealthScript Language Guide > Multiple Time Frame Analysis



19.5.2 Data Range Control Like other controls in the Data Panel, the Data Range control is independent for each Chart window. For example, you can have any number of Chart or Strategy windows open each with their own data-loading configuration. The Data Range control always displays the current state of the selected option(s) so that you won't be in doubt of the range of data selected or in use. In the image below, the Data Range configuration will cause the most-recent five years of data to be loaded for the selected symbol, or for each symbol in a Multi-Symbol Backtest 326 .



The Data Range Control (light blue)



Data Range Options The following options give you the flexibility necessary to select specific data for charting and backtesting. Note that for Streaming charts, the Data Range represents the All Data All data available is loaded. No filtering whatsoever is applied. © 2017 FMR LLC All rights reserved.
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Number of Bars (Fixed) The specified number of bars are loaded, where the final bar is the most-recent bar available. This option is not recommended for Multi-Symbol Backtests except when using synchronized DataSets, meaning that all symbols have data for all the same dates. Most Recent This option loads data for the most-recent calendar period selected - years, months, weeks, or days. Consequently, if 2 years are selected and the system date is 11 June 2008, then all data from 12 June 2006 to 11 June 2008, inclusive, is loaded. If the symbol does not contain data after 11 June 2006, then no data would be loaded. Date Range Choose the Date Range radio button to filter a DataSet by a specific date range. Any data existing between and including the dates are loaded.



Tip: When selecting the date using the drop-down feature, quickly choose a month and year by clicking them at the top of the calendar. Dates are displayed according to your computer's short date format.



No Data Available If the selected range of data does not exist in your DataSet, the message "No Data Available" appears in place of a chart. To correct the condition, carefully check the Data Range that you specified and/or update the DataSet.



19.5.3 Position Size Control How to: Size Positions Wealth-Lab is position-based. This means that Strategies create Positions, which are objects that have several properties such as symbol, date purchased, and entry price, ... and a size. Position size is not programmed into Strategies, rather it's determined by the selection in the Position Size control located atop the Data Panel. Furthermore, your choice determines if the backtest is performed in Raw Profit Mode or Portfolio Simulation Mode as described in their topics that follow.



Position Sizing Tips for Trading When trading in real life, it's not necessary or realistic to try to match your backtest results precisely. For all but the most complex real-time sizing requirements by intraday futures traders, Raw Profit Mode is usually sufficient and easy to use for live trading even if you use Percent of Equity sizing for backtests. Example Assume that you use 10% equity sizing for backtests. To apply this in real trading,
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look at your Portfolio equity at the beginning of the day. If this is $98,700, then simply select and set Raw Profit Fixed Dollar sizing to $9,870. It should be clear that by repeating this simple task on a daily basis, your live trading results should closely follow simulated results.



Operational difference between the Strategy Monitor and Backtester Wealth-Lab's Backtester runs a Strategy on all of the symbols and then applies position sizing on a Portfolio-level after the fact. The Strategy Monitor cannot take this approach because it's required to run the Strategy and produce alerts in the most timely manner possible, especially for intraday data. The Strategy Monitor runs the Strategy individually for each symbol as soon as the data is available. This will lead to differences in position sizing between the Strategy Monitor and Backtester when using Portfolio Simulation modes. For this reason (and others) it is generally recommended to use Raw Profit sizing modes in the Strategy Monitor and not a Portfolio Simulation mode (like PosSizers 300 ). For example, a PosSizer 300 that sizes based on "percent winners" would base the number of winners on all symbols in the DataSet in a Multi-Symbol Backtest, whereas in the Strategy Monitor the winners would come only from the symbol currently executing. 19.5.3.1 Raw Profit Mode Raw Profit (RP) mode shows the raw profit potential associated with a trading strategy when sizing with a fixed dollar amount or with a fixed number of Shares/Contracts for each trade, which can be useful for comparisons between trading strategies. In a nutshell, RP mode gives you the total trading gain (or loss) of a strategy if you were able to execute every trade generated. In RP mode, the concept of "Starting Capital" does not exist, consequently all trades that are signaled by the strategy will appear in the results provided that at least 1 share (or contract) can be purchased using the selected sizing. For example, if you backtest in RP mode with $5,000 fixed sizing, it would not be possible to purchase even 1 share of a stock (or index) trading above $5,000 per share.



Select Raw Profit Mode by clicking one of its radio buttons in the Position Size control.
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Raw Profit Mode (Stocks) Fixed Dollar This option gives each position an equal dollar size. The number of shares is determined by dividing the position's basis price 322 into the selected amount. We recommend using this option when testing (or trading) stocks to avoid distorted results that might occur when using fixed share position sizes. With Fixed Dollar sizing, you must specify a dollar value that would result in the purchase of at least 1 share (contract) otherwise the trade will not execute. For example, if an stock is trading for $625/share, then you must specify a minimum value of 625 to purchase at least 1 share. Basis price 322 may be calculated at a higher precision than the price displayed in an Alert, for example. The higher precision can result in a share size that is slightly higher or lower than you expect - especially for "penny stocks". Fixed Share Each position is assigned the number of shares specified. Raw Profit Mode (Futures) For a symbol to use Futures Position Sizing, you must add an entry for it in the Symbol Info Manager 310 (SIM). If the symbol does not have an entry in the SIM (or if Futures Mode is disabled) then its size is based on the Stocks Position Size configuration described above. Fixed Dollar [Margin] Analogous to Fixed Dollar for stocks, this option sizes positions on a constant margin basis. The number of contracts is determined by dividing the symbol's margin from the Symbol Info Manager 310 into the specified fixed margin. Any remainder is truncated so that the result is always an integer number of contracts. Fixed Contract Analogous to Fixed Share for stocks, each position is assigned the number of contracts specified.
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19.5.3.2 Portfolio Simulation Mode Wealth-Lab Pro's Portfolio Simulation is a true trading simulation with money management rules. In Portfolio Simulation mode, you define the amount of starting equity and the position sizing rules to be used. If several trading signals occur on the same day (bar) and your portfolio does not have enough free cash to enter all (or any) of the new trades, then the simulation will reject these trades. For more information, see How Trades Are Chosen 125 . Starting Capital The amount of starting capital to use for the Portfolio Simulation. Fixed Dollar/Margin Gives each position an equal dollar (stocks) or margin (futures) size. This is the same setting as the one described above for Raw Profit Only, with the only difference of being used in a true simulation environment with starting capital. This implies that if the simulated portfolio runs out of cash or equity, the backtest cannot enter new trades/ positions. Shares/Contracts Assigns a specified number of shares (stocks) or contracts (futures) to a position. This is the same setting as the one described above for Raw Profit Only, with the only difference of being placed in a portfolio simulation environment with starting capital. This implies that if the simulated portfolio runs out of cash or equity, the simulation will not enter new trades/positions.



When a Portfolio Simulation Mode option is selected, the background is green.



Percent of Equity Lets you scale position sizes based on changes to the overall portfolio equity level. Specify the percentage of the total account equity that each position should take. Account equity is based on cash available plus the value of open positions on the Alert bar - the bar prior to the trade. Once this value is determined, position sizing proceeds along the same lines as the Fixed Dollar/Margin options above. For example, suppose you want each new position to be worth 10% of your account's equity. If the account equity were $50,000 at the time your script generated an entry signal, the position size would be $5,000. For a stock trading at $20 per share, this would translate into 250 shares. The maximum selectable Percent of Equity is 100% x Margin Factor.



© 2017 FMR LLC All rights reserved.



Reference



300



Max Percent Risk This option creates a position size based on an initial risk level that is set in the Strategy code. Your Strategy should assign the initial stop loss price level to the RiskStopLevel property. The Max Percent Risk setting requires you to specify the maximum portfolio equity loss that you are willing to tolerate. The result is a position size based on your maximum loss level calculated by the magnitude between the position's entry and stop prices. Example Current Equity:



$100,000



Position Entry Price: Initial Stop Level: Max Percent Risk: Position Size Shares: Position Size Dollars: Loss at stop price:



$80 $72 3 (Risk no more than 3% of total capital per trade) ( 0.03 * $100,000 ) / ( $80 - $72 ) = 375 Shares 375 * $80 = $30,000 Dollars 375 * ( $80 - $72 ) = $3,000



At a position size of $30,000, if our trade stops out at the $72 level, we lose 3% ($3,000) of our total account equity. Note that the trade itself is a 10% loser, ($80 $72) / $80 = 10%. As noted in the RiskStopLevel QuickRef documentation, your Strategy must be diligent to use the established stop level to exit the Position for a loss, if required. If the calculated position cash value is greater than the current equity and no other equity Positions exist in the Portfolio Simulation, position size will be based on 100% of current equity. For the sake of argument, assume that Max Percent Risk in the previous example were selected to be 12%. In this case, 1,500 shares would be calculated as the share size, which is worth $120,000 at $80/share. Since the Current Equity is only $100,000, the calculated position will be reduced to 1,250 shares ($100,000 / $80). Consequently, if the portfolio were fully in cash, the trade would be executed. WealthScript Override (SetShareSize) This option provides the ability to dynamically size your Positions during Strategy execution, on a symbol-by-symbol basis. Use the SetShareSize method to assign a specified number of shares to the next Position created. Although SetShareSize provides some flexibility, PosSizers is the recommended method to programmatically size Positions as these have access to the equity curve, cash, and drawdown value for Portfolio Simulations. PosSizer (Position Sizer) Like the SetShareSize override, PosSizers provide the ability to dynamically size your Positions, however since they have access to Portfolio-level information such as the Equity, Cash, and Drawdown curves and are reusable, PosSizers are much more versatile. PosSizers live in compiled components, therefore you need a development tool such as Visual Studio or © 2017 FMR LLC All rights reserved.
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SharpDevelop to program your own. As with other Wealth-Lab Version 5 APIs, details and an example of a PosSizer can be found at Fidelity.com. While your installation includes a small library of PosSizers, look for more as Wealth-Lab Addin Extensions at Wealth-Lab.com. Configuring PosSizers To make PosSizers more useful, most will provide a way to change important parameters. In this case, the Configure... button will appear below the PosSizer selection. Click it to open a dialog containing a description of the PosSizer and its configurable parameters. PosSizer FAQs Q: What can a PosSizer do? A: PosSizers size Positions - only! Since PosSizers can also size a trade to zero size, they can in effect reject trades as well. Q: With multiple trades per bar, in what order does a PosSizer "see" the Positions that need to be sized? A: Wealth-Lab always sizes Positions in order of priority, which is random if your script does not assign Position.Priority. Q: Can a PosSizer exit a trade? A: No, see "What can a PosSizer do?"above.



Margin Factor Set Margin Factor to a ratio greater than 1:1 to allow a backtest to borrow cash for new purchases when required. This type of margin does not apply to futures and you should set it back to 1:1 when simulating futures trading. Contract margin for futures is set in the Symbol Info Manager. Wealth-Lab uses a simplified, but reasonable margin model that differs somewhat in comparison to the Regulation T (Reg. T) rules used by U.S. brokers. It works as follows. Assume MF represents the Margin Factor. When enabled, the amount of buying power for new purchases is calculated as follows: BuyingPower = ( ( MF - 1 ) * Equity ) + Cash, where Equity is the total Portfolio Equity and Cash is the amount of free cash available for purchases. Buy & Hold assumes the risk of full margin and pays the margin loan rate of interest 230 .



19.5.4 Symbol (Go) The Symbol box/Go button provides the ability to change the symbol in Chart/Strategy windows by manually typing an ad-hoc symbol that may or may not already exist in a DataSet. If the symbol data do not exist and File > Update Data on Demand is enabled, © 2017 FMR LLC All rights reserved.
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Wealth-Lab issues a request to retrieve the data. From the Chart View, you can manually type a symbol and strike the Enter key. This is equivalent to using the Symbol/Go method. Generally speaking, clicking a symbol in the DataSet tree has precisely the same effect on the current Chart or Strategy window with the following exception. Exception: Multi-Symbol Backtest (MSB) Mode Following a MSB, it's common practice to click symbols in the DataSet under test to view their simulated trades on a chart. By design, this does not re-run the backtest for the selected symbol so as not to reset all of the Performance Visualizations 211 containing the MSB results. In order to terminate MSB mode, it's required to either a) click select a symbol and click the "Go" button to reset the Strategy window, or b) click a symbol in a different DataSet.



19.5.5 DataSet Tree The DataSet Tree, or simply Data Tree, is contained the center area of the Data Panel and provides a list all DataSets and their symbols in a tree structure. You can control which DataSet or symbol is used for charting or backtesting by clicking an item in the Data Tree. Selecting a top-level DataSet readies Strategy windows for Multi-Symbol Backtest for the entire DataSet, whereas clicking a single symbol automatically executes the Strategy on the selected symbol.



Components of the Data Tree
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Data Tree Context Menu The options in this menu are self-explanatory, except as indicated below.



Data Tree's Right-click menu



Delete this DataSet, Remove this Symbol from the DataSet Deleting a DataSet or removing a symbol does not physically delete the data from the Static Provider's data folder. Consequently, this operation will not interfere with other DataSet that contain the same symbols.



19.5.6 Strategy Parameters Strategy Parameters an advanced programming feature of Wealth-Lab Pro Version 6. Strategy Parameters are values that an author of a scripted Strategy makes available to be modified by slider controls in the Strategy Parameters frame located at the bottom of the Data Panel 292 or in the Strategy Activation Settings dialog for the Strategy Monitor. Upon altering parameter values in a Strategy window, the script is immediately recalculated so that you can see how the change affects the Strategy performance results; exception: See: Re-run Backtest. Strategy Parameters are never applicable to indicators that have been dragged and dropped. Changing Parameter Values Change a parameter's value by moving the slider or clicking in the empty area to right or left of the vertical bar. To enter a precise value without the need to conform to the predetermined Min/Max/Increment, click the parameter name and enter the value in the dialog as shown. Apart from the slider values themselves, the following action links are found in the Strategy Parameter frame after having changed a parameter's value. Save Parameters Saves the current parameter values as the default setting for the script.
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See Advanced Options 238 > Parameter Slider Values to recall the last slider value without changing the default value for the script. Re-run Backtest This action replaces Save Parameters if you adjust slider values following a Multi-Symbol Backtest. In this case, the backtest is not automatic re-run and you must click this action link or "Go" Reset Resets the parameter value(s) to the default setting, which may have been altered by Save Parameters, and immediately re-executes the backtest.



How to: Expose Strategy Parameters A procedure to create parameters in Strategy code is given in the WealthScript Programming Guide. For Rule-based systems, see Parameter Sliders for the Strategy Builder 99 .



How to: Set Preferred Values from Sliders When you find a combination of Strategy Parameters, or Straps, that work well for a particular symbol or DataSet, you can set its Preferred Values 136 by right clicking in the slider area (not on the sliders) and selecting Store these Parameter Values as the Preferred Ones for the Symbol. Apply the PVs by enabling the PV button in the Strategy Window in the lower right status bar or in the Strategy Monitor from the Activation Settings dialog.
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Dialogs



19.6.1 Strategy Explorer The Strategy Explorer is a Windows Explorer-like interface from which you can search and select existing Strategies for charting and/or testing. Strike the Ctrl+O shortcut to Open a Strategy from the Strategy Explorer.



Associate an account to one or more Strategies.



(Create/Delete Folders) You can reorganize your Strategies by creating new or deleting existing ones. Drag and drop one or more strategies to move them into new folders. See also: Map Network Path



Only one folder level is supported. Subfolders will not be visible. Folders and Search Views The Search view provides a way to search for Strategies by name, code, or its author. You can also use Windows Explorer to add or delete folders and Strategies, which can be found in the local Data folder. Close Wealth-Lab Pro prior to such operation with third-party tools. New Rules-Based Strategy, New Script-Based Strategy These actions are the same as those found in the File menu 287 , Navigation toolbar (Charts & Strategies), or the Function toolbar 290 .



289



Import... Imports Strategies (XML-based only) from another location into the currently-selected folder. Download... Download Strategies from Wealth-Lab.com for a source of new ideas. Strategies are categorized to keep them organized in the installation folders, although it's possible for
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downloads to create new Strategy folders. Downloaded Strategies are displayed using blue text, and, to quickly identify all downloaded items click Show Downloaded Strategies in the Search view. Public Strategies Check this option to download Strategies from the public domain, offered freely by the Wealth-Lab community. Strategies are validated as "safe" by Wealth-Lab technicians before being approved for download. Private Strategies Strategies that you upload to Wealth-Lab.com are marked private by default. Downloading private strategies requires that you supply your website credentials. Published since: [Date] For best results, use the date filter to limit the number of Strategies downloaded. The calendar date will automatically default to the last date you downloaded Strategies. Delete Deletes one or more selected Strategies. Set Account... If you trade with more than one brokerage or paper account, use this action to associate one or more selected Strategies with a specific account. An associated account is the destination for trading signals (Alerts) from the specified Strategy. If a Strategy is not associated with an account, then the Default Account 240 is used. Network Paths to Strategies By default, Strategies are stored in the Strategies subfolder beneath the main User Data folder 35 . However, you can use the Strategy Explorer to map network path(s) in order to maintain Strategies on network drives. The Strategy Explorer will remember mappings between sessions, but is limited to one level of subfolders. Consequently, for the best organization we recommend mapping to a Network Path that contains categorized subfolders of Strategies (see Example). Example The image below demonstrates mapping to a network path P:\Strategies that has two subfolders Shared and Utilities, each of which contains Strategies for personal use or collaboration, if shared.
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Share Strategies between users in a Network drive.



Warning! Strategies on shared network paths are shared without source control. The version of the strategy on the network will reflect the last change to a Strategy saved by any user.
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19.6.2 Technical Indicators Use of Technical Indicators are the heart of technical analysis, and Wealth-Lab comes packed with well over 100 of the most popular indicators ready to drag and drop 87 (or double click) into Chart or Strategy windows. The actual total number of indicators available is displayed in the lower left corner. You can readily access the Technical Indicators dialog at any time by clicking the Indicators button in the Navigation or Function toolbars, from the Tools menu, a chart's right-click menu, or simply using the Ctrl+F11 shortcut. All indicators found in the dialog are available for use in the Strategy Builder 97 as well as in WealthScript code, which explored in depth in the WealthScript Language Guide. To access Technical Indicators in Strategy code, you must reference the WealthLab.Indicators namespace. Short descriptions are provided for each indicator, or follow the More Info... link at the bottom of the dialog for more details.



19.6.3 Fundamental Data Items Wealth-Lab Pro allows you to incorporate Fundamental Data items in into Chart or Strategy windows using the drag and drop 92 or doubleclick methods from the Fundamental Data dialog. You can readily access the Fundamental Data dialog at any time by clicking the Indicators button in the Navigation or Function toolbars, from the Tools menu, a chart's right-click menu, or simply using the Ctrl+U shortcut. All fundamental data items shown in the dialog are available for use in the Strategy Builder 97 and in WealthScript code, which explored in more depth in the WealthScript Language Guide. Short descriptions are provided for each item, or follow the More Info... link at the bottom to launch the Fundamental Data Guide.
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19.6.4 QuickRef The WealthScript QuickRef (Quick Reference) is a concise guide to the WealthScript class methods that you use in Strategy code. Each method shows the proper syntax and a description for its use. Most entries also contain an example (How to run Example Code 8 ). The QuickRef is intentionally a partial guide to WealthScript for use in programming Strategies. Methods that are not covered by the QuickRef are not supported, and their use may produce unexpected results. Methods to launch the QuickRef Click the QuickRef button in the Editor toolbar, or Main menu: Tools > WealthScript QuickRef, or Strike the F11 keyboard shortcut



Tip: To quickly open the QuickRef to a specific WealthScript object, function, etc., position the cursor on the word in the Strategy Editor and strike the F1 key.



19.6.5 Debug and Error Messages Window The Debug Window is a useful output device for a script. Call PrintDebug() in scripts to write information about script variables, state, etc. for use in debugging or for any other general purpose. When running a Multi-Symbol Backtest 119 , in addition to PrintDebug() output, error messages appear in the Debug window instead of in the Editor's message pane. Methods to launch the Debug Window On its first reference, the Debug window is automatically displayed. Strike the Ctrl+Alt+D keyboard shortcut. Main menu: Tools > Debug and Error Message Log Clear Messages accumulate in the Debug window until you clear them by clicking Clear. It can be convenient to automatically refresh the Debug window by including a call to ClearDebug() at the beginning of a script. Topmost Keeps this window on top of all other applications in MS Window's "Z-order" so that it is always in view.
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Symbol Info Manager The Symbol Info Manager (SIM) lets you specify special properties of futures, equity, and fund symbols. You can assign values for Point, Tick, and other items to futures symbols according to their contract specifications as well as the initial Margin requirement. Wealth-Lab uses the data provided that Futures Mode is enabled.



Enter futures contract data in the Symbol Info Manager.



SIM data are stored in the SymbolInfo.xml file located in the main data folder



35 .



Futures Mode Futures Mode must be enabled to properly work with futures data. Enabled Wealth-Lab uses the Point Value, Margin, and Tick values established for each symbol whose Type is 'Future' for backtesting and trading. Futures Mode applies only to symbols that are specified to be Type 'Future' in the SIM. It is recommended to always leave Futures Mode enabled. Disabled Symbols whose Type is 'Future' are treated as stocks (equities). Important! You can leave Futures Mode enabled always, even when working with stocks. Futures Mode simply instructs Wealth-Lab to treat all symbols whose Type is 'Future' as futures symbols. All other symbols are treated as Stocks except as specified in the SIM. Disabling the special processing of futures symbols may be necessary only in rare cases in which a stock symbol matches a futures symbol, or for some other investigative purpose.



Fields / Properties Symbol The Symbol field is a Regular Expression (RegEx)
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The Symbol field is entered using RegEx. Don't worry if you're not familiar with RegEx, you only need to know a few rules in order to create a single symbol expression that will match all contracts for a futures instrument. The guide and examples below are sufficient to cover most cases, however RegEx is a large topic; if required use web resources for more information. Example Assume you testing the S&P 500 E-mini contracts. If you didn't use RegEx for the symbols, you'd need 16 records/symbols for 4 years of contracts, all with the same specifications. With RegEx, you'll only need 1 record with the following Symbol expression: ES[HMUZ]\d Let's break down this expression: 1. The root of the contract is ES. Since these two letters are required to be matched, you specify them just as they are. 2. The choices for the third character, the month code, are grouped in brackets. It means that the character in the third position must match H or M or U or Z. 3. Finally, \d means "digit". It will match any digit character, 0 to 9, which will correspond to the contract's year. Therefore, ES[HMUZ]\d matches any of these symbols: ESM1, ESZ0, ESH8, etc. If your E-mini symbol has a space between the root and the month, then the expression would change to ES\s[HMUZ]\d, where \s matches a white space. Character (and Numeric) Ranges Previously, with the [HMUZ] example, we saw how to match an explicit set of characters. However, an alphabetic or numeric range can be defined using a hyphen as shown in the examples. Example Expression [0-9] (same result as \d) [a-fA-F] [0-9a-zA-Z]



Matches any digit, 0 through 9 any lowercase or uppercase character in the range a through f any digit or character in the ranges



Special Characters Legacy users who already have populated their symbols don't necessarily need to change anything for RegEx compatibility. However, if a symbol contains any of the following special characters, then it needs to be preceded by the Escape character, \:



\ ^ * . [ ] { } 
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Escape Character \ The first of the special characters, \, is the "escape character". Its combination with a letter that follows it has special meaning as a RegEx, just as we saw above with \d and \s. However, if your futures symbol actually uses a special character, you can escape it so that it is matched as a literal character. For example, if your data provider has an e-mini symbol like ES+M1, then the expression for those contracts would become: ES\+[HMUZ]\d Implied Anchors are automatic Since the purpose of the SIM is to match a symbol or the entire "word", it's required to use a ^ at the beginning and a $ at the end of each symbol expression. Since this is necessary for every record, Wealth-Lab does this automatically, behind the scenes, and you are not required (and should not) enter those characters around the symbol expressions.



Type Specify Equity, Future, or Mutual Fund. By default, all symbols are treated as stocks, consequently it is not necessary to specify equities in the SIM. Margin The Margin value determines the amount of cash in dollars required in a trading account to establish a single contract Futures position. In Portfolio Simulation Mode, Wealth-Lab uses the margin value to ensure that you don't overextend and take on more Positions than your current equity level can support. For example, assume cotton (CT) uses a margin setting of $8,000. If you run a backtest with Starting Capital = $100,000 and Position Size = 20% of Equity, your first Position in CT would be for (100,000 * 20%) / 8,000 = 2 contracts. This results in $8,000 * 2 = $16,000 of capital used for the Position in CT, leaving $84,000 available for additional Positions. Futures margin is a fixed value, consequently it is not possible to apply margin in a dynamic manner during backtests. Point Value In Wealth-Lab, the Point Value is amount of profit/loss generated by one contract for a one dollar change in price. For example, assume that you have a long Position in cotton for 1 contract. Since the Point Value of cotton is $50,000, your Position will gain $50,000 profit for every one dollar increase in the price of cotton. Since cotton currently trades in the $1 to $2, every 0.01 change in a bushel of cotton is worth $500. Tick Sets the tick value, or the minimum price movement of the futures symbol. For example, at the Tick Value of cotton (0.0001), each tick is worth $5.
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Tip: In Strategy code, use the Bars object's .Margin, .PointValue, and .Tick properties to access a their corresponding values for a symbol. Decimals Sets the number of digits after the decimal when displaying prices for the instrument.
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Futures Mode Characteristics Future symbols always trade in increments of their tick value found in the contract specifications. However, most often prices used in stop and limit orders are based on indicators whose values do not conform with the specification. Consequently, stop and limit prices are adjusted to the next "ceiling" or "floor" Tick value according to the order type as follows Ceiling Price for:



Floor Price for:



ShortAtLimit



BuyAtLimit



SellAtLimit



CoverAtLimit



BuyAtStop



SellAtStop



CoverAtStop



ShortAtStop



Example 1 (No Slippage 233 ) Assume you're holding a long position, p, of a futures contract that has a Tick Value of 0.25. Your calculated profit target (limit price) is $50.33. Wealth-Lab will ceiling the limit price in the signal SellAtLimit(bar + 1, 50.33, p); to the next higher Tick increment, consequently, the sale will take place when price reaches $50.50 (or greater for an opening gap in price). Example 2 (1 Tick of Slippage 234 ) With the same long position from Example 1, you have calculated a stop loss of $46.21. Wealth-Lab will floor the stop price in the signal SellAtStop(bar + 1, 46.21, p); to the next lower Tick increment. Consequently, the sale for a loss will be executed at $46.00 or lower. If 1 Tick of slippage were activated, this sale would take place at $45.75 in a backtest.
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Keyboard



19.9.1 Shortcuts In addition to the shortcuts below, you can activate/deactivate the main menu from the keyboard by striking (then releasing) the Alt key. When activated, the menu items will contain an underlined letter that you can select on the keyboard to expand the menu. You can then select the desired function in the menu drop-down list in a similar manner or by clicking the item with the mouse. Alternatively, after activating the menu with the Alt key, you can navigate with the arrow keys and press the Enter key to launch the highlighted item. To use the keyboard shortcuts, press and hold the Ctrl, Alt, and/or Shift key(s) as applicable and then strike the desired letter or F-key. Esc



Terminate Strategy Execution



F1



Main Workspace: Wealth-Lab User Guide with context-sensitive help Strategy Editor: QuickRef to the WealthScript function at the cursor



F2



Enables a field in a table for editing, as for the Symbol Info Manager



F3



Strategy Monitor



F5



Execute strategy



F11



WealthScript QuickRef



F12



Preferences



Ctrl + F4



Close window (chart, Quotes, etc.)



Ctrl + F5



Execute strategy



Ctrl + F11



Technical Indicators



Ctrl + F12



Preferences: Chart Colors and Style



Ctrl + Home



Chart: Scroll to beginning of chart Editor: Top of code



Ctrl + End



Chart: Scroll to end of chart Editor: Bottom of code



Ctrl + Tab



Switch between windows (tools) within a Wealth-Lab Workspace



Ctrl + A



Editor: Select All



Ctrl + B



(Unused)



Ctrl + C



Editor: Copy



Ctrl + D



Data Panel (hide/view)



Ctrl + E



(Unused)



Ctrl + F



Editor: Find



Ctrl + G



Editor: Go to line number



Ctrl + H



Editor: Find and Replace



© 2017 FMR LLC All rights reserved.



Reference



316



Ctrl + I



Editor: Incremental Search



Ctrl + J



(Unused)



Ctrl + K



Editor: Bookmark; after Ctrl+K, type K or a number key to complete the bookmark Editor: Go to Bookmark; after Ctrl+K, type N/P for next/previous unnumbered bookmark



Ctrl + L



Login to Fidelity



Ctrl + M



Data Manager



Ctrl + N



(Unused)



Ctrl + O



Strategy Explorer, Open Strategy



Ctrl + P



(Unused)



Ctrl + Q



(Unused)



Ctrl + R



Orders



Ctrl + S



Save Strategy



Ctrl + T



Toggle Trade Ticket (hide/view)



Ctrl + U



Fundamental Data



Ctrl + V



Editor: Paste



Ctrl + W



Open Workspace



Ctrl + X



Editor: Cut



Ctrl + Y



Chart: Chart Style Settings...



Ctrl + Z



Editor: Undo last



Additional Strategy Editor shortcuts are available. See Editor Shortcuts



Ctrl + Shift + C



New Chart Window



Ctrl + Shift + R



New Strategy from Rules



Ctrl + Shift + S



New Strategy from Code



Ctrl + Shift + W



New Main Workspace Window



Ctrl + Shift + M



New Combination Strategy



Ctrl + Shift + Q



New Quote Window



Ctrl + Shift + D



New DataSet
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.



Notice that Ctrl + Shift + Letter items are selections from the File | New menu.
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Ctrl + Alt + D



Data & Error Message Log



Ctrl + Alt + F



Symbol Info Manager



Ctrl + Alt + L



Update Data on Demand (enable/disable)



Ctrl + Alt + R



Strategy Rankings tool



Ctrl + Alt + T



Accounts



Ctrl + Alt + Z



Streaming (on/off)



More useful Windows standard shortcuts: Alt + F4



Closes application



Alt + F6



Switch windows for the current application. For example, switch between open main Wealth-Lab Workspace windows or to QuickRef, Indicators, etc.



Alt + Tab



Switch to other open applications in the Windows Task bar



19.9.2 Shortcuts by Category File | New Menu Ctrl + Shift + C



New Chart Window



Ctrl + Shift + R



New Strategy from Rules



Ctrl + Shift + S



New Strategy from Code



Ctrl + Shift + M



New Combination Strategy



Ctrl + Shift + W



New Main Workspace Window



Ctrl + Shift + Q



New Quote Window



Ctrl + Shift + D



New DataSet



File Menu Ctrl + O



Open Strategy



Ctrl + W



Open Workspace



Ctrl + F4



Close window (chart, Quotes, etc.)



Ctrl + S



Save



(none)



Save As...



F12



Preferences



Ctrl + L



Fidelity Account Login



Ctrl + Alt + L



Update Data on Demand (Enable/Disable)



Alt + F4



Exit
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Edit Menu The Edit menu is available when a Strategy Editor is in focus. Ctrl + Z



Undo



Ctrl + X



Cut



Ctrl + C



Copy



Ctrl + V



Paste



Del



Delete



Ctrl + A



Select All



Ctrl + F



Find



Ctrl + H



Find Replace



(none)



Set as Default Template Code



View Menu Ctrl + T



Trade Ticket



Ctrl + D



Data Panel (hide/view)



(none)



Status Bar



(none)



Navigation Bar



(none)



Navigation Bar Icons



(none)



Function Toolbar



(none)



Drawing Toolbar



Tools Menu (none)



Home Page



Ctrl + Alt + T



Accounts



Ctrl + R



Orders



F3



Strategy Monitor



Ctrl + M



Data Manager



Ctrl + Alt + F



Symbol Info Manager



Ctrl + Alt + R



Strategy Rankings



Ctrl + Alt + I



Index Manager



Ctrl + F11



Technical Indicators



Ctrl + U



Fundamental Data Items



Ctrl + Alt + D



Data & Error Message Log



F11



WealthScript QuickRef



F12



Preferences
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Workspaces Menu Ctrl + Shift + W



New Main Workspace Window



Ctrl + W



Open Workspace



(none)



Save Workspace



(none)



Set as Default Workspace



Window Menu (none)



Help Menu F1



Wealth-Lab Pro User Guide



F11



WealthScript QuickRef



19.9.3 Editor Shortcuts All shortcuts for the Strategy Editor's are listed in the Editor Options. Just click Options... > Keyboard in the Editor's function toolbar. Some editor shortcuts are overridden by shortcut assignments used by WealthLab for other purposes. Check the Shortcuts 315 topic. Some of the most commonly-used shortcuts are listed here. F1



Launches QuickRef for the WealthScript function at the cursor



Tab



Indent (can operate on a block selection)



Shift+Tab



Outdent (can operate on a block selection)



Ctrl+A



Select All



Ctrl+C



Copy



Ctrl+E, C



Comment selection



Ctrl+E, U



Uncomment selection



Ctrl+F



Find Dialog



Ctrl+G



Go to line number



Ctrl+H



Replace Dialog



Ctrl+I, letter(s)



Incremental search down from cursor



Shift+Ctrl+I, letter(s)



Incremental search up from cursor



Ctrl+K, K or number



Bookmark



Ctrl+K, N/P



Next/Previous unnumbered bookmark
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Ctrl+K, X



Code snippets (see below)



Ctrl+S



Save



Ctrl+T



Transpose letters at cursor, or add a white space between selection and final letter



Shift+Ctrl+U



Uppercase selection



Ctrl+V



Paste



Ctrl+X



Cut



Ctrl+Z



Undo last



Ctrl+Space



List Members (also Ctrl+K, L)
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Ctrl+Shift+Space Parameter information Shortcuts overridden by main Wealth-Lab application: Ctrl+L



Delete line (or selection)



Ctrl+M, Ctrl+M



Collapse/Expand section



Ctrl+U



Lowercase selection



Ctrl+W



Select word. Subsequently selects next word



Code snippets Code snippets allow insertion of frequently-used fragments of code into the editor by executing code snippet popup window with Ctrl + K, X key sequence (default keyboard assignment). Code snippets permit you to quickly enter one of the predefined pieces of text. If some fields are declared in the code snippets, editor allows modifying their values causing updating field value inside whole snippet. Since snippets are predefined, it's not currently possible to make additions.
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19.10 Glossary A



321 326



| B 322 | C 322 | D 323 | E 324 | F 324 | G 325 | H | O 326 | P 326 | Q 327 | R 327 | S 328 | T 329 | U



325 330



| I 325 | J 325 | K 325 | L 325 | M 326 | N | V 330 | W 331 | X 331 | Y 331 | Z 331



A Activate Strategy Activate a Strategy in the Strategy Monitor for Wealth-Lab to automatically execute a Strategy at the end of the specified interval/scale. While the Strategy Monitor is open, it automatically runs all Active Strategies to generate trading Alerts. To activate a Strategy select it and then click the Activate Strategy button. The icon appears next to the Strategy's name to indicate that it is activated to generate Alerts as shown in the image.



See also: Auto-Stage Alert(s) An Alert, or Trade Alert, is a notification for an order to be placed for the next bar. Example On 5-minute interval chart's last bar, whose time stamp is 14:05, a Strategy generates an Alert to Buy 200 shares of INTC at Market. If trading this Strategy, you should immediately place this order to be executed at the start of the next bar, whose time stamp will be 14:10 when its interval completes. Alerts do not refer to any historical or past theoretical trades created by a Strategy. Auto-Place Auto-Place automatically places Alerts as orders with Fidelity. The order's status can be monitored in the Orders 179 window. The Auto-Stage actions in the Strategy Monitor, Strategy Window, and Quotes tool become Auto-Place when Auto-Trading is enabled. See also: Auto-Stage, Auto-Trading Auto-Stage Auto-Stage automatically routes Alerts to the Orders 179 window, where the order is queued with a "Staged" status. Staged orders can be edited, and they require manual intervention to place the order. When Auto-Trading is enabled, Auto-Stage transitions to Auto-Place. Staged order is immediately Placed. Otherwise, you must manually Place the order. In a Strategy window, the Auto-Stage option (configured on the Alert tab) is available only if Streaming is enabled. See also: Stage, Auto-Place, Activate Strategy
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Auto-Trading When enabled in the Orders 179 window, Auto-Trading automatically places orders with Fidelity that enter the Orders queue. Enable Auto-Trading will not place orders with a "Staged" status that already exist in the Orders window. Special account entitlements are required to enable Auto-Trading. Call Fidelity Active Trader Support for the latest information.
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Backtest A Backtest uses actual historical data to determine what would have occurred, theoretically, had you traded a Strategy during a specified test period. In this guide, backtest and simulation are used interchangeably. See also: Raw Profit Mode, Portfolio Simulation Mode Basis Price Whenever your Strategy generates a buy or short signal, Wealth-Lab must determine the number of shares for the order. Wealth-Lab uses a Basis Price to determine the number of shares to buy or short. Basis Price is dependent on the order type as shown in the table below, where "Signal Bar" refers to the bar on which the order was signaled, and "Entry Bar" is Signal Bar + 1. Order Type



Basis Price



Actual Entry Price



Buy(Short) AtMarket



Closing price of Signal Bar



Open Price of Entry Bar



Buy(Short) AtLimit



Limit Price



Limit Price or Open Price, whichever is Lower (Higher)



Buy(Short) AtStop



Stop Price



Stop Price or Open Price, whichever is Higher (Lower)



Buy(Short) AtClose



Closing price of Signal Bar



Closing Price of Entry Bar



Buy and Hold Buy and Hold (BH) is a trading strategy in which an instrument is purchased on the open of the second bar (bar number 1) of the backtest period and held until the end of the test range. In several Performance Visualizers, Wealth-Lab displays the results of the BH strategy for comparison with your test Strategy.



C



Top Chart Style A Chart Style is a visual representation of a symbol's OHLC/V data. Examples: Line chart, Candlestick chart, Renko chart, etc.
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Data Manager The Data Manager is used to create, update, delete, and otherwise manage price and fundamental data for static DataSets. Data Panel The Data Panel is the center of data control for all Charts and Strategy windows. It's configuration can be customized for each window, and is recalled when focus returns to the associated window.



The Data Panel contains controls to modify Scale, Data Range, Position Sizing, DataSet/ Symbol, and Strategy Parameters. DataSet A DataSet is a collection of symbols, usually a group of stocks or futures, that contains static price and volume data to use for charting and Strategy testing. All available DataSets are displayed in the Data Panel. Use the Data Manager to update DataSets so that they contain the most-recent data. See also: Static Data, Data Panel, Data Manager DataSet Tree, or Data Tree The DataSet Tree is contained the center are of the Data Panel and provides a list all DataSets and their symbols in a tree structure. You can control which DataSet or symbol is used for charting or backtesting by clicking an item in the Data Tree. See also: Data Panel Data Range Use the Data Range control in the Data Panel to specify amount of data or range of © 2017 FMR LLC All rights reserved.
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dates to access/load in a Chart or Strategy Window. See also: No Data Available Default Account Applies to: Customers with multiple accounts. The default Fidelity trading account is the destination for discretionary and automated trading unless another account is specified. For example, Strategies can be associated with other accounts using the Strategy Explorer 305 as well as when configuring Strategies in the Strategy Monitor 147 . See: Trading Preferences



240



E
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Ex-Date or Ex-dividend Date The date on which shares trade at their split-adjusted and/or dividend-adjusted price. Exposure Exposure is a Performance Visualizer 212 metric that measures the amount of portfolio equity that was exposed to (committed to) the market during a backtest. A Strategy with low exposure is said to be more efficient than a Strategy that performs equally well but with higher exposure. Extensions Extensions are plug-ins that add new features or more capability to Wealth-Lab Pro. Extensions can be adapters for Data Providers, Strategy packs, Indicator libraries, or other Add-ins such as Performance Visualizers. See: Extension Manager
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Full Optimization In a Full Optimization, the entire data range is used to discover the optimum Strategy parameter(s) based on a selected metric, such as highest Net Profit or lowest Drawdown, for example See also: Walk-Forward Optimization Fundamental Data Fundamental data is any data about an instrument that is not price and volume, usually for publicly-traded companies (stocks). Some examples include Balance Sheet, Income Statement, Cash Flow, Analyst ratings, Insider transactions, and Economic indicators. Although traditional technical analysis doesn't make use of fundamental data, Wealth-Lab simplifies analyzing fundamental data in a time-series along with price and volume, enabling a "hybrid analysis" for creating medium to longterm Strategies.
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Gap Open Generally referring to daily data, price is said to "gap open" when the day's opening price is different (often differing greatly) than the previous day's closing price. Ghost bar In a streaming chart, the ghost bar refers to the right-most bar that contains partial (incomplete) interval data. Since scripts are executed using data from complete bars, the data in the ghost bar is generally not available for Strategy processing. Exception: See GetSessionOpen() in the QuickRef (F11).
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Indicators (Technical) Technical indicators are indicators based on price and/or volume data that attempt to identify repetitive patterns or trends in market data. Generally, technical traders combine conditions stemming from multiple indicators (perhaps using different time frames) for trade setups and triggers. In focus The window that is currently selected in a Workspace window is said to be "in focus". Generally, you put the focus on a window by clicking it or by striking Ctrl+Tab to switch the current window.
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Level I Level I (pronounced "level one") is the last price and current "inside" or "best" quote for an instrument, i.e., the highest bid and the lowest offer. Wealth-Lab displays Level I information in the Quotes 160 tool in the form of last price and change from the previous day's close. Level II Level II (pronounced "level two") is a real-time quotes screen that shows bid and ask depth pricing by Exchange/ECN. Generally, Level II is used by point-and-click traders for order routing. Wealth-Lab does not use and does not have access to Level II © 2017 FMR LLC All rights reserved.
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information.
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Multi-Symbol Backtest Same as backtest, but by selecting the DataSet in the Data Panel, you can run a "collective" backtest for each symbol. In Portfolio Simulation Mode, the results are combined to create a real-world Portfolio Simulation with money-management rules. MAE, MAE% Maximum Adverse Excursion represents the largest intraday loss that a trade suffered within its lifetime and can be represented in both dollars and percentage terms. To see MAE% of trades following a backtest, use Wealth-Lab's MAE/MFE Performance Visualizer 222 . In WealthScript code, use the MAE and MAEPercent properties of the Position object to access a closed Position's MAE and MAE%. MFE, MFE % Maximum Favorable Excursion represents the largest intraday gain/profit that a trade achieved within its lifetime and can be represented in both dollars and percentage terms. To see MFE% of trades following a backtest, use Wealth-Lab's MAE/MFE Performance Visualizer 222 . In WealthScript code, use the MFE and MFEPercent properties of the Position object to access a closed Position's MFE and MFE%.
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No Data Available When a symbol or DataSet does not contain any data in the range specified by the Data Range control in the Data Panel, the message No Data Available is displayed. If this message is unexpected: 1. Ensure that the Data Range control is configured properly. 2. Update the symbol "on Demand" (if applicable to the data provider), or, 3. Update the symbol's DataSet using the Data Manager.
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On-Demand (Update) You can configure Wealth-Lab to update a symbol's static price data when required, or "on demand", which is especially useful for viewing charts of ad-hoc symbols. The advantage is that you don't spend time and resources unnecessarily accessing data that you do not use. However, strategies that require many DataSet symbols can probably be updated more efficiently all at once using the Data Manager. Optimization See Full Optimization. P



Top Paper Trading
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Paper Trading allows you to use most of the same functionality that you use in Wealth-Lab Pro for real/live trading except that orders are filled in a simulated environment. Configure Paper accounts in the Accounts tool and use them in the same was as you would a real trading account. See Orders > Paper Trading 180 Parameters see: Strategy Parameters Park (Alerts/Orders) see: Stage Portfolio Simulation Mode Portfolio Simulation mode enables a true trading simulation with money management rules. In Portfolio Simulation mode, you define the amount of starting equity and the position sizing rules to be used for a backtest. If several trading signals occur on the same day (bar) and your portfolio does not have enough free cash to enter and or all of the new trades, then these trades are rejected. Change to Portfolio Simulation Mode by selecting one of its radio buttons. Be sure to enter the desired Starting Capital. Position Size The size of a Position is the quantity of shares or contracts traded. Note that Wealth-Lab is Position-based. Strategy code creates and operates on Position [objects], while those Positions are actually sized by the Position Size control 296 . Price Trigger Price triggers are stop or limit order prices used to trigger a trade Alert in the Quotes tool. You can manually add price triggers to a Quotes window. See also: Trigger Threshold
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Raw Profit Mode
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Raw Profit (RP) Mode provides the ability to obtain the raw profit potential of trading strategy (total gain or loss) when sizing Positions with a fixed dollar amount or with a fixed number of Shares/Contracts. In RP mode, all trades created by the strategy will appear in the results provided that at least one share (or contract) can be purchased based on the selected sizing. Raw Profit mode is selected by clicking one of its radio buttons in the Position Size control.
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Scale Scale is the measure of time used to summarize the trading activity of a single OHLC bar of data. Consequently, if each bar in a chart represents the trading activity for one day, the chart is said to be a "Daily [Scale] chart". Setup(s) A setup is an enabling condition for a trade action and are usually expressed as "greater than/less than" conditions. Setups generally remain in a "true" state for multiple bars awaiting a triggering condition that actually initiates, or triggers, the trade action. See also: Trigger (trade) Signal Name The Signal Name is the signalName string parameter (optional) passed to the BuyAt, SellAt, ShortAt, CoverAt, and ExitAt Trading functions in Strategy code. Additionally, Alerts generated by Tradable Trendlines are given the Signal Name Tradable Trendline(Trendline Name), where the Trendline Name is specified in the Trendline's Properties dialog. Simulation Backtest and Simulation are used interchangeably. See: Backtest Slippage If the difference between an order's expected execution price and the actual filled price results in a negative gain, it's called slippage. (If it results in a positive gain, then it's called luck.) You can simulate less-than-perfect fills by applying slippage in backtests using Slippage Preferences 234 . Stage (Alerts/Orders) Another commonly used term for staging orders is to "park" orders. Orders that are Staged are sent to the Orders tool for placement. If Auto-Trading is enabled, a Staged order is immediately Placed. Otherwise, you must Place a Staged order manually. Static (data) © 2017 FMR LLC All rights reserved.
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When you create and update DataSets, you're creating and updating static data. It's "static" because it's stored locally on your computer's hard drive for fast access. Static data are used for backtests as well as for backfill (history) in streaming charts. Strategy See: Trading Strategy Strategy Explorer The Strategy Explorer is a Windows Explorer-like interface from which you can search and select existing Strategies for charting and/or testing. Strike the Ctrl+O shortcut to launch the Strategy Explorer in order to Open a Chart window that contains an existing Strategy.



Strategy Monitor The Strategy Monitor allows you to store one or more Strategies and set up each one with custom Strategy Parameters, data, scale, and sizing so that you can manage all Trading Alerts from one location. Strategy Parameters Strategy Parameters are values that an author of a scripted Strategy makes available to be modified by slider controls in the Strategy Parameters frame located at the bottom of the Data Panel 292 or in the Strategy Activation Settings dialog for the Strategy Monitor. Upon altering parameter values in a Strategy window, the script is immediately recalculated so that you can see how the change affects the Strategy performance results. Note that Strategy Parameters are never applicable to indicators that have been dragged and dropped. Strategy Window A Strategy window is a Chart window that is loaded with a code-based Strategy (Editor tab) or rules-based Strategy (Rules tab). Strategies can be as simple as a single-plotted indicator. Streaming (data) Streaming involves the process of maintaining a subscription for one or more symbols with a provider that furnishes data in real-time on a tick-by-tick basis. The ticks are used by Charting 55 to build bars in real time, or by the Quotes 160 tool to monitor the last trade price, which is used to trigger trade Alerts.
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Template Code The code template is script that is loaded in the Editor view of a New Strategy Window. You can think of it as a document template for a memo, for example. You can change the template by modifying it and selecting Edit > Set as Default Template Code.
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TestAccount TestAccounts are local accounts to be used for Paper trading. You can add, delete, and configure PaperAccounts using the Account Balances and Positions tool (Ctrl+Alt +T). Tradable Trendline Tradable Trendlines Alerts.



71



are manual drawing objects



66



that can generate trading



Trade Ticket The Trade Ticket (Ctrl+T) allows you to place discretionary trades to the live or paper account specified in the Account selector. Trading Strategy A Trading Strategy is a set of well-defined rules, expressed in the WealthScript Language code, that determine when to enter and exit trading Positions - generally based on technical and/or fundamental analysis. You can backtest strategies in Wealth-Lab just one symbol at a time or over a complete DataSet of symbols in a true Portfolio Simulation that uses real-world rules. Trigger Threshold In the Quotes tool, stop and limit orders trigger Alerts when price has met (100%) or exceeded the stop or limit price. The trigger threshold allows you to adjust the percentage for early or late triggering by setting a value less or more than 100%, respectively. Trigger (trade) A trigger is the final condition required to initiate a trading decision. Typically, but not necessarily, a trigger is an isolated event such as a CrossOver/Under or TurnUp/ Down. See also: Setups
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Update A data update - from the Data Manager or by an on-demand request - accesses the most-recent data available and saves it to disk. Whenever possible, Wealth-Lab stores price history data from integrated data providers locally; making it unnecessary to continually request the same data for backtesting or for streaming chart backfill. See also: On-Demand
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WatchList See: DataSet Workspace A Wealth-Lab Workspace can have any number of Charts, Strategy windows, Quotes, and other tools arranged in a custom fashion to help organize your trading and/or market analysis work flow. You can launch, save, and recall any number of main Workspace windows and spread them across multiple monitors. WealthSignals WealthSignals™ is a web-based trading signals service developed by MS123, a partner company, offered exclusively at Wealth-Lab.com. See: WealthSignals Trader 169 Walk-Forward Optimization Optimization analysis that evaluates a trading strategy exclusively on the basis of its performance on Out-of-sample price data, i.e., data that have not been seen by the optimization process. See also: Full Optimization
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19.11 Acronyms Acronym



Description



API



Application Programming Interface



ANN



Artificial Neural Network



BH (or B&H)



Buy and Hold



CAGR



Compound Annual Growth Rate



DS



DataSet



FO



Full Optimization



GICS



Global Industry Classification Standard



IS



In-sample (Optimization)



MAE



Maximum Adverse Excursion



MC



Monte Carlo



MCV



Monte Carlo Visualizer



MDI



Multiple Document Interface



MFE



Maximum Favorable Excursion



MS



Microsoft



MSB



Multi-Symbol Backtest



NN



(See ANN)



OCO



One cancels other (bracket order)



OHLC/V



Open, High, Low, Close, and Volume



O.C.



Optimization Control



OM



Order Manager or Orders tool



OOS



Out-of-sample (Optimization)



PP



Paper [Trading] Provider



PV



Preferred Values (for Strategy Parameters)



RP



Raw Profit



SM



Strategy Monitor



SIM



Symbol Info Manager



Strap(s)



Strategy Parameter(s)



TIF



Time in force



TSSN



Trading System Subscriber Network



WLE



Wealth-Lab Extension



WFO



Walk-Forward Optimization
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User Guide, Wealth-Lab Pro Strategy Monitor 150 Strategy Window 113 Auto-Stage 184 Strategy Monitor 150 Strategy Window 113 Auto-Trading Checklist 199 Auto-Trading (Orders tool) 188 Awaiting Publication 175



Index -1100% of Equity Sizing



127



-Aabc (icon) 210 Account Association (Strategy Monitor) 150 Default 240 Set 305 Acronyms 332 Add blank space to chart 103 Strategy 55 Symbols (to DataSet) 37 to Strategy Monitor (Strategy Summary) Add New Parameter 130 Add to Strategy Monitor 150 Alert Time 113 Alerts ~ Pane (Strategy Monitor 153 Quotes tool 166 Strategy Monitor 154 triggering 166 Alerts View (Strategy window) 113 Allocation 104 Allow Trade Recycling 257 Trade Return Recycling 257 ASCII data 41 Data Cache 41 Parse Error 41 Associate Account (Strategy Monitor) 150 Associate Strategies with Accounts 305 Auto-Email Strategy Monitor 150 Automated Trading Features 182 Limitations 182 Auto-Place 184



-B-



111



Backtest 116 how to ~ (Multi-Symbol Backtest) 119 how to ~ (one symbol) 117 Multi-Symbol 119 on all Symbols 119 one symbol 117 results 118 symbol mode 117 Worst-case 125 Backtest Settings (Preferences) 230 Backtesting Important notes 116 Strategies 116 Backup 34 Bad Tick Filter 210 Bar Spacing 63 Bars Held (Avg) 214 basis price 127 Benchmark Buy & Hold 232 Symbol 232 Bracket Order manual place 195 OCO 195 Bracketed Orders 182 Buy & Hold 216 Benchmark Symbol 232 Buy and Hold, Equity 221



-CCallout (drawing) 68 Cancel automatic 182 © 2017 FMR LLC All rights reserved.
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Cancel Order 198 Candlestick (Chart Style) 80 Cash Freeing for new entries 120 Trade Type 194 Change chart style 79 scales 293 Chart Annotations 209 Colors 206 link charts 58, 118 open (new) 55 Right-click Menu 57, 60 Status Bar 1 (Price Data) 57 Status Bar 2 57 Styles 79 Styles (Trending) 81 Symbol 55 Tooltips 207 window overview 57 Chart Style Candlestick 80 change 79 EquiCandle 80 EquiVolume 81 Kagi 82 Line 79 Line Break 82 OHLC 80 Point and Figure 84 Renko 83 Charts Streaming 93 Checklist Auto-Trading 199 Circles (entry/exit price) 109 Clear dropped indicators 63, 87 Code Dropped Indicators 63 Colors 206 Combination Strategy 104 Commission Settings 228 Commissions 228 Compile 111 Controls Data Range 295 © 2017 FMR LLC All rights reserved.



Position Size 296 Scale 292 Strategy Parameters 303 Convert to Market 166 Copy Chart Image 60 Price Data 60 Strategy Rankings 159 Create new DataSet 37 Parallel Trendline 60 Create New DataSet 37 Creating Chart Styles for Wealth-Lab.NET



-DDaily Strategy Scheduling 150 Data backups 34 corrections 35 Edit 60 Editor 61 location 34 Manager 37 None Available 296 Panel 292 path 35 precision 34 Range Control 295 Relocate (Fidelity Provider) 50 Streaming 210 Tree 302 Update 49 Update Log 50 Data Panel 292 data path 66 Data Providers ASCII 41 Fidelity 39 MetaStock 44 Version 4 Format 44 Yahoo! 45 Data Range 295 Data Window 63 DataSet add symbols 37 create new 37 default 104
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DataSet delete 37 naming 38 rename 37 View 109 DataSet actions from Data Tree Add Symbol 302 Create DataSet 302 Delete DataSet 302 Remove Symbol 302 Rename DataSet 302 DataSet Tree 302 Right-click menu 302 DataSets 6 Debug Window 309 Default DataSet 104 Template Code 287 Default Account 240 Delete DataSet 37 Dataset (from Data Tree) 302 Drawing Object 60 dropped indicators 87 Dialog Debug & Error Messages 309 Fundamental Data Items 308 QuickRef 309 Technical Indicators 308 Diamond (drawing) 68 dimmed 292 Discretionary Trading 195 Download Strategies 305 Drawing Callout 68 Diamond 68 Ellipse 68 Fibonacci 72 Gann Fan 73 Horizontal Line 69 Image 68 Rectangle 68 Regression Channel 75 Speed Resistance 76 Text Note 68 Trendline 69 Triangle 68



Vertical Line 69 Drawing Objects Clear 67 Delete 67 How to Move 67 Modify 67 Properties 67 Resize 67 Storage Location 66 Drawing Toolbar 66



-EEdit Data 61 Edit Data 60 Editor 111 References (.NET Assemblies) 113 Ellipse (drawing) 68 Email Strategy 96 Entitlement 11 epoch defined 265 EquiCandle (Chart Style) 80 Equity Curve Scramble 257 EquiVolume (Chart Style) 81 Erase Dropped Indicators 63 Error Messages Window 309 Errors Quarantine 52 Strategy Rankings 159 Example Code *instructions* 8 Alert Sound 236 Lead Bars (GetAllDataForSymbol) 124 Position.Priority 126 Symbol details for Excel (PrintDebug) 113 TrendlineValue 70 Worst-case backtest 126 Exhaustive Optimization 133 Explore Strategies 305 Export Strategy code 96 Watchlist 52 Exposure 213 © 2017 FMR LLC All rights reserved.
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Extensions 3 Fidelity Supported Manager 244



244



-FFibonacci 72 Fidelity Data 50 intraday timestamp 39 Filled 240 Filter Bad Ticks 210 Gap 163 Find Strategies 305 Freeing cash (Portfolio Simulation) 120 from Previous Build 4 Function Toolbar Chart 57 Function Toolbar (Chart Mode) 63 Function Toolbar (non-Chart Mode) 290 Fundamental Data (dialog) 308 Fundamental Items plotting 92 Futures Mode 310 Characteristics 314



-GGann Fan (drawing) 73 Gap Filter 163 General Rules 100 Get Extensions 244 Glossary 321 Grace period (WealthSignals) greyed-out 292 Guaranteed Alerts 188



-HHide/Show Custom Panes 91 Volume Pane 91 Home page 11 Horizontal Line (drawing) How to



69
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Change Scales 293 Paper Trade 180 Reference .NET assemblies 111 Run Example Code 8 Size Positions 296 Use this Guide 6 How to (charts) Add strategy to chart 55 Change chart styles 79 change chart symbol 55 Open a new chart 55 Open a Streaming Chart 93 Plot fundamental data 92 Plot indicators 86 How to (DataSet) Add Symbols 37 Connect to Version 4 DataSources 44 Create 38 Create ASCII 41 Create Fidelity 39 Create MetaStock 44 Create Yahoo! 45 Delete 37 Modify 37 Rename 37, 38 How to (Draw) Draw Objects Manuallly 66 Modify Drawing Objects 67 Move Drawing Objects 67 Resize Drawing Objects 67 How to (Orders) Open the Orders tool 179, 201 How to (Plot) change 87 delete indicator 87 Indicator of Indicator 86 Indicators 86 interact 87 Plot MACD 87 How to (Strategy) Add blank space to chart 103 Backtest and Trade Priority 126 Convert for live trading 96 Create a Combination Strategy 104 Create a Rules-based Strategy 97 Create a Strategy from Code 103 Export a Strategy 96 Obtain worst-case results 125
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How to (Strategy) Open a New Strategy Window 103 Open an existing Strategy 108 Run a backtest (one symbol) 117 Run a Multi-Symbol backtest (MSB) 119 Run a Strategy 108 How to Run a Full Optimization 130 How to Run a Walk Forward Optimization 140 How Trades Are Chosen 125



-Iicon OCO 195 Image (drawing) 68 Import Watchlist 39 Index Builder 248 Calculation 250 Custom 248 Naming 248 Refresh 250 Synchronization 250 Updates 250 Indicators delete 87 icons 87 plotting (drag & drop) 86 properties 87 Intraday, time stamp 294 italicized (and underlined) 268



-JJitter Jitter Epoch



268



-KKagi (Chart Style) 82 Keyboard Shortcuts 111, 315



-LLast Execution Time 111 LastUpdateLog.txt 50



Limitations Automated Trading 182 Strategy Builder 100 Line (Chart Style) 79 Line Break (Chart Style) 82 Link charts 58, 118 Load Optimization Results 135 Log in to Fidelity 188 Log Scale 63 Loss Rate 214



-MMAE/MFE Performance Visualizer 321 Main Menu 287 Maintain Date Clustering 257 Serial Correlation 257 Win/Loss Sequence 257 Manager Extensions 244 Symbo Info 310 Map Network Path 306 Margin Trade Type 194 Margin Factor (equities) 301 MC Multi-Condition Group 101 Memory Usage Mode (Monte Carlo Visualizer) Menu Main 287 Minimize Custom Panes 91 Panes 91 Volume Pane 91 Mode Futures 310 Portfolio Simulation 299 Raw Profit 297 Modify Drawing Objects 67 Modify Order 198 Momentum 268 Monitor 117 Monte Carlo (Visualizer) Bar by Bar Returns 256 Baseline Run 260 Break-even 262
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Monte Carlo (Visualizer) Go, Stop, Clear 259 Introduction 225, 253 Position Sizing 255 Preferences 255 price shocks 260 Probability Curve 262 Profit & Drawdown Analysis 261 Raw Trades 256 Settings 257 Time Spans 263 Trade Price History 256 Monte Carlo Optimization 133 Move Drawing Objects 67 Multi-Condition (MC) Group 101 Multi-Symbol Backtest Reset 119



-NNetwork 306 Neural Network Evaluate Performance 279 Jitter 268 Locked 278 Momentum 268 overtraining 265 Quick Start 266 Sample Networks 281 Structure 265 Topology 268 Train 275 Training Data 271 Training Data Filter 273 Training Rate 268 Unlock 278 New and Noteworthy 2 New in Version 6.9 3 No Data Available 296 No Signals Today 175



-OOHLC (Chart Style) On demand update Open
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Different Strategy 60 new chart 55 Orders tool 179, 201 Strategy 55, 60, 108 Streaming Chart 93 Optimization Control 131 Full (Standard) 130 Getting Started 130 Graphs 138 Preferred Values 136 Results 135 Save/Load 135 Walk Forward 139 Optimization Methods Exhaustive 133 Monte Carlo 133 Optimize 117, 130 Rule-based Strategies 134 Optimize, Full Procedure 130 Optimize, Walk Forward Procedure 140 Options Advanced 238 Chart Annotations 209 Colors 206 Commissions 228 Performance Visualizers 211 Round Lots 233 Slippage 233 Sounds 236 Streaming Data 210 OR Divider 97 Order Cancel 198 Modify 198 Partial Fill 198 Orders Bracket 182 Concepts 184 List (description) 192 Open when trade Staged/Placed tool 179 Toolbar 1 188 Toolbar 2 190 overtraining 265
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-PPaper Accounts Configure 202 Paper Trading Features Not Supported 180 How Orders Are Filled 180 How To 180 Overview 180 Purpose 180 Quotes 161 Parameter sliders Strategy Builder 99 Parameters Create 304 Expose 304 Parse Error 41 Partial Fill 198 Percent, Losers 214 Percent, Winners 214 Performance Visualizers 211 Place 184 Plot Fundamental data 92 Indicators 86 MACD 87 Point and Figure (Chart Style) 84 Polygon (drawing) 68 Portfolio Simulation Mode when to use 116 Portfolio Simulation Mode (sizing) 299 Portfolio Synch 198 Portfolio Synchronization 186 PortfolioSynch 186 Position Priority 125 Position Size 100% of Equity 127 Control 296 Position Sizing Monte Carlo Visualizer 255 tips for trading 296 PosSizers 300 Preferences 205 Advanced 238 Backtest Settings 230 Chart Annotations 209



Colors 206 Commissions 228 Decimal display 239 Printing 238 Round Lots 233 Slippage 233 Sounds 236 Streaming Data 210 Preferred Values 136 Set PVs from Sliders 304 Strategy Rankings 158 Price Triggers add 162 Print Strategy Code 111 Strategy Rankings 159 Printing Preferences 238 Priority (Position) 125 Process Stock Split 60 Profit 213 Profit, Net 213 Profit, per Bar 213 Push Dropped Indicators into Code PV 136



63



-QQuarantine 50 QuickRef (WealthScript) Quotes add 162 Employing 168 Paper Trading 161 Providers 160 Workspace 160 Quotes for Paper Trading



309



162



-RRandom Position Priority 125 Rankings 157 Raw Profit Mode when to use 116 © 2017 FMR LLC All rights reserved.
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Raw Profit Mode (sizing) 297 Real-time (streaming) charts 93 Strategies 128 Rectangle (drawing) 68 Reference 286 References 111 References (.NET Assemblies) 113 Regression Channel (drawing) 75 Rejected trades 125 Reload Chart History 60 Relocate Data 50 Remove dropped indicators 87 Symbol (from Data Tree) 302 Rename DataSet (from Data Tree) 302 Rename Strategy Parameters (Rules) 100 Renko (Chart Style) 83 Re-run Backtest 303 Reset Multi-Symbol Backtest mode 119 Reset (Parameters) 303 Resize Drawing Objects 67 Results Strategy Rankings 159 Round Lots 234 Rounding limit 232 stop 232 Rules General 100 Rules-based Strategy 97 Run ~ this Strategy now 152 Strategy 108, 111



-SSave Optimization Results Parameters 303 Scale 60 Minute 39 change 293 Linear 63
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Log 63 One-click scale change 59 select 293 Scale (Control) 292 Scheduling Daily Strategies 151 Scorecard 158 Search Strategies 305 Semi-Log Scale 63 Set Account 305 WealthSignals Trader 174 Set Preferred Values from Sliders 304 Short Trade Type 194 Shortcuts by Category 317 Editor 319 Show for all charts (see tip) 63 Fundamental Data 63 Indicator Labels 63 Local Times 151 Status Bars 63 Sizing 100% of Equity 127 Portfolio Simulation Mode 299 Positions 296 Raw Profit Mode 297 Sliders Strategy Builder 99 Slippage Settings 233 Slippage, Percentage 234 Slippage, Ticks 234 Software Upgrade 288 Sounds 236 Spacing (Bar) 63 Speed Resistance Lines (drawing) 76 Splits Ignore (Yahoo!) 45 Stage 184 Status Bar (chart) Price Data 58 Status Bar 2 58 Status Bar (Strategy window) Status Bar 2 118 Stock Split (manual) 60
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Stop and Reverse 182 Strategy ~ Pane (Strategy Monitor) 150 add 55 Alerts 113 backtest 116 Child 104 Downloads 305 Editor 111 execute 108 existing 108 Explorer 305 export 96 Expose Parameters 304 Find 305 from Code 103 open 55, 108 Priority 104 Rankings 157 re-run 118 Rules-based 97 run 108 Search 305 Streaming mode 128 Summary 111 Terminate execution 315 what is a ~? 95 window (explained) 95 Strategy Builder 97 Limitations 100 Strategy Monitor 5 Employment Notes 155 QuickStart 149 Strategy Monitor 147 Strategy Parameters Rename 100 Strategy Window Reset after MSB 301 Stream 117 Streaming charts 93 Data 210 disconnect 93 enable all Chart windows 93 spikes 93 Strategies 128 Tickers 210 Switch



scales 293 Symbol Management 50 Quarantine 50 Symbol (Go) 301 Symbol Info Manager 310 synapse 265 Synchronizing Local Time 155



-TTechnical Indicators (dialog) 308 Template Code 287 Terminate Strategy execution 315 Text Note (drawing) 68 Theoretical vs. Actual 186 Threshold Trigger 162 Tickers, streaming 210 TIF 196 Time in Force 196 Time stamp (intraday) 294 Tip Add DataSet symbols to Quotes 162 add space in chart 103, 104 control log scale in Strategy code 64 Distinguishing Fib Time Zones 73 Drawing a horizontal trendline 70 enable Streaming for all charts 93 F1 in Editor for QuickRef 309 Fibonacci Values (off the chart) 72 Fill transparency for shapes 68 Gann Line settings 74 Gann Line Width 74 IPreferences) Controlling sounds for stop/limit orders 236 IPreferences) HidePaneLines() 206 IPreferences) HideVolume() 206 IPreferences) Round Lots 234 IPreferences) SetBackgroundColor() 206 IPreferences) SetBarColor() 206 Last settings for Strategy Windows 292 Locate Chart and Quotes windows 288 Pre-configure Strategies for Strategy Monitor 150 Resize chart panes manually 57 © 2017 FMR LLC All rights reserved.
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Tip Rule descriptions 97 Save Rankings in Workspaces 157 Saving plotted indicators 86 show for all charts 64 Sorting Alerts by Strategy 153 Sorting By Period returns 224 Sorting the Trades list 218 syntax errors, locating 112 Use Daily for Weekly, Monthly, etc. 293 View Kagi percentage on semi-log 82 WealthScript QuickRef 113 Toolbar Drawing 66, 291 Function (Chart Mode) 63 Function (non-Chart Mode) 290 Navigation 289 Tooltips Indicators 207 Prices 207 Rollovers 207 Topology 268 Tradable Trendline (drawing) 71 Trade Circles 109 connecting lines 109 Randomization 257 Scramble 257 Scramble and Randomize 257 Synthesize 257 Triangles 109 Trade Ticket 195 Trade Type 194 Trader WealthSignals 169 Trades dropped 127 how they're chosen 125 not included 125 rejected 125 Trades, number 214 Trades, total 214 Trading Discretionary 195 Manual 195 Right-click 61 Ticket 195 Trailing stops 182 © 2017 FMR LLC All rights reserved.



Training Rate 268 Trendline Create Parallel 60 Tradable 71 Trendline (drawing) 69 Trial Mode 1 Triangle (drawing) 68 Triangles (entry/exit) 109 Trigger Threshold 162 Triggering (What is ~?) 160 Troubleshooting different results on 2 computers No Trades 128 unexpected results 128



-UUnder Review 175 underlined (and italicized) 268 Update Data 49 Log 50 on demand 287 Update (Orders tool) 188 Upgrade software 288 User Data folder 305 utility scripts 41



-VVersion 30 Day Trial 10 Full Access 10 Product 287 Vertical Line (drawing) 69 Visualizer By Period 223 By Symbol 217 Drawdown 222 Equity Curve 220 MAE / MFE 222 Monte Carlo 225, 253 Performance 212 Profit Distribution 221 Trades 218 Visualizers 211 Volume
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Volume Backtest Settings (reduce quantity)



230



-WWalk-Forward Expanding Window 142 Sliding Window 139 Walk-Forward Optimization Default Values, Assigning 143 Efficiency 143 Interval 140 Interval, Current 144 Optimization Method 140 Overview 139 Parameter Graph 145 Preferred Values, Assigning 143 Saving 143 Saving Results 143 Scorecard 143 Settings 140 WFE 143 Window Type 140 Watchlist Import 39 Watchlists Export 52 Wealth-Lab Score 215 WealthScript QuickRef 309 WealthScript Override 299 WealthSignals 169 Abort Publishing 173 Accessing Signals 175 Awaiting Publication 175 Best practices for authors 177 Grace period 173 No Signals Today 175 Position Size factor (subscriber) 170 post a system 171 Signals Pane 175 subscribe to 170 Under Review 175 WealthSignals Trader Launch 174 Log in 174 Set Account 174 What's Changed 3



Wildcard 310 Win Rate 214 Window Expanding(WFO) 142 Sliding (WFO) 139 Wizard Rules 97 Strategy Builder 97 Workspaces Default 288 Delete Default Workspace
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